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Over view  of  t he QALoad  Player  
The QALoad Player simulates one or more virtual-users running C++ or Java based scripts, depending upon 
which middleware environment was used for the test. These scripts mimic user act ivi t ies to load test the 
appl icat ion, network, and server components of a cl ient-server system. 

The QALoad Player simulates mult iple cl ients sending middleware cal ls back to a server. General ly, these 
are database SQL cal ls — although other types of middleware layers can also be tested. When running 
virtual user simulat ion, QALoad Player can emulate mult iple users from a single platform using the mult i-
tasking features of 32-bit  Windows. The number of users that a single hardware system can emulate is 
determined by the processor speed, main memory size, middleware layer, and simulated transact ion rate. 
Please contact your QALoad distributor for further sizing in formation. 

Once started, QALoad Player funct ions ent irely in  the background without any direct user in teract ion. Al l  
commands to QALoad Player come from the QALoad Conductor. In  fact, once QALoad Player has been 
started, the only in teract ion you may have with i t  is to change startup parameters or to save the contents 
of the display window to a fi le. When the Conductor process closes for any reason during a load test, the 
associated Player processes terminate. 

Citrix and SAP 6.20/6.40 scripts play back in  a virtual user window on the desktop. For SAP, i t  is possible to 
enable or disable the VU window from the Conductor's Custom M iddleware Options dialog box. Citrix 
replay sessions are min imized by default , but can be restored on the desktop. 
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QALoad  Player  m enus 
The fol lowing menus are avai lable from the QALoad Player:  

Fi le menu  

Edit  menu  

View menu 

Options menu  

Help menu  



QALoad 05.06 Using the Player, Script  Development Workbench, and Analyze 

4 

Inst al l i ng  UNIX Player s 
For in formation about instal l ing UNIX Players, please refer to the QACenter Performance Edit ion 
Instal lat ion and Configurat ion Guide.  

You can access th is guide by cl icking 
Start>Program s>Com puw are>QALoad>Docum en tat ion>Instal l at i on  and Con f igurat ion  Guide. 
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Tun ing  QALoad  Player  f or  use w i t h  Or acle 
Oracle version 7 SQL*NET puts significant demands on the system running QALoad Player by demanding 
at least 1MB of physical memory and approximately 3MB of virtual memory per simulated user. 
Compuware recommends you fol low these guidel ines when using Oracle to opt imize QALoad Player 
performance: 

!  Set the Execut ing Threads Startup Interval parameter on the Player Configurat ion dialog box’s 
Startup Parameters tab to between 2,000 and 4,000 mil l iseconds. 

!  Unless your appl icat ion cont inual ly logs in  and out of Oracle, move the logon commands 
(DO_olog and i ts associated DO_ologof) outside the Begin_Transact ion/End_Transact ion loop, 
where the Oracnvrt  program places them by default . 
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Tr ansf er  Scr ip t s t o a UNIX Player  
Normally, the appropriate script  is automatically uploaded from the QALoad Conductor to the Players and 
compiled at runt ime. However, i f i t  is ever necessary to manually transfer a script , use the procedure that 
fol lows. 

Note: The machine where the QALoad Script Development Workbench is installed must have Winsock-
based TCP/IP to transfer a script to the UNIX machine where you wish to run it. 

To t ransf er  a scr ip t : 

The fol lowing procedure describes how to transfer a script  fi le from the Windows workstat ion where the 
QALoad Script Development Workbench resides to the system running the QALoad Player. 

1. Access the Script Development Workbench. 

2. From the Session  menu, choose the middleware session you want to start . 

3. In  the Workspace Pane, cl ick the Scripts tab. 

4. On the Scripts tab, select the script  you want to transfer. 

5. From the Tools menu, choose FTP to open the FTP Transfer dialog box. Note that the fi le name 
you selected to transfer appears in  the Fi l e to Transfer field. 

6. Enter the Host  Nam e, User Nam e, Passw ord, and Dest inat ion  Di rectory. 

7. Click Transfer to send the fi le to the system where your QALoad Player is instal led. 

8. If you want to save the in formation you have entered for subsequent transfers, cl ick Save Set t i ngs. 

9. Click Close/ Abort  to exit  the FTP Transfer dialog box.  
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Val idat ing  Scr ip t s in  t he Player  
Before adding a script  to a load test, val idate i t  to ensure that i t  runs without problems. The fol lowing 
procedure is only val id for Win32 scripts. To val idate a UNIX script , see Val idat ing a UNIX script . 

Note: During validation of SAP scripts, do not minimize the SAP window. If the window is minimized, the 
validation may fail. This problem does not occur if you select the Hide Graphical User Interface for SAP 
Users option by clicking Browse [...] in the Type column of the Script  Assignment  tab in the Conductor. This 
SAPGUI option runs SAP on an alternate desktop that is not visible. 

To conf igure t he Player  f or  val idat ion: 

1. In  the Script Development Workbench, cl ick Opt ions>Workbench  and select the Script  
Val idat ion  tab. 

2. Select the Autom at i cal l y Recom pi le check box i f you want QALoad to compile a script  before 
attempting to val idate i t . QALoad l ists any compilat ion errors in  the editor after compil ing. 

3. (For Java and OFS) select Ask  for Autom at i c Val idat ion  of  Java and OFS Scripts. 

4. Select the On ly Display Player Output  on  Script  Fai lure check box to view only Player messages 
upon script  fai lure, i f appl icable. 

5. Type a value in  the W ai t  up to field. This is the number of seconds that the QALoad Script 
Development Workbench should wait  for a script  to execute before t im ing out. 

6. In  the Player Sett ings area, select the Abort  on  Error check box for QALoad to stop script  execut ion 
upon encountering an error. 

7. Select the Debug Data check box for the script  to display a debug message indicat ing which 
command the script  is execut ing. 

8. In  the Run As area, indicate whether the transact ion should be run as th read- or process-based . 

Note: Oracle Forms Server, Citrix, Java, and Uniface scripts are limited to process-based validation only. 

9. In  the Number of users field, type a number of virtual users to run th is script  for val idat ion. The 
default  is 1. 

10. Enter a value in  the Transact ions field. For val idat ion, Compuware recommends that you accept 
the default  value of 1 transact ion. 

11. In  the Sleep Factor % field, type the percentage of each DO_SLEEP (pause in the script) to maintain. 
For val idat ion, you may not need to run every pause in the script  at  i ts ful l  length. The value can 
be a percentage between 0 and 100. The default  is 0. 

12. Click OK to save your changes. 

To val idat e a scr ip t  in  t he Player : 

1. In  the Com pi led Script  field, browse for the compiled script  DLL you want to val idate. Compiled 
scripts are usual ly located in  the directory \Program Files\Compuware\QALoad\Scripts. 

2. Type a value in  the Num ber of  Users field. Compuware recommends one user for script  val idat ion. 

3. Type a value in  the Transact ions field. Compuware recommends one transact ion for script  
val idat ion. 
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4. Select any appropriate opt ions to the right of the Compiled Script field. These opt ions determine 
the type and amount of data that wi l l  display in  the Player Main Window. For descript ions of each 
opt ions, see the topic QALoad Player Main Window. 

5. In  the Run  As area, select whether the transact ion should run as th read- or process-based. 

6. Click Start  to run the script . The Player M ain Window wil l  show the script 's progress. If the script  
runs successful ly, i t  is val id to use in  a load test.  
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Dialog  Box  and  Field  Descr ip t ion  

QALoad Player Main Window 
The QALoad Player Main Window is divided into two parts: 

!  The top port ion contains fields, buttons, and opt ions that help you configure the Player for script  
val idat ion. When an actual load test is in  progress, th is area displays the fol lowing in formation: 

 Version : The version of the QALoad Player. 

 Player Nam e: The network name assigned to the Player workstat ion. 

 Player Address: The network address of the Player workstat ion. 

 Player Port : The port  number on th is Player workstat ion being monitored by the QALoad 
Conductor. 

 Player i s runn ing… the type of virtual users th is Player is running. 

 The number of virtual users and transact ions th is Player is running. 

!  The bottom port ion of the Player M ain Window displays Player messages whi le a script  is running.  

Fields and But tons 

Com pi led Script : Navigate to the compiled script  (.dl l ) to val idate. 

Users: Type the number of users to emulate when val idat ing the selected script . Compuware recommends 
one user for script  val idat ion. 

Transact ions: Type the number of t ransact ions to run when val idat ing the selected script . Compuware 
recommends one transact ion for script  val idat ion. 

Start : Cl ick to begin script  val idat ion. Player messages wil l  display below. 

Abort : Cl ick to stop al l  virtual users immediately. 

Ex i t : Cl ick to exit  the load test graceful ly, when each virtual user is fin ished. 

Debug Data: Select th is check box to have the Player display a debug message indicat ing which command 
the script  is execut ing and to generate WWW replay log fi les. 

RR__Fai ledM sg: Select th is check box to view, in  the Player window, the poin t where a middleware 
command with in your script  fai ls. 

Check  Poin ts: Select th is check box i f you want to display the Check Point command response t imes in 
the Player window.  

Auto Clear: Select th is check box to automatical ly clear any messages from the bottom port ion of the 
window before running a new script . 

Abort  on  Error: Select th is check box to abort  script  execut ion when an error is encountered. 

Create Tim ing Fi l e: Select th is check box to create and save a Player t im ing fi le for th is Player to the 
default  QALoad t im ing fi le directory (normally \Program Files\Compuware\QALoad\TimingFiles). 

Run  As: Select i f th is Player should run scripts as th read- or process-based. 
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Save As 
Use th is dialog box to save a text fi le of the messages reported by Player during a test, or to save an exist ing 
buffer with a different name. 

Access th is dialog box from the Fi l e menu by selecting Save Buf fer or Save Buf fer As. 

Player configurat ion 
Use th is dialog box to set startup parameters for Player. The default  startup parameters are saved in the 
player sect ion of the QALOAD.INI fi le. 

Access th is dialog box from the Opt ions menu by select ing Player Con f igurat ion . 

Runtime tab 

Player Nam e: This is the name that the Player wi l l  report  to the QALoad Conductor during a request. It  
may be any string of alphanumeric characters, provided that the length does not exceed 10 characters and 
there are no embedded spaces. 

Com pi led Scripts: This field points to the directory which wil l  hold the compiled scripts. When a test is 
started, Player looks for scripts in  th is directory. The configurat ion screen wil l  veri fy that the directory 
exists. 

Compuware recommends that you use a directory on a networked drive to hold the compiled scripts. 
Otherwise you wil l  need to manually copy the script  fi les to each Player system whenever a script  changes. 

Local  Datapool : This field points to the directory which wil l  hold the local datapool fi le referenced by th is 
Player workstat ion.  

Tim ing Fi l e: This field points to the default  directory where the t im ing fi les are located. 

Java tab 

jvm .dl l  di rectory: (opt ional) This is the directory where the JVM.DLL fi le is located. If specified, th is 
JVM.DLL wil l  be used to run the Java scripts from a standalone Player; otherwise, the entry specified in  the 
Compiler Sett ings tab of the Configure QALoad Script Development Workbench dialog box wil l  be used. 
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Over view  of  t he Scr ip t  Developm en t  Wor k bench  
The QALoad Script Development Workbench is the QALoad component used to develop load test scripts. It  
contains the faci l i t ies you need for recording transact ions such as funct ion cal ls or request / response 
interact ions placed by your Windows appl icat ion. The recorded transact ion, cal led a capture fi le, contains 
raw data that must be converted to an editable test script  based on C++ or Java, depending upon which 
middleware environment is under test.  

After convert ing the recorded transact ion to a script , you can use the Script Development Workbench's 
script  editor and other funct ional i ty to make any necessary modificat ions to your script . For example, 
maybe you had to sign on to a Web server with a user name and password as part  of your recorded 
transact ion. At test t ime, when mult iple virtual users are running your test script , you might want each 
user to have a different user name/password combinat ion.  

You can use the Script Development Workbench to create a re-usable pool of user name/password 
combinat ions, saved as a datapool fi le, and edit  your script  to extract values from that fi le at test t ime. 
QALoad provides script ing commands for si tuat ions l ike that, and provides a Funct ion Wizard and onl ine 
language reference, both avai lable right from the editor, to help you locate and insert  the right commands.  

When you are sat isfied wi th your test script , you can compile i t  direct ly from the Script Development 
Workbench. And, final ly, add i t  to a load test in  the QALoad Conductor. 

In  shor t , t o p roduce a usable t est  scr ip t  you: 

1. Record a transact ion in to a capture fi le (.cap). 

2. Convert  the capture fi le to an editable script . 

3. Edi t  the script . 

4. Com pi le the script . 
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The Scr ip t  Developm en t  Wor k bench  M ain  W indow  
The QALoad Script Development Workbench main window is divided into dynamic panes that you can 
h ide or show as needed by select ing commands from the View menu.  

Hint : Click on a pane in the following graphic for a description of that pane. Use your scroll bars to see the 
rest of the graphic. 
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M enus and  Toolbar  But t ons 
The QALoad Script Development Workbench menus and buttons change depending on whether you have 
an EasyScript Session open.  

Menus and Toolbars without  an Open EasyScript  Session 
The fol lowing menus and toolbars are avai lable when an EasyScript Session is not open. 

Fi le 
View 
Options 
Session 
Tools 
Help  
Toolbar Buttons 

 Menus and Toolbars with an Open EasyScript  Session 
The fol lowing menus and toolbars are avai lable when an EasyScript Session is open. 

Fi le 
Edit  
View 
Options 
Session 
Tools 
Window 
Help 
Toolbar Buttons  
Recording Toolbar 
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Accessing  t h e QALoad  Scr ip t  Developm en t  
Wor k bench  

To access t he Scr ip t  Developm ent  W orkbench: 

1. From the Windows taskbar, cl ick the Start  button. 

2. Choose Program s>Com puw are>QALoad>Script  Developm en t  Workben ch .  



QALoad 05.06 Using the Player, Script  Development Workbench, and Analyze 

16 

Con f igur ing  t he Scr ip t  Developm en t  Wor k bench  
The first  t ime you use the QALoad Script Development Workbench, you should set opt ions to determine a 
working directory QALoad can use for temporary fi les, compiler sett ings, and other general opt ions related 
to the behavior of the QALoad Script Development Workbench. 

To set  a w ork ing d i r ect ory: 

1. Access the Script Development Workbench. 

2. From the Session  menu, choose the session you want to start . 

3. From the Opt ions menu, choose Workbench . 

4. Set any appropriate opt ions. For a descript ion of the avai lable opt ions, press F1 from the Configure 
Script  Development Workbench dialog box. 

Note: Compuware recommends that you always select Automat ically Convert  Capture on the 
Workbench Configuration tab and Automat ically Compile Scripts on the Compiler Settings tab. 

5. Click OK to save your sett ings.  
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Using  EasyScr ip t  Sessions 

EasyScript  Sessions 
When you first  open the Script Development Workbench, you can set general opt ions related to which 
panes to display, your compiler, and so on, but you cannot begin any middleware-specific act ivi t ies, such 
as recording a transact ion, unt i l  you open an EasyScript Session. Opening an EasyScript Session tai lors the 
Script Development Workbench to a specific middleware environment, providing you with al l  the 
appropriate opt ions and funct ions for your script ing needs. 

To open an EasyScript Session, choose your middleware type from the Session menu, or cl ick the 
appropriate toolbar button. Once a session is open, the Workbench interface changes. 

You can also open a Universal session to record cal ls from mult iple middlewares with in a single session. 

EasyScript  for Secure WWW 

Overview 

EasyScript for Secure WWW supports SSL/HTTPS requests when used in conjunct ion with the WWW 
middleware. This support must be purchased separately and is distributed in  a separately-instal led module. 

Import ing a Client  Cert ificate from a Web Browser (SSL) 

You can import and convert  a Cl ient Cert i ficate for any Web site you plan to visi t . 

To im por t  a cl ient  cer t i f icat e: 

1. Start  your Web browser. 

2. From the browser, select the Client Cert i ficate for the Web site you plan to visi t . 

3. Export the Client Cert i ficate (.p12 of .pfx fi le) to a directory where you can access i t  using the 
Script Development Workbench. 

Note: When the browser prompts you to enter a password, do not  enter a password. If you enter a 
password, QALoad cannot process the file. 

4. Start  a WWW Session in  the QALoad Script Development Workbench. 

5. Click Tools>Maintain Cert i ficates to open the SSL Cert i ficate Maintenance dialog box. 

6. On the Cl ien t  Cert i f i cates tab, cl ick the browse but ton [...] to browse for the Client Cert i ficate you 
want to convert . The Select the Exported Client Cert i ficate to Convert  dialog box opens. 

7. Make sure Fi l es of  Type specifies P12 fi les (*.p12) or PFX fi les (*.pfx). 

8. Select the appropriate Cl ient Cert i ficate and cl ick Open . The path and fi le name of the selected 
Client Cert i ficate appears in  En ter Cert i f i cate to Convert  on the Client Cert i ficates tab. 

9. On the Cl ien t  Cert i f i cates tab, cl ick Convert . 

10. Click Close to exit  the SSL Cert i ficate Maintenance dialog box .  
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Creat ing a Client  Cert ificate in QALoad (SSL) 

This procedure assumes you have a WWW session act ive. 

To creat e a cl ien t  cer t i f i cat e: 

1. From the Tools menu, select M ain tain  Cert i f i cates to open the SSL Cert i f i cate M ain tenance 
dialog box. 

2. On the Client Cert ificates tab, enter a name in the Cert i f i cate Nam e field. 

3. Enter the number of cert i ficates to create. 

4. Click the Create button to create the QALoad Client Cert i ficate. QALoad stores i t  in  the 
QALoad\ Cert i ficates directory. 

Note: On the Unix player platform, you must create the Certificates sub-directory in the QALoad 
directory. The directory name is case sensitive. 

5. If necessary, configure your Web server to accept QALoad as the Cert i ficate Authori ty. Refer to your 
Web server documentat ion for more in formation.  

Creat ing an SSL Cert ificate Authority 

Note that creat ing a new CA inval idates al l  previously created cl ient cert i ficates. 

To creat e an SSL Cer t i f i cat e Aut hor i t y: 

1. Start  a WWW session. 

2. From the Tools menu, select M ain tain  Cert i f i cates. 

3. Click the Cert i ficate Authori ty tab. 

4. Click the Create button to create a new Cert i ficate Authori ty with the expirat ion date shown in the 
field.  

5. Exit  and re-start  the Script  Development Workbench. 

6. After creat ing a new Cert i ficate Authori ty, re-import the CA to your Web server and then create 
new Client Cert i ficates.  

Creat ing an SSL Server Cert ificate 

To creat e an SSL Server  Cer t i f icat e: 

1. Start  a WWW session. 

2. From the Tools menu, select M ain tain  Cert i f i cates. 

3. Click the Server Cert i ficate tab. 

4. Click the Create button to create a new Server Cert i ficate with the expirat ion  date shown in the 
field.  
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Using  M idd lew ar e Sessions 

Using the Universal Session 
The Universal session al lows you to record cal ls from mult iple middleware appl icat ions with in a single 
Script  Development Workbench session. You might use the Universal session in  cases where your 
appl icat ion accesses an addit ional appl icat ion that uses a different protocol. 

For example, your browser might download and open a Java applet which then communicates with a 
Winsock server. If you recorded that act ivi ty using a simple WWW session, the Script Development 
Workbench would only record the HTTP requests that downloaded and opened the Java applet. Recording 
that transact ion with the Universal session ensures that you record the HTTP requests from the browser as 
well  as the Winsock-based communicat ion between the Java applet and the Winsock server — al l  with in a 
single script . 

You start  and record from a Universal session exact ly l ike a single middleware session with one difference 
— after start ing a Universal session you must select which middleware appl icat ion(s) to record.  

Opening a M iddleware Session 

To access t he Scr ip t  Developm ent  W orkbench and open a m iddlew are session:  

1. Click Start>Program s>Com puw are>QALoad\ Scri pt  Developm en t  Workben ch .  

2. Choose the middleware name from the Session  menu or by cl ick the appropriate button on the 
toolbar. The Defaul t  Session  Prom pt  opens.  

Note: If this middleware type should be the default every time you open the Script Development 
Workbench, select the check box Make this my default  session. If you do not want to be prompted to set a 
default middleware, clear the Enable default  session checking check box. You can also turn default session 
checking on or off from the Configure Script Development Workbench dialog box at any time. 

3. Click OK. 

Set t ing Conversion Opt ions 
Before you begin recording, you can set opt ions to automatical ly customize your script  during conversion. 
Compuware recommends you set conversion opt ions before recording, then use the opt ion to 
automatical ly convert  your capture fi les to scripts. Detai ls 

1. Access the Script Development Workbench. Detai ls 

2. From the Session  menu, select the appropriate middleware or start  a Universal session. 

3. Select Opt ions>Convert  to open the appropriate Convert  Options dialog box. 

4. In  the Session Options tree, cl ick Shared Convert  Opt ions and set any appl icable opt ions. This 
tree-view contains common opt ions that apply to al l  the middleware environments QALoad 
supports. 

5. Click the middleware-specific convert  opt ions in  the Session Options tree, and set any appropriate 
middleware-specific opt ions. 

Notes:  

 For the Citrix Web Interface environment, you must select opt ions in  both the Citrix Convert  
Options and the WWW Convert Options in  the tree view. 
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 For WWW, refer to Using the WWW Convert Options. 

6. When you are fin ished, cl ick OK to save the current  sett ings. 

Hint : Press F1 from any middleware options tab for a description of available options.  

 

ADO 

Recording ADO Sessions 

Click the ADO button on the toolbar to open an ADO session. 

To set  ADO recording opt ions and begin r ecording: 

1. Click Opt ions>Record on the menu bar. The Session Options dialog box appears. 

2. Select the appropriate opt ions in  the right-hand pane, then cl ick OK. 

3. Click the Record button on the Session toolbar. 

Set t ing ADO Convert  Opt ions 

To set  conversion  opt ions f or  an ADO session: 

1. Choose Opt ions>Convert  in  the Script Development Workbench menu bar. The Session Options 
dialog box appears. 

2. Select the appropriate opt ions in  the right-hand pane, then cl ick OK. 

ADO Method Reference 

QALoad provides descript ions and examples of the various methods that are avai lable for an ADO script . 
For detai ls, refer to the Language Reference Help sect ion for ADO. 
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Cit rix 

Overview 

Use QALoad's Citrix middleware to load test systems that run Citrix MetaFrame or Citrix MetaFrame XP.  

What is Citrix? 

Citrix middleware is a communicat ion layer that provides remote access to Windows systems. The remote 
system appears in  a window on the local system.  

Connecting to the remote system 

Once connected to a machine that is running the MetaFrame server, log in to the remote system and run 
appl icat ions. Alternat ively, specify an appl icat ion in  addit ion to a user name and password, which provides 
access only to the specified appl icat ion and min imizes user input that is necessary to access the appl icat ion 
under test. Test the environment using the Window Citrix Client to start  a Citrix session. 

Testing in load-balanced environments 

If test ing an environment that includes a server farm, use Citrix ICA fi les to support th is type of 
configurat ion. Specify the ICA fi le on the Citrix Record Options dialog box. ICA fi les are also necessary for 
encrypt ion. ICA fi les are generated on the MetaFrame server and can be obtained from your MetaFrame 
administrator. For more in formation about using ICA fi les, see Using ICA fi les.  

When ICA fi les are not provided by an appl icat ion, specify connect ion in formation using the Published 
Applicat ions or the Single Server opt ions in  the Citrix Record Options dialog box. These opt ions also 
enable you to specify l ists of publ ished appl icat ions and servers to invoke when you log on to the Citrix 
cl ient session. 

Testing using the Citrix Web Interface 

When you in i t iate Citrix-publ ished appl icat ions using a web browser, you can capture and playback scripts 
in  QALoad using the Citrix Web Interface. The Citrix Web Interface starts a Universal session with the 
Citrix and WWW middlewares selected. The WWW middleware in tercepts the ICA fi le created by the web 
server. It  passes data to and from the Citrix Server during the capture process, enabl ing you to test the 
performance of appl icat ions that are avai lable through internet connect ions. 

About  the Cit rix Web Interface 

Capture and playback scripts for Citrix appl icat ions accessed through a web browser using the Citrix Web 
Interface. This starts a Universal session for both the Citrix and WWW middlewares, which enables the 
WWW middleware to pass in formation to and from the Citrix server. 

When select ing a publ ished appl icat ion through a web browser, the request is sent to the web server. The 
web server creates an ICA fi le for the requested appl icat ion and returns i t  to the web browser. When the 
web browser finds an associated appl icat ion to handle the ICA fi le, the Citrix cl ient starts the publ ished 
appl icat ion requested. The ICA fi le used during the capture process is saved in 
QALoad\Middlewares\Temp. 

Note: Only the first ICA file received by the web browser is recorded. 

The converted script  contains both Citrix and WWW funct ions. A new variable, char* 
strICAFileName[N], is declared at the top of the script . Al l  al located memory is released at the end of the 
script .  

Accessing a Cit rix Session 

Use one of the fol lowing methods to begin recording a Citrix session. 
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To access a Ci t r ix  Cl ien t  session: 

 From the Session  menu, cl ick Ci t r i x>Window s Cl ien t . 

OR 

 On the toolbar, select the down arrow next to the Ci t r i x  button on the toolbar, then select 
Window s Cl ien t . 

To access t he Ci t r ix  W eb Int er f ace w hen select ing a Ci t r ix  session : 

 From the Session  menu, cl ick Ci t r i x>Web In terface.  

OR 

 On the toolbar, cl ick the down arrow next to the Ci t r i x  button, then select Web In terface. 

The Universal session starts with both the Citrix and WWW middlewares selected. In  the Citrix tab, 
Web Interface is selected in  the Type field. 

To access t he Ci t r ix  W eb Int er f ace f rom  a Universal  session: 

1. On the toolbar, cl ick Sessi on>Un iversal  or cl ick the Un iversal  button on the toolbar. 

2. Click Opt ions>Record. The Universal Record Options dialog box appears. 

3. In  the M iddleware Select ion pane, select W WW, then select Ci t r i x . The Universal Record dialog 
box displays both a WW W tab and a Ci t r i x  tab. In  the Ci t r i x  tab, Web In terface is selected in  the 
Type field. 

Recording a Cit rix Session 

To begin recording a Citrix session, select the down arrow next to the Ci t r i x  button on the toolbar, then 
do one of the fol lowing procedures below.  

Tips: Uppercase characters are not captured when the CAPS Lock key is on. Manually modify the script to 
use uppercase characters or hold down the SHIFT key during recording. 
Similarly, the Windows Logo key is not supported. Do not use the Windows Logo key to start applications 
while recording a Citrix script. 

To begin r ecording a Ci t r ix  Cl ien t  session: 

1. Select Window s Cl ien t  to act ivate a new Citrix session.  

2. Click  Opt ions>Record on the menu bar, and select the appropriate opt ions. 

3. Click Record on the Sessi on  toolbar.  

The Citrix capture appl icat ion appears, as shown in the fol lowing image. Cl ick the three sect ions of the 
image to learn more about the fields and the in formation that is displayed in each area. 
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To begin r ecording using t he Ci t r ix  W eb Int er f ace: 

1. Select Web In terface to act ivate Universal session for the Citrix Web Interface. 

2. Click Record on the Sessi on  toolbar. The Un iversal  Record Opt ions dialog box displays. 

3. Select the appropriate opt ions, then cl ick Start  Record . 

Set t ing Cit rix Convert  Opt ions  

To set  conversion  opt ions f or  Ci t r ix  Cl ient  session:  

1. Choose Opt ions>Convert  in  the Script Development Workbench menu bar. The Session Options 
dialog box appears. 

2. Select the appropriate opt ions, then cl ick OK. 

To set  conversion  opt ions f or  Ci t r ix  W eb In t er f ace session:  
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1. Choose Opt ions>Convert  in  the Script Development Workbench toolbar. The Session Options 
dialog box appears with both Citrix and WWW selected. 

2. Click the Session  Opt ions tab. 

3. Under Convert  Options, cl ick Ci t r i x  Convert  Opt ions. 

4. Select the appropriate opt ions, then cl ick OK. 

Note: During the conversion process for both Cl ient and Web Interface sessions, cal ls to the 
CtxSetWindowTitle method are sometimes placed at an incorrect l ine in  the script . Determine the 
correct l ine by inspect ing the capture fi le and moving the cal l  to that posit ion in  the script . 

The CtxSetWindowTitle method is added by QALoad during conversion and should otherwise not 
be modified or manually added to a script . 

Using ICA Files 

ICA fi les, which are generated on the MetaFrame server, contain configurat ion opt ions for Citrix. You can 
specify an ICA fi le on the Citrix Record Options dialog box. 

ICA fi les are specified in  the script  with the CtxSetICAFile command. If an ICA fi le is specified, the cal l  is 
generated with an unquali fied fi le name. For example: 

CtxSetICAFile("customapp.ica"); 

Note: The file name is not fully-qualified because the file may not exist in the same location among the 
remote Player machines. 

To val idate the script  on the same machine on which i t  was captured, copy the ICA fi le to the 
QALoad\BinaryFiles directory. 

To use the ICA fi le on remote Player machines, the ICA fi le should be specified as an attached fi le in  the 
External Data column of the Script Assignment tab in  the Conductor. 

Insert ing Screenshots in the Cit rix Script  

During the Citrix session, you can take a screenshot of the contents of the connect ion window. This inserts 
a wait  point in  the script  for the screenshot you select and saves the image as a bitmap. You can select: 

!  Insert  Wait  for Ful l  Screenshot - Inserts a wait  point based on a ful l  screenshot of the current 
display. 

!  Insert  Wait  for Part ial  Screenshot - Inserts a wait  point based on a part ial  screenshot of the current 
display. 

!  Save Current Screenshot - Saves a screenshot of the current display to a bitmap fi le. 

Note: Images are saved to \ QALoad \Middlewares\Citrix\Captures\screenshot.  

To inser t  a f ul l  screenshot  in t o t he Ci t r ix  scr ip t : 

1. In  the Citrix Capture dialog box, cl ick Screenshots>In sert  W ai t  for Ful l  Screenshot . The Screen 
Capture Preview screen displays the image. 

2. Click Fin i sh  to confirm the screenshot. The Specify Screenshot Name dialog box displays with a l ist  
of al l  previously saved screenshots.  

3. In  the Nam e field, type a descript ive name for the image.  
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4. Click OK. The image is saved as a bitmap and a wai t  point for the screenshot is inserted in to the 
script . 

To inser t  a par t ial  screenshot  in t o t he Ci t r ix  scr ip t : 

1. In  the Citrix Capture dialog box, cl ick Screenshots>In sert  W ai t  for Part i al  Screenshot . The 
selected screen displays wi th the message "Select a rectangular region of the screenshot you want to 
insert ." 

2. Hold down the left  mouse button and drag the cursor across the screen to select the region to save. 
The Screen Capture Preview screen appears with the image you selected. 

3. Click Fin i sh . The Specify Screenshot Name dialog box appears with a l ist  of al l  previously saved 
screenshots. 

4. In  the Name field, type a descript ive name for the image.  

5. Click OK. The image is saved as a bitmap and a wai t  point for the screenshot is inserted in to the 
script . 

To save t he cur rent  screen: 

1. In  the Citrix Capture dialog box, cl ick Screenshots>Save Curren t  Screenshot . The Screen Capture 
Preview screen displays. 

2. Click Fin i sh . The Specify Screenshot Name dialog box displays with a l ist  of al l  previously saved 
screenshots.  

3. In  the Name field, type a descript ive name for the image.  

4. Click OK. The image is saved as a bitmap. 

Clearing Events from the Internal Queue 

In  response to mouse and keyboard input, the Citrix server sends screen update events of the updated 
screen image to the Citrix cl ient appl icat ion. You can synchronize these screen update events with the text 
or graphic updates in  the appl icat ion by using CtxWaitForScreenUpdate to insert  waitpoints in  the Citrix 
script .  

When numerous matching screen update events occur, such as the flashing edit  cursor, they stay in  the 
in ternal queue indefin i tely. This can cause the CtxWaitForScreenUpdate funct ion to complete prematurely 
by matching events with previously stored screen updates. You can clear the in ternal queue by using the 
CtxScreenEventExists funct ion in  a simple loop. Th is flushes al l  past screen update events from the 
in ternal queue, so a fol lowing CtxWaitForScreenUpdate can successful ly wai t  for the next occurrence of 
the desired screen update event.  

Cit rix Command Reference 

QALoad provides descript ions and examples of the various commands avai lable for a Citrix script . For 
detai ls, refer to the Language Reference Help sect ion for Citrix. 
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Advanced Script ing Techniques for Cit rix 

Handling Citrix Server Farms 

Citrix servers can be grouped in farms. When load test ing, you may want to connect to a Citrix server farm 
rather than to a specific server. Load test ing requirements may include connect ing to a Citrix server farm, 
where the load balancing feature supports dynamic redirect ion to a given server at connect ion t ime. This 
load tests the server farm and Citrix load balancing rather than a single server, which can provide a more 
real ist ic load test.   

To record a script  that connects to a farm, you must use an ICA fi le to connect. However, when a capture 
takes place, a specific server (in  the farm) must have a connect ion. Specify the correct ICA fi le to connect 
to the server farm as well  as a specific server with in that server farm.  

To veri fy that your script  is connect ing to a server farm and not a specific server, assign the server name to 
one blank space when val idat ing the script . In  order to record a script  that connects to a farm, you must 
use an ICA fi le specified in  the Citrix Record Options dialog. Since the ICA fi le should contain al l  the 
necessary connect ion in formation, the server field should be left  blank when recording.  

When converted, the CitrixServer variable has a blank space: 

. 

. 

. 

/* Declare Variables */ 
const char *CitrixServer   = " "; 
const char *CitrixUsername = "citrix"; 
const char *CitrixPassword = "~encr~657E06726F697206"; 
const char *CitrixDomain   = "qacitrix2"; 
const int CitrixOutputMode = OUTPUT_MODE_NORMAL; 

. 

. 

. 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("Orders.cpp"); 

CitrixInit(4); 

/* Citrix replay settings */ 

CtxSetConnectTimeout(90); 
CtxSetDisconnectTimeout(90); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetDomainLoginInfo(CitrixUsername, CitrixPassword, Citrix-Domain); 
CtxSetICAFile("PRD desktop.ica"); 
CtxSetEnableCounters(TRUE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 

SYNCHRONIZE(); 

 

The Citrix cl ient ignores th is value and uses the ICA fi le to dynamical ly retrieve the server name at 
playback t ime. 

Conclusion  

When you use these techniques to set up a Citrix server farm test script , you al low for dynamic server 
redirect ion at playback as part  of test ing a load balanced Citrix server farm.  
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Handling Dynamic Windows 

During conversion, CtxWaitForWindowCreate cal ls are added to the script  for each named window 
creat ion event. During replay, some dynamic windows that were in  the capture may not appear, which 
causes the script  to fai l  because a wait  point t imes out. To avoid script  fai lure in  th is circumstance, 
comment out the CtxWaitForWindowCreate commands that may be referencing dynamic windows. 

 

Handling Dynamic Window Titles 

Some appl icat ions create windows whose t i t les vary depending on the state of the window. For example, 
M icrosoft  Word creates a t i t le based on the default  document name at the t ime of the window creat ion. 
During replay, th is dynamic t i t le can differ from the window t i t le that was recorded, and the window is 
not recognized. If th is occurs, t ry the fol lowing steps to modify the script : 

1. Ensure that  the Enable Wi ldcard Ti t l e M atch  check  box  i s selected in  the Ci t r i x  conversion  
opt ions prior to convert i ng the recording.  
In  the Window Verificat ion group of the Ci t r i x  Convert  Opt ions dialog box, ensure that the 
Enable Wi ldcard Ti t l e M atch  check box is selected. This check box is selected by default . If you 
are working with a previously-converted script , ensure that a CtxSetEnableWildcardMatching 
command exists in  the script  prior to the BEGIN_TRANSACTION command and that the parameter 
is set to TRUE. 

2. Veri fy w hether there i s an  i ssue w i th  dynam ic w i ndow  t i t l es.  
When a script  fai ls on val idat ion because the run t ime window t i t le is different than the expected 
window t i t le from the recording, i t  is l ikely that you are deal ing with a dynamic t i t le issue that can 
be handled by th is script ing technique. In  th is case, the script  fai ls on the 
CtxWaitForWindowCreate cal l . 

3. Iden t i fy a m atch  “ pat tern ”  for the dynam ic w indow  t i t l e.  
Note the error message that is returned during val idat ion (or replay). The message indicates the 
expected window t i t le versus the window t i t le from script  playback. Examine the differences in  the 
window t i t les to create a “ match pattern”  that recognizes the window t i t le, whi le ignoring other 
windows. A match pattern can be a simple substring of the window t i t le or a pattern string using 
wildcard characters such as ? (to match any single character) or * (to match any number of 
characters). The examples below i l lustrate the different match patterns. 

4. Insert  a CtxSetWindow M atchTi t l e com m and pr ior to the CtxWai tForWi ndow Create cal l  for 
the dynam ic w indow .  
When adding the CtxSetWindowMatchTit le command, ensure that the first  parameter contains the 
correct window object and the second parameter contains the match string in  double-quotes. 

5. Val idate the script  to ensure the CtxWai tForWindow Create com m and recogn izes the dynam ic 
w indow  nam e.  
Run the revised script  through val idat ion to ensure that the script  succeeds. If the script  does not 
val idate successful ly, go to step 3 to determine i f the match pattern is correct. 

Example 1: Using a substring match 

In th is example, the M icrosoft  Word appl icat ion generates a dynamic t i t le when the script  is replayed. The 
dynamic name is a concatenat ion of the default  document that Word creates at appl icat ion startup with 
the name of the appl icat ion. The script  is altered to reflect the fact that the string “ M icrosoft  Word”  is 
always part  of the window t i t le: 

// Window CWI_13 ("Microsoft Word") created 
CtxSetWindowMatchTitle( CWI_13, “Microsoft Word” ); 
CtxWaitForWindowCreate(CWI_13); 

Example 2: Using a wi ldcard match with the * character 
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In  th is example, the SampleClientApp appl icat ion generates a dynamic t i t le when the script  is replayed. 
The dynamic name is the name of the appl icat ion fol lowed by the name of the user, beginning with the 
word “ User” . The asterisk (*) wi ldcard is subst i tuted for a given username, reflect ing the pattern of 
“ SampleClientApp – User:”  as part  of the window t i t le fol lowed by an arbitrary user name: 

// Window CWI_13 ("SampleClientApp – User: John") created 
CtxSetWindowMatchTitle(CWI_13,“SampleClientApp – User: *” ); 
CtxWaitForWindowCreate(CWI_13); 

Example 3: Using a wi ldcard match with the ? character 

In  th is example, the RandomValue appl icat ion generates a dynamic t i t le when the script  is replayed. The 
dynamic name is the appl icat ion fol lowed by a random single digit . The question mark character is 
subst i tuted for the single digit  to reflect the pattern  that begins “ RandomValue: ” , fol lowed by single digit : 

// Window CWI_13 ("RandomValue: 0") created 
CtxSetWindowMatchTitle( CWI_13, “Sample Application: ?” ); 
CtxWaitForWindowCreate(CWI_13); 

 

Handling Unexpected Events in Citrix 

The CtxWindowEventExists and CtxScreenEventExists commands can be used to handle unexpected 
window and screen events in  Citrix scripts. When there is a possibi l i ty of unexpected dialogs appearing or 
unexpected screen events occurring, you must modi fy the script  to respond to the changes and cont inue 
the load test. 

For example, i f a script  opens a M icrosoft  Word document that resides on a network, and that document is 
already open by another network user, an unexpected dialog box appears that prompts the user to choose 
between cont inuing to open the document in  read-only mode or to cancel i t . To prevent script  fai lure, 
modificat ions can be made in the script  to handle the dialog boxes that appear in  th is si tuat ion.  

General ly, to handle unexpected events, you record two scripts. The first  script  contains a recording of the 
expected events. The second script  should include the unexpected events. Using the 
CtxWindowEventExists and CtxScreenEventExists funct ions, create a condit ional block of code that 
handles the dialogs that may appear. 

Exam ple 

The fol lowing script  example shows the addit ional script  l ines that were added to handle a Word 
document that is already open by another user on a network. The added l ines appear in  boldface type. 

/* 
 *  capSave11111-2.cpp 
 * 
 *  Script Converted on June 21, 2004 at 01:04:17 PM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 50 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
  
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Window Verification             : Yes 
 *   Session Timeouts                : Yes 
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
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 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *   Include Wait Points             : Yes 
 *   Enable Counters                 : No 
 *   Include Unnamed Windows         : Yes 
 *   Output Mode                     : Normal 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 */ 
  
#define CITRIX_CLIENT_VERSION "8.00.60000" 
#define CITRIX_ICO_VERSION    "2.4" 
#define SCRIPT_VER 0x00000205UL 
  
#include <stdio.h> 
#include "smacro.h" 
  
#include "do_citrix.h" 
  
/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
  
#ifndef NULL 
#define NULL  0 
#endif 
  
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 
            /* Declare Variables */ 
            const char *CitrixServer      = "qaccitrix"; 
            const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL;             
  
            /* Citrix Window Information Objects */ 
            CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
            CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
            CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
            CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 
397, 127); 
            CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 
397, 127); 
            CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
            CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
            CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
            CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
            CtxWI *CWI_10 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
            CtxWI *CWI_11 = new CtxWI(0x1005a, "", 2, 49, 205, 408); 
            CtxWI *CWI_12 = new CtxWI(0x2006a, "", 200, 186, 156, 287); 
            CtxWI *CWI_13 = new CtxWI(0x10138, "", 112, 116, 416, 248); 
            CtxWI *CWI_14 = new CtxWI(0x50036, "Microsoft Word", -4, -4, 649, 461); 
            CtxWI *CWI_15 = new CtxWI(0x1017e, "Open", 19, 23, 602, 387); 
            CtxWI *CWI_16 = new CtxWI(0x20174, "*Microsoft Word", -4, -4, 649, 461); 
            CtxWI *CWI_17 = new CtxWI(0x10058, "", 113, 114, 305, 26); 
            CtxWI *CWI_18 = new CtxWI(0x2013e, "Calculator", 66, 66, 261, 253); 
            CtxWI *CWI_19 = new CtxWI(0x1005a, "", 2, 49, 205, 408); 
            CtxWI *CWI_20 = new CtxWI(0x3006a, "Shut Down Windows", 111, 96, 418, 193); 
  
            CtxWI *CWI_117 = new CtxWI(0x20172, "File In Use", 144, 127, 352, 179); 
            CtxWI *CWI_118 = new CtxWI(0x30172, "11111111 (Read-Only) - Microsoft Word", -4, 
-4, 649, 461); 
             
            SET_ABORT_FUNCTION(abort_function); 
  
            DEFINE_TRANS_TYPE("capSave11111-2.cpp"); 
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            CitrixInit(1); 
  
            /* Citrix replay settings */ 
            CtxSetConnectTimeout(60); 
            CtxSetDisconnectTimeout(60); 
            CtxSetWindowTimeout(30); 
            CtxSetPingTimeout(20); 
            CtxSetWaitPointTimeout(30); 
            CtxSetWindowVerification(TRUE); 
            CtxSetEnableCounters(FALSE); 
            CtxSetWindowRetries(5, 5000); 
            CtxSetEnableWildcardMatching(TRUE); 
             
            SYNCHRONIZE(); 
  
            BEGIN_TRANSACTION(); 
  
            DO_SetTransactionStart(); 
             
            CtxConnect(CitrixServer, CitrixOutputMode); 
             
            // Window CWI_1 ("Warning !!") created 1087837356.454 
             
            CtxWaitForWindowCreate(CWI_1, 2125);             
             
            DO_MSLEEP(1891); 
            CtxPoint(246, 267);  //1087837358.797             
             
            DO_MSLEEP(453); 
            CtxMouseDown(CWI_1, L_BUTTON, NONE, 246, 267);  // 1087837358.797 
             
            CtxMouseUp(CWI_1, L_BUTTON, NONE, 247, 267); //1087837359.032 
             
            . 
            . 
            . 
             
            DO_MSLEEP(63); 
            // Window CWI_14 ("Microsoft Word") created 1087837397.390 
             
            CtxWaitForWindowCreate(CWI_14, 141);             
             
            DO_MSLEEP(78); 
            CWI_14->setTitle("Document1 - Microsoft Word"); //1087837397.468 
             
            // Window CWI_13 ("") destroyed 1087837397.468             
             
            DO_MSLEEP(2468); 
            CtxPoint(37, 50);  //1087837400.218             
             
            DO_MSLEEP(282); 
            CtxClick(CWI_14, 203, L_BUTTON, NONE); //1087837400.421 
             
            // Window CWI_15 ("Open") created 1087837400.764 
             
            CtxWaitForWindowCreate(CWI_15, 344); 
             
             
            DO_MSLEEP(1656); 
            CtxPoint(132, 99);  //1087837402.671             
             
            DO_MSLEEP(250); 
            CtxDoubleClick(CWI_15); // 1087837402.874             
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            DO_MSLEEP(109);       
             
             
            DO_MSLEEP(1953); 
            CtxPoint(247, 197);  //1087837404.827 
             
            // Window CWI_15 ("Open") destroyed 1087837404.827 
  
  
            if(CtxWindowEventExists(EVT_STR_CTXWINDOWCREATE,3000,CWI_16)) 
            BeginBlock();    
                        CtxPoint(337, 265);  //1087837404.905 
             
                        // Window CWI_16 ("11111111 - Microsoft Word") created 
1087837404.905 
             
                        CtxWaitForWindowCreate(CWI_16, 31); 
             
                        // Window CWI_14 ("Document1 - Microsoft Word") destroyed 
1087837404.905  
             
                        DO_MSLEEP(7547); 
                        CtxPoint(628, 9);  //1087837414.592             
             
                        DO_MSLEEP(2141); 
                        CtxClick(CWI_16, 281, L_BUTTON, NONE); //1087837414.873             
             
                        DO_MSLEEP(234); 
                        // Window CWI_16 ("11111111 - Microsoft Word") destroyed 
1087837415.108 
             
                        CtxPoint(113, 93);  //1087837418.779 
             
                        // Window CWI_17 ("") created 1087837418.779 
            EndBlock() 
  
///ReadOnly Code Start 
  
            else 
            BeginBlock();    
             
                        // Window CWI_117 ("File In Use") created 1087840076.599 
             
                        CtxWaitForWindowCreate(CWI_117, 578); 
             
                        DO_MSLEEP(2360); 
                        CtxPoint(358, 283);  //1087840079.068 
             
             
                        DO_MSLEEP(125); 
                        CtxClick(CWI_117, 281, L_BUTTON, NONE); //1087840079.365 
             
             
                        DO_MSLEEP(109); 
                        // Window CWI_117 ("File In Use") destroyed 1087840079.458 
             
                        // Window CWI_118 ("11111111 (Read-Only) - Microsoft Word") created 
1087840079.521 
             
                        CtxWaitForWindowCreate(CWI_118, 63); 
             
                        // Window CWI_115 ("Document1 - Microsoft Word") destroyed 
1087840079.521 
                         
                        DO_MSLEEP(4766); 
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                        CtxPoint(631, 3);  //1087840084.490 
             
                        DO_MSLEEP(203); 
                        CtxClick(CWI_118, 250, L_BUTTON, NONE); //1087840084.740 
             
                        DO_MSLEEP(93); 
                        // Window CWI_118 ("11111111 (Read-Only) - Microsoft Word") 
destroyed 1087840084.833 
             
                        DO_MSLEEP(2407); 
                        CtxPoint(34, 465);  //1087840087.333 
  
            EndBlock(); 
  
///ReadOnly Code End  
  
  
            DO_MSLEEP(1063); 
             
            DO_MSLEEP(484); 
            CtxPoint(112, 93);  //1087837419.654             
             
            DO_MSLEEP(406); 
            CtxDoubleClick(CWI_9); // 1087837419.904             
            . 
            . 
            . 
 
            // Window CWI_9 ("Program Manager") destroyed 1087837440.122 
             
            // Window CWI_7 ("") destroyed 1087837440.138 
             
            DO_SetTransactionCleanup(); 
             
            CtxDisconnect(); 
             
             
            END_TRANSACTION(); 
  
            delete CWI_1; // "Warning !!" 
            delete CWI_2; // "Log On to Windows" 
            delete CWI_3; // "Please wait..." 
            delete CWI_4; // "Citrix License Warning Notice" 
            delete CWI_5; // "Citrix License Warning Notice" 
            delete CWI_6; // "UsrLogon.Cmd" 
            delete CWI_7; // "" 
            delete CWI_8; // "ICA Seamless Host Agent" 
            delete CWI_9; // "Program Manager" 
            delete CWI_10; // "" 
            delete CWI_11; // "" 
            delete CWI_12; // "" 
            delete CWI_13; // "" 
            delete CWI_14; // "Microsoft Word" 
            delete CWI_15; // "Open" 
            delete CWI_16; // "11111111 - Microsoft Word" 
            delete CWI_17; // "" 
            delete CWI_18; // "Calculator" 
            delete CWI_19; // "" 
            delete CWI_20; // "Shut Down Windows" 
  
            delete CWI_117; // "File In Use" 
            delete CWI_118; // "11111111 (Read-Only) - Microsoft Word" 
             
            CitrixUninit(); 
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            REPORT(SUCCESS); 
            EXIT(); 
            return(0); 
} 
  
void abort_function(PLAYER_INFO *s_info) 
{ 
            RR__printf("Virtual User ABORTED."); 
             
            CitrixUninit(); 
             
            EXIT(); 
} 

 

Using the CtxWaitForScreenUpdate Command 

In some situat ions, a window may vary in  how long i t  takes to refresh on the screen. For example, the 
Windows Start  menu is an unnamed window that can take varying amounts of t ime to appear, depending 
on system resource usage. To prevent playback problems in which a mouse cl ick does not synchronize with 
i ts in tended window, insert  the CtxWaitForScreenUpdate command in the script  after the act ion that 
causes the window to appear. The parameters for the CtxWaitForScreenUpdate command correspond to 
the X and Y coordinates and the width and height of the window. This command ensures that the window 
has enough t ime to display before the mouse cl ick. 

Java 

Accessing JavaDoc 

QALoad provides JavaDoc for your reference. To access i t  from the Script Development Workbench menu, 
choose Help>EasyScript  for Java: JavaDoc from a Java session. 

 

Creat ing a Java Script  

To creat e a Java scr ipt  f or  QALoad : 

1. With a Java session open, choose Fi le>New  from the menu. 

2. In  the Fi le area, cl ick on the M iddlew are tree i tem. 

3. In  the Fi lename field, type a name for your new Java script . Note that Java fi le names do have 
special requirements, and QALoad enforces those requirements. For example, Java fi le names 
cannot contain spaces. If you try to include a space in your fi le name, QALoad gives you an error 
prompt. 

4. Click OK. The Create Java Script dialog box opens. 

5. Under the Script field is a select ion box l ist ing al l  the templates avai lable in  your 
\QALoad\Middlewares\Java\Templates directory. QALoad provides four default  templates. If 
you cl ick on a template name, a sample is shown in the right pane. The four templates are: 

 long format — Provides al l  required and opt ional methods. 

 new class — Creates a class associated with the script . 

 old format — Shows modi ficat ions needed to run legacy scripts. 
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 short  format — Provides only the min imum required methods. 

Select the template that best suits your needs and cl ick OK. QALoad creates a stub script  by the name 
you designated and opens i t  in  the Workbook pane for edit ing. 

6. Edit  your script  as necessary. You can use QALoad's Java Script Options dialog box to edit  some 
script  at tributes. 

Note: The main call in the script is used for debugging proposes and is not executed in the Conductor. 
  

Set t ing Classpaths in QALoad Player for EasyScript  for Java 

When loading a class by name in the QALoad Player during runt ime, do not use a class name on the 
Enterprise Java Bean (EJB) In it ialContext cal l . Instead, use a class instance or add a l ine of code before the 
JNDI lookup cal l . Refer to the fol lowing examples: 

Using a class instance 

Replace the In it ialContext propert ies and JNDI names in the fol lowing example with the values that are 
appropriate for your appl icat ion. 

Before: 
java.util.Hashtable ht = new java.util.Hashtable();  
ht.put(javax.naming.Context.INITIAL_CONTEXT_FACTORY, 
"org.jnp.interfaces.NamingContextFactory");  
ht.put(javax.naming.Context.PROVIDER_URL, "fh12623:1099");  
javax.naming.InitialContext ic = new javax.naming.InitialContext(ht);  
Object ref = ic.lookup("AddressMSvc"); 

After: 
org.jnp.interfaces.NamingContextFactory nf = new 
org.jnp.interfaces.NamingContextFactory();  
java.util.Hashtable ht = new java.util.Hashtable();  
ht.put(javax.naming.Context.PROVIDER_URL, "fh12623:1099");  
javax.naming.Context ic = nf.getInitialContext(ht);  
Object ref = ic.lookup("AddressMSvc"); 

Adding a l ine of code before the JNDI lookup call 

Add the fol lowing l ine before the JNDI lookup cal l : 
Thread.currentThread().setContextClassLoader(getClass().getClassLoader()); 

If i t  is a stat ic method, use the fol lowing sample, replacing CLASSNAME with the class name of the code. 
Thread.currentThread().setContextClassLoader(CLASSNAME.class.getClassLoader()); 

Execut ing a Java Applet  

Java applets are handled by the fol lowing process: 

1. The browser makes a request to a Web server for an HTML document that contains embedded Java 
applets. 

2. The browser downloads the Java applets, in  the order in  which they appear on the Web page, and 
immediately executes them. 

Example Web Page 

The fol lowing Web page contains two sect ions that reference Java applets. Not ice the parameters that 
fol low the applet. The browser passes these parameters when invoking an applet. 
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<HTML> 
<HEAD> 
<TITLE>Java Example</TITLE></HEAD> 
<BODY> 

<center><h2>Java Applet Example</h2><hr> 
 
<applet code="LScrollText.class" width="500" height="20" > 
<PARAM NAME="MESSAGE" VALUE="Scrolling Text created by Java Applet... >>Click here to 
Download<< Use it FREE"> 
<PARAM NAME="FONTHEIGHT" VALUE="14"> 
<PARAM NAME="SPEED" VALUE="2"> 
<PARAM NAME="PIXELS" VALUE="1"> 
<PARAM NAME="FONTCOLOR" VALUE="0000FF"> 
<PARAM NAME="BACKCOLOR" VALUE="FFFF00"> 
<PARAM NAME="TARGET" VALUE="lscrolltext.zip"> 
</applet> 

<br><br><br> 

A scrolling message, with custom colors, font size, speed, and target URL.<br> 
The source (.ZIP) file can be downloaded by clicking the associated area in text window. 

<br><br><br><hr> 

<APPLET CODE="imagefader.class" WIDTH=80 HEIGHT=107> 
<PARAM name="demicron" value="www.demicron.se"> 
<PARAM name="reg" value="A00012"> 
<PARAM name="maxitems" value="3"> 
<PARAM name="width" value="80"> 
<PARAM name="height" value="107"> 
<PARAM name="bitmap0" value="anibal.jpg"> 
<PARAM name="bitmap1" value="jak.jpg"> 
<PARAM name="bitmap2" value="jan.jpg"> 
<PARAM name="url0" value=" "> 
<PARAM name="url1" value=" "> 
<PARAM name="url2" value=" "> 
<PARAM name="step" value="0.05"> 
<PARAM name="delay" value="20"> 
<PARAM name="sleeptime" value="2000"> 

</APPLET> 

<br><br><br> 

This applet is a very popular image fader that displays a series of images, and allows URLs 
to be associated with each image.<br><br><hr> 

</center> 
</BODY></HTML> 

Example script 

QALoad does not evaluate Java applets. They appear as main requests. The example script  features the 
fol lowing elements: 

!  A DO_Http cal l  to retrieve the main page. 

!  A DO_Http cal l  to retrieve the scrol l ing text class. 

!  A DO_Http cal l  to retrieve the image fader class Java applet. 

How  I t  Works: QALoad interacts with the Web server without execut ion of the Java applet program wi th in 
the virtual browser. The browser accepts the pages that contain Java applets, but does not execute the 
applet as part  of the load test. The Java applets are not evaluated by QALoad and appear as main requests 
in  the script . 

DO_InitHttp(s_info); 
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... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/java.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Java Example", TITLE); 

/* Request: 2 */ 
DO_Http("GET http://www.host.com/LScrollText.class HTTP/1.0\r\n\r\n"); 

/* Request: 3 */ 
DO_Http("GET http://www.host.com/imagefader.class HTTP/1.0\r\n\r\n"); 
DO_Http("GET http://www.host.com/jak.jpg HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

Oracle 

Recording an Oracle Session 

Click the Oracle button on the toolbar to open an Oracle session. 

To set  Oracle r ecording opt ions and begin recording: 

1. Click Opt ions>Record on the menu bar. The Session Options dialog box appears. 

2. Select the appropriate opt ions in  the right-hand pane, then cl ick OK. 

3. Click the Record button on the Session toolbar. 

Set t ing Oracle Convert  Opt ions 

To set  conversion  opt ions f or  an Oracle session : 

1. Choose Opt ions>Convert  in  the Script Development Workbench menu bar. The Session Options 
dialog box appears. 

2. Select the appropriate opt ions in  the right-hand pane, then cl ick OK. 

Act iveData for Oracle 

ActiveData for Oracle 

Oracle variabl izat ion is a powerful script ing assistant that provides automatic correlat ion of data values in  
your script  (auto-variabl izat ion) and lets you use a datapool as the source of data values (manual-
variabl izat ion). 

Auto-variabl i zat ion  

When you enable auto-variabl izat ion, QALoad correlates the data values produced by the execut ion of 
recorded SQL statements and assigns a single source variable to matching bind and stat ic variables that 
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subsequently use the value. Auto-variabl izat ion wil l  on ly target a capture fi le's bind variables and 
embedded stat ic data in  recorded SQL statements as receivers of source variables. Source variables wi l l  be 
automatical ly generated based on the capture fi le's PostBind data, Fetch data, and embedded Stat ic data in  
SQL statements. Source variables from PostBind data wi l l  be generated only i f the PostBind data belongs to 
one of these OCI bind data types: 

Code OCI7 Bind Data Type OCI8 Bind Data Type 

3 SQLT_INT SQLT_INT 

4 SQLT_FLT SQLT_FLT 

68 SQLT_UIN SQLT_UIN 

1 SQLT_CHR SQLT_CHR 

5 SQLT_STR SQLT_STR 

96 SQLT_AFC SQLT_AFC 

97 SQLT_AFC SQLT_AFC 

11 SQLT_RID SQLT_RID Not Appl icable 

in  OCI8 

Source variables from Fetch data wi l l  be generated only i f the Fetch data belongs to one of the above OCI 
datatypes or one of the fol lowing:  

Code OCI7 Fetch  Data Type OCI8 Fetch  Data Type 

6 SQLT_VNU SQLT_VNU 

2 SQLT_NUM SQLT_NUM 

Note: Fetch data is made available in the capture file only when the Oracle Capture Option Use Fetch 
data for Variablizat ion is selected. 

Stat ic data embedded in SQL statements wi l l  be used as source variable or receiver of a source variable only 
when the SQL statement states a SELECT, INSERT, UPDATE or DELETE operat ion. SQL statements that 
contain stored procedures (e.g. BEGIN…) wil l  be excluded. 

Auto-variabl izat ion occurs by default  in  QALoad, but you can turn i t  off by clearing the conversion opt ion 
Variabl i zat ion  (Act i veData) on the Oracle Convert  Opt ions tab. If you choose to use automatic 
variabl izat ion, you can then use manual-variabl izat ion to change a source variable previously determined 
by auto-variabl izat ion to data from a local or central datapool. 

M an ual  Variabl i zat ion  

Manual variabl izat ion al lows you to change the source of variables ident i fied through auto-variabl izat ion 
to use data from central or local datapools. You use the variabl izat ion tree-view and the opt ions avai lable 
from the tree-view to view and change source variables.  
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Manual variabl izat ion is l im ited to changing the source variables to data that  was prepared from a local  
datapool or conductor (central) datapool. Once changed, al l  (but not individual) source variables may be 
changed back to the original source variables. 

Why use Act i veData for Oracle? 

!  To avoid dupl i cate key errors w h ich  can  occur during playback  w hen  th e data relat i onsh ips 
h idden  (im pl ied) w i th in  a set  of  Oracle SQL statem en ts are not  recorded. For example, a 
recorded Select SQL statement may include the Oracle nextval expression to get the next sequential  
unique number in  the database. The returned value from the expression is used for the primary key 
in  a subsequent Insert  statement. The primary key is associated with a bind variable. The value of 
the bind variable is recorded and noted in  the QALoad script . When the script  is played back, the 
returned value from nextval wi l l  natural ly be different from the value of the bind variable. The 
Insert  SQL execut ion incurs a dupl icate key error from the Oracle server.  

Oracle variabl izat ion prevents th is error by providing a logical relat ionship between the returned data 
from the Select statement and the data for the Insert  bind variable. The data relat ionship is establ ished 
through a source variable. 

!  To reduce diagnost i c t im e for playback  data i ssues, especial l y w hen  deal in g w i th  l arge scripts. 
Using a single source variable for script  variables that have the same data value reduces the amount 
of debugging t ime that would have been spent on mult iple script  variables. Addit ional ly, the 
Compare Tool aids you in debugging data issues by h ighl ight ing SQL and data differences that 
could in fluence the load test of two similar capture fi les. 

 

Variablization menu 

Access the Variabl i zat ion  menu from the Script Development Workbench's Session  menu, or by right-
cl icking from the variabl izat ion tree-view.  

Create/ Edi t  a source: Opens a tree-view of your variabl ized 
statements and their sources. 

Show  Capture Di f feren ce: Accesses the Compare Tool, where you  
can choose a capture fi le to compare to the current capture fi le and 
have the differences in  SQL statements and bind data h ighl ighted for 
your comparison with in the variabl izat ion tree-view.  

Revariabl i ze: Deletes al l  manually generated source variables and re-
executes auto-variabl izat ion. Note that datapool sources may not be 
changed back to PostBind, Fetch, or Stat ic data unless you select th is 
opt ion. 

Rem ove al l  sources: Deletes al l  source variables from the script 's .var 
fi le. 

Show  SQL statem en t : Provides a detai led view of the h ighl ighted 
SQL statement. The detai led view wil l  display associated Bind and 

Column data (from the Execute statement), associated PostBind data, and associated Fetch data. 

Hin ts: Opens the Oracle Variabl izat ion Hints onl ine help. 

Word w rap: Shows the complete SQL statement in  wrapped format. This is selected by default . 

Displ ay opt ions: Al lows you to change display opt ions to one of the fol lowing: Only statements with bind 
variables, Unsourced Bind statements, or Show al l  SQL statements (default). 

The Refresh  the curren t  view  opt ion wil l  re-draw the tree-view after a source is manually changed. 

Save the Variabl i zat ion  VAR f i l e: Saves any changes to the script 's .var fi le. 

Save and Convert : Saves changes to the .var fi le and re-converts the script . 
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Save and Convert  As: Saves changes to the .var fi le and prompts you to save your script  under a new name 
before re-convert ing i t . 

 

Variablize 

Use th is dialog box to variabl ize a fi le or to compare two similar fi les. The results are displayed in a tree-
view from which you can manually variabl ize the fi le or view the differences between the two fi les. When 
you compare two fi les, the differences in  SQL statements and bind data are h ighl ighted with in the 
Variabl izat ion tree-view. 

Variabl i ze the fol l ow ing capture f i l e: Lists the path and name of the curren t ly selected capture fi le (.cap). 

Com pare and Variabl i ze w i th  the fol l ow ing f i l e: Navigate to the capture fi le you'd l ike to compare to the 
current ly selected capture fi le. 

Variabl i ze: Variabl izes the fi le and displays the recorded SQL statements, bind variables, stat ic variables 
embedded in SQL statements, data values and the sources of data values as determined by auto-
variabl izat ion. 

Cancel : Closes the dialog box without making any changes. 

 

Source Details 

Displays detai ls about the source of the selected variable, and al lows you to replace the source with data 
from a central or local datapool.  

Nam e: Lists the name of the field in  the script  that was variabl ized. 

Value: Lists the value assigned to the variabl ized field. 

Line #: Lists the script  l ine where the field is located. 

(Defaul t ) From  Postbind/ Fetch / Stat i c data: If th is opt ion is selected, the source of the variable was 
determined by auto-variabl izat ion.  

Source variable nam e in  Convert  scri pt : The name assigned to the variable by auto-variabl izat ion, or 
when replaced by a datapool variable. 

From  datapool : Select th is opt ion to change the source to a central or local datapool. 

Field Num ber: Specify the column number in  the datapool fi le to use as the source. 

Advanced Opt ions: Cl ick to open the Act iveData Advanced Source Options dialog box where you can 
format the source before using i t , if necessary. 

Displ ay val ues m atched by auto-variabl i zat ion : In  th is area, cl ick the appropriate button to determine 
which values to display: Sources, Matching values, or Matching names and values. 

M atch  exact : Select i f the source must be an exact match, or de-select to use the source for a sub-string 
search. 

Update Source: Cl ick to update the variable source according to the sett ings on th is dialog. 

Update ALL: Cl ick to use the newly created source variable for al l  i tems in the l ist  area. 

Delete Source: Cl ick to delete the variable and al l  i ts references from the tree-view. 

Qui t : Cl ick to cancel without saving any changes. 

 

Comparing Files 

The Oracle Variabl izat ion Compare Tool compares two similar capture fi les, ident i fies the differences in  
SQL statements and bind data, and h ighl ights them in the Variabl izat ion Tree View. 
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Why Use the Com pare Tool? 

The Compare Tool can help you debug data issues in  your transact ion that may cause load test problems, 
especial ly in  large scripts. With the differences h ighlighted in  a window display, you can quickly determ ine 
i f manual variabl izat ion is warranted for specific variables. Manual variabl izat ion can help you work 
around data issues that in fluence load tests. 

To use t he Com pare Tool : 

1. In  the Workspace pane, right-cl ick on the first  capture fi le you want to compare and select 
Variabl i ze from the shortcut menu. The Variabl ize dialog box opens, displaying the path and 
name of the selected fi le.  

2. Select the Com pare and Variabl i ze w i th  the fol l ow ing f i l e check box, and then navigate to the 
capture fi le you wish to compare against the first  selected fi le. 

3. Click the Variabl i ze button. A new tab opens in the Script Development Workbench, present ing a 
tree-view of the data. Differences in  SQL statements and bind data are h ighl ighted. 

4. View differing values by cl icking on a h ighl ighted bind variable or SQL statement. The Show 
Capture Difference window opens, l ist ing the value used in each fi le.  

5. If you do not need to change the data, cl ick OK to be returned to the tree-view. If you need to 
change the source of a bind i tem to a datapool variable, cl ick Go to Source Di splay. The Source 
Detai ls (for bind data) window or Show SQL Statement (for SQL statements) window opens. 

6. Change the source of any variables to cal l  datapool i tems. 

7. Save the .var fi le and convert  your capture fi le to bui ld an updated script  by right-cl icking and 
select ing Save and Convert  or Save and Convert  As. 

 

Setting up QALoad to run Oracle scripts on UNIX 

After instal l ing the QALoad UNIX Player and ut i l i t ies, you should ensure that the fol lowing environment 
variables are set prior to start ing the Player Agent (loadagent):  

Plat form  Envi ronm en t  
Variable 

Value 

Al l  Plat form s: ORACLE_HOME <path>/oracle/product/<version> 

 TNS_ADMIN <location of config files> 

 ORACLE_SID <oracle instance name 

Linux : LD_LIBRARY_PATH <playerdir>/lib:<ORACLE_HOME>/lib

Solari s: LD_LIBRARY_PATH <playerdir>/lib:<ORACLE_HOME>/lib

 

Sett ing environment variables on UNIX systems depends on your login shel l . For example: 

!  For ksh : export ORACLE_HOME=/oracle/product/8.1.6 

!  For csh : setenv ORACLE_HOME /oracle/product/8.1.6 

The ORACLE_HOME environment variable points to the directory where the Oracle workstat ion software 
has been instal led. The TNS_ADMIN environment variable should point to the locat ion of the cl ient 
and/or server config fi les. ORACLE_SID should be set to the name of the Oracle instance. For each UNIX 
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platform, update the appropriate l ibrary path variable to include the l ibrary di rectory for the part icular 
version of Oracle. 

Scripts wi l l  automatical ly be downloaded to the Player machines by the Conductor and compiled, i f 
necessary, at test execut ion t ime. 

During the automatic script  download and compile, i f a script  compile error occurs, a scriptname.err fi le 
wi l l  be generated in  the scripts directory. 

To compile a script  by hand, use the Rmake command. The syntax is as fol lows: 

Rmake <scriptdir>/<scriptname> 

   or 

Rmake <scriptdir>/<scriptname>  

 

Oracle Command Reference 

QALoad provides descript ions and examples of the various commands avai lable for an Oracle script . For 
detai ls, refer to the Language Reference Help sect ion for Oracle OCI Version 7, General Oracle, or Oracle 
OCI Version 8. 

OFS 

Set t ing Oracle Forms Convert  Opt ions 

Use the fol lowing procedures to set Oracle Forms convert  opt ions and advanced convert  opt ions. Use the 
advanced convert  opt ions to customize the post-capture steps taken before convert ing the capture fi le to a 
script , or to manually perform post-capture processing of a proxycap (hexadecimal encoded) fi le. This 
produces a new cap fi le, postcapweb fi le, longcap fi le, and sortedcap. This process overwrites these fi les 
when they already exist . 

To set  conversion  opt ions f or  Oracle Form s in a single session :  

1. Choose Opt ions>Convert  in  the Script Development Workbench toolbar. The Session Options 
dialog box appears. 

2. Select the appropriate opt ions, then cl ick OK. 

To set  conversion  opt ions f or  Oracle Form s in a Universal  session :  

1. Choose Opt ions>Convert  in  the Script Development Workbench toolbar. The Session Options 
dialog box appears with both Oracle Forms Server and WWW selected. 

2. Click the Session  Opt ions tab. 

3. Under Convert  Opt ions in  the tree view, cl ick Oracle Form s Convert  Opt ions. 

4. Select the appropriate opt ions, then cl ick OK. 

To set  Advanced conver t  op t ions: 

1. Choose Opt ions>Convert  in  the Script Development Workbench toolbar to open the Session 
Options dialog box. 

2. In  the Convert  Options tree view, cl ick Advanced Convert  Opt ions. 
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3. Select the appropriate opt ions, then cl ick OK. 

Recording Oracle Forms Server Sessions 

You can record an Oracle Forms session in  a single session, or in  a Universal session for Oracle E-Business 
Suite 11i (EBS-11i) and Oracle E-Business Suite 12 (EBS-12). Select the down arrow next to the Oracle 
Form s Server Session  but ton on the toolbar, then fol low one of the procedures below.  

To begin r ecording an OFS single session: 

1. Select Oracle Form s to act ivate a new OFS single session.  

2. From the toolbar, select Opt ions>Record, and select the appropriate opt ions. 

3. Click Record on the Sessi on  toolbar.  

To begin r ecording OFS in a Universal  session: 

1. Select E-Business Sui te 11i  or E-Business Sui te 12 to act ivate Universal session for the Oracle 
Forms and WWW middlewares. 

2. Click Record on the Sessi on  toolbar. The Session  Opt ions dialog box displays with the M iddleware 
tab on top. Both WWW and Oracle Forms Server are selected. 

3. Click the Session  Opt ions tab.  

4. In   the tree view under Record Options, select Oracle Form s Record Opt ions. The Oracle Forms 
Record Options pane displays on the right. The session you in i t iated, either E-Business Suite 11i or 
E-Business Suite 12, automatical ly displays in  the Form s En vi ronm en t  field. 

5. Select the appropriate opt ions, then cl ick OK to begin recording. 

Note: When you record  EBS-12 using Internet Explorer 6, changing the Accessibility option on the EBS-12 
login page from the default (None) requires modifications to your script in order for it to run properly. Refer 
to Changing Accessibility Options in Oracle EB-12 for more information. 
 

Oracle Forms Recording Modes 

QALoad supports recording Oracle E-Business Suite (EBS) 12 and 11i, and Oracle Appl icat ions using Forms 
10g, 9i, and patched 6i (versions 6.0.8.14 and up). These appl icat ions may be recorded in HTTP mode (also 
cal led Servlet mode), SSL mode (also cal led HTTPS or Secure Servlet mode), and socket mode. These 
recording types are described briefly below. 

Recording Servlet Mode 

Oracle Forms Applicat ions use HTTP to send Forms data across the network. To record in  Servlet mode, 
select Servlet in  the Connect ion Mode l ist  in  the Record Options dialog box before you start  recording your 
appl icat ion.  

Note: When using server-side recording, you must perform steps to configure the server. See Using server-
side recording for more information. Server-side recording is not available for EBS-12 or EBS-11i. 

Recording SSL Mode 

To record an OFS appl icat ion in  Secure Servlet (SSL) mode, select Secure Servlet in  the Connect ion Mode 
l ist  in  the Record Options dialog box. For non-EBS-12 appl icat ions, you must specify a certDB fi le by 
entering the Jin it iator certDB fi le that the appl icat ion uses. The certDB fi le veri fies the SSL Cert i ficate 
Authori ty on the cl ient side prior to the Forms connect ion. This field is not required for EBS-12. 
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Note: SSL mode is not available with server-side recording. 

Recording Socket Mode 

For Socket M ode recording, QALoad must start  your appl icat ion for you through your browser. Before 
recording, enter the URL of the Forms applet page in the URL field, and the Form s Server port  in  the Port  
field. If you leave the Port  field blank, or enter an incorrect port  number, your recording wil l  on ly result  in  
an empty capture fi le. You may leave the URL field blank, but wi l l  be prompted for the Forms applet page 
on the in i t ial  browser page. From the applet page, cl ick the l ink to your Forms appl icat ion. QALoad wil l  
take over recording at th is point. 

Checkpoints in Oracle Forms Server scripts 

EasyScript for Oracle Forms Server supports QALoad's automatic middleware checkpoint t im ings in  both 
HTTP and socket modes. Default  checkpoints (Begin/End Checkpoint pairs) are not supported.  

Automatic checkpoints are enabled from the Conductor's Tim ing Opt ions column on the Script  
Assignm en t  tab and are enabled on a script-by-script  basis.  

At playback, automatic checkpoints are executed during the ofsSendRecv statement. 

Forms validat ion/ playback debugging opt ions 

Debug data  

When the Debug Data opt ion is enabled on the Configure Script  Development Workbench dialog box for 
val idat ion, or the Conductor's Debug Trace opt ion is enabled for playback, executed script  statements wi l l  
be displayed. For example:  

VU 0 : Line:90, ofsSetWindowSize( "FORMWINDOW" ,6, OFS_ENDMSG, 137, 750, 600 ) 
VU 0 : Line:91, ofsActivateWindow( "WINDOW_START_APP" ,11, OFS_ENDMSG, 247 ) 
VU 0 : Line:92, ofsShowWindow( "WINDOW_START_APP" ,11, OFS_ENDMSG, 173 ) 
VU 0 : Line:93, ofsFocus( "BUTTON" ,51, OFS_ENDMSG, 174 ) 
VU 0 : Line:94, ofsSetWindowSize( "FORMWINDOW" ,6, OFS_ENDMSG, 137, 750, 600 ) 
VU 0 : Line:95, ofsSendRecv( 1 )  //ClientSeqNo=2|MsgCount=6 

Oracle Forms Server method reference 

QALoad provides descript ions and examples of the various methods and funct ions avai lable for an Oracle 
Forms Server script . For detai ls, refer to the Language Reference Help sect ion for Oracle Forms Server. 

Using the certDB File for OFS Replay 

In  some Oracle Appl icat ion Server and Oracle E-Business Suite 11i environments, the cert i ficates needed for 
the SSL handshake with the server are not in  the default  wal let  used during replay. This causes the SSL 
handshake to fai l . 

You can use the certDB fi le used by JIn it iator for OFS replay. To do th is for Script  Val idat ion, place the 
certdb.txt  fi le in  the BinaryFi les directory. 

To use t he cer t DB f i le f or  OFS replay in  Conduct or : 

1. In  the Conductor's Script  Assignment tab, select a script  in  the Script column. 

2. Click Browse  . The External Data dialog box appears. 

3. In  Attached Fi les, cl ick Add. The Add Attached Fi le dialog box displays. 



Script Development Workbench 

45 

4. From the BinaryFi les folder, select certdb.tx t , then cl ick Open . 

5. Click OK. 

Advanced Script ing Techniques 

Understanding the C++ Script 

Oracle Forms Server scripts are produced for al l  Oracle E-Business Suite and Oracle Appl icat ions recordings. 
The C++ script  executes OFS-related statements by passing the statements in  the script  DLL to the OFS Java 
engine that performs the cl ient act ivi t ies and the cl ient communicat ion with the server. Because the C++ 
script  statements are direct ly t ied to corresponding methods in the OFS Java engine, modificat ions to the 
script  statements are l im ited to changing the property parameter values through variabl izat ion. 

An OFS C++ script  contains three main sect ions: Connect ion, Appl icat ion Body, and Disconnect. The 
QALoad transact ion loop includes al l  three sect ions by default .  The transact ion loop can be moved using 
the guidel ines described in Moving the OFS transact ion loop. An internal auto checkpoint is created during 
connect ion statements and transmission statements. 

The C++ script  statements are a condensed version of the Java-style script  statements.  The C++ script  
statements show the GUI controls in  the OFS appl icat ion and the control propert ies, which are either 
control at tributes or act ivi t ies. For example: 

ofsClickButton( "BUTTON", 52, OFS_ENDMSG, 325 ); 

In  th is example, the user cl icks (property 325) a button ( control ID 52).  OFS_ENDMSG is a flag that 
indicates that the GUI act ivi ty ends the current OFS Message.  

QALoad also al lows OFS and WWW statements from a Universal session to be scripted in  the C++ script , 
providing the abi l i ty to play back WWW and OFS statements. QALoad automatical ly extracts ICX t ickets 
and any necessary cookies from the WWW middleware traffic and passes them to the OFS middleware. 

 

Connection Statements 

The connect ion script  l ines in  the C++ script  vary depending on the type of Forms connect ion mode that is 
act ive. You choose the Forms connect ion mode on the Oracle Forms Record Options dialog box. Forms 
connect ion modes include server-side recording, HTTP, HTTPS, or socket. 

Server-side recording is l im ited to appl icat ions that  use Oracle Appl icat ion Server. HTTP connect ion mode 
is avai lable for appl icat ions using Forms 9i and for appl icat ions using the patched Forms 6i version 
configured with the HTTP servlet. HTTPS connect ion mode is strict ly for SSL-enabled appl icat ions that use 
Forms 9i. Socket connect ion mode is for appl icat ions that use Forms 6i and lower versions, such as Oracle 
11i. 

Server-side recording connect ions 

Server-side recording mode contains only one connect ion statement. The funct ion that is used – 
ofsSetServletMode –  contains the l istener servlet value that you entered on the Oracle Form s Server 
Recording Opt ions dialog box. The first  parameter defines the HTTP or HTTPS configurat ion of the 
appl icat ion environment. The second parameter defines the name of the Forms Listener Servlet used by the 
appl icat ion. To connect, QALoad internal ly invokes Oracle’s dispatch cal ls using the two parameters. 
Oracle’s proprietary classes provide the implementat ion for the HTTP or HTTPS connect ion.  For example: 

ofsSetServletMode(OFS_HTTP, "http://ntsap45b:7779/forms90/l90servlet" ); 

HTTP connect ions 

HTTP connect ion mode contains mult iple connect ion statements. To connect, QALoad internal ly performs 
Java cal ls to accomplish the fol lowing tasks:   

!  Define HTTP header propert ies 
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!  Connect to the Forms Servlet (an HTTP-GET request) 

!  Set the parameters of the Forms Listener Servlet 

!  Connect to the Forms Listener Servlet (an HTTP-GET request) 

!  Set addit ional HTTP header property for the Listener Servlet 

!  Connect to the Forms Listener Servlet (an HTTP-POST request). The last connect ion statement also 
in i t iates the required Forms “ handshake”  and determines the Forms encrypt ion used by the 
appl icat ion environment .  

For example: 

ofsHTTPSetHdrProperty("User-Agent", "Java1.3.1.9" );  
ofsHTTPSetHdrProperty("Host", "ntsap45b:7779" );  
ofsHTTPSetHdrProperty("Accept", "text/html, image/gif, image/jpeg, *; q=.2, "*/*; q=.2" 
);  
ofsHTTPSetHdrProperty("Connection", "Keep-alive" );  
ofsHTTPConnectToFormsServlet( 
"http://ntsap45b:7779/forms90/f90servlet?ifcmd=startsession"  ); 
ofsHTTPSetListenerServletParms( "?ifcmd=getinfo&ifhost=C104444D01&ifip= "192.168.234.1" 
); 
ofsHTTPConnectToListenerServlet( "http://ntsap45b:7779/forms90/l90servlet"); 
ofsHTTPSetHdrProperty("Content-type", "application/x-www-form-urlencoded" );  
ofsHTTPInitialFormsConnect(); 

HTTPS connect ions 

HTTPS connect ion mode uses the same connect ion statements as HTTP mode.  

Socket  connect ions 

Socket mode contains only one connect ion statement.  The funct ion that is used – ofsConnectToSocket  – 
contains the port  number and the URL you entered on the Oracle Forms Record Options dialog box to start  
OFS capture. The port  value is the port  on which the Forms Server direct ly l istens for Forms traffic. To 
connect, QALoad uses Java cal ls to open a Java socket using the parameters, in i t iate the required Forms 
"handshake” , and determine the Forms encrypt ion used by the appl icat ion environment. For example: 

ofsConnectToSocket("10.10.0.167", 9002 ); 

 

Application Statements 

The appl icat ion statements in  the C++ script  consist of property statements and transmission statements. 
Property statements describe the attributes and act ivi t ies of GUI controls in  the appl icat ion. Transmission 
statements send the GUI controls and their propert ies as Forms Message data to the server. There is only 
one transmission statement: ofsSendRecv. QALoad creates an in ternal auto checkpoint when th is statement 
is executed. In  the fol lowing example, the first  two (property) statements set the locat ion and size of a 
FormWindow GUI control. The ofsSendRecv statement sends the GUI control  propert ies to the server. 

ofsSetWindowLocation( "FORMWINDOW", 6, OFS_ENDMSG, 135, 0, 0);   //Property  
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 650, 500);   //Property 
ofsSendRecv(1 ); //Transmission 

Param eters of  a property statem en t : 

The parameters of a property statement are arranged in the fol lowing sequence: 

1. Captured con t rol  nam e.  If the name is not avai lable, th is value is the class name to which the 
control belongs. 

2. Captured con t rol  ID. 

3. Act ion  type. This flag indicates i f the property is to be added to the current Forms Message or i f the 
property ends the current Forms Message. During playback, each control is treated as a Forms 
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Message. When the current Message ends, QALoad translates the control and i ts propert ies to 
binary format. The val id values are: 

 OFS_ADD –  add the property to the current Message. 

 OFS_ENDMSG – add the property to the current Message and end the Message. 

 OFS_STARTSUBMSG – add the property of the succeeding nested Message to the current 
Message. 

4. Property ID. The Forms version-specific ID of the property. 

5. Property value. Captured value of the property (opt ional) 

6. Property value. Captured value of the property (opt ional) 

For example: 

ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 650, 500); 

In  th is example, control ID 6, which belongs to GUI class FORMWINDOW, is resized (PROPERTY 
137) to have coordinates 650 and 500. This marks the end of the current Message. 

Forms environment statements: 

The in i t ial  set of statements in  the Forms script  describes the Forms appl icat ion environment. In  th is set, 
the "version”  and the “ cmdline”  propert ies are the most important. The version property shows the Forms 
Bui lder version used by the appl icat ion. The version  indicates the capabi l i t ies of the appl icat ion. For 
example, some versions cannot support HTTP connect ions. The cmdline property shows the Forms 
configurat ion parameters passed to the server by the Forms applet. The parameter “ record=names”  
indicates that the appl icat ion enables GUI control names to be captured. Control names are preferred in  
mult i-threaded playback. The “ ICX”   parameter indicates that the appl icat ion  uses a Personal Home Page. 

In the sample script  below, the Forms bui lder version is 90290 (the version used in Oracle 9iAS Release 2, 
unpatched). The cmdline property shows “ record=forms”  which defaults “ record=names” . The cmdline 
property does not have the “ ICX”  t icket parameter. 

ofsSetInitialVersion( "RUNFORM", 1, OFS_ADD, 268, "90290" ); 
ofsSetScreenResolution( "RUNFORM", 1, OFS_ADD, 263, 96, 96); 
ofsSetDisplaySize( "RUNFORM", 1, OFS_ADD, 264, 1024, 768); 
ofsInitSessionCmdLine("RUNFORM", 1, OFS_ADD, 265,  
 "server module=test1.fmx userid=  sso_userid=  debug=no buffer_records=no debug_" 
 "messages=no array=no query_only=no quiet=yes render=no host=ntsap45b.prodti.com" 
 "puware.com port= record=forms tracegroup=debug log=run1 term=" ); 
ofsSetColorDepth( "RUNFORM", 1, OFS_ADD, 266, "256" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "0" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "8421504" ); 
ofsSetFontName( "RUNFORM", 1, OFS_ADD, 383, "Dialog" ); 
ofsSetFontSize( "RUNFORM", 1, OFS_ADD, 377, "900" ); 
ofsSetFontStyle( "RUNFORM", 1, OFS_ADD, 378, "0" ); 
ofsSetFontWeight( "RUNFORM", 1, OFS_ADD, 379, "0" ); 
ofsSetScaleInfo( "RUNFORM", 1, OFS_ADD, 267, 8, 20); 
ofsSetNoRequiredVAList( "RUNFORM", 1, OFS_ADD, 291 ); 
ofsSetPropertyString( "RUNFORM", 1, OFS_ENDMSG, 530, "America/New_York" ); 
ofsSendRecv(1 ); 
//ClientSeqNo=1|CapTime=1086884188.281|MsgCount=1 

Sending messages to the server: 

The ofsSendRecv statement sends the accumulated GUI controls and their propert ies to the Forms Server as 
binary data. This statement represents the point at which the cl ient sends a Forms Terminal Message to the 
server. In  Oracle Forms, the cl ient and the server must end each data block with a Terminal Message before 
any transmission occurs. 

In ternal ly, QALoad varies the binary data transmission depending on the connect ion mode: 
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!  For server-side recording mode, QALoad sends the binary data by invoking Oracle’s dispatch cal ls. 
Oracle’s own classes provide the implementat ion for the HTTP transmission.  

!  For HTTP or HTTPS mode, QALoad wraps the binary data inside an HTTP stream and invokes Java’s 
HTTP cal ls.  

!  For socket mode, QALoad sends the binary data direct ly to the Java socket opened at the 
connect ion point . 

The ofsSendRecv statement has one parameter: the response code of the captured Terminal Message. The 
possible values for th is parameter are 1 (add), 2 (update), and 3 (close). Typical ly, when the response code 
is 3, the Forms Server reacts by removing the GUI controls associated with the cl ient message from the 
server cache. 

A comment l ine appears after each ofsSendRecv statement that contains script-tracking in formation. The 
information on the comment l ine is also found in the capture fi le in  each ofsSendRecv capture l ine. The 
comment l ine shows the relat ive sequence of each cl ient request, as represented by a Terminal Message, 
from the start  of the appl icat ion (e.g. Cl ientSeqNo=1). The comment l ine also shows the t im ing mark of 
the captured Terminal Message (e.g. CapTime=1086884188.281) and the number of Forms messages 
contained in the request (e.g. MsgCount=1). The number of Messages can be veri fied by count ing the 
preceding ENDMSG and STARTSUBMSG flags in  the request block. The comment l ine is useful for 
debugging playback issues because i t  readi ly shows the cl ient request sequence number where the issue is 
occurring. 

Gett ing the server reply: 

During the execut ion of ofsSendRecv, QALoad also obtains the server’s reply and translates the binary 
Forms data in to Forms control values and control propert ies. The values are also writ ten to the playback 
log fi le (in  capture fi le format) i f script  logging is enabled. The fol lowing sample is a server reply: 

VU 0 :   M|S|2|0|1 
VU 0 :   P|S|322|java.lang.Integer|0|151000320 
VU 0 :   P|S|279|java.lang.Boolean|0|false 
VU 0 :   P|S|525|java.lang.String|AMERICAN_AMERICA.WE8MSWIN1252 
VU 0 :   T|S|1|ServerSeqNo=1|MsgCount=76 

The first  l ine indicates the start  of a Forms Message from the server (M |S). The th ird parameter is an act ion 
code (1= add, 2= update, 3= delete, 4= get property value). The fourth parameter is the Class Code of the 
control (0 = root class). The fi fth  parameter is the Control ID (1= RunForm). 

The second, th ird and fourth l ines are property l ines related to the above Forms Message from the server 
(P|S).  The th ird parameter of each l ine is the property ID (322). The fourth parameter is the data type of 
th is property (java.lang.In teger). The fi fth  parameter is the data value. If the value is 0, the data value is in  
a sixth parameter (false).  

The th ird l ine is the terminal message l ine from the server (T|S). The th ird parameter is the response code 
associated with the terminal message (1= add, 2= update,  = close). The fourth parameter is the relat ive 
sequence of the server reply, as represented by a Terminal Message, from the start  of the appl icat ion (e.g. 
ServerSeqNo= 1). The fi fth  parameter is the number of Forms messages contained in the reply (e.g. 
MsgCount = 1). The number of Messages may be veri fied by count ing the preceding M|S flags in  the reply 
block.  The fourth and fi fth  parameters are script-tracking in formation, which can be useful for debugging 
a playback issue. If logging is enabled, the log fi le shows the tracking in formation, which can make the 
comparison between server responses and captured responses easier. 

Processing large data and delayed response scenarios: 

When HTTP or HTTPS connect ion mode is used, Forms data is wrapped inside the HTTP reply stream. 
QALoad checks the HTTP header of the reply before processing the Forms data.  The HTTP header 
sometimes indicates that the cl ient needs to perform addit ional HTTP POST requests to obtain the 
complete Forms data. This indicat ion occurs when the content-length of the reply is 64000 (a large data 
scenario), or the content-type is "text/plain”  and the HTTP header contains an  “ i ferror: ”  string (a delayed 
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response/re-post scenario). QALoad performs the necessary POST requests to obtain the complete reply 
data, and then translates the accumulated reply data to Forms controls and propert ies. 

Disconnect statements 

The disconnect script  l ines vary depending on the Forms connect ion mode.   

!  In  server-side recording mode, the ofsServerSideDisconnect script  statement in ternal ly invokes 
Oracle’s dispatch cal ls to disconnect.  

!  In  HTTP mode, the ofsHTTPDisconnect statement in ternal ly makes Java cal ls to disconnect the 
main URL connect ion from the servlet.  

!  In  socket mode, the ofsSocketDisconnect statement  closes the socket on which the Forms Server 
l istens for traffic. 

Using Script Logging as a Debugging tool 

You can debug a playback issue in a C++ script  by enabl ing replay logging. The opt ion for enabl ing replay 
logging is located on the Script Assignment tab of the Conductor. For more in formation about enabl ing log 
fi le generat ion, see Debugging a script .  

When logging is enabled, QALoad writes the cl ient requests and server repl ies to the playback log fi le in  the 
same format as the capture fi le. The playback log fi le is found in the \QALoad\LogFiles directory. When 
there is an issue during playback, such as the server not responding to a cl ient  request, you can compare 
the capture fi les and check the differences in  the server reply data. Both the capture fi le and the log fi le 
contain tracking in format ion appended to the server’s terminal messages. The tracking data contains the 
relat ive sequence number of the server reply from the start  of the Forms session and the t im ing mark. The 
tracking data also shows the number of Forms messages contained in the reply block. The number of 
messages are based on the number of  “ M |S”  l ines prior to the “ T|S”  l ines.  

In  the fol lowing example, the first  set of statements shows the logged statements and the second set of 
statements shows the captured statements. The ServerSeqNo value shows that th is is the 8th reply from the 
server. The MsgCount value of 1 shows that only one Forms Message is included in th is reply block. 

1087419810.000|ofsShowWindow|WINDOW_START_APP|11|OFS_ENDMSG|173|PROPERTY_VISIBLE|java.lang.B
oolean|true 
1087419810.000|ofsSendRecv|1|ClientSeqNo=8|CapTime=1087419810.000|MsgCount=1 
1087419810.000|M|S|2|0|30 
1087419810.000|P|S|135|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087419810.000|P|S|137|java.awt.Point|0|java.awt.Point[x=706,y=464] 
1087419810.000|P|S|139|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087419810.000T|S|1|ServerSeqNo=8|CapTime=1087419810.000|MsgCount=1 

   

1087402349.296|ofsShowWindow|WINDOW_START_APP|11|OFS_ENDMSG|173|PROPERTY_VISIBLE|java.lang.B
oolean|true 
1087402349.296|ofsSendRecv|1|ClientSeqNo=8|CapTime=1087402349.296|MsgCount=1 
1087402349.296|M|S|2|0|30 
1087402349.296|P|S|135|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087402349.296|P|S|137|java.awt.Point|0|java.awt.Point[x=706,y=464] 
1087402349.296|P|S|139|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087402349.296|T|S|1|ServerSeqNo=8|CapTime=1087402349.296|MsgCount=1 
 

Moving the OFS Transaction Loop 

To enable movement of the QALoad transact ion loop in the C++ script , you must fi rst  record a ful l  business 
transact ion and a part ial  business transact ion. The business transact ion is the act ivi ty that you would l ike 
to repeat during QALoad playback.  Insert  QALoad capture comments (using the Insert  Com m and button 
on the Recording toolbar) at the start  and end of a business transact ion. These comments wi l l  help you 
find the spots in  the script  where you would l ike to reposit ion the BEGIN_TRANSACTION() and 
END_TRANSACTION() statements. Then re-start  the business transact ion.  
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QALoad's OFS script  presents a sequence of Forms GUI objects. The GUI objects contain context 
dependencies. For example, when a window is opened, the buttons, text fields and edit  boxes inside that 
window are logical ly dependent on the state of that window. When only one business transact ion is 
captured and the corresponding script ’s transact ion loop is moved, the sequence of the GUI objects is 
broken during the second i terat ion of the transact ion loop. The broken sequence results in  a broken 
context, which causes the server to respond unpredictably during playback on the second and subsequent 
i terat ions of the transact ion loop. When the business transact ion is restarted during capture, the Forms 
GUI objects that compose the new transact ion are used to anchor in to the new transact ion loop without 
breaking the context dependencies of  GUI objects. 

When modifying the script , use the comment l ines as guides in  moving the END_TRANSACTION()  and 
BEGIN_TRANSACTION() statements. Ensure that there is a contextual flow from the new posit ion of the 
END_TRANSACTION() statement to the new posit ion of the BEGIN_TRANSACTION() statement. The set  of 
GUI objects that belong to the ofsSendRecv() statement just before the new END_TRANSACTION() 
statement must be the same as the set of GUI objects that belong to the ofsSendRecv() statement prior to 
the new BEGIN_TRANSACTION() statement. 

During playback, modify the Conductor sett ing for Transact ion Pacing on the Script Assignment tab to 
al low the database to process each new business transact ion. 

The fol lowing example shows a modified OFS transact ion loop: 

New posit ion of the BEGIN_TRANSACTION statement 

/* 
NewSales 
*/ 

DO_SLEEP(13); 
ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "B" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 1, 1); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "1" ); 
ofsIndexKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 175, 97, 0); 

DO_SLEEP(6); 
ofsSendRecv(1); //ClientSeqNo=31|MsgCount=2|1093981339.921 
BEGIN_TRANSACTION(); 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "Business World" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 14, 14); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsRemoveFocus( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 174 ); 
ofsSetSelection( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ADD, 195, 0, 0); 
ofsSetCursorPosition( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ENDMSG, 193, "0" ); 
ofsFocus( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ENDMSG, 174 ); 

DO_SLEEP(6); 
ofsSendRecv(1); //ClientSeqNo=32|MsgCount=4|1093981347.296 

New posit ion of the END_TRANSACTION statement 

/* 
EndTrans 
*/ 

DO_SLEEP(39); 
ofsSendRecv(1); //ClientSeqNo=61|MsgCount=4|1093981458.031 

ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsSelectMenuItem( "Sales Orders", 257, OFS_ENDMSG, 477, "MENU_11059" ); 

DO_SLEEP(26); 
ofsSendRecv(1); //ClientSeqNo=62|MsgCount=2|1093981485.265 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "B" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 1, 1); 
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ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "1" ); 
ofsIndexKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 175, 97, 0); 

DO_SLEEP(3); 
ofsSendRecv(1); //ClientSeqNo=63|MsgCount=2|1093981488.437 
END_TRANSACTION(); 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "Business World" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 14, 14); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsIndexSKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 176, 10, 0); 

DO_SLEEP(13); 
ofsSendRecv(1); //ClientSeqNo=64|MsgCount=2|1093981502.640 

Tips:  
During capture, the OFS configuration parameter "record=names" must be enabled to produce control names 
that may be included in the converted script. Control names persist throughout the Forms session, unlike 
control IDs, whose values may change at runtime. Add the “ record=names”  parameter in the Formsweb.cfg 
file or add this parameter to the startup servlet URL.  
Control IDs can create problems when the transaction loop is moved. Some of the control IDs that have been 
instantiated by the server prior to the new transaction loop lose context during iterations of the new loop. For 
example, in a second loop iteration, the server assumes that these client controls are new, generates new 
control IDs, and eventually cannot find the proper context. Then the server stops responding. If control names 
are used, Forms objects that have been instantiated before the new transaction loop are maintained through 
all iterations of the loop because the control name persists throughout the application session. 
During playback, ensure that the sleep factor is at 100% and that the transaction pacing is set to a large 
enough value for the server to process the business transaction that is contained in the new loop. These 
options can be set on the Script Assignment tab of the Conductor. 

 

Verifying OFS Window Creation 

The ofsWindowCreated command does two th ings. First , i t  ensures that for the ofsSendRecv() command 
preceding i t , the server includes in  the response that a FormWindow object with the t i t le specified is 
created. The script  returns FALSE if the object is not created. Second, the original (captured) control ID is 
associated with the object  represent ing the control in  OFS replay’s in ternal l ist  of controls, which is in  
addit ion to the (runt ime) control ID that is tracked.  

This al lows better tracking of FormWindow GUI controls that exist  at  runt ime by being able to match up 
both the control name and the original control ID.  

The ofsWindowCreated command only handles objects of type FormWindow.  

Using the ofsWindow Created Script  Com m and  

The fol lowing example shows an example from a modified OFS script : 

   ofsSendRecv(1); //ClientSeqNo=1|MsgCount=1|1137439721.484 

   if (!ofsWindowCreated(11, "WINDOW_LARGE_GRAPH")) 
{ 
  // Only fail if this window was not created 
  RR__FailedMsg(s_info, "WINDOW_LARGE_GRAPH was not created!"); 
} 
ofsWindowCreated(15, "WINDOW_START_APP"); 
ofsWindowCreated(20, "WINDOW_CONTROLSTEST"); 
ofsWindowCreated(24, "WINDOW_GRAPHICSTEST"); 
ofsWindowCreated(28, "WINDOW_DATABASETEST"); 
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SAP 

Overview of SAP 

Use QALoad's SAP middleware to load test systems that run SAP 6.20 and 6.40.  

What is SAP? 

The SAP GUI front-end is a middleware that al lows users to access SAP servers from Windows. The SAP 
servers run various SAP business appl icat ions, such as appl icat ions for customer relat ionship management, 
human resources, and supply chain management. 

Connecting to the SAP Server 

Once you have connected to a machine that is running the SAP server, you can log on and interact with 
the SAP appl icat ions.  

Configuring an SAP Client  for Load Test ing 

Before you can record an SAP session, you must have an SAP cl ient that is configured to enable QALoad to 
access the SAP server. Configure the SAP cl ient through the SAP Logon appl icat ion. 

To conf igure an SAP cl ien t  f or  load t est ing: 

1. Start  the SAP Logon appl icat ion. From the taskbar, cl ick Start>Program s>SAP Fron t  
End>SAPlogon . 

2. Click New ... on the SAP Logon dialog box. The New Entry dialog box appears. 

 

3. Type values in  the Descri pt i on , Appl i cat ion  Server, and System  num ber fields.  

Note: QALoad uses the value in the Descript ion field to connect to the server. 

4. Click OK. The new SAP server entry appears in  the l ist  in  the SAP Logon dialog box . 

SAP Recording Opt ions (Versions 6.x) 

Save Server Descri pt i on : Select to specify and save the server descript ion (name) to which you want to 
connect during recording. If th is check box is not selected, you are prompted for a server descript ion 
during the log on process. 
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Recording an SAP Session  

An SAP server connect ion must be configured before you can connect with QALoad. See Configuring an 
SAP Client for Load Test ing for more in formation. Addit ional ly, your SAP administrator must set the 
SAPGUI/User_Scripting securi ty profi le parameter to TRUE to successful ly record a script . For more 
in formation about SAP securi ty sett ings, refer to the SAP publ icat ion t i t led "Sapgui Scripting Security". 

To record an SAP session: 

1. If you have not already chosen SAP as the session type, cl ick SAP Session  to act ivate a new SAP 
session.  

2. In  the Script Development Workbench, cl ick Record on the Session toolbar. 

3. If you have not selected the Save Server Descript ion Record opt ion, the SAP Server Descript ion 
dialog box appears. Type the name of the SAP server to which you want to connect. This value is 
the same as the Descri pt i on  field that displays in  the SAP Logon configurat ion appl icat ion. Press 
En ter. A logon dialog box appears. 

 

4. Type a user ID in the User field and the password in  the Passw ord field. Press En ter. The SAP 
appl icat ion starts.  
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5. In  the SAP appl icat ion, turn off the script ing and not i ficat ion opt ions. Cl ick Custom izing of  l ocal  
l ayout  and choose Opt ions. The Options dialog box appears. On the Script ing tab, select Enable 
Script i ng and clear the two Not i fy check boxes. 

6. Begin recording act ions in  SAP. 

SAP Convert  Opt ions  

Save Passw ord: Select to save the encrypted password. If th is check box is not selected, you are prompted 
for a password during conversion. 

VB Script : Select to generate Visual Basic Script  for debugging outside QALoad. If th is opt ion is not 
selected, you receive C++ scripts that can be used for playback with in QALoad. 

Insert  SAP con t rol  com m ents: Select one of the fol lowing to insert  SAP control l ists as comments in your 
script .  

!  None: There is no control  in formation shown as a comment in  the script . 

!  Tex t f i elds and Statusbars: Control types GuiTextField or GuiStatusbar wi l l  be in  the script  as 
comments with in formation: type, name, and id string. 

!  Al l  con t rol s: Al l  controls wi l l  be in  the script  as comments with in formation: type, name, and id 
string. 

Bui ld SAP Libraries: Cl ick Bui ld to generate the QALoad SAP l ibraries based on your version of SAP. If you 
receive l inking errors whi le val idat ing or compil ing, you should cl ick th is button.  

SAP Command Reference (Versions 6.x) 

QALoad provides descript ions and examples of the various commands avai lable for an SAP script . For 
detai ls, refer to SAP 6.x Language Reference Commands. 

Viewing the SAP Control Log  

Assist your script ing by using the SAP capture control log fi le to view the in formation that was present at 
capture . The log fi le is in  XML format.  

To open t he cont rol  log : 

1. In  the Script Development Workbench Workspace, cl ick the Captures tab or the Scripts tab, then 
right-cl ick on an SAP script  or capture fi le.   

OR 

Open an SAP script  or capture fi le, then right-cl ick on the open fi le. 

2. From the right-cl ick menu, choose View  Con t rol  Log. 
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Advanced Script ing Techniques for SAP 

Adding Custom Counters to Retrieve Server Information 

The fol lowing example adds custom counters to obtain and save the SAP Server in formation that is 
avai lable through the SAP Gui Script ing API. Not ice that SAPGuiSessionInfo is cal led before logging off , 
because the data is not avai lable after logging off. 

int id1, id2, id3, id4; 

long lRoundTrips,lFlushes; 

// "Counter Group", "Counter Name", "Counter Units 
// (Optional)", Data Type, Counter Type. 

id1 = DEFINE_COUNTER("Cumulative Group", "Cumulative RoundTrips", 0, DATA_LONG, 
COUNTER_CUMULATIVE); 

id2 = DEFINE_COUNTER("Cumulative Group", "Cumulative Flushes", 0, DATA_LONG, 
COUNTER_CUMULATIVE); 

id3 = DEFINE_COUNTER("Instance Group", "Instance RoundTrips", 0, DATA_LONG, 
COUNTER_INSTANCE); 

id4 = DEFINE_COUNTER("Instance Group", "Instance Flushes", 0, DATA_LONG, COUNTER_INSTANCE); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

try{ 
   SAPGuiConnect( s_info,"qacsapdb2"); 
   ... 
   SAPGuiSessionInfo(GetRoundTrips,lRoundTrips); 
   SAPGuiSessionInfo(GetFlushes,lFlushes); 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen( "SESSION_MANAGER", "SAPLSPO1", "Log Off" ); 

   COUNTER_VALUE( id1,lRoundTrips); 
   COUNTER_VALUE( id2,lFlushes); 
   COUNTER_VALUE( id3,lRoundTrips); 
   COUNTER_VALUE( id4,lFlushes); 

} // end try 

catch (_com_error e){ 
   char buffer[1024]; 
   sprintf(buffer,"SAP: EXCEPTION 0x%x %s for VU(%i)\n",e.Error(), (char *)e.Description(), 
S_task_id); 

   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

Required Commands 

Certain commands must be present in  an SAP script  for i t  to run successful ly. These commands are created 
automatical ly during the conversion process. Most of the commands exist  before the 
BEGIN_TRANSACTION statement. The required commands include: 

SET_ABORT_FUNCTION(abort function); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info, "ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard(‘*’); 
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SYNCHRONIZE(); 

Requi red com m ands for t ransact ion  restart i ng 

When transact ion restart ing is enabled in  the Conductor for an SAP script , the fol lowing commands, 
which are automatical ly added by QALoad during script  conversion, must exist  for the script  to run: 

SAPGuiApplication(RegisterROT); 
SAPGuiApplication(RevokeROT); 
SAPGui_error_handler(s_info, buffer); 

The SAPGuiApplicat ion command properly registers and removes the script 's SAP GUI usage on the 
Runtime Object Table (ROT). If a transact ion fai ls, these act ions are taken to start  and clean up the SAP 
environment. 

Note: Do not call RR__FailedMsg in an SAP script if the script includes a restart transaction operation. 
SAPGui_error_handler can be called with the same parameters as RR__FailedMsg to output a fatal error 
message while still allowing a proper clean up of the current transaction before restarting the transaction.  
 

Error Handling and Reporting 

A try/catch block is automatical ly generated for the commands between the BEGIN_TRANSACTION and 
END_TRANSACTION statements. This construct provides error handl ing and report ing from the script . 

BEGIN_TRANSACTION(); 

try{ 

   SAPGuiConnect( s_info,"qacsapdb2"); 
   SAPGuiVerCheckStr("6204.119.32"); 

   //Set SapApplication = CreateObject("Sapgui.ScripingCtrl.1")    
   //SapApplication.OpenConnection ("qacsapdb") 
   //Set Session = SapApplication.Children(0).Children(0) 

   DO_SLEEP(3); 

   SAPGuiPropIdStr("wnd[0]"); 
   SAPGuiCmd3(GuiMainWindow, ResizeWorkingPane, 83, 24, false); 

   DO_SLEEP(6); 

   SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME"); 
   SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 

   SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE"); 
   SAPGuiCmd1Pwd(GuiPasswordField, PutText,"~encr~1211616261"); 

   SAPGuiCmd0(GuiPasswordField,SetFocus); 
   SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 

   SAPGuiPropIdStr("wnd[0]"); 
   SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
   SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 

   ... 

   DO_SLEEP(10); 

   SAPGuiPropIdStr("wnd[0]/usr/cntlIMAGE_CONTAINER/shellcont/shell/shellcont[0]/shell"); 
   SAPGuiCmd1(GuiCtrlTree, ExpandNode, "0000000003"); 
   SAPGuiCmd1(GuiCtrlTree, PutSelectedNode, "0000000004"); 
   SAPGuiCmd1(GuiCtrlTree, PutTopNode, "Favo"); 
   SAPGuiCmd1(GuiCtrlTree, DoubleClickNode, "0000000004"); 
   SAPGuiCheckScreen("SESSION_MANAGER", "SAPLSMTR_NAVIGATION", "SAP Easy Access"); 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

} // end try 
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catch (_com_error e){ 
   char buffer[1024]; 
   sprintf (buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(),  
            (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

To include the log on with in the transact ion loop, move the SAPGuiConnect  cal l  inside the try block as 
shown in the fol lowing example: 

SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("capture.cpp"); 
RESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

try{ 

   SAPGuiConnect( s_info,"qacsapdb2"); 
   SAPGuiVerCheckStr("6204.119.32"); 
   ... 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

} // end try 

catch (_com_error e){ 

   char buffer[1024]; 
   sprintf(buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(),  
           (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

To include the log on outside the transact ion loop, move the log off sect ion so that i t  fol lows the 
END_TRANSACTION statement. However, ensure that the recording with in the transact ion loop begins 
and ends in the same locat ion in  the menu system. For example: 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
   RR__FailedMsg(s_info,"ERROR initializing COM"); 
SAPGuiSetCheckScreenWildcard('*'); 

SYNCHRONIZE(); 

SAPGuiConnect( s_info,"qacsapdb2"); 

SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME"); 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 

SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE"); 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~1211616261"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
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SAPGuiPropIdStr("wnd[0]"); 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 

BEGIN_TRANSACTION(); 

try{ 
   SAPGuiVerCheckStr("6204.119.32"); 
   ... 
} // end try 

catch (_com_error e){ 
   char buffer[1024]; 
   sprintf(buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(), 
           (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

 

Handling Multiple Logons 

You may need to modify your script  to handle mult iple logons when the recording scenario differs from 
the run-t ime scenario. For example, i f when you record, no users are logged on to the SAP environment 
and when you run the script , users are already logged on, the script  may fai l . To work around th is issue, 
you can use the SAPGuiPropIdStrExists and SAPGuiPropIdStrExistsEnd commands to handle either 
scenario. This technique works by checking for the mult iple logon dialog box from SAP and select ing the 
Con t inue opt ion. 

The fol lowing example demonstrates the usage of the SAPGuiPropIdStrExists and 
SAPGuiPropIdStrExistsEnd commands to handle mult iple logons: 

... 

SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 
SAPGuiPropIdStrExists("wnd[1]/usr/radMULTI_LOGON_OPT2"); 

   DO_SLEEP(24); 

   SAPGuiCmd0(GuiRadioButton,Select); 
   SAPGuiCmd0(GuiRadioButton,SetFocus); 
   SAPGuiPropIdStr("wnd[1]/tbar[0]/btn[0]"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("S000","SAPMSYST","License Information for Multiple Logon"); 

SAPGuiPropIdStrExistsEnd("wnd[1]/usr/ radMULTI_LOGON_OPT2"); 

... 

 

Checking the SAP Status Bar 

The SAP status bar displays error and status messages, as shown in the fol lowing figure. 
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You can use the SAPGuiCheckStatusbar command to test for certain status responses in the SAP 
environment. 

The SAPGuiCheckStatusbar command is used in the fol lowing script  example: 

... 
SAPGuiPropIdStr("wnd[0]"); 
SAPGuiCmd1(GuiMainWindow, SendVKey, 0); 
SAPGuiCheckScreen("S000", "SAPMSYST", "SAP"); 
SAPGuiCmd3(GuiMainWindow, ResizeWorkingPane, 94, 24, false); 

//SAPGuiCheckStatusbar returns TRUE if the message is found 
//and FALSE if not found 

BOOL bRetSts = SAPGuiCheckStatusbar("wnd[0]/sbar", "E: Make an entry in all required 
fields"); 

if (bRetSts) 
    RR__printf(" True\n"); 

else 
    RR__printf(" False\n"); 

... 

 

Object Life Span 

Whenever a script  is run, al l  objects on the SAP GUI window are deleted and re-created. These objects, 
which are created in  the SAP environment and can disappear without user in teract ion, can cause script  
fai lure i f the script  references the objects after they have disappeared. 

For more troubleshoot ing in formation, refer to SAP’s publ icat ion t i t led “ SAP GUI Scripting API for the 
Windows and Java Platforms” . 
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UNIFACE 

Uniface recording opt ions 

Un i face executable: Enter the ful l  path or browse to the Uniface 7 executable that is used by the 
appl icat ion you want to record. For example: c:\usys72\bin\UNIFACE.exe. 

Work ing di rectory: Enter or browse to the working directory of your Uniface appl icat ion or the directory 
of any addit ional fi les your appl icat ion may require that do not reside in  the appl icat ion’s path 
environment. 

In i t i al i zat ion  (.i n i ) f i l e: Enter or browse to the ful l  path to the Uniface appl icat ion 's in i t ial izat ion fi le. 

Assignm en t  (.asn ) f i l e: Enter or browse to the ful l  path to the appl icat ion 's assignment fi le. For example: 
c:\usys72\project\myapp.asn. 

Com m and l i ne statem en t : Type command l ine opt ions that should be used at appl icat ion startup, 
including the command that is used to start  the appl icat ion. For example:  warehouse 1 control 
use=control dnp=tcp: 

Uniface conversion opt ions 

Includes: Type the ful l  path or browse to the directory that contains the database include fi les. 

Libraries: Type the ful l  path or browse to the directory that contains the database l ibrary fi les. 

Generate Un i face l i sts: Uniface can handle in ternal  l ist  structures. Select th is check box to convert  strings 
contain ing l ist  i tems to a succession of DO_URB_xxx cal ls that manipulate Uniface l ists. 

Show  output  param eters: Select th is opt ion for the converted script  to contain the output parameters of 
an operat ion as commented l ines. 

Insert  t race m essages as com m ents: Select th is opt ion for the converted script  to contain the recorded 
content of the message frame as commented l ines. 

Uniface command reference 

QALoad provides descript ions and examples of the various commands avai lable for a Uniface script . For 
detai ls, refer to the Language Reference Help sect ion for Uniface. 
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Winsock 

How QALoad handles DO_WSK_Send commands 

QALoad displays the contents of a DO_WSK_Send command as a string in  a Winsock script . Some of these 
strings are very large, which can cause a compiler error (fatal error C1076: compiler l im it : in ternal heap 
l im it  reached) i f there are several large strings in  a single script . 

To avoid th is compilat ion  error, QALoad does not al low strings that are displayed in a Winsock script  to be 
more than 12,000 characters. If a DO_WSK_Send command has a send buffer larger than 12,000 characters, 
i ts buffer is broken into smaller strings during the conversion. These smaller strings are then copied in to a 
char buffer named "SendBuffer", which is sent in  the DO_WSK_Send command. The size of the SendBuffer 
variable, by default , is declared as the size of the largest DO_WSK_Send + 1000. For example: 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 
{ 
/* Declare Variables */ 
char SendBuffer[22139];  //Largest send is 21139 + 1000 

    ... 
... 
... 

     strcpy(SendBuffer, "$$ ...."); //Assume a large string, shortened for this example 
strcat(SendBuffer, "$$ ...."); 

     /* 12675 bytes */ 
DO_WSK_Send(S1, SendBuffer); 

     ... 
... 

     strcpy(SendBuffer, "$$ ...."); //SendBuffer is reused 
strcat(SendBuffer, "$$ ...."); 
strcat(SendBuffer, "$$ ...."); 

     /* 21139 bytes */ 
DO_WSK_Send(S1, SendBuffer); 

     ... 
... 

     REPORT(SUCCESS); 
EXIT(); 
return(0); 
} 

Handling Winsock applicat ion data flow 

Frequently, server programs return unique values (for example, a session ID) that vary with each execut ion 
of the script  and may be vital  to the success of subsequent transact ions. To create scripts that include these 
values, you need to subst i tute the hard-coded values returned by the server with variables. The fol lowing 
original and modified code examples demonstrate th is technique. 

Original code 

In th is script , the server sends a session ID in response to a connect ion by the cl ient. This session ID is 
required to successful ly complete subsequent transact ions. 

/* 
* wsk-AdvancedTechniques_original.c 
* 
* This script contains support for the following 
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* middlewares: 
* - Winsock 
*/ 
 
/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 
{ 

/* Declare Variables */ 

SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

///////////////////////////////////////////////////// 
// The session id returned by the server is 
// unique to each connection 
///////////////////////////////////////////////////// 

/* 21bytes: SessionID=jrt90847\r\n */ 

DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// This unique id is then used for subsequent 
// requests 
////////////////////////////////////////////////////// 

/* 34 bytes */ 

DO_WSK_Send(S1, "SessionID=jrt90847\r\n:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 
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EXIT(); 

return(0); 
} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User %i:ABORTED.", S_task_id); 

EXIT(); 
} 

Modified code 

If the original script  (wsk-AdvancedTechniques_original.c shown above) is replayed, i t  wi l l  fai l  because the 
session ID wil l  not be unique; rather, i t  wi l l  be the session ID that is coded in the script . To use the unique 
session ID received from the server, variable subst i tut ion must be used. 

/* 
* wsk-AdvancedTechniques_modified.c 
* 
* This script contains support for the following 
* middlewares: 
* - Winsock 
*/ 

/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 

{ 

/* Declare Variables */ 

char Buffer[64]; 
char SendBuffer[64]; 
int nBytesReceived = 0; 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 
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DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

////////////////////////////////////////////////////// 
// The reply from the server is read into 
// the Buffer variable. We will then have 
// the unique Session ID for this connection. 
// Also need to null-terminate the buffer 
// after receiving. 
////////////////////////////////////////////////////// 

DO_WSK_Recv(S1, Buffer, 64, 0, &nBytesReceived); 
Buffer[nBytesRecieved] = '\0'; 

/* 21bytes: SessionID=jrt90847\r\n */ 

//DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// Finally, substitute the Session ID received from 
// the server with the one coded in the script. 
////////////////////////////////////////////////////// 

sprintf(SendBuffer, "%s:^B^@^@^@^B^@^@^@^A^@^@^@", Buffer); 
DO_WSK_Send(S1, SendBuffer); 

/* 34 bytes */ 

//DO_WSK_Send(S1, "SessionID=jrt90847:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 

EXIT(); 

return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 

{ 
RR__printf("Virtual User %i:ABORTED.", S_task_id); 
EXIT(); 
} 

Winsock Recording Opt ions 

User Started: Select th is opt ion i f you want to start  your appl icat ion manually for recording, either before 
or after you start  recording. Because th is method may fai l  to record your appl icat ion’s in i t ial  cal ls, 
Compuware recommends you use the Autom at i c opt ion instead. Select the User Started opt ion when you 
do not know the ful l  appl icat ion startup name and command opt ion parameters or when the appl icat ion 
spawns off processes that generate traffic that you want recorded. 

Notes:  
If you run a character-based application in a DOS window, the Script Development Workbench does not 
record the API calls. 
 
If you choose this option and the application under test generates traffic before the first Windows screen 
displays, you must also select the Capture Init ializat ion Phase check box on the Workbench Configuration 
tab of the Configure QALoad Script Development Workbench dialog box. 
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Autom at i c: Select th is opt ion i f you want QALoad to automatical ly start  your Winsock-based cl ient, 
al lowing you to record early appl icat ion startup act ivi ty. This is the recommended method of recording 
because i t  takes advantage of QALoad’s enhanced abi l i t ies to handle various mult i-threaded programming 
techniques. When you select th is opt ion, the QALoad Script Development Workbench records the API cal ls 
that occur before the cl ient enters i ts message loop. Select th is opt ion to record traffic from just one 
appl icat ion. This opt ion l im its the recording output to just the traffic generated by the appl icat ion, not 
including the traffic that is generated by processes spawned by the appl icat ion. 

Com m and Line: Enter the command l ine of your Winsock-based cl ient. Note that i f you enter the ful l  
path, QALoad automatical ly enters the path in  the Work ing Di rectory field. 

Work ing Di rectory: Enter the working directory of your Winsock-based cl ient, i f necessary. 

Capture: Select the Winsock version to record. 

Set  IP Addresses: Cl ick th is button to open the Add/Delete IP Addresses dialog box, which you can use to 
specify the IP addresses and ports on which you want to record Winsock API cal ls or that you wish to 
exclude from recording.  

Winsock Conversion Opt ions 

There are no special ized conversion opt ions for Winsock.  

Winsock Command Reference 

QALoad provides descript ions and examples of the various commands avai lable for a Winsock script . For 
detai ls, refer to the Language Reference Help sect ion for Winsock. 

Advanced Script ing Techniques for Winsock 

Understanding Data representation in the Script 

This sect ion describes how data that is sent and received is displayed in a Winsock script . Use th is sect ion 
as a reference when you examine a script . 

During the conversion process, QALoad determines how to represent each character in  the script . This 
conversion process uses the fol lowing rules: 

1. The character is compared to the “ space”  character in  the ASCII table, which has a decimal value of 
32. If the character’s value is less than 32, the fol lowing steps are taken : 

a. If the character is “ \ r” , “ \ n” , “ \ t” , or “ \ f” , i t  is represented in the script  as a normal C 
escape character. 

b. If the character is either “ ^ \ ”  or “ ^^” , i t  is represented in the script  as an octal  character. 
For example, the values would be “ \ 034”  and “ \ 036” , respect ively. 

c. If the character’s value is less than 32 and i t  does not meet the descript ions in  a) and b) 
above, i t  is represented in the script  as a control character. For example, i f the character is a 
nul l  character, i t  is represented in the script  as “ ^@” . 

2. If the character’s decimal value is between 32 (the “ space”  character) and 126 (~), i t  displays in  the 
script  as a standard readable ASCII character, with the fol lowing except ions: 

 If the character is “ \ ” , which has a decimal value of 92, i t  is represented as “ \ \ ”  in  the 
script . 

 If the character is “ “ “ , which has a decimal value of 34, i t  is represented as “ \ ” ”  in  the 
script . 
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 If the character is “ ^” , which has a decimal value of 94, i t  is represented as “ ^^”  in  the 
script . 

3. If the character has a decimal value of 127, which corresponds to Delete (DEL), i t  is represented as 
“ ^”  in  the script . 

The fol lowing table summarizes the results of rules 1-3. 

Code Octal  Decim al  Char 

^@ 000 0 NUL 

^A 001 1 SOH 

^B 002 2 STX 

^C 003 3 ETX 

^D 004 4 EOT 

^E 005 5 ENQ 

^F 006 6 ACK 

^G 007 7 BEL 

^H 010 8 BS 

\t 011 9 HT 

\n 012 10 LF 

^K 013 11 VT 

\f 014 12 FF 

\r 015 13 CR 

^N 016 14 SO 

^O 017 15 SI 

^P 020 16 SLE 

^Q 021 17 SC1 

^R 022 18 DC2 

^S 023 19 DC3 

^T 024 20 DC4 

^U 025 21 NAK 

^V 026 22 SYN 

^W 027 23 ETB 

^X 030 24 CAN 
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^Y 031 25 EM 

^Z 032 26 SIB 

^[ 033 27 ESC 

\034 034 28 FS 

^] 035 29 GS 

^_ 037 31 US 

 040 32 SP 

\" 042 34 " 

\\ 134 92 \  

^^ 136 94 ^  

^? 177 127 DEL 

4. If the character is not included in the groups defined in steps 1-3, i t  is represented as an octal 
character in  the script . These characters are often referred to as h igh ASCII characters (those with a 
decimal value greater than 128), and are represented in the script  as “ \ OOO” , where OOO is the 
octal value for the ASCII character. 

 

Handling Winsock application data flow 

Frequently, server programs return unique values (for example, a session ID) that vary with each execut ion 
of the script  and may be vital  to the success of subsequent transact ions. To create scripts that include these 
values, you need to subst i tute the hard-coded values returned by the server with variables. The fol lowing 
original and modified code examples demonstrate th is technique. 

Original  code 

In th is script , the server sends a session ID in response to a connect ion by the cl ient. This session ID is 
required to successful ly complete subsequent transact ions. 

/* 
* wsk-AdvancedTechniques_original.c 
* 
* This script contains support for the following 
* middlewares: 
* - Winsock 
*/ 
 
/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 
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void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 
{ 

/* Declare Variables */ 

SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

///////////////////////////////////////////////////// 
// The session id returned by the server is 
// unique to each connection 
///////////////////////////////////////////////////// 

/* 21bytes: SessionID=jrt90847\r\n */ 

DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// This unique id is then used for subsequent 
// requests 
////////////////////////////////////////////////////// 

/* 34 bytes */ 

DO_WSK_Send(S1, "SessionID=jrt90847\r\n:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 

EXIT(); 

return(0); 
} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User %i:ABORTED.", S_task_id); 

EXIT(); 
} 

M odi f i ed code 
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If the original script  (wsk-AdvancedTechniques_original.c shown above) is replayed, i t  wi l l  fai l  because the 
session ID wil l  not be unique; rather, i t  wi l l  be the session ID that is coded in the script . To use the unique 
session ID received from the server, variable subst i tut ion must be used. 

/* 
* wsk-AdvancedTechniques_modified.c 
* 
* This script contains support for the following 
* middlewares: 
* - Winsock 
*/ 

/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 

{ 

/* Declare Variables */ 

char Buffer[64]; 
char SendBuffer[64]; 
int nBytesReceived = 0; 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

////////////////////////////////////////////////////// 
// The reply from the server is read into 
// the Buffer variable. We will then have 
// the unique Session ID for this connection. 
// Also need to null-terminate the buffer 
// after receiving. 
////////////////////////////////////////////////////// 

DO_WSK_Recv(S1, Buffer, 64, 0, &nBytesReceived); 
Buffer[nBytesRecieved] = '\0'; 
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/* 21bytes: SessionID=jrt90847\r\n */ 

//DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// Finally, substitute the Session ID received from 
// the server with the one coded in the script. 
////////////////////////////////////////////////////// 

sprintf(SendBuffer, "%s:^B^@^@^@^B^@^@^@^A^@^@^@", Buffer); 
DO_WSK_Send(S1, SendBuffer); 

/* 34 bytes */ 

//DO_WSK_Send(S1, "SessionID=jrt90847:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 

EXIT(); 

return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 

{ 
RR__printf("Virtual User %i:ABORTED.", S_task_id); 
EXIT(); 
} 

Saving Server Replies 

There are two methods for saving the ent ire reply that a server sends back. The fol lowing paragraphs 
describe each method. 

Using the Response() an d ResponseLength () com m ands 

The Response() command can be cal led direct ly after the DO_WSK_Expect() command. It  returns a pointer 
to the data that has been received by DO_WSK_Expect(). To also receive the length of the replay, cal l  the 
ResponseLength() command, which returns the number of characters that were received. The fol lowing 
example uses the Response() and ResponseLength() commands. 

Example  

In  th is example, variables are declared to store the results from the two funct ions. Both funct ions are also 
used to save the buffer that is received with in the DO_WSK_Expect() command. 

/* Declare Variables */ 
int x = 0; 
char *temp; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 21 bytes: You are now connected */ 

DO_WSK_Expect(S1, "d"); 
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// Used to store the data that was received by the 
// DO_WSK_Expect 

temp = Response(); 

// Used to get the size of the response that was received 
// so far 

x = ResponseLength(); 

/* The line below will print the length of the response and the actual response */ 

RR__printf(“length = %d, and response= %s",x, temp); 
DO_WSK_Closesocket(S1); 

The message “ length=21 response=You are now connected”  displays in  the Player buffer window. 

 

Using the DO_WSK_Recv() com m and 

To save a response based on i ts size instead of a unique character string that is used with in the 
DO_WSK_Expect() command, use the DO_WSK_Recv() command. This command enables you to specify 
how much data to receive and where to store the data. 

You can also use the DO_WSK_Recv() command to store the reply that is returned from the server. This 
strategy is useful when you need to retrieve the buffer that is returned from the server, even though the 
returned data is too dynamic and causes the DO_WSK_Expect() command to fai l  every t ime. 

Example  

In  th is example, the DO_WSK_Recv() command is used to save a server reply based on size. Two variables 
are declared to store the results from the DO_WSK_Recv() command. 

/* Declare Variables */ 
int size = 0; 
char temp[45]; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 21 bytes: You are now connected */ 

memset(temp,'\0',45); 
DO_WSK_Recv(S1,temp,45,0,&size); 
RR__printf("size=%d string=%s",size,temp); 
DO_WSK_Closesocket(S1); 

The message “ size=21 string=You are now connected”  displays in  the Player buffer window. 

Note: If you use this method as a substitute for the DO_WSK_Expect() command, ensure that you receive 
the correct information prior to calling the next function in the script. 

Parsing server replies for values 

To parse a buffer for a part icular value, you can write a parsing rout ine that searches the ent ire buffer for 
the value. However, you can also use one of QALoad ’s Winsock helper commands. The fol lowing scenarios 
describe two situat ions in  which you could use the Winsock commands to solve a parsing problem. 

Scenario 1: 
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To find a string in  a server reply, you can use the SkipExpr() and ScanExpr() commands. SkipExpr() 
searches for the first  occurrence of a string in  the in ternal buffer that contains the response that was 
received with in the DO_WSK_Expect() command. Then, use the ScanExpr() command to search for 
another string. ScanExpr() saves the buffer from the first  occurrence of the string that was used with 
SkipExpr() up to and including the string used with in ScanExpr(). The first  parameter of ScanExpr() is a 
UNIX-style regular expression. The fol lowing table l ists the most common expressions: 

Character M ean ing 

. Matches the end of a string. 

* Matches any number of characters. 

? Matches any one character. 

Example In th is example, the buffer contains “ sessionid=1234567890abc” , and the goal is to retrieve 
everyth ing after the “ =” , up to and including “ abc” . 

/* Declare Variables */ 
char temp[35]; 
int size = 0; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 23 bytes: sessionid=1234567890abc */ 

DO_WSK_Expect(S1, "c"); 
SkipExpr("sessionid="); 
size=ScanExpr(".*abc" , temp); 
RR__printf("length = %d string = %s", size, temp); 
DO_WSK_Closesocket(S1); 

The message “ length=13 string=1234567890abc”  displays in  the Player buffer window. 

Scenario 2: 

You may have data returned from the server that is too dynamic, that is, you are not able to base parsing 
on actual characters. The solut ion is to base the parsing on character posit ions instead. 

For example, to save the characters 20 through 25, you could use the ScanSkip() and ScanString() 
commands. ScanSkip() skips a specified number of characters in  the in ternal buffer that stores the response 
that was received with in the DO_WSK_Expect() command. ScanString() scans a number of characters from 
the current posit ion with in the buffer in to a character string. 

Example  

In  th is example, a buffer contain ing “ xxx123456789yyy”  is returned from the server. The value between 
“ xxx”  and “ yyy”  is returned. 

/* Declare Variables */ 

char temp[15]; 

... 

BEGIN_TRANSACTION(); 

... 
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DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 16 bytes: xxx0123456789yyy */ 

memset(temp,'\0',15); 
DO_WSK_Expect(S1, "yyy"); 
ScanSkip(3); 
ScanString(10,temp); 
RR__printf("string=%s",temp); 
DO_WSK_Closesocket(S1); 

The message “ string=0123456789”  displays in  the Player buffer window. 

WWW 

Convert ing a WWW Script   

QALoad has been enhanced to enable you to control how much automated processing is performed during 
test execut ion by choosing HTML mode or HTTP mode for script  conversion. When going through the 
WWW convert  for the first  t ime, you are now prompted to choose between HTML mode and HTTP mode.  

Tip: Compuware recommends that you use the WWW Convert Options dialog box to convert between 
modes, rather than manually edit the script. 

Typical HTML processing uses more processor cycles and memory during test execut ion, but requires less 
script ing. The Visual Navigator is generated using QALoad's Document Object  Mode (DOM) approach, 
which also is used for playback.  

HTTP processing instructs QALoad to disable most of i ts automatic HTML handl ing engine during replay, 
and i t  also affects how the script  is generated. In  th is mode, the convert  process uses some HTML parsing 
to generate the Visual Navigator. This parsing method also is used for playback instead of the DOM. The 
HTTP mode replaces M in imized Processor mode. Scripts converted before QALoad release 5.6 using 
M in imized Processor mode wil l  replay in  HTTP mode. 

Caut ion: Once you convert a script using HTTP mode or HTML mode, you must reconvert the script to 
change the convert mode. This is necessary so that the convert and replay methods match. Failure to change 
modes by reconverting the script can cause the script to replay incorrectly. 

Using the WWW Record Opt ions   

Use the WWW Record Options to determine how QALoad handles captures web page transact ion data.  

To set  t he W W W  recording opt ions: 

1. With a WWW session open, cl ick Opt ions>Record. The Session Options dialog box appears with 
the WWW Record Options h ighl ighted in  the tree view control. The WWW Record Options dialog 
box appears on the right. 

2. Select the appropriate opt ions, then do one of the fol lowing: 

!  Click OK to save the select ions and return to the WWW session screen. 

!  Click Advanced Record Opt ions in  the tree view control. The Advanced Recording Options 
dialog box appears on the right. 

3. Select the appropriate opt ions.  
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4. Click OK. The basic record opt ions and the advanced opt ions are saved and you return to the 
WWW session screen. 

Using the WWW Convert  Opt ions 

Use the WWW Convert Options to control how QALoad produces scripts from recorded transact ion data. 
You can also choose the convert  and playback mode for WWW middleware sessions. The convert  and 
playback mode determines the amount of memory and processor QALoad uses during replay. 

To select  t he processing  m ode: 

1. With the WWW session open, cl ick Opt ions>Convert . The Session Options dialog box displays. 

2. Click WWW Convert  Opt ions in  the tree view control. The WWW Convert Options dialog box 
appears on the right side of the screen. 

3. Select the convert  mode to use for the WWW middleware sessions. You can choose: 

!  HTML Mode - to reduce the amount of script ing. 

!  HTTP Mode - to control processor and memory usage. 

Tip: Compuware recommends that you use the WWW Convert Options dialog box to convert between 
modes, rather than manually edit the script.  

4. Click each of the fol lowing to display the associated dialog box and select the appropriate opt ions: 

Note: The options available for Parsing depend on whether you select HTTP or HTML mode.  

 Parsing 

 Verificat ion 

 Caching 

 Traffic Fi l ters 

 Rule Fi l ters 

 Connect ion Sett ings 

 Content Type Handling 

 General 

 Siebel 

5. Click OK to save the sett ings and return to the main WWW session screen . 

Caut ion: Once you convert a script using HTTP mode or HTML mode, you must reconvert the script to 
change the convert mode. This is necessary so that the convert and replay methods match. Failure to change 
modes by reconverting the script can cause the script to replay incorrectly. 

Using the WWW Playback Opt ions   

The WWW Playback opt ions you select affect the ent ire script . 

To select  t he W W W  Playback  Opt ions: 

1. With a script  open in a WWW session, double-cl ick Playback  Opt ions in  the tree view. The 
avai lable session opt ions display in  the tree view. 
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2. Double-cl ick W W W Playback  Opt ions in  the tree view.  

3. Click each playback opt ion in  the tree view to display the associated dialog box on the right.  

4. Click each of the fol lowing to display the associated dialog box and select the appropriate opt ions: 

Note: The options available for Parsing depend on the mode you select in the WWW Convert Options 
dialog box.  

 Parsing (HTML Mode or HTML Mode) 

 Caching 

 Traffic Fi l ters 

 Connect ion Sett ings 

 Proxy 

 General 

 Siebel 

 

 

Configuring a Web Browser (WWW) 

Before you record the WWW requests your Web browser makes, you must configure the browser to use 
QALoad’s proxy server. 

To conf igure a W eb brow ser : 

1. Start  your Web browser. 

2. Specify proxy sett ings: 

 In  the field designated to specify the address of the proxy server, enter the machine name 
where QALoad Script Development Workbench is instal led. 

 In  the Port  field, enter the port(s) that you specified on the Script Development Workbench’s 
WWW Record Options wizard (Capture Ports fields). 

3. Click OK.  

Best  Pract ices 

Comparison of HTTP Mode and HTML Mode  

Choosing HTML mode or HTTP mode for script  conversion enables you to control how much automated 
processing is performed during test execut ion. Typical HTML processing uses more processor cycles and 
memory during test execut ion, but requires less script ing. HTTP processing instructs QALoad to disable 
most of i ts automatic HTML handl ing engine during replay, and i t  also affects how the script  is generated.  

Features Avai lable 
for Select ion  

HTTP 
M ode 

HTM L M ode Convert  
Opt ions Page 

Parsing  Yes No (Always On) Parsing 

Dynamic Cookie Handling Yes No (Always On) Parsing 
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Dynamic Redirects Yes No (Always On) Parsing 

Authent icat ion Yes Yes N/A 

HTTPS Yes Yes N/A 

Extracts Yes Yes N/A 

Tit le Veri ficat ion  Yes Yes Verificat ion 

Content Check Yes Yes Content Type 
Handling 

Chunked Data Yes Yes N/A 

Streaming Media Yes Yes General 

Traffic Fi l ters Yes Yes Traffic Fi l ters 

Parameterizat ion Rules Yes Yes Rule Fi l ters 

Al low JavaScript Execut ion Yes No Parsing 

Click_Ons No Yes N/A 

Fi l l  In  Forms No Yes N/A 

Caching Yes Yes Caching 

Expert User Yes Yes N/A 

Universal Mode Yes Yes N/A 

Represent CJK as Octal 
Characters 

Yes Yes General 

UTF-8 Yes Yes N/A 

XML Requests Yes Yes General 

Meta Refresh Yes Yes General 

Automatic Sub-request 
Processing 

Yes No (Always On) Parsing 

Set JavaScript Execut ion 
Level 

No Yes Parsing 

Set JavaScript Loop 
Timeout 

Yes Yes Parsing 

Manually Select Sub-
requests 

Yes Yes Parsing 
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Persistent Connect ions 
During Replay 

Yes Yes Connect ion Sett ings 

Graceful Socket Shutdown Yes Yes Connect ion Sett ings 

Baud Rate Emulat ion Yes Yes Connect ion Sett ings 

Reuse SSL Session ID Yes Yes Connect ion Sett ings 

Siebel Support Yes Yes Siebel 

Strip Al l  Cookies Yes Yes General 

 

Using HTML Mode  

HTML mode converts and replays scripts using ful l  Document Object Model (DOM) and JavaScript engine. 
HTML documents are ful ly parsed in HTML mode. JavaScript can be executed at different levels, including 
NONE, LIMITED, and FULL. Because HTML mode uses ful l  DOM and JavaScript engine, i t  uses more 
processor cycles and memory during test execut ion, but requires less script ing.  

Use HTML mode to create load test ing scripts quickly and easi ly, and for load tests requiring fewer virtual 
users (VU) running on any player machine. You can use HTML mode to create scripts for heavier load 
test ing, but the scripts may require more player machines on which to run the VUs. 

Considerat ions 

!  Javascript  - Javascript  can be executed at different levels, including None, Limited, and Ful l . 

!  CPU usage - Uses more processor cycles during test execut ion 

!  M em ory - Uses more memory during test execut ion 

!  Param eteri zat ion  - Requires less script ing and less parameterizat ion than HTTP mode because 
QALoad is better able to in fer user act ions using i ts DOM. 

Use th i s m ode i f  you are: 

!  test ing a web site that uses complex JavaScript with complex HTML pages that  contains a 
significant number of l inks, tables or HTML objects 

!  a novice tester and wish to work with scripts that more closely resemble the user's in teract ions with 
the appl icat ion under test  

!  only test ing with a low number of virtual users or have significant hardware resources avai lable for 
load test ing execut ion  

Tip: Compuware recommends that you use the WWW Convert Options dialog box to convert between 
modes, rather than edit the script manually. 

Sam ple Script  

The fol lowing shows a sample of a script  with HTML mode selected: 

… 
… 
SET_SCRIPT_LANGUAGE(SLID_English); 

DO_WWWInitialize(s_info, HTML_MODE); 
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... 

... 

BEGIN_TRANSACTION(); 

… 
… 
Using HTTP Mode  

HTTP mode converts and replays scripts using a simpli fied HTML parser and l im ited JavaScript engine. You 
can control the level of HTML document parsing, and whether JavaScript should be executed. HTTP mode 
does less processing during replay and uses less memory because i t  does not create Document Object 
Models (DOM) for each processed HTML page.  

HTTP mode may require more parameterizat ion than HTML mode. During conversion, act ions are 
represented in the visual script  by NavigateTo or PostTo tree i tems instead of Cl ickOn or Fi l l -In  Form tree 
i tems. This means that any dynamic variables passed from reply to request must be managed in the script . 
Use the Variable Replacement Wizard to develop rules to find parameters in  your script  and replace them 
with variables.  

Considerat ions 

!  JavaScri pt  — Because JavaScript execut ion is l im ited, some scripts may require customizat ion to 
emulate Javascript  operat ions not executed by QALoad. 

!  Autom at i c Sub-requests — When Parsing is selected, automatic Sub-requests are enabled. When 
not enabled, QALoad executes the same sub-requests made during the capture phase (instead of 
parsing the server responses). This makes playback h ighly scalable, but very dynamic web 
appl icat ions may require addit ional script ing. Al l  subrequests and addit ional  subrequests are 
selected by default  during the convert . 

!  Funct ions — Converted scripts use only the Navigate_To() and Post_To funct ions; the Click_On() 
funct ion is disabled.  

!  Param eteri zat ion  — May require more parameterizat ion than HTML mode. 

!  M em ory and CPU Usage — Does less processing and uses less memory during replay. 

!  Dyn am ic variables — Dynamic variables passed from reply to request must be managed in the 
script .  

Use th i s m ode i f  you are: 

!  test ing a web site that makes l i t t le use of Javascript  and creates pages with few HTML opt ions on 
them 

!  an experienced load tester and wish to work with scripts that more closely resemble the 
appl icat ions HTTP interact ions with the server under test 

!  you are test ing for h igh virtual user throughput or simulat ing h igh numbers of concurrent virtual 
users from l im ited hardware resources 

Tip: Compuware recommends that you use the WWW Convert Options dialog box to convert between 
modes, rather than edit the script manually. 

Sam ple Script   

The fol lowing shows a sample script  with HTTP mode selected: 

… 
… 
SET_SCRIPT_LANGUAGE(SLID_English); 
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DO_WWWInitialize(s_info, HTTP_MODE); 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

 

Sample Scripts for Convert Options 

Below are samples of how the WWW convert  opt ions appear in  a script . Compuware recommends that you 
use the WWW Convert Options dialog box to convert  between modes, rather than edit  the script  
manually.  

Once you convert  a script  using HTTP mode or HTM L mode, you must reconvert  the script  to change the 
convert  mode. This is necessary so that the convert  and replay methods match. Fai lure to change modes by 
reconvert ing the script  can cause the script  to replay incorrect ly. 

 

Parsing 

Parse Pages 

When the Page Parsing opt ion is selected on the WWW Convert Options, QALoad performs l im ited 
parsing operat ions on incoming HTML pages. This opt ion only appl ies to HTTP mode, and is disabled i f 
HTML mode is selected as the convert  mode.  

You should disable th is opt ion i f you find that you need to fi t  more HTTP mode virtual users on a single 
player machine. Disabl ing th is opt ion can decrease the processor usage required by a virtual user.  

Considerat ions 

!  When selected, l im ited parsing is performed on incoming HTML pages. 

!  Must be selected to enable the Al low Javascript  execut ion opt ion. 

!  Must be selected to enable the Automatical ly process sub-requests opt ion. 

!  May increase processor usage required by a virtual user. 

Use th is opt ion to: 

!  Allow Javascript  to be executed in HTTP mode. 

!  Allow automatic sub-request ing to be used in HTTP mode. 

!  Enable document veri ficat ion in  HTTP mode. 

Al low  JavaScript  Execut i on  

This opt ion is only enabled when the Parse Pages opt ion is selected in  HTTP conversion mode. When th is 
opt ion is enabled, QALoad executes JavaScript in  replay as i f the LIMITED JavaScript Execut ion Level is 
used. Since JavaScript in  HTML mode is control led by the JavaScript Execut ion Level opt ion, th is opt ion is 
disabled i f HTML mode is selected as the convert  mode. 

Considerat ions 

!  The opt ion to turn on or turn off JavaScript execut ion is avai lable only in  HTTP mode. JavaScript 
execut ion in  HTML mode is control led by the JavaScript Execut ion Level opt ion . 
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!  When enabled, QALoad executes JavaScript at  the Limited execut ion level.  

!  May decrease the amount of parameterizat ion required for certain scripts. 

!  May increase the processor t ime required by a virtual user. 

Use th is opt ion to: 

Decrease the amount of parameterizat ion required. 

Autom at i cal l y Process Sub-requests i n  HTTP M ode 

When th is opt ion is selected, QALoad does not insert  sub-requests (such as .jpg, .gi f, .css, .js, etc.) direct ly 
in to the script  fi le, but automatical ly makes these requests during replay by parsing them out of the HTML 
pages. 

This opt ion is only enabled when HTTP mode is selected and the Parse Pages opt ion is enabled. HTML 
mode always processes sub-requests automatical ly.  

Considerat ions 

!  When th is opt ion is disabled, QALoad executes the same sub-requests made during the capture 
phase instead of parsing the server response. 

!  Very dynamic web appl icat ions may require addit ional script ing. 

!  All sub-requests and addit ional sub-requests are selected by default  during convert . 

!  Enabling th is opt ion requires more processing during playback. 

Use th is opt ion to: 

!  Allow QALoad to manage sub-requests. 

!  Reduce the length of .cpp script  fi les. 

!  Increase .cpp script  fi le readabi l i ty. 

Dyn am ic Redi rect  Handl ing 

Select ing th is opt ion enables the QALoad replay engine to dynamical ly handle 3XX redirects. When a 3XX 
redirect page is returned during replay, QALoad processes the redirect and requests the redirected page as 
well . This opt ion only appl ies to HTTP mode, and is disabled i f HTML mode is selected as the convert  
mode. 

Considerat ions 

!  This opt ion should normally only be disabled i f you do not want the script  to fol low 3XX redirects. 

!  Dynamic redirect handl ing does not handle JavaScript redirects. 

!  Dynamic redirect handl ing does not handle meta refresh redirects.   

Use th is opt ion to: 

!  Dynamical ly handle 3XX redirects. 

!  Process the redirect and also request the redirected page. 

Dyn am ic Cook ie Handl ing 

When you select  th is opt ion, QALoad automatical ly processes dynamic cookies during replay. This opt ion 
only appl ies to HTTP mode, and is disabled i f HTML mode is selected as the convert  mode. QALoad always 
handles dynamic cookies in  HTML mode. 
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Considerat ions 

!  Not select ing th is opt ion hard codes cookie values from the capture fi le in to the script  fi le.  

!  When th is opt ion is not selected in  HTTP mode, QALoad places Set(NEXT_REQUEST, COOKIE) 
commands into the generated script  fi le.  

!  When th is opt ion is enabled, and you st i l l  can insert  Set(NEXT_REQUEST_ONLY, COOKIE) 
statements. This can override the cookie value that QALoad sends for any cookie that is being 
dynamical ly handled. 

!  You should only disable th is opt ion i f you require more control over the cookies that QALoad 
sends during replay. 

Use th is opt ion to: 

!  Ensure that dynamic cookies are processed during replay. 

!  Ensure that dynamic cookies are not automatical ly inserted in to the script  during convert . 

Example Web Page 

Script Example with Option Selected 

Script Example with Option Not Selected 

Example Web Page 

The cookies for th is si te are: 
Set-Cookie: SaneID=172.22.24.180-4728804960004 
Set-Cookie: SITESERVER=ID=f0544199a6c5970a7d087775f83b23af 
<html> 
<head></head> 
<body> 
<br>RELOAD PAGE TO INCREMENT COUNTER<br><br> 
</body> 
</html> 
Script example with the Dynamic Cookie Handling option selected 
The following example has the “Handle Dynamic Cookies” check box selected. 
... 
... 
Set(EVERY_REQUEST, HTTP_MODE_HANDLE_DYNAMIC_COOKIES, TRUE); 
BEGIN_TRANSACTION(); 
... 
... 
Navigate_To("http://www.host.com/cgi-bin/cookies5.pl "); 
Navigate_To("http://www.host.com/cgi-bin/cookies5.pl "); 
... 
... 
END_TRANSACTION(); 
... 
... 

Script Example with the Dynamic Cookie Handling Option Selected 

The fol lowing example has the Dynam ic Cook ie Handl ing check box selected. 
... 
... 
Set(EVERY_REQUEST, HTTP_MODE_HANDLE_DYNAMIC_COOKIES, TRUE); 
BEGIN_TRANSACTION(); 
... 
... 
Navigate_To("http://www.host.com/cgi-bin/cookies5.pl "); 
Navigate_To("http://www.host.com/cgi-bin/cookies5.pl "); 
... 
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... 
END_TRANSACTION(); 
... 
... 

Script Example with the Dynamic Cookie Handling Option Not Selected 

The fol lowing example has the Dynam ic Cook ie Handl ing check box cleared. 
... 
... 
Set(EVERY_REQUEST, HTTP_MODE_HANDLE_DYNAMIC_COOKIES, FALSE); 
BEGIN_TRANSACTION(); 
... 
... 
Navigate_To("http://www.host.com/cgi-bin/cookies5.pl "); 
/* Request: 2 */ 
Set(NEXT_REQUEST_ONLY, COOKIE, "SaneID",  
"172.22.24.180-4728804960004"); 
Set(NEXT_REQUEST_ONLY, COOKIE, " SITESERVER ",  
" ID=f0544199a6c5970a7d087775f83b23af "); 
Navigate_To("http://www.host.com/cgi-bin/cookies5.pl "); 
... 
... 
END_TRANSACTION(); 
... 
... 

 

JavaScri pt  Execut ion  Level  

This opt ion controls the types of JavaScript statements that QALoad executes while running in  HTML 
mode. The levels are None, Limited, and Ful l . Limited is selected by default .     

This opt ion only appl ies when HTML is selected as the convert  mode. In HTTP mode, th is opt ion is 
disabled and there is only a single level of JavaScript  execut ion. 

The fol lowing table explains each JavaScript Execut ion Level: 

Execut ion  Level  Descript i on  

None No JavaScript is executed during replay. 

Limited Only the fol lowing JavaScript statements are executed during replay: 

!  document.cookie = 

!  window.document.cookie =  

!  document.write() 

!  window.document.write() 

Images are also requested where the image.src statement occurs. 

Ful l  Al l  JavaScript statements are executed during replay. 

Considerat ions 

!  When using the Limited JavaScript Execution Level, you may need to do further parameterization and edit the script. 

!  In HTTP mode, only the Limited level of JavaScript execution is available. 

!  Using no JavaScript execution or a Limited level execution requires less processing time and memory usage than 
the Full level of JavaScript execution. 
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Use th is opt ion to: 

Control the amount of processor and memory usage. 

JavaScri pt  Loop Tim eout  

This opt ion controls the amount of t ime that a JavaScript runs before QALoad terminates the JavaScript 
code. JavaScript can run in to in fin i te loops, or take a very long t ime to run. This opt ion appl ies to both  
HTML and HTTP mode. 

Considerat ions 

!  The t imeout value should be decreased i f you find that an unnecessary JavaScript is running longer 
than the t imeout value.  

!  The t imeout value should be increased i f you find that a necessary JavaScript is running longer 
than the t imeout value.   

!  Make sure that a necessary JavaScript is able to complete before the t imeout value of t ime is 
reached. 

Use th is opt ion to: 

Prevent JavaScripts from running into in fin i te loops or from running indefin i tely . 

 

Connection Settings 

Connect ion  Set t i ngs 

These opt ions control how QALoad handles connect ions to target servers during replay.  

Considerat ions 

!  Connect ion  Opt ions — Select to keep the connect ion to the server open for each request sent to 
the server. 

!  Graceful  Socket  Shutdow n  — Select to control how QALoad terminates i ts socket connect ions.  

!  Baud Rate Em ulat ion  — Select to simulate a specific baud rate for transmission of requests. 

!  SSL Session  — Select to instruct QALoad to reuse the current session 's communicat ion in formation 
(session ID) for al l  page requests with in the transact ion. 

Use th is opt ion to: 

Control how QALoad handles connect ions to target  servers during replay.  

Persi sten t  Connect ions During Replay 

This is an opt ion placed in the script  to be used at replay t ime. Select ing th is opt ion keeps the connect ion 
to the server open for each request sent to the server.  

Considerat ions 

Keeping connect ions open (persistent) can increase the speed at which requests are sent to the server. 

Use th is opt ion to: 

Control processor and memory usage for requests. 

See also: 
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Sample Scripts: Persistent Connect ions During Replay 

Connect ion Sett ings 

M ax  Concurren t  Connect ions 

This opt ion indicates the maximum number of connect ions that a DO_Http or DO_Https command opens 
to the server at any t ime. These simultaneous connect ions are only used i f sub-request ing is enabled. 

Considerat ions 

!  Keeping the maximum number of connect ions open can increase the speed at which requests are 
sent to the server. 

!  In  HTTP mode, i f the Automatically process subrequests opt ion on the Parsing Options page is NOT 
selected, th is opt ion is disabled. 

Use th is opt ion to: 

Control processor and memory usage for requests. 

M ax  Connect ion  Ret ries 

This opt ion specifies the number of t imes during replay that QALoad wil l  at tempt to connect to the server 
after t im ing out.  

Considerat ions 

You must select Persistent connect ions during replay to enable th is opt ion. 

Use th is opt ion to: 

Control processor and memory usage for requests. 

Server Respon se Tim eout  

This opt ion specifies, in  seconds, the length of t ime during replay that QALoad waits for data from the 
server before t im ing out.  

Considerat ions 

You must select Persistent connect ions during replay to enable th is opt ion. 

Use th is opt ion to: 

Control processor and memory usage for requests. 

Graceful  Socket  Shutdow n  

When th is opt ion is enabled, QALoad attempts to graceful ly terminate socket connect ions by making sure 
that al l  remain ing data has been sent and received before closing a socket connect ion.  

Considerat ions 

Enabling th is opt ion usual ly requires more t ime before the socket is shut down.  

Use th is opt ion to: 

Control how QALoad terminates i ts socket connect ions.  

 

Baud Rate Em ulat ion  
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Use th is opt ion to simulate slower connect ions to a Web server, such as 56 Kbps modem or DSL.  

Specify a baud rate when enabl ing baud rate emulat ion in  the Convert  Opt ions dialog box. 

Considerat ions 

!  The DO_SetBaudRate command is inserted in to the script  with the specified baud rate as i ts only 
parameter.  

!  If baud rate emulat ion must be asymmetric (the upload rate is different than the download rate), 
use the DO_SetBaudRateEx command.  

!  DO_SetBaudRateEx takes two parameters: the upload baud rate and the download baud rate.  

Use th is opt ion to: 

!  Simulate a specific baud rate for transmission of requests. 

!  Simulate a specific baud rate for recept ion of requests. 

General 

Proxy HTTP Version   

A WWW script can be set to 1.1 or 1.0. When set to 1.1, al l  proxy HTTP requests and subrequests are sent 
as HTTP/1.1. When set to 1.0, al l  proxy HTTP requests and subrequests are sent as HTTP/1.0.  

Considerat ion 

HTTP 1.1 requests receive chunked repl ies.  

Use th is opt ion to: 

Specify the HTTP version of requests and sub-requests sent to the server.  

M ETA Refresh  Th reshold  

When th is opt ion is selected, the t ime value that you specify in  the seconds field is compared to a Web 
page’s META Refresh value (e.g. <META HTTP-EQUIV=Refresh CONTENT=” 10” ; 
URL=” http:/ /www.compuware.com” >).  

Considerat ions 

!  If the CONTENT field value is less than the t ime value you specify, the page is treated as a 
redirected page.  

!  If the CONTENT field value is greater than the t ime value you specify, the page is treated as a 
regular page. 

Use th is opt ion to:  

Avoid in fin i te loops in  the script . In fin i te loops can occur i f a page refreshes periodical ly to update data. 

Sample Scripts 

Script  Example with Option Selected 

Script Example with Option Not Selected 

Script Example with the META Refresh Threshold Option Selected 

The fol lowing example has the M ETA Refresh  Th reshold check box selected and is set to a value greater 
than 5. 
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... 

... 

Set(EVERY_REQUEST, HTTP_VERSION, "1.1"); 

Set(EVERY_REQUEST, META_REFRESH_THRESHOLD, 5); 

BEGIN_TRANSACTION(); 

... 

... 

/ * Request: 1 */  

Navigate_To(“ http:/ /host/path/ to/page.pl"); 

Veri fy(PAGE_TITLE , "You have reached the final page!!"); 

Script Example with META Refresh Threshold Option Not Selected 

The fol lowing example has the M ETA Refresh  Th reshold check box cleared. The example also appl ies to 
having the opt ion selected and set to a value less than 5. 

... 

... 

/ /  WWW General Options 

Set(EVERY_REQUEST, HTTP_VERSION, "1.1"); 

BEGIN_TRANSACTION(); 

... 

... 

/ * Request: 1 */  

Navigate_To(“ http:/ /host/path/ to/page.pl"); 

Veri fy(PAGE_TITLE, “ Just Wait” ); 

DO_SLEEP(5); 

/ * Request: 2 */  

Navigate_To(“ http:/ /host/path/ to/ realpage.pl"); 

Veri fy(PAGE_TITLE, "You have reached the final page!!"); 

Represen t  CJK as Octal  Characters 

When th is opt ion is selected, the double-byte characters used for Chinese, Japanese, and Korean (CJK) 
scripts are converted in to octal format.  

Considerat ions 

!  Since CJK characters use Double Byte Character Sets (DBCS), encoding must be enabled for a 
capture with CJK characters, so that the double-byte characters can be viewed in a legible format. 

!  Data stays in  encoded format throughout the load test: from capture, through convert  and replay, 
to the analysis of the t im ing fi le.  

Use th is opt ion to: 
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!  Enable the encoding of captured data from web appl icat ions contain ing Double Byte Character Sets 
(DBCS) such as Chinese, Japanese, or Korean.  

!  Encode al l  nat ive characters when nat ive character support cannot be used.  

St ream ing M edia 

QALoad supports two types of streaming media: 

!  RealOne Player 

!  Windows Media Player 

Considerat ions 

!  Streaming media is not supported through firewalls and across proxies. 

!  When streaming media conversion is enabled and you record a transact ion that cal ls streaming 
media, an addit ional command is inserted in to the script  that requests the media.  

!  You do not have to l isten to or view the ent ire media you are request ing. Simply record i ts URL and 
ensure that the appropriate media player is instal led on the QALoad Player machines that wi l l  
execute playback of the script . 

!  At run t ime, the script  invokes the media player and requests the streaming media resource. 

Use th is opt ion: 

For audio and video download test ing of scripts with Windows Media Player or RealOne Player and 
their supported media formats through a WWW session.  

St r i p Al l  Cook ies f rom  Request  

When th is opt ion is selected, no cookies are sent wi th requests. 

Use th is opt ion to: 

Specify whether cookies are sent with requests. 

Document Title Verification 

Enables document t i t le veri ficat ion for main requests of type HTML or TEXT. 

Considerat ions 

There are three supported methods for veri fying a document t i t le: search for the En t i re Docum en t  Ti t l e, 
the Pref i x  of the document t i t le, or the Suf f i x  of the document t i t le.  

Use th i s opt ion  to: 

!  Create scripts that veri fy characters contained in document t i t les.  

!  Detect and handle error messages that are returned in an HTML page.  

Caching 

When a caching opt ion is enabled, requested images, .css, or .js fi les are cached at playback t ime.  

Considerat ions 

!  Types of documents that QALoad caches on the virtual user during replay are: None, Im ages, CSS, 
JS, and Im ages, or Al l .  

!  The caching level names denote the types of documents that QALoad caches on the virtual user 
during replay.  
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!  If these documents are referenced after the virtual user has already requested and received the 
document once, they are not requested from the target server again by that virtual user. 

Use th i s opt ion  to: 

Select the type of caching you would l ike the WWW replay engine to use during playback. 

Script  Sam ples 

Caching Option: None  
Set(EVERY_REQUEST, CACHING, NO_CACHING); 

Caching Option: Images  

Set(EVERY_REQUEST, CACHING, IMAGES); 

Caching Option: CSS, JS, and Images 

Set(EVERY_REQUEST, CACHING, IMAGES_JS_AND_CSS); 

Caching Option: All  
Set(EVERY_REQUEST, CACHING, ALL); 

 

Traffic Filters 

Traffic Fi l ters al lows you to fi l ter out certain requests whi le playing back a script .  

Considerat ions 

Traffic fi l ters do not affect  XML requests that are writ ten to the Visual Navigator tree when a capture fi le is 
converted.  

Use th i s opt ion  to: 

!  Determine which traffic should be: 

 included in your script  

 blocked from your script  

 converted to subrequests in  the script   

 Also block specific substrings in  the path of URLs, such as .jpg to block al l  JPEG images. 

Rule Filters 

Selects the Rule Folders that are scanned for matching rules when convert ing a WWW capture fi le in to a 
Visual Navigator script . 

Considerat ions 

!  Rules are sets of parameters that are establ ished to subst i tute certain pre-establ ished variables for 
system generated variables.  

!  Parameters and Rules are establ ished using the Variable Replacement Wizard. 

Use th i s opt ion  to: 

Control the rules QALoad uses during the convert  process to help parameterize scripts. 
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Enable Siebel Support 

The Enable Siebel Support  opt ion al lows QALoad to ident i fy i f the capture fi le to be converted is a Siebel  
fi le.  

Considerat ions 

!  This opt ion results in  adding a new command in the script  cal led SiebelIn it ial ize, which ident i fies 
the script  as a Siebel script .  

!  Two addit ional commands are also inserted in to the script : SiebelUpdatePage and GetSiebelValue. 
These two commands are only added i f there were HTML responses in the capture fi le, which 
resulted in  generat ion of Siebel variables.  

!  When the convert  process is complete, al l  HTML pages with Siebel variables attached to them at 
the convert  process are output in to the script  fi le so playback can retrieve values from the Siebel 
Correlat ion Library. These parameters appear in  various PostTo commands in the script  and are 
correlated automatical ly to local variables created by the Siebel Correlat ion Library. 

Note: When you want to modify the values of the parameters provided to create a new value for each 
transaction, you must manually parameterize the values.  

Use th i s opt ion  to: 

Record, modify, and play back scripts for the purpose of performance test ing against Siebel appl icat ions 
and environments. 

Script  Sam ples 

Example Script  with Option Selected 

Example Script  with Option Not Selected 

Script Example with the Enable Siebel Support Option Selected 

The fol lowing example has the Enable Siebel  Support  check box selected. 
CLoadString __Siebel_1 = "VRId-3"; 
CLoadString __Siebel_2 = ""; 
CLoadString __Siebel_3 = "SWERowId0=1-7BZ"; 
CLoadString __Siebel_4 = ""; 
CLoadString __Siebel_5 = "1-136"; 
CLoadString __Siebel_6 = "SWERowId0=1-7BZ"; 
CLoadString __Siebel_7 = ""; 
CLoadString __Siebel_8 = "1-1UY"; 
CLoadString __Siebel_9 = ""; 
CLoadString __Siebel_10 = "1-1UY"; 
CLoadString __Siebel_11 = ""; 
CLoadString __Siebel_12 = "1-1UY"; 
… 
…  
// WWW General Options 
Set(EVERY_REQUEST, HTTP_VERSION, "1.1"); 
SiebelInitialize(); // Siebel support is enabled 
 
…. 
…. 
Post_To("http://dtw-siebel78/callcenter_enu/start.swe"); 
// Get the Siebel parameters from this page 
SiebelUpdatePage(); 
__Siebel_5 = GetSiebelValue(" S_BC3_S09_R06_FID "); 
__Siebel_8 = GetSiebelValue(" S_BC3_S09_R05_FID "); 
__Siebel_10 = GetSiebelValue(" S_BC3_S09_R05_FID "); 
__Siebel_12 = GetSiebelValue(" S_BC3_S09_R05_FID "); 
…. 
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…. 
// Original string was: 
//   "1-136" 
// Variablized string is: 
//   "{$ VAR:Siebel-5 $}" 
// 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWERowId", __Siebel_5); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEC", "7"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEMethod", "PositionOnRow"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEReqRowId", "1"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWERPC", "1"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEApplet", "Contact Assoc Applet"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEView", "Account Detail - Contacts View"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWECmd", "InvokeMethod"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWESP", "false"); 
 
// Original string was: 
//   "1156341790828" 
// Variablized string is: 
//   "{$ DATETIME:MS1970 $}" 
// 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWETS", TIME_SINCE_1970("milliseconds")); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEIgnoreCtrlShift", "0"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEP", "1B_Account Contact List 
Applet9_NewRecord0_0_1_7"); 
 
// Original string was: 
//   "SWERowId0=1-7BZ" 
// Variablized string is: 
//   "{$ VAR:Siebel-7 $}" 
// 
//-- Update the Calculation Variable Siebel-7 -- 
// 
// Variablized string is: 
//   "SWERowId0={$ VAR: Siebel-6 $}" 
// 
__Siebel_7 = "SWERowId0="; 
__Siebel_7 += __Siebel_6; 
__Siebel_7 = __Siebel_7; 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWERowIds", __Siebel_7); 
Set(NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 20 - http://dtw-siebel78/callcenter"); 
 
Post_To("http://dtw-siebel78/callcenter_enu/start.swe"); 
DO_SLEEP(1); 

Script Example with the Enable Siebel Support Option Not Selected 

The fol lowing example has the Enable Siebel  Support  check box cleared. 
Siebel_off 
extern "C" int rhobot_script(PLAYER_INFO* s_info) 
{ 
// Declare Variables 
// 
                              
 
 
SET_ABORT_FUNCTION(abort_function); 
 
DEFINE_TRANS_TYPE("cap_siebel_on.cpp"); 
 
 
SET_SCRIPT_LANGUAGE(SLID_English); 
DO_InitHttp(s_info); 
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// Playback Options 
// 
Set(EVERY_REQUEST, PROXY_MODE, PROXY_AUTOMATIC_CONFIGURATION); 
Set(EVERY_REQUEST, PROXY_SCRIPT, "http://proxyconf.compuware.com"); 
Set(EVERY_REQUEST, HTTP_VERSION, "1.1"); 
Set(EVERY_REQUEST, PROXY_HTTP_VERSION, "1.0"); 
Set(EVERY_REQUEST, JAVASCRIPT_LEVEL, FULL); 
Set(EVERY_REQUEST, USER_PATIENCE, 120); // Maximum time to wait for an HTTP Reply 
Set(EVERY_REQUEST, CONNECTION_RETRIES, 4);  // maximum attempts to connect 
Set(EVERY_REQUEST, BROWSER_THREADS, 2); // total browser threads to simulate 
Set(EVERY_REQUEST, CACHING, NO_CACHING);     // Enable/Disable cache 
Set(EVERY_REQUEST, REUSE_CONNECTION, TRUE);   // maintain socket connection if possible 
Set(EVERY_REQUEST, REUSE_SECURE_SESSION, TRUE); 
.. 
.. 
.. 
Navigate_To("http://dtw-siebel78/callcenter_enu/start.swe"); 
 
//---------  REQUEST # 6  --------- 
// 
//  current page url is http://dtw-
siebel78/callcenter_enu/start.swe?SWECmd=GetCachedFrame&SWEACn=..... 
// 
Set(NEXT_REQUEST_ONLY, HEADER, "Accept", "image/gif, image/x-xbitmap, image/jpeg" 
        ", image/pjpeg, application/x-shockwave-flash, */*"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "s_2_1_57_0", "Business"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "s_2_1_27_0", "sdfasdf"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "s_2_1_28_0", "sfdasfd"); 
} 

Streaming Media 

Streaming Media Support 

QALoad includes support for audio and video download test ing of both Windows Media Player and 
RealOne Player and their supported media formats through a WWW session. When streaming media 
conversion is enabled and you record a transact ion that cal ls streaming media, an addit ional command 
that requests the media is inserted in to your script  . You do not have to l isten to or view the ent ire media 
you are request ing. You simply need to record i ts URL and ensure that the appropriate media player is 
instal led on the Player machines that plays back the script . At run t ime, the script  invokes your media 
player and requests the streaming media resource. Streaming media through a firewall  or proxy server is 
not supported. 

QALoad's streaming media support includes the fol lowing media player(s). The appropriate media player 
must be instal led on the machine you are recording from as well  as any QALoad Player machine that wi l l  
be execut ing the script . 

!  RealOne Player — The media download is in i t iated by request ing a fi le that is a data type 
supported by the RealOne Player. Supported data types are RealAudio, RealVideo, RealText, RealPix, 
and SMIL. As a result , the DownloadMediaRP command wil l  be inserted in to the script  at  the 
appropriate point. At runt ime, th is command in it iates and waits for complet ion of the download. 
RealOne Player scripts must be executed as process-based scripts. 

!  Window s M edia Player — The media download is in i t iated by downloading a fi le with a content 
type of (audio|video)/ (x-ms-asf|s-ms-asf) in  the browser. Current ly, only .asx fi les are supported. As 
a result , the DownloadMediaFromASX command is inserted in to the script  at  the appropriate 
point.  

Note: QALoad does not support scripts that have both RealNetworks media and Windows Media in the 
same script. To test both types in a single load test, use a different script for each type. 
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Please note that asynchronous cal ls may not be played back exact ly as they were recorded. For example, i f 
you cl ick on a l ink in  the browser whi le recording while the media is playing, during replay that l ink is not 
requested unt i l  the media cl ip has fin ished being processed. 

 

Recording Streaming Media 

To record st r eam ing m edia: 

1. With a WWW session open in the Script Development Workbench, choose Opt ions>Convert  from 
the menu. 

2. On the WWW tab, cl ick Advanced. 

3. Select the Streaming Media opt ion and cl ick OK. 

When you record your transact ion, make sure you invoke your media player through cl icking a l ink or 
typing a URL in your web browser. QALoad records the URL from your web browser; therefore, you must 
use your browser to access your media fi le or else the URL wil l  not be recorded in your script . 

 

Streaming Media in Visual Navigator 

If you selected the Streaming Media opt ion on the WWW Advanced conversion opt ions dialog box before 
recording your script , and the recorded transact ion contains RealOne Player or Windows Media streaming 
requests, your streaming media request wi l l  be presented as a Page in the tree-view, similar to the fol lowing 

graphic:  

The form-view (bottom pane) for a streaming media page shows the 
t i t le Real Media Request or Windows Media Request to indicate the type 
of request you recorded, and l ists the fol lowing fields: 

Requested URI: Lists the requested URI that invoked the media 
player. For Real M edia the fi le typical ly is an RM fi le, whi le for 
Windows Media i t  is  typical ly an ASX fi le. 

Play M edia Request : Select th is check box for the virtual user to 
process the RM or ASX fi le that is received and make the necessary 
requests to dupl icate what  the cl ient performed while receiving the 
streaming media. If th is checkbox is not selected, then no further 
processing is performed after receiving the RM or ASX fi le. 

Play Requested M edia for N seconds: You can specify how much of the streaming media fi le the virtual 
user should play, in  seconds, before moving on to the next request. A value of zero indicates that the ent ire 
media stream should be played. 

Note: While a virtual user is playing a media request it will not make any other requests in the transaction 
loop. This may be different than what the user performed when recording the transaction because a browser 
is capable of spawning the streaming media player as a separate executable which can execute at the same 
time that the user continues to make further web requests in the browser. 
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CJK Support  

CJK Support in QALoad  

QALoad supports load test ing of Chinese, Japanese, and Korean (CJK) Web appl icat ions that use Double 
Byte Character Sets (DBCS). DBCS is a character set that uses two bytes (16 bits) rather than one byte (8 
bits) to represent a single character. Some languages, such as Chinese, Japanese, and Korean, have writ ing 
schemes with many different characters and character sets that cannot be represented with single-byte 
characters such as ASCII and EBCDIC.  

QALoad supports the fol lowing: 

!  Simpli fied Chinese - People's Republic of China (PRC), Singapore 

!  Tradit ional Chinese - Taiwan, Hong Kong, Macau 

!  Japanese 

!  Korean  

Notes:  

CJK support only applies to the WWW middleware. Currently, QALoad only supports the CJK Double 
Byte Character Sets; Web applications that host Bi-Directional (BiDi) characters (which includes Arabic 
and Hebrew languages) are not currently supported. 
UTF-8-encoded characters are treated as an additional character set used on CJK platforms. They are 
supported when represented on their native operating system. For example, Japanese characters are 
displayed properly on a Japanese operating system. 

QALoad provides two methods of support for CJK: nat ive character and encoding. Depending on your 
test ing requirements and environment, i t  may be necessary to use both mechanisms to support the load 
test ing of a Web site that contains CJK characters.  

!  Nat i ve Character: converts the CJK characters to their original characters in  Chinese, Japanese, or 
Korean. Nat ive character support is only possible when using a nat ive operat ing system (OS) such 
as load test ing a Japanese Web appl icat ion from a Japanese version of M icrosoft  Windows. QALoad 
supports one CJK language's characters in  a script  at  a t ime, plus ASCII/Engl ish. Nat ive character 
support is used with in test scripts, error messages (generated through system commands that use 
nat ive characters) and t im ing fi les, making script  edit ing easier and t im ing fi le analysis quicker. 

!  Encoding: encodes al l  CJK characters in to a sequence of prin table characters regardless of the 
language and exact character set in  use. Encoding support is used when load test ing mult iple 
language sites from the same OS, or when load test ing a CJK site from that of another CJK 
platform. For example, test ing a si te with Japanese characters from a Korean or Engl ish/ASCII OS. 
The encoding opt ion is used when nat ive character support cannot be used or when script  
portabi l i ty between different CJK language OS is required. 

Native Character CJK Support 

By default , QALoad translates Chinese, Japanese, and Korean (CJK) characters i f you are using the QALoad 
Workbench on the same CJK language operat ing system as the operat ing system on which the Web 
appl icat ion is being captured. There are no opt ions to enable, but you may wish to ensure that the 
Represen t  CJK as Octal  Characters opt ion check box is not selected.  

To veri fy, th is opt ion is located on the General page under WWW Convert Options in  Opt ions>Convert  as 
shown below. 
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Below is an example of a t im ing fi le with nat ive characters displayed in QALoad Analyze below. 
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Encoding CJK Support 

QALoad uses the encoding opt ion when convert ing a capture fi le contain ing more than one set of Chinese, 
Japanese, or Korean (CJK) language characters. The encoding opt ion also is used when convert ing the 
script  on a CJK language operat ing system different than the one on which the appl icat ion was captured.  

To over r ide QALoad's Nat ive Charact er  Suppor t  and enable Encoded Suppor t : 

1. In  the QALoad Script Development Workbench, cl ick Opt ions>Convert . The Session Options 
dialog box appears.  

2. In  the tree view under WWW Convert Options, cl ick General . The General convert  opt ions dialog 
box displays.  

3. In  the Other category, select the Represen t  CJK as Octal  Characters check box as shown below. 
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When using encoded characters in  QALoad test scripts, the result ing t im ing fi les do not display 
checkpoints in  their nat ive language. The fol lowing graphic of QALoad Analyze shows a t im ing fi le with 
encoded characters with in i t .  
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Represent CJK as Octal Characters 

When th is opt ion is selected, the double-byte characters used for Chinese, Japanese, and Korean (CJK) 
scripts are converted in to octal format.  

Considerat ions 

!  Since CJK characters use Double Byte Character Sets (DBCS), encoding must be enabled for a 
capture with CJK characters, so that the double-byte characters can be viewed in a legible format. 

!  Data stays in  encoded format throughout the load test: from capture, through convert  and replay, 
to the analysis of the t im ing fi le.  

Use th i s opt ion  to: 

!  Enable the encoding of captured data from web appl icat ions contain ing Double Byte Character Sets 
(DBCS) such as Chinese, Japanese, or Korean.  

!  Encode al l  nat ive characters when nat ive character support cannot be used.  

 

CJK and Visual Navigator 

The Visual Navigator handles both nat ive and encoded Chinese, Japanese, and Korean (CJK) characters. 
(See CJK Support in  QALoad for more in formation about CJK support.) 

The fol lowing graphic shows how the Visual Navigator provides nat ive character support. Both Engl ish and 
Chinese characters are displayed in the Workbook Pane. 
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The same capture fi le, Shanghai.cap, is open in the graphic below. Here, the Visual Navigator displays the 
Chinese characters in  encoded format. 
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Develop ing  a Test  Scr ip t  

Recording a Transact ion 

Recording M iddleware Calls 

QALoad begins recording before start ing your appl icat ion, ensuring that any early startup act ivi ty is 
recorded. 

Hint : You can save yourself some steps later by setting options now to automatically convert your 
recorded capture file and compile it into a script. 

To record a m iddlew are cal l : 

(WWW only) If you are running your appl icat ion on Windows XP SP2, Compuware recommends you turn 
the 'pop-up blocker' feature off before recording a transact ion. The feature can be disabled via the browser 
window's Tools menu in In ternet  Opt ions>Pri vacy. 

1. Open an appropriate middleware session in  the QALoad Script Development Workbench. 

2. (Oracle Forms Server only) Choose Opt ions>Workbench , then cl ick the Com pi ler Set t i ngs tab. In  
the Java sect ion of the dialog box, set the locat ion of your Java fi les for recording. 

3. Select Session>Record>Start . QALoad launches your appl icat ion and any proxies, i f necessary, and 
begins recording any cal ls. 

4. Run the desired user operat ions using your appl icat ion. 

5. (WWW only) If you are capturing SSL requests using EasyScript for Secure WWW, the browser 
generates one or more prompts indicat ing the fol lowing: 

 It  does not recognize the authori ty who signed the server cert i ficate. 

 The server cert i ficate presented by the Web site does not contain the correct si te name. 

When you receive these prompts, cl ick the browser’s Next or Cont inue button so you can connect to 
and exchange information with the desired Web site. 

6. (Optional) At any t ime during the recording process, you can insert  any necessary commands or 
comments in to the capture fi le.  

7. When you have recorded a complete transact ion, stop the appl icat ion from which you are 
recording. 

8. When you fin ish, cl ick Stop Record. You are prompted to save your capture fi le. By default , 
capture fi les (.cap) are saved in the QALoad\Middlewares\<middleware_name>\captures directory. 

Note: If QALoad is not able to record from your application, try QALoad’s alternate procedure for 
recording.  

The Script Development Workbench automatical ly converts a capture fi le to a script  fi le when you stop the 
recording process. You are prompted i f a script  by the same name already exists, so that you can decide 
whether to overwrite an exist ing script  or to save your script  under a different name. 
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Changing Recording Opt ions without  Recording 

You can view and change recording opt ions at any t ime without recording a capture fi le. 

To change recording opt ions w i t hout  r ecording : 

1. Access the QALoad Script Development Workbench. Detai ls 

2. From the Session  menu, select the appropriate middleware or start  a Universal session. 

3. From the Opt ions menu, choose Record. The Record Options wizard opens, showing a tab of 
recording opt ions for the middleware you selected. 

4. On your middleware tab, select opt ions and enter in formation as appropriate. 

5. Click OK. 

For a descript ion of avai lable recording opt ions, see Record Options Wizard.  

Insert ing Commands/ Comments into a Capture File 

You can insert  commands or comments while recording a capture fi le. 

To inser t  com m ands/ com m ent s in t o a capt ure f i le: 

1. On the Recording toolbar, cl ick Insert  Com m and. The toolbar expands into a window where you 
can select opt ions for insert ing commands into your capture fi le. 

2. In  the Com m and Type area, select whether you want to insert  a comment or a begin/end 
checkpoint. 

3. In  the Com m and In fo area, type your comment or a descript ion of the checkpoint. 

4. Do one of the fol lowing: 

!  Click Insert  to insert  your comment or checkpoint command into your capture fi le. 

!  Click  Insert  Com m and again to close the expanded window without insert ing a command. 

5. Continue recording your t ransact ion as usual . 

Recording with Manual Program Startup 

Use th is procedure to manually start  your appl icat ion and the Record faci l i ty. You can start  your 
appl icat ion at any t ime before or after start ing to record. 

This procedure only appl ies to Winsock and SAP. 

To record w i t h m anual  program  st ar t up: 

1. Access the QALoad Script Development Workbench. Detai ls 

2. Choose the appropriate session from the Session  menu. 

3. From the Opt ions menu, choose Record to open the Record Options wizard. 

4. On your middleware tab, select the User Started Program  opt ion. Cl ick OK. 

5. WW W On ly: Start  your browser. 
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6. Click Start  Record . 

7. Start  your appl icat ion (SAP only: start  QALSAP.EXE, which is located in  the \QALoad directory). 

8. Run the user operat ions you want to record. As you execute the operat ions, QALoad records the 
operat ions in  a capture fi le (.cap). 

9. (Optional) At any t ime during the recording process, you can insert  any necessary commands or 
comments in to the capture fi le. Detai ls 

10. When you fin ish, cl ick Stop Record. You must stop recording before you shut down the appl icat ion 
from which you are recording. QALoad prompts you to save your capture fi le. By default , capture 
fi les are saved in the QALoad\Middlewares\<middleware_name>\Captures directory .  

Convert ing a Transact ion to a Script  

Convert ing 

A capture fi le contains al l  the raw data that was recorded, but i t  needs to be converted in to an editable 
script  fi le before you can proceed. The script  fi le can then be open in the Script Development Workbench 
editor and edited as needed. 

To conver t  a capt ure f i le t o a scr ipt : 

1. Access the QALoad Script Development Workbench. Detai ls. 

2. From the Session  menu, choose the session you want to start . 

3. If you have not already done so, set conversion opt ions. 

4. In  the Workspace Pane, cl ick the Captures tab. 

5. Click the capture fi le you want to convert  and cl ick Session>Convert . The capture fi le is converted 
to a script . In  the Workspace Pane, cl ick the Scripts tab to view the l ist  of scripts you have 
converted. 

Note: (WWW Only) When you click Session>Convert , the WWW Script Conversion Mode Selection dialog 
box displays. Choose the mode in which to convert the script. How? 

Note: If an Error/Warning Summary opens in the Output  Pane, resolve any errors. 

6. Compile the script .  
Note: You can set an option to automatically convert your recorded transactions into scripts. How? 

Set  Up Automat ic Conversion and Compilat ion of a Script  

The Script Development Workbench automatical ly converts a capture fi le when you stop the recording 
process and compile the result ing script . You are prompted i f a script  by the same name already exists, so 
that you can decide whether to overwrite an exist ing script  or to save your script  under a different name. 

If the default  sett ings to automatical ly convert  a capture fi le have been changed, fol low the steps below to 
reset the automatic conversion and compilat ion. 

To set  up aut om at ic conversion and com pi lat ion: 

1. From the Script  Developm en t  Workben ch  menu, choose Opt ions>Workbench . 
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2. On the Workbench Configurat ion tab, in  the Record Opt ions area, select the check box 
Autom at i cal l y Convert  Capture. 

3. Click the Com pi ler Set t ings tab. 

4. Select the check box Autom at i cal l y com pi le scri pts. 

5. Select the check box Prom pt  before overw ri t i ng script  to ensure that a script  is not overwrit ten 
accidental ly.  

6. Click OK to save your sett ings. 

Edit ing a Script  

Edit ing a Script  

The Funct ion Wizard al lows you to quickly and easi ly edit  your script  by choosing from the QALoad 
commands avai lable to your script  and insert ing them with a cl ick of your mouse.  

The Funct ion Wizard is located in  the Script Development Workbench in a 
pane on the right side of the window. You can enable or disable the 
Funct ion Wizard from the View  menu or by cl icking the Show  or Hide 
Funct ion  Wizard button on the toolbar.  

The Funct ion Wizard l ists al l  funct ions that are val id to use in  your open 
script . Funct ions are grouped in logical sect ions with in the top window of 
the wizard. When you h ighl ight a funct ion in  the top window of the 
wizard, the lower window l ists a descript ion of that funct ion and i ts 
parameters.  

To insert  a funct ion in to your script , locate i t  in  the Funct ion Wizard and 
then simply drag-and-drop the funct ion in to your script .  

The funct ion wil l  be writ ten in to your script  at  the point you chose. When 
you insert  a funct ion using the wizard, a text box opens showing the 
proper syntax and parameter opt ions. (The text box may not appear i f an 
associated variable or object has not been declared in  the script .) As you 
edit  the funct ion 's parameters, the text box h ighl ights the parameter that 
is current ly being edited.  

Note for ADO scripts: After inserting an ADO method, change the # sign 
to the appropriate object number. 

  

 

 

Using Custom Counters and Messages 

QALoad al lows you to define your own counters and insert  messages into your script , where they are 
writ ten to your t im ing fi le and are viewable in  Analyze or at runt ime in the Conductor.  

Counters can be either cumulative or instance. This determines how they are graphed in Analyze: 

!  For a cumulat ive counter, Analyze keeps a running sum of the counter whi le graphing verses 
elapsed t ime. This type of counter is used for al l  the WWW error counters. Each t ime a WWW error 
occurs, a value of 1 (one) is wri t ten for that counter. When looking at a detai led view in Analyze, 
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you can see at what t imes that error occurred. When you graph a counter in  Analyze, the graph 
shows the total number of occurrences verses the elapsed t ime.  

!  For an instance counter, Analyze graphs each value direct ly. No summing of previous values is 
done.  

Counters must be added manually using the QALoad commands DEFINE_COUNTER and 
COUNTER_VALUE. Messages must be added manually using the QALoad command SCRIPT_MESSAGE. 

The fol lowing sample script  i l lustrates both script  counters and messages: 

#include <stdio.h> 
#include "smacro.h" 
#include "do_www.h" 

int rhobot_script( PLAYER_INFO *s_info ) 
{ 
char  buf1[256]; 
int   id1, id2, id3, id4; 

DEFINE_TRANS_TYPE( "ScriptCounters " );  
DO_InitHttp(s_info); 

// "Counter Group", "Counter Name", "Counter Units (Optional)",  
// Data Type, Counter Type. 

id1 = DEFINE_COUNTER( "Cumulative Group", "Cumulative long",  
                      0, DATA_LONG, COUNTER_CUMULATIVE); 
id2 = DEFINE_COUNTER( "Cumulative Group", "Cumulative float",  
                      0, DATA_FLOAT, COUNTER_CUMULATIVE); 
id3 = DEFINE_COUNTER( "Instance Group", "Instance long",  
                      0, DATA_LONG, COUNTER_INSTANCE); 
id4 = DEFINE_COUNTER( "Instance Group", "Instance float",  
                      0, DATA_FLOAT, COUNTER_INSTANCE); 

SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 

// add value to cumulative counter 1 
COUNTER_VALUE( id1, 1 ); 
DO_SLEEP( 2 ); 

// add value to cumulative counter 2 
COUNTER_VALUE( id2, 1.5 ); 
RND_DELAY( 6 ); 

// add value to instance counter 1 
COUNTER_VALUE( id3, s_info->nRndDelay ); 

// add custom message for this user 
wsprintf( buf1, "User %d slept for %d milliseconds during transaction %d", 
          s_info->nAbsVUNum, s_info->nRndDelay, s_info->s_trans_count ); 
SCRIPT_MESSAGE( "User Messages", buf1 ); 
DO_SLEEP( 2 ); 

// add value to instance counter 2 
// relative user number plus pi times the current transaction number 
COUNTER_VALUE( id4, s_info->nRelVUNum + ( 3.14159 * s_info->s_trans_count ) ); 

END_TRANSACTION(); 
DO_FreeHttp(); 
REPORT(SUCCESS); 
EXIT(); 

} 
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Defining Checkpoints 

Checkpoint statements col lect t im ings of events, such as the execut ion of SQL statements. If you manually 
insert  checkpoint statements in to your capture fi le during the recording process, or i f you select the 
Include Defaul t  Checkpoin t  Statem en ts conversion opt ion before convert ing a script , your script  
includes checkpoints.  

Otherwise, you must manually insert  checkpoints in  your scripts to col lect t im ings. 

Defining Transact ion Loops 

If you did not insert  begin-and end-transact ion commands into your capture f i le, QALoad’s Convert  faci l i ty 
automatical ly places begin-and end-transact ion commands at the start  and end of the recorded sequence. 
QALoad scripts execute the code between the begin-and end-transact ion commands in a loop according to 
the number of t imes you specify in  the QALoad Conductor when sett ing up a test. 

Depending on how you completed your recording, you may want to move one or both of these transact ion 
commands to another place in  the script  to more accurately define the transact ion that runs during the 
load test. 

For example, let ’s say during the recording process you log in  and log out as part  of the procedure. 
However, during the load test you do not want to log in  and log out as part  of every transact ion. To avoid a 
login and logout with every procedure, move the begin- and end-transact ion commands so the login and 
logout commands are outside of the transact ion loop. 

Simulat ing User-Entered Data 

When you create a script , you probably have some constant data embedded in  the script , for example, an 
employee number, that automatical ly enters your appl icat ion’s input fields while recording. If you run a 
load test using th is script , the script  uses the same data for each transact ion. To run a real ist ic test, you can 
modify the script  to use variable data from a datapool fi le. By varying the data input over the course of a 
test, the behavior more real ist ical ly emulates the behavior of mult iple users. You can use the QALoad Script 
Development Workbench to create, maintain, and use datapool fi les (.dat) to insert  variable data in to your 
scripts. 

A datapool can be defined as either central or local: 

!  Cent ral : a datapool that resides on the same workstat ion as the QALoad Conductor, and is 
avai lable to any Player system on the network that requests i t  from the QALoad Conductor. A 
central datapool is control led by the QALoad Conductor, and you use the QALoad Conductor to set 
any opt ions relat ing to a central datapool. 

!  Local : a datapool that resides on a Player workstat ion, and is only avai lable to that Player. Because 
a local datapool resides local ly and is only avai lable to the local Player, i t  does not generate any 
network traffic. Use the QALoad Script Development Workbench to insert  local datapools in to a 
script . 

The fol lowing sect ions describe how to create and use central and local datapools. 

Creating a Datapool File 

You can create a datapool fi le using the Script Development Workbench. 

To creat e a dat apool  f i le: 

1. Open a middleware session in  the QALoad Script Development Workbench. 

2. From the Fi l e menu, choose New . 
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3. On the New  dialog box that opens, select New  from the Datapools tree i tem. 

4. In  the Fi l enam e field, type a unique name for your datapool fi le. 

5. In  the Row s: and Cols: fields, type the number of rows and columns your new datapool should 
have. 

6. Click OK. 

7. Enter your datapool records in  the grid that opens in the Workbook Pane. 

8. When you are fin ished entering datapool records, cl ick Fi l e>Save As to name your datapool fi le. 

9. Click OK to save the fi le. QALoad saves the fi le in  your \QALoad\Datapools directory. 

Modifying a Datapool File 

You can modify a datapool fi le using the Script Development Workbench. 

To m odi f y a dat apool  f i le: 

1. In  the Workspace Pane, cl ick the Datapools tab. 

2. Double-cl ick the datapool  fi le you want to modify. The datapool fi le opens in the Workbook pane. 

3. Make the appropriate changes and save the fi le. 

Using a Central Datapool File in a Script 

You assign a central datapool fi le to a specific script  by select ing the datapool fi le and sett ing any 
appropriate opt ions using the Conductor. Each script  can use a single central  datapool. The central 
datapool is avai lable to al l  Player workstat ions running the test. The fol lowing procedures describe how to 
assign and extract data from a central datapool. These procedures assume you have already created the 
datapool fi le as described above. 

To assign a cent ral  dat apool  f i le: 

1. With a session ID fi le open in the QALoad Conductor, cl ick the Script  Assignm en t  tab. 

2. In  the Ex ternal  Data column for the selected script , cl ick Brow se. 

3. In  the Ex ternal  Data dialog box, navigate to the datapool you wish to use. Select i t  and cl ick 
Open . 

4. If you wish to re-use the datapool records when the script  reaches the end of the fi le, select 
Rew ind. To only use each record once, and then discard i t , select St r i p. 

5. When you are done, cl ick OK. 

Using Data Records f rom  a Cen t ral  Datapool  Fi le 

To use data from a central  datapool in  your load test, you wil l  have to modify your script . Typical ly, you 
wil l  read one record per transact ion.  

To add dat apool  st at em ent s t o your  scr ip t : 

1. With your script  open in the QALoad Script Development Workbench, navigate to the place where 
you want to insert  a datapool variable and h ighl ight the text to replace. 

2. From the Session  menu, choose In sert>Datapool . The Insert  New  Datapool  dialog box appears. 

3. Select a datapool from the l ist  and cl ick OK, or cl ick Add to open the Select  Datapool  dialog box 
where you can choose a datapool fi le to add to your test . 
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4. When you are fin ished, the QALoad Script Development Workbench places several datapool 
funct ions in to your script , denot ing them with markers so you can easi ly ident i fy them . 

 Using Local Datapool Files in a Script 

You assign a local datapool fi le to a specific script  by select ing the datapool fi le and sett ing any appropriate 
opt ions using the QALoad Script Development Workbench. Each script  can use up to 64 local datapools. 
Use the fol lowing procedures to assign and extract data from a local datapool  fi le. These procedures assume 
you have created a datapool as described above. 

To assign a local  dat apool : 

1. Open a session in  the QALoad Script Development Workbench. 

2. In  the Workspace pane, cl ick the Scripts tab. 

3. On the Scripts tab, double-cl ick on the appropriate script  name to open i t  in  the Workbook pane. 

4. From the Session  menu, choose In sert>Datapool . The Insert  Datapool  Com m ands dialog box 
appears. 

5. On the Insert  Datapool  Com m ands dialog box, cl ick Add. The Select  Datapool  dialog box opens. 

6. In  the Type field, select Local . Note that you can also choose to insert  a central datapool from th is 
dialog box. If you choose to insert  a central datapool from here, the QALoad Script Development 
Workbench places the Conductor command GET_DATA in to the script  just after the 
BEGIN_TRANSACTION command, bookmarks the command in the margin of the script , and uses any 
opt ions set for the specified datapool in  the QALoad Conductor. 

7. In  the ID field, give the datapool a unique ident i fier. The name can contain alphanumeric 
characters only. Use underscores ( _ ) for spaces. This ID wil l  help you ident i fy the datapool in  your 
script , for example “ACCOUNT_NUMS”. 

8. In  the Fi lename field, type (or browse for) the ful ly qual i fied path of your datapool fi le. For 
example: c:\Program 
Files\Compuware\QALoad\Workbench\<middleware_name>\Scripts\datapool.dat 

9. If you wish to re-use the datapool records when the script reaches the end of the file, select Rewind at End of File. 
To only use each record once, and then discard it, clear this option. 

10. When you are fin ished, cl ick OK. The selected datapool is displayed on the Insert  New  Datapool  
dialog box. 

11. Click OK. The QALoad Script Development Workbench wil l  place a #define statement ident i fying 
the datapool fi le near the beginning of your script , and place the datapool commands 
OPEN_DATA_POOL, READ_DATA_RECORD, and CLOSE_DATA_POOL at the default  locat ions in  the script . 
These statements wi l l  be bookmarked in the margin for easy ident i ficat ion. 

12. When you are fin ished modifying the script , save any changes. 

For detai led in formation about any of these commands, refer to the Language Reference sect ion. 

Using Data Records f rom  a Local  Datapool  Fi l e 

To use data from a local datapool fi le you wil l  have to modify your script  to read data records and fields at 
the appropriate place in  the script . Datapool fi les should typical ly be opened with the statement 
OPEN_DATA_POOL just before the BEGIN_TRANSACTION statement, then datapool fields can be cal led in to 
the script  to replace variable strings. The OPEN_DATA_POOL statement is automatical ly inserted in to your 
script  when you use the QALoad Script Development Workbench to insert  your datapool. 

1. Read a record from the datapool fi le using the fol lowing command, which reads a single record 
from the local datapool fi le you specify: 
READ_DATA_RECORD(<LOCAL DATAPOOL ID>); 
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2. To access the fields of th is record, subst i tute GET_DATA_FIELD(ACCOUNT_NUMS, n) expressions in  
place of variable strings. 

3. After the END_TRANSACTION statement, close the local datapool fi le by using the fol lowing 
statement: 
CLOSE_DATA_POOL( LOCAL DATAPOOL ID ); 

Note that th is statement is added automatical ly i f you use the QALoad Script Development Workbench to 
insert  your datapool. 

For detai led in formation about any of these commands, refer to the Language Reference sect ion. 

Inserting Variable Data with ActiveData Substitution 

The QALoad Script Development Workbench al lows you to transform string data from quoted constants or 
substrings into variables. Act iveData variable subst i tut ion lets you ident i fy and right-cl ick on a string to 
declare the selected string a variable with in the QALoad script . This faci l i ty also lets you select or edit  
datapool entries more dynamical ly, making script  development easier and more efficient.  

To subst i t ut e a dat apool  value or  a var iable in  p lace of  a select ed st r ing in  your  scr ip t : 

1. Start  the appropriate session in  the QALoad Script Development Workbench. 

2. In  the Workspace pane, cl ick the Scripts tab. 

3. On the Script  tab, double-cl ick the script  you wish to open. The script  opens in the Workbook 
pane. 

4. In  the script , h ighl ight the string you wish to replace. 

5. Right-cl ick anywhere in  the h ighl ighted string. 

!  To subst i tute a value from a datapool : 

 — Click Act i veData>Datapool  Subst i tut i on  in  the shortcut menu that opens. The 
Act i veData Datapool  Subst i tut i on  dialog box opens. 

 In  the Datapool (s) area, h ighl ight the datapool to use. The contents of the datapool fi le 
display below. If the datapool you want to use is not l isted, cl ick the Add button to add 
i t  to the l ist  of avai lable datapools. 

 In  the Field: ID field, type the field number of the specific value to use from the 
datapool. 

 When you are fin ished, cl ick OK. The QALoad Script Development Workbench wil l  
place a #define statement ident i fying the datapool  fi le at the beginning of your script . 
It  wi l l  also insert  the datapool commands OPEN_DATA_POOL, READ_DATA_RECORD, 
GET_DATA_FIELD and CLOSE_DATA_POOL at  the default  locat ions in  the script , and 
bookmark them in the margin for easy ident i ficat ion. Refer to the Language Reference 
sect ion for detai led in formation about any of those commands. 

 To subst i tute a variable: 

 Click Act i veData>Variable Subst i tut i on  from the shortcut menu that appears. The 
Act i veData Variable Subst i tut i on  dialog box opens. 

h. Assign a variable name for the selected string in  the Variable Nam e field. 

i . Click OK. The QALoad Script Development Workbench wil l  declare the variable at the 
beginning of your script  and subst i tute the named variable for the selected string. It  wi l l  
also bookmark both locat ions for easy ident i ficat ion. 

6. When you are fin ished, save your script  changes. Compuware recommends that you also compile 
your script  to check for any errors. 
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Middleware Script ing Techniques 

Citrix 

Handl ing Ci t r i x  Server Farm s 

Citrix servers can be grouped in farms. When load test ing, you may want to connect to a Citrix server farm 
rather than to a specific server. Load test ing requirements may include connect ing to a Citrix server farm, 
where the load balancing feature supports dynamic redirect ion to a given server at connect ion t ime. This 
load tests the server farm and Citrix load balancing rather than a single server, which can provide a more 
real ist ic load test.   

To record a script  that connects to a farm, you must use an ICA fi le to connect. However, when a capture 
takes place, a specific server (in  the farm) must have a connect ion. Specify the correct ICA fi le to connect 
to the server farm as well  as a specific server with in that server farm.  

To veri fy that your script  is connect ing to a server farm and not a specific server, assign the server name to 
one blank space when val idat ing the script . In  order to record a script  that connects to a farm, you must 
use an ICA fi le specified in  the Citrix Record Options dialog. Since the ICA fi le should contain al l  the 
necessary connect ion in formation, the server field should be left  blank when recording.  

When converted, the CitrixServer variable has a blank space: 

. 

. 

. 

/* Declare Variables */ 
const char *CitrixServer   = " "; 
const char *CitrixUsername = "citrix"; 
const char *CitrixPassword = "~encr~657E06726F697206"; 
const char *CitrixDomain   = "qacitrix2"; 
const int CitrixOutputMode = OUTPUT_MODE_NORMAL; 

. 

. 

. 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("Orders.cpp"); 

CitrixInit(4); 

/* Citrix replay settings */ 

CtxSetConnectTimeout(90); 
CtxSetDisconnectTimeout(90); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetDomainLoginInfo(CitrixUsername, CitrixPassword, Citrix-Domain); 
CtxSetICAFile("PRD desktop.ica"); 
CtxSetEnableCounters(TRUE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 

SYNCHRONIZE(); 

 

The Citrix cl ient ignores th is value and uses the ICA fi le to dynamical ly retrieve the server name at 
playback t ime. 

Conclusion 
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When you use these techniques to set up a Citrix server farm test script , you al low for dynamic server 
redirect ion at playback as part  of test ing a load balanced Citrix server farm.  

Handl ing Dynam ic Win dow  Ti t l es 

Some appl icat ions create windows whose t i t les vary depending on the state of the window. For example, 
M icrosoft  Word creates a t i t le based on the default  document name at the t ime of the window creat ion. 
During replay, th is dynamic t i t le can differ from the window t i t le that was recorded, and the window is 
not recognized. If th is occurs, t ry the fol lowing steps to modify the script : 

1. Ensure that  the Enable Wi ldcard Ti t l e M atch  check  box  i s selected in  the Ci t r i x  conversion  
opt ions prior to convert i ng the recording.  
In  the Window Verificat ion group of the Ci t r i x  Convert  Opt ions dialog box, ensure that the 
Enable Wi ldcard Ti t l e M atch  check box is selected. This check box is selected by default . If you 
are working with a previously-converted script , ensure that a CtxSetEnableWildcardMatching 
command exists in  the script  prior to the BEGIN_TRANSACTION command and that the parameter 
is set to TRUE. 

2. Veri fy w hether there i s an  i ssue w i th  dynam ic w i ndow  t i t l es.  
When a script  fai ls on val idat ion because the run t ime window t i t le is different than the expected 
window t i t le from the recording, i t  is l ikely that you are deal ing with a dynamic t i t le issue that can 
be handled by th is script ing technique. In  th is case, the script  fai ls on the 
CtxWaitForWindowCreate cal l . 

3. Iden t i fy a m atch  “ pat tern ”  for the dynam ic w indow  t i t l e.  
Note the error message that is returned during val idat ion (or replay). The message indicates the 
expected window t i t le versus the window t i t le from script  playback. Examine the differences in  the 
window t i t les to create a “ match pattern”  that recognizes the window t i t le, whi le ignoring other 
windows. A match pattern can be a simple substring of the window t i t le or a pattern string using 
wildcard characters such as ? (to match any single character) or * (to match any number of 
characters). The examples below i l lustrate the different match patterns. 

4. Insert  a CtxSetWindow M atchTi t l e com m and pr ior to the CtxWai tForWi ndow Create cal l  for 
the dynam ic w indow .  
When adding the CtxSetWindowMatchTit le command, ensure that the first  parameter contains the 
correct window object and the second parameter contains the match string in  double-quotes. 

5. Val idate the script  to ensure the CtxWai tForWindow Create com m and recogn izes the dynam ic 
w indow  nam e.  
Run the revised script  through val idat ion to ensure that the script  succeeds. If the script  does not 
val idate successful ly, go to step 3 to determine i f the match pattern is correct. 

Example 1: Using a substring match 

In th is example, the M icrosoft  Word appl icat ion generates a dynamic t i t le when the script  is replayed. The 
dynamic name is a concatenat ion of the default  document that Word creates at appl icat ion startup with 
the name of the appl icat ion. The script  is altered to reflect the fact that the string “ M icrosoft  Word”  is 
always part  of the window t i t le: 

// Window CWI_13 ("Microsoft Word") created 
CtxSetWindowMatchTitle( CWI_13, “Microsoft Word” ); 
CtxWaitForWindowCreate(CWI_13); 

Example 2: Using a wildcard match with the *  character 

In  th is example, the SampleClientApp appl icat ion generates a dynamic t i t le when the script  is replayed. 
The dynamic name is the name of the appl icat ion fol lowed by the name of the user, beginning with the 
word “ User” . The asterisk (*) wi ldcard is subst i tuted for a given username, reflect ing the pattern of 
“ SampleClientApp – User:”  as part  of the window t i t le fol lowed by an arbitrary user name: 
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// Window CWI_13 ("SampleClientApp – User: John") created 
CtxSetWindowMatchTitle(CWI_13,“SampleClientApp – User: *” ); 
CtxWaitForWindowCreate(CWI_13); 

Example 3: Using a wildcard match with the ? character 

In  th is example, the RandomValue appl icat ion generates a dynamic t i t le when the script  is replayed. The 
dynamic name is the appl icat ion fol lowed by a random single digit . The question mark character is 
subst i tuted for the single digit  to reflect the pattern  that begins “ RandomValue: ” , fol lowed by single digit : 

// Window CWI_13 ("RandomValue: 0") created 
CtxSetWindowMatchTitle( CWI_13, “Sample Application: ?” ); 
CtxWaitForWindowCreate(CWI_13); 

Handl ing Dynam ic Win dow s 

During conversion, CtxWaitForWindowCreate cal ls are added to the script  for each named window 
creat ion event. During replay, some dynamic windows that were in  the capture may not appear, which 
causes the script  to fai l  because a wait  point t imes out. To avoid script  fai lure in  th is circumstance, 
comment out the CtxWaitForWindowCreate commands that may be referencing dynamic windows. 

Handl ing Unexpected Even ts in  Ci t r i x  

The CtxWindowEventExists and CtxScreenEventExists commands can be used to handle unexpected 
window and screen events in  Citrix scripts. When there is a possibi l i ty of unexpected dialogs appearing or 
unexpected screen events occurring, you must modi fy the script  to respond to the changes and cont inue 
the load test. 

For example, i f a script  opens a M icrosoft  Word document that resides on a network, and that document is 
already open by another network user, an unexpected dialog box appears that prompts the user to choose 
between cont inuing to open the document in  read-only mode or to cancel i t . To prevent script  fai lure, 
modificat ions can be made in the script  to handle the dialog boxes that appear in  th is si tuat ion.  

General ly, to handle unexpected events, you record two scripts. The first  script  contains a recording of the 
expected events. The second script  should include the unexpected events. Using the 
CtxWindowEventExists and CtxScreenEventExists funct ions, create a condit ional block of code that 
handles the dialogs that may appear. 

Example 

The fol lowing script  example shows the addit ional script  l ines that were added to handle a Word 
document that is already open by another user on a network. The added l ines appear in  boldface type. 

/* 
 *  capSave11111-2.cpp 
 * 
 *  Script Converted on June 21, 2004 at 01:04:17 PM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 50 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
  
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Window Verification             : Yes 
 *   Session Timeouts                : Yes 
 *    Connect Timeout (s)            : 60 
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 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *   Include Wait Points             : Yes 
 *   Enable Counters                 : No 
 *   Include Unnamed Windows         : Yes 
 *   Output Mode                     : Normal 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 */ 
  
#define CITRIX_CLIENT_VERSION "8.00.60000" 
#define CITRIX_ICO_VERSION    "2.4" 
#define SCRIPT_VER 0x00000205UL 
  
#include <stdio.h> 
#include "smacro.h" 
  
#include "do_citrix.h" 
  
/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
  
#ifndef NULL 
#define NULL  0 
#endif 
  
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 
            /* Declare Variables */ 
            const char *CitrixServer      = "qaccitrix"; 
            const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL;             
  
            /* Citrix Window Information Objects */ 
            CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
            CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
            CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
            CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 
397, 127); 
            CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 
397, 127); 
            CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
            CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
            CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
            CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
            CtxWI *CWI_10 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
            CtxWI *CWI_11 = new CtxWI(0x1005a, "", 2, 49, 205, 408); 
            CtxWI *CWI_12 = new CtxWI(0x2006a, "", 200, 186, 156, 287); 
            CtxWI *CWI_13 = new CtxWI(0x10138, "", 112, 116, 416, 248); 
            CtxWI *CWI_14 = new CtxWI(0x50036, "Microsoft Word", -4, -4, 649, 461); 
            CtxWI *CWI_15 = new CtxWI(0x1017e, "Open", 19, 23, 602, 387); 
            CtxWI *CWI_16 = new CtxWI(0x20174, "*Microsoft Word", -4, -4, 649, 461); 
            CtxWI *CWI_17 = new CtxWI(0x10058, "", 113, 114, 305, 26); 
            CtxWI *CWI_18 = new CtxWI(0x2013e, "Calculator", 66, 66, 261, 253); 
            CtxWI *CWI_19 = new CtxWI(0x1005a, "", 2, 49, 205, 408); 
            CtxWI *CWI_20 = new CtxWI(0x3006a, "Shut Down Windows", 111, 96, 418, 193); 
  
            CtxWI *CWI_117 = new CtxWI(0x20172, "File In Use", 144, 127, 352, 179); 
            CtxWI *CWI_118 = new CtxWI(0x30172, "11111111 (Read-Only) - Microsoft Word", -4, 
-4, 649, 461); 
             
            SET_ABORT_FUNCTION(abort_function); 
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            DEFINE_TRANS_TYPE("capSave11111-2.cpp"); 
  
            CitrixInit(1); 
  
            /* Citrix replay settings */ 
            CtxSetConnectTimeout(60); 
            CtxSetDisconnectTimeout(60); 
            CtxSetWindowTimeout(30); 
            CtxSetPingTimeout(20); 
            CtxSetWaitPointTimeout(30); 
            CtxSetWindowVerification(TRUE); 
            CtxSetEnableCounters(FALSE); 
            CtxSetWindowRetries(5, 5000); 
            CtxSetEnableWildcardMatching(TRUE); 
             
            SYNCHRONIZE(); 
  
            BEGIN_TRANSACTION(); 
  
            DO_SetTransactionStart(); 
             
            CtxConnect(CitrixServer, CitrixOutputMode); 
             
            // Window CWI_1 ("Warning !!") created 1087837356.454 
             
            CtxWaitForWindowCreate(CWI_1, 2125);             
             
            DO_MSLEEP(1891); 
            CtxPoint(246, 267);  //1087837358.797             
             
            DO_MSLEEP(453); 
            CtxMouseDown(CWI_1, L_BUTTON, NONE, 246, 267);  // 1087837358.797 
             
            CtxMouseUp(CWI_1, L_BUTTON, NONE, 247, 267); //1087837359.032 
             
            . 
            . 
            . 
             
            DO_MSLEEP(63); 
            // Window CWI_14 ("Microsoft Word") created 1087837397.390 
             
            CtxWaitForWindowCreate(CWI_14, 141);             
             
            DO_MSLEEP(78); 
            CWI_14->setTitle("Document1 - Microsoft Word"); //1087837397.468 
             
            // Window CWI_13 ("") destroyed 1087837397.468             
             
            DO_MSLEEP(2468); 
            CtxPoint(37, 50);  //1087837400.218             
             
            DO_MSLEEP(282); 
            CtxClick(CWI_14, 203, L_BUTTON, NONE); //1087837400.421 
             
            // Window CWI_15 ("Open") created 1087837400.764 
             
            CtxWaitForWindowCreate(CWI_15, 344); 
             
             
            DO_MSLEEP(1656); 
            CtxPoint(132, 99);  //1087837402.671             
             
            DO_MSLEEP(250); 
            CtxDoubleClick(CWI_15); // 1087837402.874             
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            DO_MSLEEP(109);       
             
             
            DO_MSLEEP(1953); 
            CtxPoint(247, 197);  //1087837404.827 
             
            // Window CWI_15 ("Open") destroyed 1087837404.827 
  
  
            if(CtxWindowEventExists(EVT_STR_CTXWINDOWCREATE,3000,CWI_16)) 
            BeginBlock();    
                        CtxPoint(337, 265);  //1087837404.905 
             
                        // Window CWI_16 ("11111111 - Microsoft Word") created 
1087837404.905 
             
                        CtxWaitForWindowCreate(CWI_16, 31); 
             
                        // Window CWI_14 ("Document1 - Microsoft Word") destroyed 
1087837404.905  
             
                        DO_MSLEEP(7547); 
                        CtxPoint(628, 9);  //1087837414.592             
             
                        DO_MSLEEP(2141); 
                        CtxClick(CWI_16, 281, L_BUTTON, NONE); //1087837414.873             
             
                        DO_MSLEEP(234); 
                        // Window CWI_16 ("11111111 - Microsoft Word") destroyed 
1087837415.108 
             
                        CtxPoint(113, 93);  //1087837418.779 
             
                        // Window CWI_17 ("") created 1087837418.779 
            EndBlock() 
  
///ReadOnly Code Start 
  
            else 
            BeginBlock();    
             
                        // Window CWI_117 ("File In Use") created 1087840076.599 
             
                        CtxWaitForWindowCreate(CWI_117, 578); 
             
                        DO_MSLEEP(2360); 
                        CtxPoint(358, 283);  //1087840079.068 
             
             
                        DO_MSLEEP(125); 
                        CtxClick(CWI_117, 281, L_BUTTON, NONE); //1087840079.365 
             
             
                        DO_MSLEEP(109); 
                        // Window CWI_117 ("File In Use") destroyed 1087840079.458 
             
                        // Window CWI_118 ("11111111 (Read-Only) - Microsoft Word") created 
1087840079.521 
             
                        CtxWaitForWindowCreate(CWI_118, 63); 
             
                        // Window CWI_115 ("Document1 - Microsoft Word") destroyed 
1087840079.521 
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                        DO_MSLEEP(4766); 
                        CtxPoint(631, 3);  //1087840084.490 
             
                        DO_MSLEEP(203); 
                        CtxClick(CWI_118, 250, L_BUTTON, NONE); //1087840084.740 
             
                        DO_MSLEEP(93); 
                        // Window CWI_118 ("11111111 (Read-Only) - Microsoft Word") 
destroyed 1087840084.833 
             
                        DO_MSLEEP(2407); 
                        CtxPoint(34, 465);  //1087840087.333 
  
            EndBlock(); 
  
///ReadOnly Code End  
  
  
            DO_MSLEEP(1063); 
             
            DO_MSLEEP(484); 
            CtxPoint(112, 93);  //1087837419.654             
             
            DO_MSLEEP(406); 
            CtxDoubleClick(CWI_9); // 1087837419.904             
            . 
            . 
            . 
 
            // Window CWI_9 ("Program Manager") destroyed 1087837440.122 
             
            // Window CWI_7 ("") destroyed 1087837440.138 
             
            DO_SetTransactionCleanup(); 
             
            CtxDisconnect(); 
             
             
            END_TRANSACTION(); 
  
            delete CWI_1; // "Warning !!" 
            delete CWI_2; // "Log On to Windows" 
            delete CWI_3; // "Please wait..." 
            delete CWI_4; // "Citrix License Warning Notice" 
            delete CWI_5; // "Citrix License Warning Notice" 
            delete CWI_6; // "UsrLogon.Cmd" 
            delete CWI_7; // "" 
            delete CWI_8; // "ICA Seamless Host Agent" 
            delete CWI_9; // "Program Manager" 
            delete CWI_10; // "" 
            delete CWI_11; // "" 
            delete CWI_12; // "" 
            delete CWI_13; // "" 
            delete CWI_14; // "Microsoft Word" 
            delete CWI_15; // "Open" 
            delete CWI_16; // "11111111 - Microsoft Word" 
            delete CWI_17; // "" 
            delete CWI_18; // "Calculator" 
            delete CWI_19; // "" 
            delete CWI_20; // "Shut Down Windows" 
  
            delete CWI_117; // "File In Use" 
            delete CWI_118; // "11111111 (Read-Only) - Microsoft Word" 
             
            CitrixUninit(); 
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            REPORT(SUCCESS); 
            EXIT(); 
            return(0); 
} 
  
void abort_function(PLAYER_INFO *s_info) 
{ 
            RR__printf("Virtual User ABORTED."); 
             
            CitrixUninit(); 
             
            EXIT(); 
} 

Using the CtxWai tForScreenUpdate Com m and 

In some situat ions, a window may vary in  how long i t  takes to refresh on the screen. For example, the 
Windows Start  menu is an unnamed window that can take varying amounts of t ime to appear, depending 
on system resource usage. To prevent playback problems in which a mouse cl ick does not synchronize with 
i ts in tended window, insert  the CtxWaitForScreenUpdate command in the script  after the act ion that 
causes the window to appear. The parameters for the CtxWaitForScreenUpdate command correspond to 
the X and Y coordinates and the width and height of the window. This command ensures that the window 
has enough t ime to display before the mouse cl ick. 

OFS 

Understanding the C++ Script  

Oracle Forms Server scripts are produced for al l  Oracle E-Business Suite and Oracle Appl icat ions recordings. 
The C++ script  executes OFS-related statements by passing the statements in  the script  DLL to the OFS Java 
engine that performs the cl ient act ivi t ies and the cl ient communicat ion with the server. Because the C++ 
script  statements are direct ly t ied to corresponding methods in the OFS Java engine, modificat ions to the 
script  statements are l im ited to changing the property parameter values through variabl izat ion. 

An OFS C++ script  contains three main sect ions: Connect ion, Appl icat ion Body, and Disconnect. The 
QALoad transact ion loop includes al l  three sect ions by default .  The transact ion loop can be moved using 
the guidel ines described in Moving the OFS transact ion loop. An internal auto checkpoint is created during 
connect ion statements and transmission statements. 

The C++ script  statements are a condensed version of the Java-style script  statements.  The C++ script  
statements show the GUI controls in  the OFS appl icat ion and the control propert ies, which are either 
control at tributes or act ivi t ies. For example: 

ofsClickButton( "BUTTON", 52, OFS_ENDMSG, 325 ); 

In  th is example, the user cl icks (property 325) a button ( control ID 52).  OFS_ENDMSG is a flag that 
indicates that the GUI act ivi ty ends the current OFS Message.  

QALoad also al lows OFS and WWW statements from a Universal session to be scripted in  the C++ script , 
providing the abi l i ty to play back WWW and OFS statements. QALoad automatical ly extracts ICX t ickets 
and any necessary cookies from the WWW middleware traffic and passes them to the OFS middleware. 

Connect ion  Statem en ts 

The connect ion script  l ines in  the C++ script  vary depending on the type of Forms connect ion mode that is 
act ive. You choose the Forms connect ion mode on the Oracle Forms Record Options dialog box. Forms 
connect ion modes include server-side recording, HTTP, HTTPS, or socket. 

Server-side recording is l im ited to appl icat ions that  use Oracle Appl icat ion Server. HTTP connect ion mode 
is avai lable for appl icat ions using Forms 9i and for appl icat ions using the patched Forms 6i version 
configured with the HTTP servlet. HTTPS connect ion mode is strict ly for SSL-enabled appl icat ions that use 
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Forms 9i. Socket connect ion mode is for appl icat ions that use Forms 6i and lower versions, such as Oracle 
11i. 

Server-side recording connect ions 

Server-side recording mode contains only one connect ion statement. The funct ion that is used – 
ofsSetServletMode –  contains the l istener servlet value that you entered on the Oracle Form s Server 
Recording Opt ions dialog box. The first  parameter defines the HTTP or HTTPS configurat ion of the 
appl icat ion environment. The second parameter defines the name of the Forms Listener Servlet used by the 
appl icat ion. To connect, QALoad internal ly invokes Oracle’s dispatch cal ls using the two parameters. 
Oracle’s proprietary classes provide the implementat ion for the HTTP or HTTPS connect ion.  For example: 

ofsSetServletMode(OFS_HTTP, "http://ntsap45b:7779/forms90/l90servlet" ); 

HTTP connect ions 

HTTP connect ion mode contains mult iple connect ion statements. To connect, QALoad internal ly performs 
Java cal ls to accomplish the fol lowing tasks:   

!  Define HTTP header propert ies 

!  Connect to the Forms Servlet (an HTTP-GET request) 

!  Set the parameters of the Forms Listener Servlet 

!  Connect to the Forms Listener Servlet (an HTTP-GET request) 

!  Set addit ional HTTP header property for the Listener Servlet 

!  Connect to the Forms Listener Servlet (an HTTP-POST request). The last connect ion statement also 
in i t iates the required Forms “ handshake”  and determines the Forms encrypt ion used by the 
appl icat ion environment .  

For example: 

ofsHTTPSetHdrProperty("User-Agent", "Java1.3.1.9" );  
ofsHTTPSetHdrProperty("Host", "ntsap45b:7779" );  
ofsHTTPSetHdrProperty("Accept", "text/html, image/gif, image/jpeg, *; q=.2, "*/*; q=.2" 
);  
ofsHTTPSetHdrProperty("Connection", "Keep-alive" );  
ofsHTTPConnectToFormsServlet( 
"http://ntsap45b:7779/forms90/f90servlet?ifcmd=startsession"  ); 
ofsHTTPSetListenerServletParms( "?ifcmd=getinfo&ifhost=C104444D01&ifip= "192.168.234.1" 
); 
ofsHTTPConnectToListenerServlet( "http://ntsap45b:7779/forms90/l90servlet"); 
ofsHTTPSetHdrProperty("Content-type", "application/x-www-form-urlencoded" );  
ofsHTTPInitialFormsConnect(); 

HTTPS connect ions 

HTTPS connect ion mode uses the same connect ion statements as HTTP mode.  

Socket connect ions 

Socket mode contains only one connect ion statement.  The funct ion that is used – ofsConnectToSocket  – 
contains the port  number and the URL you entered on the Oracle Forms Record Options dialog box to start  
OFS capture. The port  value is the port  on which the Forms Server direct ly l istens for Forms traffic. To 
connect, QALoad uses Java cal ls to open a Java socket using the parameters, in i t iate the required Forms 
"handshake” , and determine the Forms encrypt ion used by the appl icat ion environment. For example: 

ofsConnectToSocket("10.10.0.167", 9002 ); 

 

Appl i cat ion  Statem en ts 
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The appl icat ion statements in  the C++ script  consist of property statements and transmission statements. 
Property statements describe the attributes and act ivi t ies of GUI controls in  the appl icat ion. Transmission 
statements send the GUI controls and their propert ies as Forms Message data to the server. There is only 
one transmission statement: ofsSendRecv. QALoad creates an in ternal auto checkpoint when th is statement 
is executed. In  the fol lowing example, the first  two (property) statements set the locat ion and size of a 
FormWindow GUI control. The ofsSendRecv statement sends the GUI control  propert ies to the server. 

ofsSetWindowLocation( "FORMWINDOW", 6, OFS_ENDMSG, 135, 0, 0);   //Property  
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 650, 500);   //Property 
ofsSendRecv(1 ); //Transmission 

Parameters of a property statement: 

The parameters of a property statement are arranged in the fol lowing sequence: 

1. Captured con t rol  nam e.  If the name is not avai lable, th is value is the class name to which the 
control belongs. 

2. Captured con t rol  ID. 

3. Act ion  type. This flag indicates i f the property is to be added to the current Forms Message or i f the 
property ends the current Forms Message. During playback, each control is treated as a Forms 
Message. When the current Message ends, QALoad translates the control and i ts propert ies to 
binary format. The val id values are: 

 OFS_ADD –  add the property to the current Message. 

 OFS_ENDMSG – add the property to the current Message and end the Message. 

 OFS_STARTSUBMSG – add the property of the succeeding nested Message to the current 
Message. 

4. Property ID. The Forms version-specific ID of the property. 

5. Property value. Captured value of the property (opt ional) 

6. Property value. Captured value of the property (opt ional) 

For example: 

ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 650, 500); 

In  th is example, control ID 6, which belongs to GUI class FORMWINDOW, is resized (PROPERTY 
137) to have coordinates 650 and 500. This marks the end of the current Message. 

Forms environment statements: 

The in i t ial  set of statements in  the Forms script  describes the Forms appl icat ion environment. In  th is set, 
the "version”  and the “ cmdline”  propert ies are the most important. The version property shows the Forms 
Bui lder version used by the appl icat ion. The version  indicates the capabi l i t ies of the appl icat ion. For 
example, some versions cannot support HTTP connect ions. The cmdline property shows the Forms 
configurat ion parameters passed to the server by the Forms applet. The parameter “ record=names”  
indicates that the appl icat ion enables GUI control names to be captured. Control names are preferred in  
mult i-threaded playback. The “ ICX”   parameter indicates that the appl icat ion  uses a Personal Home Page. 

In the sample script  below, the Forms bui lder version is 90290 (the version used in Oracle 9iAS Release 2, 
unpatched). The cmdline property shows “ record=forms”  which defaults “ record=names” . The cmdline 
property does not have the “ ICX”  t icket parameter. 

ofsSetInitialVersion( "RUNFORM", 1, OFS_ADD, 268, "90290" ); 
ofsSetScreenResolution( "RUNFORM", 1, OFS_ADD, 263, 96, 96); 
ofsSetDisplaySize( "RUNFORM", 1, OFS_ADD, 264, 1024, 768); 
ofsInitSessionCmdLine("RUNFORM", 1, OFS_ADD, 265,  
 "server module=test1.fmx userid=  sso_userid=  debug=no buffer_records=no debug_" 
 "messages=no array=no query_only=no quiet=yes render=no host=ntsap45b.prodti.com" 
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 "puware.com port= record=forms tracegroup=debug log=run1 term=" ); 
ofsSetColorDepth( "RUNFORM", 1, OFS_ADD, 266, "256" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "0" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "8421504" ); 
ofsSetFontName( "RUNFORM", 1, OFS_ADD, 383, "Dialog" ); 
ofsSetFontSize( "RUNFORM", 1, OFS_ADD, 377, "900" ); 
ofsSetFontStyle( "RUNFORM", 1, OFS_ADD, 378, "0" ); 
ofsSetFontWeight( "RUNFORM", 1, OFS_ADD, 379, "0" ); 
ofsSetScaleInfo( "RUNFORM", 1, OFS_ADD, 267, 8, 20); 
ofsSetNoRequiredVAList( "RUNFORM", 1, OFS_ADD, 291 ); 
ofsSetPropertyString( "RUNFORM", 1, OFS_ENDMSG, 530, "America/New_York" ); 
ofsSendRecv(1 ); 
//ClientSeqNo=1|CapTime=1086884188.281|MsgCount=1 

Sending messages to the server: 

The ofsSendRecv statement sends the accumulated GUI controls and their propert ies to the Forms Server as 
binary data. This statement represents the point at which the cl ient sends a Forms Terminal Message to the 
server. In  Oracle Forms, the cl ient and the server must end each data block with a Terminal Message before 
any transmission occurs. 

In ternal ly, QALoad varies the binary data transmission depending on the connect ion mode: 

!  For server-side recording mode, QALoad sends the binary data by invoking Oracle’s dispatch cal ls. 
Oracle’s own classes provide the implementat ion for the HTTP transmission.  

!  For HTTP or HTTPS mode, QALoad wraps the binary data inside an HTTP stream and invokes Java’s 
HTTP cal ls.  

!  For socket mode, QALoad sends the binary data direct ly to the Java socket opened at the 
connect ion point . 

The ofsSendRecv statement has one parameter: the response code of the captured Terminal Message. The 
possible values for th is parameter are 1 (add), 2 (update), and 3 (close). Typical ly, when the response code 
is 3, the Forms Server reacts by removing the GUI controls associated with the cl ient message from the 
server cache. 

A comment l ine appears after each ofsSendRecv statement that contains script-tracking in formation. The 
information on the comment l ine is also found in the capture fi le in  each ofsSendRecv capture l ine. The 
comment l ine shows the relat ive sequence of each cl ient request, as represented by a Terminal Message, 
from the start  of the appl icat ion (e.g. Cl ientSeqNo=1). The comment l ine also shows the t im ing mark of 
the captured Terminal Message (e.g. CapTime=1086884188.281) and the number of Forms messages 
contained in the request (e.g. MsgCount=1). The number of Messages can be veri fied by count ing the 
preceding ENDMSG and STARTSUBMSG flags in  the request block. The comment l ine is useful for 
debugging playback issues because i t  readi ly shows the cl ient request sequence number where the issue is 
occurring. 

Getting the server reply: 

During the execut ion of ofsSendRecv, QALoad also obtains the server’s reply and translates the binary 
Forms data in to Forms control values and control propert ies. The values are also writ ten to the playback 
log fi le (in  capture fi le format) i f script  logging is enabled. The fol lowing sample is a server reply: 

VU 0 :   M|S|2|0|1 
VU 0 :   P|S|322|java.lang.Integer|0|151000320 
VU 0 :   P|S|279|java.lang.Boolean|0|false 
VU 0 :   P|S|525|java.lang.String|AMERICAN_AMERICA.WE8MSWIN1252 
VU 0 :   T|S|1|ServerSeqNo=1|MsgCount=76 

The first  l ine indicates the start  of a Forms Message from the server (M |S). The th ird parameter is an act ion 
code (1= add, 2= update, 3= delete, 4= get property value). The fourth parameter is the Class Code of the 
control (0 = root class). The fi fth  parameter is the Control ID (1= RunForm). 
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The second, th ird and fourth l ines are property l ines related to the above Forms Message from the server 
(P|S).  The th ird parameter of each l ine is the property ID (322). The fourth parameter is the data type of 
th is property (java.lang.In teger). The fi fth  parameter is the data value. If the value is 0, the data value is in  
a sixth parameter (false).  

The th ird l ine is the terminal message l ine from the server (T|S). The th ird parameter is the response code 
associated with the terminal message (1= add, 2= update,  = close). The fourth parameter is the relat ive 
sequence of the server reply, as represented by a Terminal Message, from the start  of the appl icat ion (e.g. 
ServerSeqNo= 1). The fi fth  parameter is the number of Forms messages contained in the reply (e.g. 
MsgCount = 1). The number of Messages may be veri fied by count ing the preceding M|S flags in  the reply 
block.  The fourth and fi fth  parameters are script-tracking in formation, which can be useful for debugging 
a playback issue. If logging is enabled, the log fi le shows the tracking in formation, which can make the 
comparison between server responses and captured responses easier. 

Processing large data and delayed response scenarios: 

When HTTP or HTTPS connect ion mode is used, Forms data is wrapped inside the HTTP reply stream. 
QALoad checks the HTTP header of the reply before processing the Forms data.  The HTTP header 
sometimes indicates that the cl ient needs to perform addit ional HTTP POST requests to obtain the 
complete Forms data. This indicat ion occurs when the content-length of the reply is 64000 (a large data 
scenario), or the content-type is "text/plain”  and the HTTP header contains an  “ i ferror: ”  string (a delayed 
response/re-post scenario). QALoad performs the necessary POST requests to obtain the complete reply 
data, and then translates the accumulated reply data to Forms controls and propert ies. 

Disconnect  statem en ts 

The disconnect script  l ines vary depending on the Forms connect ion mode.   

!  In  server-side recording mode, the ofsServerSideDisconnect script  statement in ternal ly invokes 
Oracle’s dispatch cal ls to disconnect.  

!  In  HTTP mode, the ofsHTTPDisconnect statement in ternal ly makes Java cal ls to disconnect the 
main URL connect ion from the servlet.  

!  In  socket mode, the ofsSocketDisconnect statement  closes the socket on which the Forms Server 
l istens for traffic. 

Using Script  Logging as a Debugging tool  

You can debug a playback issue in a C++ script  by enabl ing replay logging. The opt ion for enabl ing replay 
logging is located on the Script Assignment tab of the Conductor. For more in formation about enabl ing log 
fi le generat ion, see Debugging a script .  

When logging is enabled, QALoad writes the cl ient requests and server repl ies to the playback log fi le in  the 
same format as the capture fi le. The playback log fi le is found in the \QALoad\LogFiles directory. When 
there is an issue during playback, such as the server not responding to a cl ient  request, you can compare 
the capture fi les and check the differences in  the server reply data. Both the capture fi le and the log fi le 
contain tracking in format ion appended to the server’s terminal messages. The tracking data contains the 
relat ive sequence number of the server reply from the start  of the Forms session and the t im ing mark. The 
tracking data also shows the number of Forms messages contained in the reply block. The number of 
messages are based on the number of  “ M |S”  l ines prior to the “ T|S”  l ines.  

In  the fol lowing example, the first  set of statements shows the logged statements and the second set of 
statements shows the captured statements. The ServerSeqNo value shows that th is is the 8th reply from the 
server. The MsgCount value of 1 shows that only one Forms Message is included in th is reply block. 

1087419810.000|ofsShowWindow|WINDOW_START_APP|11|OFS_ENDMSG|173|PROPERTY_VISIBLE|java.lang.B
oolean|true 
1087419810.000|ofsSendRecv|1|ClientSeqNo=8|CapTime=1087419810.000|MsgCount=1 
1087419810.000|M|S|2|0|30 
1087419810.000|P|S|135|java.awt.Point|0|java.awt.Point[x=0,y=0] 



QALoad 05.06 Using the Player, Script  Development Workbench, and Analyze 

120 

1087419810.000|P|S|137|java.awt.Point|0|java.awt.Point[x=706,y=464] 
1087419810.000|P|S|139|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087419810.000T|S|1|ServerSeqNo=8|CapTime=1087419810.000|MsgCount=1 

   

1087402349.296|ofsShowWindow|WINDOW_START_APP|11|OFS_ENDMSG|173|PROPERTY_VISIBLE|java.lang.B
oolean|true 
1087402349.296|ofsSendRecv|1|ClientSeqNo=8|CapTime=1087402349.296|MsgCount=1 
1087402349.296|M|S|2|0|30 
1087402349.296|P|S|135|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087402349.296|P|S|137|java.awt.Point|0|java.awt.Point[x=706,y=464] 
1087402349.296|P|S|139|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087402349.296|T|S|1|ServerSeqNo=8|CapTime=1087402349.296|MsgCount=1 
 

M oving the OFS Transact ion  Loop 

To enable movement of the QALoad transact ion loop in the C++ script , you must fi rst  record a ful l  business 
transact ion and a part ial  business transact ion. The business transact ion is the act ivi ty that you would l ike 
to repeat during QALoad playback.  Insert  QALoad capture comments (using the Insert  Com m and button 
on the Recording toolbar) at the start  and end of a business transact ion. These comments wi l l  help you 
find the spots in  the script  where you would l ike to reposit ion the BEGIN_TRANSACTION() and 
END_TRANSACTION() statements. Then re-start  the business transact ion.  

QALoad's OFS script  presents a sequence of Forms GUI objects. The GUI objects contain context 
dependencies. For example, when a window is opened, the buttons, text fields and edit  boxes inside that 
window are logical ly dependent on the state of that window. When only one business transact ion is 
captured and the corresponding script ’s transact ion loop is moved, the sequence of the GUI objects is 
broken during the second i terat ion of the transact ion loop. The broken sequence results in  a broken 
context, which causes the server to respond unpredictably during playback on the second and subsequent 
i terat ions of the transact ion loop. When the business transact ion is restarted during capture, the Forms 
GUI objects that compose the new transact ion are used to anchor in to the new transact ion loop without 
breaking the context dependencies of  GUI objects. 

When modifying the script , use the comment l ines as guides in  moving the END_TRANSACTION()  and 
BEGIN_TRANSACTION() statements. Ensure that there is a contextual flow from the new posit ion of the 
END_TRANSACTION() statement to the new posit ion of the BEGIN_TRANSACTION() statement. The set  of 
GUI objects that belong to the ofsSendRecv() statement just before the new END_TRANSACTION() 
statement must be the same as the set of GUI objects that belong to the ofsSendRecv() statement prior to 
the new BEGIN_TRANSACTION() statement. 

During playback, modify the Conductor sett ing for Transact ion Pacing on the Script Assignment tab to 
al low the database to process each new business transact ion. 

The fol lowing example shows a modified OFS transact ion loop: 

New position of the BEGIN_TRANSACTION statement 

/* 
NewSales 
*/ 

DO_SLEEP(13); 
ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "B" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 1, 1); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "1" ); 
ofsIndexKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 175, 97, 0); 

DO_SLEEP(6); 
ofsSendRecv(1); //ClientSeqNo=31|MsgCount=2|1093981339.921 
BEGIN_TRANSACTION(); 
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ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "Business World" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 14, 14); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsRemoveFocus( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 174 ); 
ofsSetSelection( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ADD, 195, 0, 0); 
ofsSetCursorPosition( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ENDMSG, 193, "0" ); 
ofsFocus( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ENDMSG, 174 ); 

DO_SLEEP(6); 
ofsSendRecv(1); //ClientSeqNo=32|MsgCount=4|1093981347.296 

New position of the END_TRANSACTION statement 

/* 
EndTrans 
*/ 

DO_SLEEP(39); 
ofsSendRecv(1); //ClientSeqNo=61|MsgCount=4|1093981458.031 

ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsSelectMenuItem( "Sales Orders", 257, OFS_ENDMSG, 477, "MENU_11059" ); 

DO_SLEEP(26); 
ofsSendRecv(1); //ClientSeqNo=62|MsgCount=2|1093981485.265 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "B" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 1, 1); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "1" ); 
ofsIndexKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 175, 97, 0); 

DO_SLEEP(3); 
ofsSendRecv(1); //ClientSeqNo=63|MsgCount=2|1093981488.437 
END_TRANSACTION(); 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "Business World" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 14, 14); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsIndexSKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 176, 10, 0); 

DO_SLEEP(13); 
ofsSendRecv(1); //ClientSeqNo=64|MsgCount=2|1093981502.640 

Tips:  
During capture, the OFS configuration parameter "record=names" must be enabled to produce control names 
that may be included in the converted script. Control names persist throughout the Forms session, unlike 
control IDs, whose values may change at runtime. Add the “ record=names”  parameter in the Formsweb.cfg 
file or add this parameter to the startup servlet URL.  
Control IDs can create problems when the transaction loop is moved. Some of the control IDs that have been 
instantiated by the server prior to the new transaction loop lose context during iterations of the new loop. For 
example, in a second loop iteration, the server assumes that these client controls are new, generates new 
control IDs, and eventually cannot find the proper context. Then the server stops responding. If control names 
are used, Forms objects that have been instantiated before the new transaction loop are maintained through 
all iterations of the loop because the control name persists throughout the application session. 
During playback, ensure that the sleep factor is at 100% and that the transaction pacing is set to a large 
enough value for the server to process the business transaction that is contained in the new loop. These 
options can be set on the Script Assignment tab of the Conductor. 

 

SAP 

Requi red Com m ands 
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Certain commands must be present in  an SAP script  for i t  to run successful ly. These commands are created 
automatical ly during the conversion process. Most of the commands exist  before the 
BEGIN_TRANSACTION statement. The required commands include: 

SET_ABORT_FUNCTION(abort function); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info, "ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard(‘*’); 
SYNCHRONIZE(); 

Required commands for transact ion restart ing 

When transact ion restart ing is enabled in  the Conductor for an SAP script , the fol lowing commands, 
which are automatical ly added by QALoad during script  conversion, must exist  for the script  to run: 

SAPGuiApplication(RegisterROT); 
SAPGuiApplication(RevokeROT); 
SAPGui_error_handler(s_info, buffer); 

The SAPGuiApplicat ion command properly registers and removes the script 's SAP GUI usage on the 
Runtime Object Table (ROT). If a transact ion fai ls, these act ions are taken to start  and clean up the SAP 
environment. 

Note: Do not call RR__FailedMsg in an SAP script if the script includes a restart transaction operation. 
SAPGui_error_handler can be called with the same parameters as RR__FailedMsg to output a fatal error 
message while still allowing a proper clean up of the current transaction before restarting the transaction.  
 

Error Handl ing and Report i ng 

A try/catch block is automatical ly generated for the commands between the BEGIN_TRANSACTION and 
END_TRANSACTION statements. This construct provides error handl ing and report ing from the script . 

BEGIN_TRANSACTION(); 

try{ 

   SAPGuiConnect( s_info,"qacsapdb2"); 
   SAPGuiVerCheckStr("6204.119.32"); 

   //Set SapApplication = CreateObject("Sapgui.ScripingCtrl.1")    
   //SapApplication.OpenConnection ("qacsapdb") 
   //Set Session = SapApplication.Children(0).Children(0) 

   DO_SLEEP(3); 

   SAPGuiPropIdStr("wnd[0]"); 
   SAPGuiCmd3(GuiMainWindow, ResizeWorkingPane, 83, 24, false); 

   DO_SLEEP(6); 

   SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME"); 
   SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 

   SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE"); 
   SAPGuiCmd1Pwd(GuiPasswordField, PutText,"~encr~1211616261"); 

   SAPGuiCmd0(GuiPasswordField,SetFocus); 
   SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 

   SAPGuiPropIdStr("wnd[0]"); 
   SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
   SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 



Script Development Workbench 

123 

   ... 

   DO_SLEEP(10); 

   SAPGuiPropIdStr("wnd[0]/usr/cntlIMAGE_CONTAINER/shellcont/shell/shellcont[0]/shell"); 
   SAPGuiCmd1(GuiCtrlTree, ExpandNode, "0000000003"); 
   SAPGuiCmd1(GuiCtrlTree, PutSelectedNode, "0000000004"); 
   SAPGuiCmd1(GuiCtrlTree, PutTopNode, "Favo"); 
   SAPGuiCmd1(GuiCtrlTree, DoubleClickNode, "0000000004"); 
   SAPGuiCheckScreen("SESSION_MANAGER", "SAPLSMTR_NAVIGATION", "SAP Easy Access"); 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

} // end try 

catch (_com_error e){ 
   char buffer[1024]; 
   sprintf (buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(),  
            (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

To include the log on with in the transact ion loop, move the SAPGuiConnect  cal l  inside the try block as 
shown in the fol lowing example: 

SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("capture.cpp"); 
RESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

try{ 

   SAPGuiConnect( s_info,"qacsapdb2"); 
   SAPGuiVerCheckStr("6204.119.32"); 
   ... 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

} // end try 

catch (_com_error e){ 

   char buffer[1024]; 
   sprintf(buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(),  
           (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

To include the log on outside the transact ion loop, move the log off sect ion so that i t  fol lows the 
END_TRANSACTION statement. However, ensure that the recording with in the transact ion loop begins 
and ends in the same locat ion in  the menu system. For example: 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoInitialize(0); 
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if( hr != ERROR_SUCCESS ) 
   RR__FailedMsg(s_info,"ERROR initializing COM"); 
SAPGuiSetCheckScreenWildcard('*'); 

SYNCHRONIZE(); 

SAPGuiConnect( s_info,"qacsapdb2"); 

SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME"); 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 

SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE"); 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~1211616261"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 

SAPGuiPropIdStr("wnd[0]"); 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 

BEGIN_TRANSACTION(); 

try{ 
   SAPGuiVerCheckStr("6204.119.32"); 
   ... 
} // end try 

catch (_com_error e){ 
   char buffer[1024]; 
   sprintf(buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(), 
           (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

 

Handl ing M ul t i ple Logons 

You may need to modify your script  to handle mult iple logons when the recording scenario differs from 
the run-t ime scenario. For example, i f when you record, no users are logged on to the SAP environment 
and when you run the script , users are already logged on, the script  may fai l . To work around th is issue, 
you can use the SAPGuiPropIdStrExists and SAPGuiPropIdStrExistsEnd commands to handle either 
scenario. This technique works by checking for the mult iple logon dialog box from SAP and select ing the 
Con t inue opt ion. 

The fol lowing example demonstrates the usage of the SAPGuiPropIdStrExists and 
SAPGuiPropIdStrExistsEnd commands to handle mult iple logons: 

... 

SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 
SAPGuiPropIdStrExists("wnd[1]/usr/radMULTI_LOGON_OPT2"); 

   DO_SLEEP(24); 

   SAPGuiCmd0(GuiRadioButton,Select); 
   SAPGuiCmd0(GuiRadioButton,SetFocus); 
   SAPGuiPropIdStr("wnd[1]/tbar[0]/btn[0]"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("S000","SAPMSYST","License Information for Multiple Logon"); 

SAPGuiPropIdStrExistsEnd("wnd[1]/usr/ radMULTI_LOGON_OPT2"); 

... 
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Check ing the SAP Status Bar 

The SAP status bar displays error and status messages, as shown in the fol lowing figure. 

 

You can use the SAPGuiCheckStatusbar command to test for certain status responses in the SAP 
environment. 

The SAPGuiCheckStatusbar command is used in the fol lowing script  example: 

... 
SAPGuiPropIdStr("wnd[0]"); 
SAPGuiCmd1(GuiMainWindow, SendVKey, 0); 
SAPGuiCheckScreen("S000", "SAPMSYST", "SAP"); 
SAPGuiCmd3(GuiMainWindow, ResizeWorkingPane, 94, 24, false); 

//SAPGuiCheckStatusbar returns TRUE if the message is found 
//and FALSE if not found 

BOOL bRetSts = SAPGuiCheckStatusbar("wnd[0]/sbar", "E: Make an entry in all required 
fields"); 

if (bRetSts) 
    RR__printf(" True\n"); 

else 
    RR__printf(" False\n"); 

... 

Object  Li fe Span  

Whenever a script  is run, al l  objects on the SAP GUI window are deleted and re-created. These objects, 
which are created in  the SAP environment and can disappear without user in teract ion, can cause script  
fai lure i f the script  references the objects after they have disappeared. 

For more troubleshoot ing in formation, refer to SAP’s publ icat ion t i t led “ SAP GUI Scripting API for the 
Windows and Java Platforms” . 
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Winsock 

Understanding Data represen tat ion  in  the Script  

This sect ion describes how data that is sent and received is displayed in a Winsock script . Use th is sect ion 
as a reference when you examine a script . 

During the conversion process, QALoad determines how to represent each character in  the script . This 
conversion process uses the fol lowing rules: 

1. The character is compared to the “ space”  character in  the ASCII table, which has a 
decimal value of 32. If the character’s value is less than 32, the fol lowing steps are taken: 

a. If the character is “ \ r” , “ \ n” , “ \ t” , or “ \ f” , i t  is represented in the script  as a normal C escape 
character. 

b. If the character is either “ ^ \ ”  or “ ^^” , i t  is represented in the script  as an octal  character. For 
example, the values would be “ \ 034”  and “ \ 036” , respect ively. 

c. If the character’s value is less than 32 and i t  does not meet the descript ions in  a) and b) above, 
i t  is represented in the script  as a control character. For example, i f the character is a nul l  
character, i t  is represented in the script  as “ ^@” . 

2. If the character’s decimal value is between 32 (the “ space”  character) and 126 (~), i t  displays in  the 
script  as a standard readable ASCII character, with the fol lowing except ions: 

 If the character is “ \ ” , which has a decimal value of 92, i t  is represented as “ \ \ ”  in  the 
script . 

 If the character is “ “ “ , which has a decimal value of 34, i t  is represented as “ \ ” ”  in  the 
script . 

 If the character is “ ^” , which has a decimal value of 94, i t  is represented as “ ^^”  in  the 
script . 

3. If the character has a decimal value of 127, which corresponds to Delete (DEL), i t  is represented as 
“ ^”  in  the script . 

The fol lowing table summarizes the results of rules 1-3. 

Code Octal  Decim al  Char 

^@ 000 0 NUL 

^A 001 1 SOH 

^B 002 2 STX 

^C 003 3 ETX 

^D 004 4 EOT 

^E 005 5 ENQ 

^F 006 6 ACK 

^G 007 7 BEL 

^H 010 8 BS 

\t 011 9 HT 
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\n 012 10 LF 

^K 013 11 VT 

\f 014 12 FF 

\r 015 13 CR 

^N 016 14 SO 

^O 017 15 SI 

^P 020 16 SLE 

^Q 021 17 SC1 

^R 022 18 DC2 

^S 023 19 DC3 

^T 024 20 DC4 

^U 025 21 NAK 

^V 026 22 SYN 

^W 027 23 ETB 

^X 030 24 CAN 

^Y 031 25 EM 

^Z 032 26 SIB 

^[ 033 27 ESC 

\034 034 28 FS 

^] 035 29 GS 

^_ 037 31 US 

 040 32 SP 

\" 042 34 " 

\\ 134 92 \  

^^ 136 94 ^  

^? 177 127 DEL 

4. If the character is not included in the groups defined in steps 1-3, i t  is represented as an octal 
character in  the script . These characters are often referred to as h igh ASCII characters (those with a 
decimal value greater than 128), and are represented in the script  as “ \ OOO” , where OOO is the 
octal value for the ASCII character. 
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Handl ing Winsock  appl i cat ion  data f l ow  

Frequently, server programs return unique values (for example, a session ID) that vary with each execut ion 
of the script  and may be vital  to the success of subsequent transact ions. To create scripts that include these 
values, you need to subst i tute the hard-coded values returned by the server with variables. The fol lowing 
original and modified code examples demonstrate th is technique. 

Original code 

In th is script , the server sends a session ID in response to a connect ion by the cl ient. This session ID is 
required to successful ly complete subsequent transact ions. 

/* 
* wsk-AdvancedTechniques_original.c 
* 
* This script contains support for the following 
* middlewares: 
* - Winsock 
*/ 
 
/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 
{ 

/* Declare Variables */ 

SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

///////////////////////////////////////////////////// 
// The session id returned by the server is 
// unique to each connection 
///////////////////////////////////////////////////// 

/* 21bytes: SessionID=jrt90847\r\n */ 
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DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// This unique id is then used for subsequent 
// requests 
////////////////////////////////////////////////////// 

/* 34 bytes */ 

DO_WSK_Send(S1, "SessionID=jrt90847\r\n:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 

EXIT(); 

return(0); 
} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User %i:ABORTED.", S_task_id); 

EXIT(); 
} 

Modified code 

If the original script  (wsk-AdvancedTechniques_original.c shown above) is replayed, i t  wi l l  fai l  because the 
session ID wil l  not be unique; rather, i t  wi l l  be the session ID that is coded in the script . To use the unique 
session ID received from the server, variable subst i tut ion must be used. 

/* 
* wsk-AdvancedTechniques_modified.c 
* 
* This script contains support for the following 
* middlewares: 
* - Winsock 
*/ 

/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 

{ 

/* Declare Variables */ 
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char Buffer[64]; 
char SendBuffer[64]; 
int nBytesReceived = 0; 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

////////////////////////////////////////////////////// 
// The reply from the server is read into 
// the Buffer variable. We will then have 
// the unique Session ID for this connection. 
// Also need to null-terminate the buffer 
// after receiving. 
////////////////////////////////////////////////////// 

DO_WSK_Recv(S1, Buffer, 64, 0, &nBytesReceived); 
Buffer[nBytesRecieved] = '\0'; 

/* 21bytes: SessionID=jrt90847\r\n */ 

//DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// Finally, substitute the Session ID received from 
// the server with the one coded in the script. 
////////////////////////////////////////////////////// 

sprintf(SendBuffer, "%s:^B^@^@^@^B^@^@^@^A^@^@^@", Buffer); 
DO_WSK_Send(S1, SendBuffer); 

/* 34 bytes */ 

//DO_WSK_Send(S1, "SessionID=jrt90847:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 

EXIT(); 

return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 

{ 
RR__printf("Virtual User %i:ABORTED.", S_task_id); 
EXIT(); 
} 

Saving Server Repl ies 
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There are two methods for saving the ent ire reply that a server sends back. The fol lowing paragraphs 
describe each method. 

Using the Response() and ResponseLength() commands 

The Response() command can be cal led direct ly after the DO_WSK_Expect() command. It  returns a pointer 
to the data that has been received by DO_WSK_Expect(). To also receive the length of the replay, cal l  the 
ResponseLength() command, which returns the number of characters that were received. The fol lowing 
example uses the Response() and ResponseLength() commands. 

Example  

In  th is example, variables are declared to store the results from the two funct ions. Both funct ions are also 
used to save the buffer that is received with in the DO_WSK_Expect() command. 

/* Declare Variables */ 
int x = 0; 
char *temp; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 21 bytes: You are now connected */ 

DO_WSK_Expect(S1, "d"); 

// Used to store the data that was received by the 
// DO_WSK_Expect 

temp = Response(); 

// Used to get the size of the response that was received 
// so far 

x = ResponseLength(); 

/* The line below will print the length of the response and the actual response */ 

RR__printf(“length = %d, and response= %s",x, temp); 
DO_WSK_Closesocket(S1); 

The message “ length=21 response=You are now connected”  displays in  the Player buffer window. 

 

Using the DO_WSK_Recv() command 

To save a response based on i ts size instead of a unique character string that is used with in the 
DO_WSK_Expect() command, use the DO_WSK_Recv() command. This command enables you to specify 
how much data to receive and where to store the data. 

You can also use the DO_WSK_Recv() command to store the reply that is returned from the server. This 
strategy is useful when you need to retrieve the buffer that is returned from the server, even though the 
returned data is too dynamic and causes the DO_WSK_Expect() command to fai l  every t ime. 

Example  

In  th is example, the DO_WSK_Recv() command is used to save a server reply based on size. Two variables 
are declared to store the results from the DO_WSK_Recv() command. 
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/* Declare Variables */ 
int size = 0; 
char temp[45]; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 21 bytes: You are now connected */ 

memset(temp,'\0',45); 
DO_WSK_Recv(S1,temp,45,0,&size); 
RR__printf("size=%d string=%s",size,temp); 
DO_WSK_Closesocket(S1); 

The message “ size=21 string=You are now connected”  displays in  the Player buffer window. 

Note: If you use this method as a substitute for the DO_WSK_Expect() command, ensure that you receive 
the correct information prior to calling the next function in the script. 

Parsing server repl i es for  values 

To parse a buffer for a part icular value, you can write a parsing rout ine that searches the ent ire buffer for 
the value. However, you can also use one of QALoad ’s Winsock helper commands. The fol lowing scenarios 
describe two situat ions in  which you could use the Winsock commands to solve a parsing problem. 

Scenario 1: 

To find a string in  a server reply, you can use the SkipExpr() and ScanExpr() commands. SkipExpr() 
searches for the first  occurrence of a string in  the in ternal buffer that contains the response that was 
received with in the DO_WSK_Expect() command. Then, use the ScanExpr() command to search for 
another string. ScanExpr() saves the buffer from the first  occurrence of the string that was used with 
SkipExpr() up to and including the string used with in ScanExpr(). The first  parameter of ScanExpr() is a 
UNIX-style regular expression. The fol lowing table l ists the most common expressions: 

Character M ean ing 

. Matches the end of a string. 

* Matches any number of characters. 

? Matches any one character. 

Example In th is example, the buffer contains “ sessionid=1234567890abc” , and the goal is to retrieve 
everyth ing after the “ =” , up to and including “ abc” . 

/* Declare Variables */ 
char temp[35]; 
int size = 0; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 



Script Development Workbench 

133 

/* 23 bytes: sessionid=1234567890abc */ 

DO_WSK_Expect(S1, "c"); 
SkipExpr("sessionid="); 
size=ScanExpr(".*abc" , temp); 
RR__printf("length = %d string = %s", size, temp); 
DO_WSK_Closesocket(S1); 

The message “ length=13 string=1234567890abc”  displays in  the Player buffer window. 

Scenario 2: 

You may have data returned from the server that is too dynamic, that is, you are not able to base parsing 
on actual characters. The solut ion is to base the parsing on character posit ions instead. 

For example, to save the characters 20 through 25, you could use the ScanSkip() and ScanString() 
commands. ScanSkip() skips a specified number of characters in  the in ternal buffer that stores the response 
that was received with in the DO_WSK_Expect() command. ScanString() scans a number of characters from 
the current posit ion with in the buffer in to a character string. 

Example  

In  th is example, a buffer contain ing “ xxx123456789yyy”  is returned from the server. The value between 
“ xxx”  and “ yyy”  is returned. 

/* Declare Variables */ 

char temp[15]; 

... 

BEGIN_TRANSACTION(); 

... 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

/* 16 bytes: xxx0123456789yyy */ 

memset(temp,'\0',15); 
DO_WSK_Expect(S1, "yyy"); 
ScanSkip(3); 
ScanString(10,temp); 
RR__printf("string=%s",temp); 
DO_WSK_Closesocket(S1); 

The message “ string=0123456789”  displays in  the Player buffer window. 

WWW 

Sim ulat ing Variable IP Addresses 

While QALoad can simulate mult iple virtual users from a single system, i t  general ly does so using a single 
source IP address. In  most  test ing situat ions th is isn ’t  a problem, but with a small  set of HTTP-based 
appl icat ions, i t  may not be the best way to simulate real-l i fe act ivi ty. For QALoad Player machines with  
more than one stat ic IP address, QALoad can direct each virtual user to use a di fferent source IP address.  

To accomplish th is, a local datapool fi le contain ing a l ist  of local stat ic IP addresses must be created on 
each QALoad Player mach ine. When you enable IP spoofing in  the QALoad Conductor, the QALoad 
Conductor instructs each QALoad Player to create the appropriate datapool fi le at run t ime. The QALoad 
Player uses these addresses for connect ions to HTTP and SSL servers. Each virtual user receives one address 
for use with al l  i ts connect ions. If there are more virtual users than addresses, IP addresses are re-used 
start ing from the beginning of the datapool fi le. 
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Modifying a Script  to Use Variable IP Addresses 

QALoad uses the DO_IPSpoofEnable command to insert  IP addresses from the datapool in to the script . 
When th is command is executed, the script  opens the datapool fi le located on the QALoad Player, reads 
the first  avai lable data record, and stores that record for use on al l  subsequent DO_Http and DO_Https 
cal ls. If there are more virtual users than IP addresses in  the datapool fi le, IP addresses are reused. You can 
automatical ly generate the DO_IPSpoofEnable command in your script  during conversion by select ing the 
IP Spoofing opt ion from the QALoad Script Development Workbench’s WW W Advanced dialog box. 
Access th is dialog box from the Convert  Options wizard’s WWW tab by cl icking the Advanced button. 
This opt ion inserts the DO_IPSpoofEnable command direct ly in  the script  during conversion, before the 
first  DO_Http or DO_Https command.  

Creat ing a Datapool of IP Addresses 

Use the fol lowing procedure to create a datapool of val id IP addresses from the QALoad Conductor. This 
fi le is automatical ly created on the QALoad Player workstat ions (Windows and UNIX) at run t ime. 

To creat e a dat apool  of  IP addresses: 

1. Start  QALoad Conductor. 

2. Click the M ach ine Assignm en t  tab. 

3. Select a script  in  the Script  field. 

4. Click Manager Players. The Manage Player Machines and Groups dialog box appears. 

5. Double-cl ick the Player machine name in the l ist . The Propert i es dialog box appears. 

6. Select the Generate IP Spoof  Data (m ach ines w i th  m ul t i ple IP addresses on ly) opt ion in  the 
Player Machine sett ings field. 

7. Click OK.  

At run t ime, the QALoad Conductor sends a command to each QALoad Player Agent to create the datapool 
fi le of IP addresses, and the script  is sent to the server using the different IP addresses. 

The Generate IP Spoof  Data check box is val id only for WWW scripts. 

Note: The machine on which the QALoad Conductor resides must have static IP addresses assigned to it. If 
no static IP addresses are found, the QALoad Conductor displays a warning and the datapool file is not 
generated. The datapool file is named ipspoof.dat, and is saved in the \Compuware\QALoad\Datapools 
directory. 
 

Handl ing Error M essages f rom  the Web Server 

When a server returns an error message, i t  returns i t  in  one of two ways. It  ei ther returns an error message 
with a response code (for example, 404 Not Found) or returns an HTML page that contains an error 
message. The fol lowing sect ions provide examples of code that you can use in  your script  to handle errors 
that the Web server returns to the browser. 

Handling error messages with response codes 

The example below demonstrates how to write code to handle error messages that include response codes 
that the Web server returns to the browser. The code performs the fol lowing act ions: 

!  Checks for an error code using the DO_GetLastHttpError command 

!  Aborts or cont inues script  execut ion, based on the WWW_FATAL_ERROR statement  

Example 
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int error; 
char errorString[30]; 
 
DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 

if((error = DO_GetLastHttpError()) > 399) 

{ 
sprintf(errorString, "Error in response: %d\n", error); 
WWW_FATAL_ERROR("Request-host", errorString); 
} 

Handling error messages returned in an HTML page 

The examples below demonstrate how to write code to handle error messages that the Web server returns 
to the browser in  an HTM L page. 

Using DO_VerifyDocTitle to verify page requests 

By insert ing the DO_VerifyDocTit le command into your script , you can compare the HTML document 
t i t les in  your load test script  with the document t i t les you original ly captured. The code performs the 
fol lowing act ions: 

!  Calls DO_Http to request an HTML page from the Web server 

!  Calls DO_VerifyDocTit le with the original HTML document t i t le. If the t i t les do not match, 
DO_VerifyDocTit le exits the script  

Exam ple 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to The Main Page", TITLE); 

Searching response text for error messages 

In some scripts, error messages are displayed as text  in  an HTML page. The fol lowing example 
demonstrates how to detect these messages in a script . The code performs the fol lowing act ions: 

!  Searches for errors returned as HTML from the Web server 

!  Branches to error handl ing code 

Exam ple 

int response; 
response = DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
if (strstr (response, "200 OK") == NULL) 
   WWW_FATAL_ERROR("host", "Response did not have 200 OK"); 

Sim ulat ing JavaScript  

JavaScript is handled by the fol lowing process: 

1. The browser makes a page request to a server for a page that contains JavaScript. 

2. Because JavaScript is simply uncompiled code, the browser downloads and immediately executes 
th is code upon receipt of the page. 

Supported Objects 

QALoad supports the bui l t -in  JavaScript objects (global, object, funct ion, array, string, boolean, number, 
math, date, regexp, and error), document objects, and image objects. 

Supported Propert ies 

The only document propert ies that QALoad supports are cookies, t i t le, and the images array. The only 
image property that QALoad supports is src. 
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Evaluation Errors 

If an object, property, or funct ion used with in a block of JavaScript code is not defined, i t  causes a 
JavaScript except ion. The except ion stops evaluat ion of that block. 

Example Web Page 

The fol lowing Web page contains the JavaScript funct ion and an onLoad tag that cal ls the scrol l i t  funct ion. 
The onLoad tag tel ls the browser to execute the JavaScript immediately after loading the page. The scrol l i t  
funct ion displays a scrol l ing banner region on the Web page. 

<HTML> 
<HEAD> 
<TITLE>Java Script Example</TITLE></HEAD> 
 
<SCRIPT LANGUAGE="JavaScript" src="js_do_nothing.js"> 

function scrollit_r2l(seed) 
{ 

var m1 = " Welcome to Compuware's QALoad homepage."; 
var m2 = " Glad to see you."; 
var m3 = " Thanks for coming. "; 
var msg = m1 + m2 + m3; 
var out = " "; 
var c = 1; 

if (seed > 100) { 
seed--; 
var cmd="scrollit_r2l(" + seed + ")"; 
timerTwo=window.setTimeout(cmd,100); 
} 

else if (seed <= 100 && seed > 0) { 
for (c=0 ; c < seed ; c++) { 
out+=" "; 
} 
out+=msg; 
seed--; 
var cmd="scrollit_r2l(" + seed + ")"; 
window.status=out; 
timerTwo=window.setTimeout(cmd,100); 
} 

else if (seed <= 0) { 
if (-seed < msg.length) { 
out+=msg.substring(-seed,msg.length); 
seed--; 
var cmd="scrollit_r2l(" + seed + ")"; 
window.status=out; 
timerTwo=window.setTimeout(cmd,100); 
} 

else { 
window.status=" "; 
timerTwo = window.setTimeout("scrollit_r2l(100)", 75); 
} 
} 
} 

</script> 

<BODY onLoad="timerONE=window.setTimeout('scrollit_r2l(100)',500);"> 
<!-- End scrolltext --> 
 
<center><h2>Java Script Example</h2><hr>Check out the browser's scrolling status 
 bar.<br><br> 
</center> 



Script Development Workbench 

137 

</BODY></HTML> 

Example script 

The fol lowing script  features a DO_Http cal l  to retrieve the JavaScript page.  

How  I t  Works: QALoad evaluates the JavaScript in  the context of script  blocks, onLoad tags, and src and 
then executes them. 

DO_InitHttp(s_info); 

... 

... 

BEGIN_TRANSACTION(); 
DO_AutomaticSubRequests(TRUE); 

... 

... 

DO_Http("GET http://www.host.com/js.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Java Script Example", TITLE); 

... 

... 

END_TRANSACTION(); 

 

Sim ulat ing Cook ies 

This sect ion describes how QALoad handles cookies. Cookies are handled by the fol lowing process: 

1. The browser makes a CGI request to a server for a dynamic page. 

2. When the server sends the page back to the browser, the page includes a cookie in  the header. The 
browser saves the cookie along with in formation that t ies i t  to the Web server. 

3. On al l  subsequent requests to that Web server, the browser passes the cookie along with the 
request . 

Example Web page 

The fol lowing CGI Perl  script  generates a Set-Cookie header as a part  of subsequent HTTP requests. 

Set-Cookie: SaneID=172.22.24.180-4728804960004 
Set-Cookie: SITESERVER=ID=f0544199a6c5970a7d087775f83b23af 

<html> 

... 

The cookies for this site are:<br><br> 

<B>SaneID=172.22.24.180-4728804960004; SITESERVER=ID=f0544199a6c5970a7d087775f83b23af 
</B><P> 

<b>Next cookie for this URL will be : 1</b><br> 
<br>RELOAD PAGE TO INCREMENT COUNTER<br><br><A HREF=http://www.host.com/index.htm>Return to 
previous homepage.</A> 

Example script  when Dynamic Cookie Handling is turned on 

This is the default  method by which QALoad handles cookies. The example script  features the fol lowing 
elements: 

!  Two CGI requests that return dynamic pages 

!  Cookies are handled by the replay engine 
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BEGIN_TRANSACTION(); 
DO_DynamicCookieHandling(TRUE); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl" 
        "HTTP/1.0\r\n\r\n"); 

/* Request: 2 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl" 
        "HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

Example script  when Dynamic Cookie Handling is turned off 

The example script  features the fol lowing elements: 

!  A CGI request that returns a dynamic page 

!  Two DO_GetCookieFromReply cal ls to retrieve the cookie from reply 

!  Two DO_SetValue cal ls to set the cookie 

!  A free cookie 

How  I t  Works: For cookies that are set with CGI scripts, the script  stores incoming cookies in  a variable 
and passes them back to the Web browser in  the reply from the CGI script . The script  handles these 
cookies by execut ing a DO_GetCookieFromReply command after the CGI request. 
DO_GetCookieFromReply stores the cookie values in  variables, which the script  then passes back to 
subsequent CGI requests using the DO_SetValue command. 

int i; 
char *Cookie[4]; 

... 

... 

for(i=0;i<4;i++) 
Cookie[i]=NULL; 
DO_InitHttp(s_info); 

... 

... 

BEGIN_TRANSACTION(); 
DO_DynamicCookieHandling(FALSE); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl  
        "HTTP/1.0\r\n\r\n"); 

/*Set-Cookie: NUM=1 */ 
DO_GetCookieFromReplyEx("NUM", &Cookie[0], '*'); 

/*Set-Cookie: SQUARE=1 */ 
DO_GetCookieFromReplyEx("SQUARE", &Cookie[1], '*'); 

/* Request: 2 */ 
DO_SetValue("cookie000", Cookie[0]); /* NUM=1 */ 
DO_SetValue("cookie001", Cookie[1]); /* SQUARE=1 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl " 
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        "HTTP/1.0\r\n" 
        "Cookie: {*cookie000}; {*cookie001}\r\n\r\n"); 

... 

... 

DO_HttpCleanup(); 
for(i=0; i<4; i++) 
{ 
free(Cookie[i]); 
Cookie[i]=NULL; 
} 

END_TRANSACTION(); 

 

Execut ing a Visual  Basic scri pt  

QALoad does not evaluate a Visual Basic script . However, any Visual Basic script  request that occurs is 
inserted in to the script  as a main request. 

Sim ulat ing Fram es 

Frames are handled by the fol lowing process: 

1. The browser makes a main page request to a Web server for a page that contains frames. 

2. The browser parses the frame pages and places them in sub-windows with in the browser, each of 
which displays the frame content. 

Example Web Page 

The fol lowing Web page contains four frames. 

<HTML> 
<HEAD> 
<TITLE>FRAME Example</TITLE> 
</HEAD> 

<! -- Here is the FRAME information for browsers with frames --> 

<FRAMESET Rows="*,*"><!-- Two rows, each equal height --> 
  <FRAMESET Cols="*,*"><!-- Two columns, equal width --> 
     <FRAME Src="findex.htm" Name="ul-frame"> 
     <FRAME Src="findex.htm" Name="ur-frame"> 
  </FRAMESET> 

   <FRAMESET Cols="*,*"><!-- Two columns, equal width --> 
     <FRAME Src="findex.htm" Name="ll-frame"> 
     <FRAME Src="findex.htm" Name="lr-frame"> 
  </FRAMESET> 
</FRAMESET> 

</HTML> 

Example Script  

QALoad automatical ly generates al l  constructs necessary to request frames. The example script  features the 
fol lowing element: 

!  A DO_Http cal l  to retrieve the main page. 

How  I t  Works: The frames are treated as sub-requests and are evaluated and requested by QALoad . 

BEGIN_TRANSACTION(); 
DO_AutomaticSubRequests(TRUE); 
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... 

... 

DO_Http("GET http://www.host.com/frameset.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("FRAME Example", TITLE); 

... 

... 

END_TRANSACTION(); 

Sim ulat ing Brow ser Cach ing 

Browser caching is handled by the fol lowing process: 

1. When the browser makes a request for stat ic HTML pages, i t  may include an opt ion to retrieve the 
page only i f i t  is newer than the one held in  the browser’s cache. 

2. If browser caching is enabled, the server returns only newer versions of the page. If browser caching 
is not enabled, the server always returns the page. 

How  I t  Works: The QALoad Script Development Workbench disables browser caching while recording, 
which means a page is always retrieved.  

Request ing Passw ord-protected Di rectories 

Web developers use password-protected directories to protect access to some pages. When the browser 
requests a page in a password-protected directory, the server returns a special response that specifies the 
page is password-protected. When the browser receives th is type of reply, i t  gathers the user ID and 
password, encrypts them, and passes them back to the server in  a subsequent request. 

Example Script  

QALoad automatical ly generates al l  the constructs that are necessary to execute a request of a password-
protected directory. 

The example script  features the fol lowing elements: 

!  DO_BasicAuthorizat ion, which takes the user ID and password as parameters 

!  DO_Http request to the password-protected directory 

BEGIN_TRANSACTION(); 
DO_BasicAuthorization("frank", "~encr~557A2549474E57444A"); 

... 

... 

DO_Http("GET http://www.host.com/access_controlled/secure.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Successful Test of a Secured Page", TITLE); 

... 

... 

END_TRANSACTION(); 

Example Script  

QALoad also handles Windows Domain Authent icat ion (NTLM). 

The example script  features the fol lowing elements: 

!  A DO_NTLMAuthorizat ion cal l , which takes the domain, user ID, and password as parameters 

!  DO_Http request to the NTLM protected directory 

BEGIN_TRANSACTION(); 
DO_NTLMAuthorization("dom1\\frank", "~encr~557A2549474E57444A"); 
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... 

... 

DO_Http("GET http://www.host.com/ntlm_controlled/secure.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Successful Test of a NTLM Page", TITLE); 

... 

... 

END_TRANSACTION(); 

 

Reuse SSL session  ID 

This opt ion is avai lable only on an SSL instal lat ion of QALoad . By default , th is opt ion is not selected and 
SSL session IDs are not re-used, which reflects standard browser behavior. If your appl icat ion re-uses SSL 
session IDs, consider select ing th is opt ion. 

The Reuse SSL session ID opt ion is used by the replay engine at replay t ime and the current session’s ID is 
re-used for al l  the requests with in the transact ion. 

Script  example with the Reuse SSL Session ID opt ion selected 

The fol lowing example has the Reuse SSL session  ID check box selected. 

... 

... 

SYNCHRONIZE(); 

/* Select following statement for reuse of Session ID with */ 
/* SSL. If session ID needs only to be reused within */ 
/* a transaction insert after the BEGIN_TRANSACTION */ 
/* statement */ 
 
/* DO_SSLReuseSession(TRUE); */ 

BEGIN_TRANSACTION(); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/subs.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Page Of Subs", TITLE); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Script example with the Reuse SSL Session ID not selected 

The fol lowing example has the Reuse SSL session  ID check box cleared. 

... 

... 

SYNCHRONIZE(); 

/* Select following statement for reuse of Session ID */ 
/* with SSL. If session ID needs only to be reused within */ 
/* a transaction, insert after the BEGIN_TRANSACTION */ 
/* statement */ 
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/* DO_SSLReuseSession(FALSE); */ 

BEGIN_TRANSACTION(); 

... 

... 

/* Request: 1 */ 

DO_Http("GET http://www.host.com/subs.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Page Of Subs", TITLE); 

... 

... 

END_TRANSACTION(); 

... 

... 

CGI Requests 

Simulat ing CGI Requests 

The fol lowing topics describe strategies for simulat ing CGI requests: 

CGI Parameter Encoding 

CGI Get Requests 

CGI Post Requests 

CGI Forms 

CGI Parameter Encoding 

Common Gateway Interface (CGI) is widely used on World Wide Web sites to provide the abi l i ty to run 
server-side scripts that can take variable input from a Web browser. QALoad recognizes when the browser 
has communicated to a CGI si te and automatical ly creates variables for parameters whenever necessary. For 
example, many CGI submission forms contain h idden parameters that the user cannot modify, but are 
always sent in  the WWW request. Because these values can contain variable data, QALoad inserts 
statements in to the script  to store these h idden parameters in  variables and append them automatical ly to 
CGI requests. 

CGI requests also include parameters that the browser has al lowed the user to modify. For example, a CGI 
form might require a user to enter a name and address and cl ick a submit button to cont inue. QALoad does 
not automatical ly store these types of parameters in  variables, but instead provides an easy way to modi fy 
the content of the parameters that are being sent in  the CGI request using the DO_SetValue command.  

When you modify parameters that are passed into a QALoad CGI request, ensure that al l  CGI parameters 
contain ing characters that are not alphanumeric (a-Z, 0-9) are encoded before being sent to the server. CGI 
encoding entai ls insert ing the ASCII value of a character, prefixed with the “ %”  character, in to the 
parameter. QALoad automatical ly CGI-encodes any values that i t  detects during the recording and 
conversion process; however, to manually add or modify any CGI parameter strings after your script  is 
created, you must manual ly encode special characters to ensure that the CGI parameter data is sent to the 
Web server properly. For example, to insert  the “ =”  character in to a CGI parameter, fi rst  determine i ts 
ASCII hexadecimal value (3D), and insert  that value in to the CGI parameter prefixed with “ %” . In  the CGI 
parameter string, “ %3D”  would replace “ =” . Al l  CGI parameter encoding is handled by th is method, except 
for spaces. Blank spaces must be specified in  the encoded CGI string by the character “ +” , rather than the 
ASCII value. 

QALoad provides an automatic way of performing th is encoding using the DO_EncodeString command.  
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CGI Get Requests 

Get requests are handled by the fol lowing process: 

1. The browser makes a request to a server for a URL that contains a cal l  to a Common Gateway 
Interface (CGI) program. 

2. The server cal ls the CGI program, which usual ly returns a Web page. The returned page is cal led a 
dynamic page because i t  is created by the CGI program. 

3. The browser accepts the result ing dynamic page and displays i t . 

Example Web Page 

The fol lowing Web page contains an anchor (l ink) that references a CGI program. The reference results in  a 
CGI Get request.  

The anchor cal ls the CGI program named perl_1.pl with some parameters. In  perl_1.pl?name=FRANK, the 
quest ion mark (?) denotes the start  of parameters that need to be passed to the program. The name/value 
pair being passed to the perl_1.pl program is name=FRANK. 

When you cl ick the anchor text (dynamic HTML page), the browser makes a CGI Get request. A Get 
request, when executed by the server, passes parameters in  an environment variable to the CGI program. 
This type of parameter handl ing is l imited to 255 characters. 

<HTML> 
<HEAD> 
<TITLE> QALoad WWW Capture Examples</TITLE> 
</HEAD> 
<BODY> 
<A HREF="/cgi-bin/perl_1.pl?name=FRANK">Dynamic HTML Page</A> 
</BODY> 
</HTML> 

Example Script 

QALoad automatical ly generates al l  constructs that are necessary for a CGI Get request. The fol lowing 
script  uses a DO_Http cal l  for the CGI Get request.  

How  I t  Works: The script  processes a CGI Get request the same way i t  processes URL l inks to a page. In  the 
example script  below, note that the parameters passed to the Web server on the CGI cal l  are recorded 
unchanged. The parameters do not change unless the page is dynamical ly generated. 

char *Anchor[1]; 
for(i=0;i<1;i++) 
Anchor[i]=NULL; 

DO_InitHttp(s_info); 

SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 

/* 
* Anchor 'http://www.host.com/cgi-bin/perl_1.pl?name=FRANK' 
* 'Dynamic HTML Page' 
*/ 

DO_GetAnchorHREF("Dynamic HTML Page", &Anchor[0]); 
DO_SetValue("Anchor000", Anchor[0]); 
DO_Http("GET {*Anchor000} HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Perl Example Page", TITLE); 

... 
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... 

for(i=0; i<1; i++) 

{ 
free(Anchor[i]); 
Anchor[i]=NULL; 
} 

END_TRANSACTION(); 

CGI Post Requests 

Post requests are handled by the fol lowing process: 

1. The browser makes a request to a server for an HTM L page that contains a form that uses an act ion 
statement with a Post cal l  to a CGI program. 

2. When you cl ick the Submit button on a CGI form, the browser makes a Post request and the server 
returns a Web page. 

3. The browser accepts the dynamic page and displays i t . Because i t  is a CGI Post  request, the browser 
passes the parameters of the program to the CGI script  as command l ine opt ions. 

Example Web Page 

The fol lowing Web page contains a form that cal ls a CGI script  with a Post Request. 

<html> 
<head><title> QALoad's Perl Example Page</title> 
</head><body><center> QALoad's Perl Example Page</center> 
<form name = myform method = POST action = perl_1.pl> 
<input type = text name = yourname size = 50><br> 
<input type = submit value = "Submit Request"> 
<input type = reset> 
</form> 
</body></html> 

Example Script 

QALoad automatical ly generates al l  the constructs that are necessary for a CGI Post request. The fol lowing 
script  features a DO_HTTP request that executes a CGI Post request : 

char *ActionURL[1]; 
... 
... 
for(i=0;i<1;i++) 
ActionURL[i]=NULL; 
... 
... 
BEGIN_TRANSACTION(); 
/* Request: 1 */ 
DO_SetValue("name", "FRANK"); 
DO_Http("GET http://www.host.com/cgi-bin/perl_1.pl?{name} " 
        "HTTP/1.0\r\n\r\n"); 

DO_VerifyDocTitle(" QALoad's Perl Example Page", TITLE); 
/* ActionURL[0]="http://www.host.com/cgi-bin/perl_1.pl" */ 
DO_GetFormActionStatement(FORM(1), &ActionURL[0]); 

... 

/* Request: 2 From: QALoad's Perl Example Page */ 
DO_SetValue("action_statement0", ActionURL[0]); 
DO_SetValue("yourname", "PostFrank"); 
DO_SetValue("function", "View the log of previous visitors."); 
DO_Http("POST {*action_statement0} HTTP/1.0\r\n" 
        "Content-Type: application/x-www-form-urlencoded\r\n" 
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        "Content-Length: {*content-length}\r\n\r\n" 
        "{yourname}&{function}"); 

DO_VerifyDocTitle(" QALoad's Perl Example Page", TITLE); 

... 

... 

for(i=0; i<1; i++) 
{ 
free(ActionURL[i]); 
ActionURL[i]=NULL; 
} 

END_TRANSACTION(); 

 

CGI Forms 

Common Gateway Interface (CGI) forms are handled by the fol lowing process: 

1. The browser requests a page that contains a CGI form. It  displays the page and provides the 
in teract ion for input fields that the CGI form specif ies. 

2. A user enters data in to the CGI form and cl icks the submit button. This act ion causes the browser 
to process the CGI form’s act ion statement. 

3. The browser processes the act ion statement, gathers al l  input fields as name value pairs, and passes 
them to a CGI cal l  contained in the act ion statement . 

Example Web page 

The fol lowing Web page contains a CGI form with: 

!  An act ion statement 

!  Input fields 

!  Hidden fields 

<HTML> 
<HEAD><TITLE>Forms Example</TITLE> 
</HEAD> 
<BODY> 
<FORM ACTION="http://www.host.com/cgi-bin/perl_9.pl" method=post> 

<TABLE> 
<TR> 
<TD>Name: 
<TD><INPUT NAME="name" SIZE="20" MAXLENGTH=20> 
<TR> 
<TD>Password: 
<TD><INPUT TYPE =password NAME="password" SIZE="20" MAXLENGTH=20> 

There is a hidden field containing data here: <INPUT TYPE=hidden NAME="hidden" VALUE="This 
rocks!"> 

Here is another hidden field: <INPUT TYPE=hidden NAME="hidden1" VALUE="Web testing is fun"> 

</FORM> 
</BODY> 
</HTML> 

Example script 

QALoad automatical ly generates al l  the constructs that are necessary to make a CGI form request. 

The example includes the fol lowing features: 
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!  A DO_Http cal l  to retrieve the forms page. 

!  Commented descript ion of the input fields on the page. 

!  GetFormValueByName commands to retrieve the values of the h idden fields from the form. 

!  DO_SetValue cal ls to store the field names and their user-entered values. 

!  A DO_Http cal l  for the CGI get request. 

char *Field[2]; 
char *ActionURL[1]; 
 
... 
... 
 
for(i=0;i<2;i++) 
Field[i]=NULL; 
 
for(i=0;i<1;i++) 
ActionURL[i]=NULL; 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

/* Request: 1 */ 

DO_Http("GET http://www.host.com/forms.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Forms Example", TITLE); 

/* ActionURL[0]="http://www.host.com/cgi-bin/perl_9.pl" */ 

DO_GetFormActionStatement(FORM(1), &ActionURL[0]); 

/* Form:1 text Name: name, Value: , Desc: */ 
/* Form:1 text Name: password, Value: , Desc: */ 
/* Form:1 hidden Name: hidden, Value: This rocks! */ 

DO_GetFormValueByName(FORM(1), "hidden", "hidden", 1, &Field[0]); 

/* Form:1 hidden Name: hidden1, Value: Web testing is fun */ 

DO_GetFormValueByName(FORM(1), "hidden", "hidden1", 1, &Field[1]); 

/* Request: 2 From: Forms Example */ 

DO_SetValue("action_statement0", ActionURL[0]); 
DO_SetValue("name", "form-name"); 
DO_SetValue("password", "form-password"); 
DO_SetValue("hidden", Field[0]); 
DO_SetValue("hidden1", Field[1]); 
DO_Http("POST {*action_statement0} HTTP/1.0\r\n" 
        "Content-Type: application/x-www-form-urlencoded\r\n" 
        "Content-Length: {*content-length}\r\n\r\n" 
        "{name}&{password}"); 

DO_VerifyDocTitle("Forms Example - Results", TITLE); 

... 

... 

for(i=0; i<2; i++) 
{ 
free(Field[i]); 
Field[i]=NULL; 
} 
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for(i=0; i<1; i++) 
{ 
free(ActionURL[i]); 
ActionURL[i]=NULL; 
} 

END_TRANSACTION(); 

Compiling a Script  

Compiling a Test  Script  

A QALoad script  is a real C++ script , and therefore needs to be compiled before i t  can be used. QALoad 
works with your exist ing compiler to compile usable test scripts. If you make changes to an exist ing script , 
you must re-compile i t  before you can successful ly use i t  in  a test. If you add an uncompiled or out-of-date 
script  to a load test, the QALoad Conductor prompts you to compile the script . 

Set  Up Automat ic Conversion and Compilat ion of a Script  

The Script Development Workbench automatical ly converts a capture fi le when you stop the recording 
process and compile the result ing script . You are prompted i f a script  by the same name already exists, so 
that you can decide whether to overwrite an exist ing script  or to save your script  under a different name. 

If the default  sett ings to automatical ly convert  a capture fi le have been changed, fol low the steps below to 
reset the automatic conversion and compilat ion. 

To set  up aut om at ic conversion and com pi lat ion: 

1. From the Script  Developm en t  Workben ch  menu, choose Opt ions>Workbench . 

2. On the Workbench Configurat ion tab, in  the Record Opt ions area, select the check box 
Autom at i cal l y Convert  Capture. 

3. Click the Com pi ler Set t ings tab. 

4. Select the check box Autom at i cal l y com pi le scri pts. 

5. Select the check box Prom pt  before overw ri t i ng script  to ensure that a script  is not overwrit ten 
accidental ly.  

6. Click OK to save your sett ings. 

Test ing a Script  

Validat ing Scripts in Workbench 

Before adding a script  to a load test, val idate i t  to ensure that i t  runs without problems. The fol lowing 
procedure is only val id for Win32 scripts. To val idate a UNIX script , see Val idat ing a UNIX script . 

Note: During validation of SAP scripts, do not minimize the SAP window. If the window is minimized, the 
validation may fail. This problem does not occur if you select the Hide Graphical User Interface for SAP 
Users option by clicking Browse [...] in the Type column of the Script  Assignment  tab in the Conductor. This 
SAPGUI option runs SAP on an alternate desktop that is not visible. 
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To conf igure t he Scr ip t  Developm ent  W orkbench f or  val idat ion : 

1. Click Opt ions>Workben ch  and select the Script  Val idat ion  tab. 

2. Select the Autom at i cal l y Recom pi le check box i f you want QALoad to compile a script  before 
attempting to val idate i t . QALoad l ists any compilat ion errors in  the editor after compil ing. 

3. (For Java and OFS) select Ask  for Autom at i c Val idat ion  of  Java and OFS Scripts. 

4. Select the On ly Display Player Output  on  Script  Fai lure check box to view only Player messages 
upon script  fai lure, i f appl icable. 

5. Type a value in  the W ai t  up to field. This is the number of seconds that the QALoad Script 
Development Workbench should wait  for a script  to execute before t im ing out. 

6. In  the Player Sett ings area, select the Abort  on  Error check box for QALoad to stop script  execut ion 
upon encountering an error. 

7. Select the Debug Data check box for the script  to display a debug message indicat ing which 
command the script  is execut ing. 

8. In  the Run As area, indicate whether the transact ion should be run as th read- or process-based . 

Note: Oracle Forms Server, Citrix, Java, and Uniface scripts are limited to process-based validation only. 

9. In  the Num ber of  users field, type a number of virtual users to run th is script  for val idat ion. The 
default  is 1. 

10. Enter a value in  the Tran sact ions field. For val idat ion, Compuware recommends that you accept 
the default  value of 1 transact ion. 

11. In  the Sleep Factor % field, type the percentage of each DO_SLEEP (pause in the script) to 
maintain. For val idat ion, you may not need to run every pause in the script  at  i ts ful l  length. The 
value can be a percentage between 0 and 100. The default  is 0. 

12. Click OK to save your changes. 

To val idat e a scr ip t  in  W orkbench: 

1. In  the Workspace Pane, cl ick the Scripts tab. 

2. Double-cl ick on the appropriate script  name to open the script . 

3. From the Session  menu, choose Val idate Script . 

You receive a message and trace in formation in  the Output pane. When the script  executes successful ly, 
you receive a confirmation message. If i t  does not execute successful ly, use the trace in formation to help 
you ident i fy errors. 

Debugging a Script  

Debugging a Script  

If you encountered errors whi le val idat ing or test ing a script , use QALoad's debugging opt ions to monitor 
the Player(s) that generated errors whi le they are running or after the test.  

You can watch a virtual user execute a script  on a Player Workstat ion while i t  is running. To monitor 
selected virtual users at runt ime, enable the Debug Trace opt ion before you run your test. Each virtual user 
for which you enabled Debug Trace displays messages on i ts assigned Player workstat ion indicat ing which 
commands are being executed. 
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You can instruct the Conductor to generate and save detai ls about the script  execut ion of selected virtual 
users by enabl ing Logfi le Generat ion before you run your test. This appl ies to Citrix, ODBC, Oracle, Oracle 
Forms Server, SAP, Winsock, or WWW only.  

To enable t he debug opt ions: 

1. On the Conductor's Script  Assignment tab, h ighl ight the script  you want to monitor. 

2. In  the Debug Options column, cl ick the brow se (...) button (note that the button may not be 
visible unt i l  you cl ick in  the Debug Options column). 

3. On the Debug Options dialog box, you can opt ional ly choose the fol lowing opt ions:  

a. To enable the Debug Trace opt ion: in  the Debug Trace Virtual User Range area, choose 
which virtual users (i f any) to monitor. You can choose None or Al l  Virtual Users, or choose 
Virtual User(s) and then type the numbers assigned to the virtual users you want to monitor. 
You can monitor individual virtual users or ranges of virtual users.  

b. To enable Logfi le Generat ion: in  the Logfi le Generat ion Virtual User Range area, choose 
which virtual users (i f any) to monitor. You can choose None or Al l  Virtual Users, or choose 
Virtual User(s) and then type the numbers assigned to the virtual users you want to monitor. 
You can monitor individual virtual users or ranges of virtual users.  

4. Click OK to save your changes.  

5. From the Conductor's main menu, cl ick Fi l e>Save to save your test session ID. 

6. Run your test as usual.  

Note: Some log files are generated automatically when you run a test in the Script Development 
Workbench or Player.  

QALoad Support  Log Files 

The table below ident i fies the QALoad log (support) fi les that are generated automatical ly during a test. 

Note: Some log files are generated automatically when you run a test in the Script Development 
Workbench or Player.  

Each virtual user for which you enabled Logfi le Generat ion in  Conductor creates a fi le contain ing 
in formation about their performance. After the test is fin ished, the Conductor requests al l  log fi les from 
the Players and save them in the directory \Program Files\Compuware\QALoad\LogFiles on the 
workstat ion where the Conductor is instal led.  

Log fi les are named <scriptname>_<middleware>_vu<AbsoluteVirtualUserNumber>.<ext>, where: 

!  <scriptname> is the name of the script the virtual user ran 

!  <middleware> is the name of your middleware application 

!  <AbsoluteVirtualUserNumber> is the identification number assigned to the virtual user 

!  <.ext> is the file extension, dependent upon which middleware application you are testing 

M iddlew are .RIP 
Fi le 

.CAP Fi le  
(Replay 

Capture) 

.TRC Fi le 
Player Trace 

.LOG Fi le 

ADO No No Yes Yes 

Citrix Yes Yes Yes No 



QALoad 05.06 Using the Player, Script  Development Workbench, and Analyze 

150 

ODBC No No Yes *Yes 

Oracle No No Yes *Yes 

Oracle 
Forms 
Server 

Yes Yes Yes No 

SAP No No Yes Yes 

Uniface No Yes Yes No 

Winsock No No Yes *Yes 

WWW Yes Yes Yes No 

Note: *This middleware also uses the .log file in replay capture.   

Verifying Script  Checkpoints 

You can quickly veri fy the syntax of the checkpoint commands BeginCheckpoint() and EndCheckpoint() 
in  your script  every t ime you compile your script  by sett ing a single opt ion, or on-the-fly with a single 
menu command. 

To aut om at ical ly ver i f y scr ip t  checkpoin t s, every t im e you com pi le a scr ipt : 

1. From the Script Development Workbench's main menu, cl ick Opt ions>Workbench . 

2. On the Configure Script  Development Workbench dialog box, cl ick the Com pi ler Set t i ngs tab. 

3. Select the Veri fy Checkpoin ts opt ion. 

4. Click OK. 

Every t ime you compile your script , the Script  Development Workbench veri fies the syntax of your 
checkpoint statements, and ensures the parameters passed in each pair match . If any errors are 
encountered, an error message displays in  the Output pane. You can cl ick on any error l ine to go direct ly 
to that l ine in  the script . 

To m anual ly ver i f y scr ip t  checkpoint s, f or  t he open scr ip t  only: 

With your script  open in the Workbook pane, cl ick Session>Veri fy Checkpoin ts.  

The Script Development Workbench veri fies the syntax of your checkpoint statements, and ensures the 
parameters passed in each pair match. If any errors are encountered, an error message displays in  the 
Output pane. You can cl ick on any error l ine to go direct ly to that l ine in  the script . 
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Visual  Navig at or  ( W W W )  

The Visual Navigator 
The visual script ing in terface, cal led the Visual Navigator, has three panes that represent different aspects 
of your script , and menu i tems that offer you addit ional funct ional i ty. Using the Visual Navigator to 
develop your scripts makes your job easier. For example, searching through l ines of code to locate a 
part icular button you cl icked on a part icular page can take a long t ime, but using the Visual Navigator you 
can simply cl ick through the pages to locate that button. In  fact, you can develop your whole script  – 
recording, variabl izing, convert ing, compil ing, and running i t  – al l  from the Visual Navigator's in terface 
without ever wri t ing a l ine of code. 

For a brief explanat ion of each Visual Navigator pane, cl ick on the panes in the graphic below. For more 
in formation about a pane, use the l inks l isted after the graphic. 

Note: To make the following graphic fit better in this help window, we've turned off the Script 
Development Workbench toolbars and panes that are not directly related to this help topic. You can 
hide/show many of the Script Development Workbench toolbars and panes using commands available from 
the View menu. 

 

Visual Navigator Menus 
The Visual Navigator has a number of special menu commands to help you develop your script . 

Visual Navigator Menu 

Edit  Menu 

Tools Menu 
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Visual Navigator Menu 

The Visual Navigator menu is the main menu for Visual Script ing. Access the Visual Navigator menu from 
the Script Development Workbench's main menu, or right-cl ick on any i tem in the Visual Navigator tree-
view (left  pane).  

 

Datapools and Variables: Opens the Datapools and Variables dialog box, where you can add, delete, or 
modify datapool fi les or variables.  

View  Script  Fi l e: Opens a window showing the C++ (.cpp) fi le based on what is current ly showing in the 
Visual Navigator's tree-view. This is a read-only script .  

Create Edi table Script  Fi le: Creates an editable C++ (.cpp) script  based on the current Visual Script . You 
can modify th is script  direct ly; however, any changes made to the script  wi l l  not be reflected in  the tree 
and vise-versa.  

Show  Hidden  Fields: Displays form fields that are h idden by the browser.  

Show  Redi rected Pages (3xx ):Toggles whether or not redirected pages are displayed. These are pages that 
come back with a reply status code of 3xx, for example: 302 Not Found. 

Show  Cl ien t  Error Pages (4xx ): Toggles whether or not Cl ient Error pages are displayed. These are pages 
that come back with a reply status code of 4xx, for example: 407 Proxy Authorization Required. 

Show  Server Error Pages (5xx ): Toggles whether or not Server Error pages are displayed. These are pages 
that come back with a reply status code of 5xx, for example: 503 Service Unavailable.  

Insert  Tree I tem : Opens a sub-menu where you can choose to insert  certain tree i tems into your script . For 
detai ls, see Insert ing script  i tems. 

Delete Tree I tem : Deletes the current ly selected tree i tem. If the selected i tem may not be deleted from the 
script , th is command is unavai lable.  

View  Source: Opens a text window displaying the source code of the current ly act ive HTML Page or 
Subrequest in  the tree view. 

Edit  Menu 

The Script Development Workbench Edit  menu provides special commands for Visual Navigator 
funct ional i ty as well  as common Edit  menu commands. Access the Edit  menu from the main menu, or 
right-cl ick on an edit  box that can be variabl ized in  the Visual Navigator form-view (bottom pane). Fields 
that can be variabl ized are denoted with a Var button.  
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The commands on the Edit  menu are dynamic and the avai labi l i ty of certain commands depends upon 
whether you have text selected and where your cursor is. The fol lowing graphics i l lustrate the difference: 

 

Insert  Variable/ Subst i tute w i th  Variable: Opens the Datapools and Variables dialog, al lowing you to 
insert  a variable or replace the selected text with a variable. Subst i tuted text wi l l  refer to a local variable or 
datapool variable and wil l  look similar to one of the fol lowing examples: 

{$ VAR:Customer Number $} 

{$ VAR:Last Name:Customer Data $} 

These commands are only avai lable when the cursor is placed in an edit  box on a tree-view i tem that can 
be variabl ized (you wil l  see Var or Var Wiz next to i t ).  

Insert  Random  Value/ Subst i tute w i th  Random  Value: Opens the Random Number Tag dialog box where 
you can specify a range wi th in which a random number should be generated for th is value. The subst i tuted 
text looks l ike th is:  

{$ RANDOM:0:100 $} 

and i t  produces a random number between the lower and upper l im it  each t ime i t  is executed. 

These commands are only avai lable when the cursor is placed in an edit  box on a tree-view i tem that can 
be variabl ized (you wil l  see Var next to i t ).  

Insert  VU Num ber/ Subst i tute w i th  VU Num ber (Absolute): Inserts or replaces the h ighl ighted text with 
the fol lowing text:  

{$ VU:ABS $} 

This is the virtual user number at runt ime. The absolute virtual user number is assigned depending on the 
number of Players in  use. For example, two Player machines with 50 virtual users on each, would assign 
numbers 0 through 49 for Player 1 and 50 through 99 for Player 2. Typical ly, the VU number is combined 
with other text to form a larger string, such as:  

Customer{$ VU:ABS $} 

In  th is example, Player 1 has values of Customer0 through Customer49, and Player 2 has values of 
Customer50 through Customer99. These commands are only avai lable when the cursor is placed in an edit  
box on a tree-view i tem that can be variabl ized (you wil l  see Var or Var Wiz next to i t ).  
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Insert  VU Num ber/ Subst i tute w i th  VU Num ber (Relat i ve): Inserts or replaces the h ighl ighted text with 
the fol lowing text:  

{$ VU:REL $} 

This is the virtual user number at runt ime. The relat ive virtual user number is assigned to each Player in  
use. Each Player has relat ive numbers from 0 to N, where N is the total number of VUs run on that Player. 
For example, two Player machines with 50 virtual users on each, would assign numbers 0 through 49 to 
each Player. Typical ly, the VU number is combined with other text to form a larger string, such as:  

Customer{$ VU:REL $} 

In  th is example, Player 1 has values of Customer0 through Customer49, and Player 2 has values of 
Customer0 through Customer49. These commands are only avai lable when the cursor is placed in an edit  
box on a tree-view i tem that can be variabl ized (you wil l  see Var next to i t ). 

Revert  to Original  St r i ng: Rol ls the contents of the selected edit  box back to when i t  was first  created, 
usual ly when the recording was converted to a Visual Script .  

This menu i tem is enabled only i f the edit  box with in the form can be variabl ized and i t  has been changed 
at some point. 

Delete Variable Reference: Deletes the variable from the selected edit  box. Note that you can also 
h ighl ight a variable and press the Delete key to delete a variable with in an edit  box. 

This menu i tem becomes enabled when you h ighl ight a variable inside of an edit  box.  

Tools Menu 

The Script Development Workbench Tools menu provides access to the Rule Library for parameterizat ion, 
the ZipFi le wizard for col lect ing fi les needed by the Technical Support team to analyze and resolve a 
problem, and common Tools menu commands. Access the Tools menu from the Script Development 
Workbench main menu. 

 
  

Rule Library: Opens the Rule Library dialog box, where you can add, delete, or modify saved Variable 
Replacement Rules. 

Visual Navigator's Find and Replace Feature 
Visual Navigator has an enhanced Find/Replace feature that al lows you to find occurrences of strings 
with in the tree-view, al lowing you to quickly locate and/or replace text. For example, you could find 
occurrences of Smith and replace them al l  with the datapool variable {$ Last Name:User Info $}. 

To access Visual  Navigat or 's Find f eat ure: 
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1. Select  Edi t>Find in  the toolbar.  The Find and Replace dialog box displays with the Find tab on 
top. 

2. Enter the appropriate opt ions and cl ick Find Nex t . When al l  matches are found, close the dialog 
box or cl ick Repl ace to use the Replace feature. 

To access Visual  Navigat or 's Replace f eat ure: 

1. Select  Edi t>Replace in the toolbar.  The Find and Replace dialog box displays with the Replace tab 
on top. 

2. Enter the appropriate opt ions. 

3. Do one of the fol lowing: 

 Click Find Nex t  to review each ident i fied variable before replacing i t . 

 Click Replace Al l  to replace al l  variables without reviewing them. 

4. Close the Find Replace dialog box . 

Developing a Script  Using the Visual Navigator (WWW) 

Recording a Visual Navigator Script  

Recording a Visual Navigator Script 

You record a Visual Navigator script  the same way you record a regular QALoad script  — by sett ing opt ions 
to determine the behavior of QALoad while recording, and then cl icking through a transact ion to mimic a 
user. QALoad records al l  sent and received HTTP and SSL cal ls using the Script Development Workbench's 
Web proxy and writes the act ivi ty to a capture fi le.  

After recording, the capture fi le must be converted to an editable, C++ script . This is the point where Visual 
Scripting differs from a regular WWW script. By sett ing a single opt ion before convert ing the capture fi le to 
an editable script , you can turn your capture fi le data in to a Visual Script  that al lows you to view the actual 
Web pages you recorded in a browser-l ike in terface, where you can manipulate the transact ion and easi ly 
insert  variable in formation in to your script  without  direct ly edit ing a l ine of code. 

To record a Visual  Scr ip t : 

If you are running your appl icat ion on Windows XP SP2, Compuware recommends you turn the 'pop-up 
blocker' feature off before recording a transact ion. The feature can be disabled via the browser window's 
Tools menu in In ternet  Opt ions>Pri vacy. 

1. Open a WWW session in  the Script Development Workbench.  

2. Click Opt ions>Record. The WWW Record Options dialog box opens. Set any relevant opt ions. 

3. Click OK.  

4. For convenience, set conversion opt ions now also. Cl ick Opt ions>Convert . The Session Options 
dialog box opens. Set any appl icable opt ions on the Shared Convert  Options and WWW Convert 
Options screens. Cl ick OK. (You can set conversion opt ions after recording your transact ion, i f you 
prefer, or even change pre-set opt ions at any t ime after recording and then re-convert  the capture 
fi le to apply the changes.)  

5. From the toolbar, cl ick the Start  Record button. QALoad launches your appl icat ion and any 
proxies, i f necessary, and begins recording cal ls. 
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6. Record the transact ion . 

7. When you are fin ished, cl ick the Stop Record button. You are prompted to save your capture fi le. 
By default , capture fi les (.cap) are saved in the directory QALoad\Middlewares\WWW\captures. In  the 
Fi l e Nam e field, type a fi le name and cl ick OK. The WWW Script Conversion  Mode Select ion 
dialog box appears.  
 

Note: If you previously set opt ions to prompt automatic conversion, your capture fi le is 
converted to a Visual Script  and opens automatical ly in  the editor. For more in formation about 
sett ing up automatic conversion, see Configuring the Script Development Workbench. 

8. Select either HTM L M ode or HTTP M ode. Cl ick OK.  

9. Click the Captures tab and locate the capture fi le you just saved. 

10. Right-cl ick the fi le and choose Convert . QALoad converts your capture fi le to a Visual Navigator 
script  and opens i t  in  the editor.  

Visual Navigator Files 

When you create a script  using Visual Navigator, QALoad saves important in formation about your script  in  
the fol lowing fi les. These fi les are saved in the directory \Compuware\QALoad\Middlewares\WWW in  the 
subdirectories \Scripts and \Captures. Some of these fi les can be modified, and can be opened from the 
Script Development Workbench's Workspace pane, i f necessary. 

Note: If you choose to enable support for Siebel while converting a capture file, you must copy the Siebel 
files from the Siebel installation folder to C:\Program Files\Compuware\QALoad\BinaryFiles. 

Fi l enam e Descript i on  

Fi l es Generated From  Recording 

<filename>.cap A fi le contain ing al l  of the requests 
and responses that were recorded. 

<filename>.rfd Replies to subrequests, wh ich most ly 
consist  of images, style sheets, and 
javascripts. This data is used to 
visual ly recreate the pages as they 
appeared when recording. 

Fi l es Generated From  Conversion  to a Visual  Script  

<filename>.vistree Contains most of the elements of the 
Visual Navigator tree, including any 
elements that you modify later or 
add to your script . 

<filename>.VisHtml Contains the HTML pages of al l  the 
main requests as well  as images, 
stylesheets, and other subrequested 
pages. This data is used to visual ly 
recreate the pages as they appeared 
when recording. 

<filename>.VisXml Contains any XML/SOAP 
information that was recorded. 

<filename>.cpp A C++ representat ion of your script . 
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Insert ing Script  Items 

Inserting Tree Items 

You can insert  a number of script  i tems into your converted script .  

To inser t  t ree i t em s: 

1. Do one of the fol lowing: 

 From the Script Development Workbench main menu, choose  Visual  
Navigator>In sert  Tree I tem .  

 Right-cl ick in  the tree-view (left  pane) and choose Insert  Tree I tem .  

2. Choose the i tem to insert . 

Most of the inserted i tems can be moved up and down the tree using the Up/Dow n arrows in the form-
view (bottom pane) for that i tem. You can also delete an i tem highl ighted in  the tree-view by choosing 
Delete Tree I tem  from the menu. 

The fol lowing script  i tems can be inserted from the Visual  Navigator menu:  

Extract String 

Cookie 

Http Header 

Content Check 

CGI Parameter 

Synch 

IP Spoof 

Read Datapool 

Checkpoint Pair 

Increment/Decrement /Reset Variable 

Print Values (debugging) 

Comment 

 

Inserting Cookies into a Script 

Cookie i tems can be added direct ly to the Html Page i tem they apply to, under the Act ion  i tem (for 
example, a Cl ick on Link i tem).  

To inser t  a cook ie i t em : 

1. In  the Visual Navigator tree-view (left  pane), navigate to the Html Page i tem requiring the cookie 
and then cl ick on i t  to select i t .  

2. From the menu, choose Visual  Navigator>Insert  Tree I tem >Cook ie. A Cookie form-view opens in 
the bottom pane. 

3. In  the Nam e field, type a name for the new Cookie or cl ick Var Wiz... to access the Select Variable 
dialog box where you can select a value from a datapool fi le or create a variable for th is field. 
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4. In  the Value field, type a value for the new Cookie or cl ick Var Wiz... to access the Select Variable 
dialog box where you can select a value from a datapool fi le or create a variable for th is field. 

5. Click Save to save your changes. 

The Cookie i tem is added to the script  for the selected Html Page i tem.  

 

Inserting HTTP headers into a Visual Navigator script 

You can insert  HTTP headers under the Common Http Headers tree i tem. 

To inser t  a new  Ht t p  Header  i t em : 

1. In  the Visual Navigator tree-view (left  pane), navigate to the Com m on Ht tp Headers script  i tem, 
and then cl ick on i t . 

2. From the menu, choose Visual  Navigator>Insert  Tree I tem >Ht tp Header. An Ht tp Header form-
view opens in the bottom pane. 

3. In  the Nam e field, type a name for the new header or cl ick Var Wiz... to access the Select Variable 
dialog box where you can select a value from a datapool fi le or create a variable for th is field. 

4. In  the Value field, type a value for the new header or cl ick Var Wiz... to access the Select Variable 
dialog box where you can select a value from a datapool fi le or create a variable for th is field. 

5. Click Save to save your changes. 

The header i tem is added to the script , and wil l  be used for al l  requests at playback unless i t  is overwrit ten 
by a header with the same name underneath an individual request act ion.  

XML Support  

XML Support 

QALoad's XML support is handled through the Script Development Workbench's Visual Navigator, which 
displays your script 's HTTP or XML requests in  an easy-to-use, visual ly-based interface that offers you 
point-and-cl ick script  edit ing. Although XML is supported through the Visual  Navigator, Compuware 
recommends you read through th is help topic as well  as the Visual Navigator help topics to become 
famil iar with the features that are unique to QALoad's XML support. 

When an HTTP request is made for an XML document, ei ther in  the form of an HTTP GET request or an 
HTTP POST request with an XML document as the post data, the data is displayed in the three Visual 
Navigator panes as i l lustrated below. Cl ick on a pane in the graphic for a descript ion of i ts contents and 
funct ional i ty. 

Note: To make the following graphic fit better in this help window, the Script Development Workbench 
toolbars and panes that are not directly related to this help topic are not displayed. You can hide/show many 
of the Script Development Workbench toolbars and panes using commands available from the View menu. 



Script Development Workbench 

159 

 

XML Requests 

When an HTTP request is for an XML document, ei ther in  the form of an HTTP GET request, or an HTTP 
POST request with an XM L document as the post data, then an XML Request  tree i tem is displayed in the 
tree-view (left  pane). The form-view (bottom pane) for an XML Request i tem includes the fol lowing fields: 

Reply Status: The reply status code. The status code is 200 OK for most pages that return correct ly. 

Request  URI: This read-only field shows the URI requested, which resulted in  th is page being displayed.   

Checkpoin t  Nam e: If the page has a t i t le, i t  is used as the checkpoint name. If not, the word Checkpoint is 
used. To make sure al l  checkpoint names are unique, QALoad adds a number to the beginning of the 
checkpoint name. 

XM L Request  Sub-i tem s 

An XML Request i tem can contain the fol lowing sub-i tems.  

XML Reply  

The URI of the document returned as a result  of the XML request. XML data corresponding to the reply is 
displayed in the browser-view. 

HTTP Headers 

If a header exists under an act ion i tem, i t  is sent for that request only. If the header has the same name as 
one of the common headers, i t  overrides the common header for th is request only. The form-view (bottom 
pane) for an HTTP header l ists i ts name and value. Because there is no XML data recorded for a header, the 
browser-view remains empty. It  is possible to insert  addit ional HTTP Headers. 

Cookies CGI Parameter 
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The Cookies tree i tem contains a l ist  of Cookie i tems that were sent in  the header of the request that th is 
i tem made while being recorded. Cookies are added automatical ly by the browser based on the URI that is 
being requested. They are either set as a result  of the previous reply (server returned a Set-Cookie 
command), or they are set by JavaScript contained in the previous reply. The form-view for a cookie i tem 
l ists i ts name and value. Because there is no XML data recorded for a header, the browser-view remains 
empty.  

XML Document-view 

When you cl ick on an XML Request i tem in the tree-view (left  pane) the right pane becomes a document-
view displaying a tree-view of detai ls about the XM L document requested or returned as the result  of an 
XML request. Each individual XML item appears as a node in the XML document tree. XML elements can 
have chi ld elements and these appear as chi ld nodes of the XML element. Attributes of an element appear 
as chi ld nodes of the element, with the attribute value appearing as a chi ld of the attribute name. 

What  i f  no XM L data i s associ ated w i th  a request? 

If there is no XML document associated with the XML request (for example, an HTTP GET) a message 
indicat ing that there is no XML to be displayed is shown in the XML document-view. 

How  does the docum en t -view  relate to the form -view ? 

Select ing an i tem in the XML document tree displays the form-view detai ls corresponding to that XML 
element type in the bottom pane. 

Fol lowing is an example of XML request data displayed in a port ion of the XML document-view: 

 

XML Form-view 

When an XML request is displayed in the document-view (top pane) — as a result  of an XML request i tem 
or XML reply chi ld i tem being selected in  the Visual Navigator tree-view — you can cl ick on i tems in the 
document-view to display in formation about each in the form-view (bottom pane). If no XML item is 
selected in  the document-view, the XML Page form-view displays instead. For XML items, the form view 
display opt ions depend on two th ings: 

!  what type of XML item is selected in  the Visual Navigator tree-view (left  pane): an XML request or 
an XML reply 

!  what type of XML item is subsequently selected in  the XML document-view (top pane) 

When an XML item is selected in  the XML document-view, the value of that XML item is displayed in an 
edit  box in  the form-view. Some values — attribute values and text values — can be edited or variabl ized 
(that is, subst i tut ing one or more variables for the value in  an XML request or select ing the return value 
from an XML reply i tem to be received by a variable for later use in  the script). Text i tems, which are values 
between element tags, and attribute values represent volat i le i tems in an XML document structure, used for 
passing values to and from Web Services, for example. 

The fol lowing tables l ist  the possible act ions for XML items displayed in a form-view. Val id act ions are 
determined by the XML item type and whether the i tem is from an HTTP POST request or from an HTTP 
reply. 
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In  the fol lowing tables: 

!  If an i tem is editable, the value in  the form-view can be changed and the new value is used during 
replay. 

!  If a value can be variablized, a variable can be subst i tuted for al l  or part  of the value. The variable's 
value is placed in the variable's locat ion at replay. An example is a value received from an i tem 
from a previous XML document reply. 

!  If a variable can receive a replay value, the return value for the i tem can be placed into a selected 
variable during replay. The variable can then be subst i tuted for an input value in  a later XML 
request . 

XM L Request  I tem s 

XM L Request  I tem  Edi table? Can  the Value 
be Variabl i zed? 

Declarat ion No No 

DTD (Document 
Type Defin i t ion) 

No No 

PI (Processing 
Instruct ion) 

No No 

Comment No No 

Element No No 

Attribute (Name) No No 

Attribute (Value) Yes Yes 

Text Yes Yes 

 
XM L Reply I tem s 

XM L Request  I tem  Can  Variable 
Receive Replay 

Value 

Declarat ion No 

DTD (Document Type 
Defin i t ion) 

No 

PI (Processing 
Instruct ion) 

No 

Comment No 

Element No 

Attribute (Name) No 

Attribute (Value) Yes 
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Text Yes 

Visual Script ing Concepts 

Int roducing Visual Script ing 

Visual Navigator for WWW is QALoad's easy-to-use visual in terface to QALoad's powerful script  
development tools. Visual  Navigator for WWW renders your recorded C++-based transact ion in  a tri -paned, 
browser-l ike environment  similar to popular visual ly-oriented development tools, with icons represent ing 
al l  the elements of your script . In  fact, you could set  up and run a WWW script without ever having to 
modify a C++-based script . 

With Visual Navigator's advanced edit ing features, you don't  have to know the syntax of QALoad's 
command set or your HTML requests or responses to customize your script . You can quickly and easi ly: 

!  See what URL cal ls were made and what type they were (for example a POST or GET statement) 

!  See what in formation was passed in a cal l  

!  See what repl ies/pages were returned 

!  Add checkpoints or comments in to your script  

!  Move the begin/end transact ion statement 

!  Move the synchronize statement 

!  Edit  an HTTP header 

!  Set part icular flags and commands 

!  Add datapools 

!  Parameterizing your script  

!  Extract in formation from a reply to use in  subsequent cal ls 

!  Save your script  and go back to i t  at  any t ime for further edit ing 

!  Create a C++-based script  fi le, i f you l ike   

Looking at  a Transact ion Loop 

The transact ion loop is the port ion of your script  that is played back repeatedly, represent ing mult iple 
users making requests. The elements in  your transact ion loop depend on what  was original ly recorded on 
each page you requested. You can move the transact ion loop up or down in the tree-view using the arrow 
buttons, to al low certain requests to be moved in or out of the Transact ion Setup area, where they wil l  be 
executed before beginning the transact ion loop. 

Note: The following graphic does not show all the possible script elements, but gives a good 
representation of what your transaction loop might look like in the Visual Navigator. 

 

High-level script items 

There are three h igh-level script  i tems in the transact ion loop that represent the web pages you've 
recorded. NavigateTo, HTML Pages, and XML Requests:  

NavigateTo: This is always the first  i tem under the Transact ion Loop element , and is always denoted wi th 
an arrow icon. It  l ists the URL that was typed into the web browser at the start  of recording. This specifies 
the first  request to be made. The result  of th is request is the next i tem in the tree, which is general ly an 
HTML Page i tem.  

If the first  i tem is an HTTP request for XML data, i t  wi l l  appear as an XML Request i tem in the tree.  
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Page (HTM L): Fol lowing NavigateTo there wil l  typical ly be a set of HTML Page i tems, which are always 
denoted with a globe icon underneath the Transact ion Loop element. These represent pages visi ted whi le 
the transact ion was being recorded. 

The form-view (bottom pane) l ists the request 's reply status, the requested URI, and the associated 
checkpoint name for the page returned. 

HTML Page i tems can be parent to a number of script  i tems in the tree-view, such as Act ion i tems. For 
more in formation about sub-i tems that can exist  under a Page i tem, see HTM L Page sub-i tems. 

XM L Request : Requests for XML documents are denoted by a document/arrow icon underneath the 
Transact ion Loop element . These represent the requests for XML data made during the transact ion that 
was recorded. XML Request i tems can be parent to a number of lower-level script  sub-i tems in the tree-
view, such as Header and Cookie i tems and the XmlReply document i tem. See XML requests to learn about 
sub-i tems that can exist  under an XML Request i tem. 

XML Support  

QALoad's XML support is handled through the Script Development Workbench's Visual Navigator, which 
displays your script 's HTTP or XML requests in  an easy-to-use, visual ly-based interface that offers you 
point-and-cl ick script  edit ing. Although XML is supported through the Visual  Navigator, Compuware 
recommends you read through th is help topic as well  as the Visual Navigator help topics to become 
famil iar with the features that are unique to QALoad's XML support. 

When an HTTP request is made for an XML document, ei ther in  the form of an HTTP GET request or an 
HTTP POST request with an XML document as the post data, the data is displayed in the three Visual 
Navigator panes as i l lustrated below. Cl ick on a pane in the graphic for a descript ion of i ts contents and 
funct ional i ty. 

Note: To make the following graphic fit better in this help window, the Script Development Workbench 
toolbars and panes that are not directly related to this help topic are not displayed. You can hide/show many 
of the Script Development Workbench toolbars and panes using commands available from the View menu. 
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Streaming Media in Visual Navigator 

If you selected the Streaming Media opt ion on the WWW Advanced conversion opt ions dialog box before 
recording your script , and the recorded transact ion contains RealOne Player or Windows Media streaming 
requests, your streaming media request wi l l  be presented as a Page in the tree-view, similar to the fol lowing 
graphic:  

The form-view (bottom pane) for a streaming media page shows the 
t i t le Real Media Request or Windows Media Request to indicate the type 
of request you recorded, and l ists the fol lowing fields: 

Requested URI: Lists the requested URI that invoked the media 
player. For Real M edia the fi le typical ly is an RM fi le, whi le for 
Windows Media i t  is  typical ly an ASX fi le. 

Play M edia Request : Select th is check box for the virtual user to 
process the RM or ASX fi le that is received and make the necessary 
requests to dupl icate what  the cl ient performed while receiving the 
streaming media. If th is checkbox is not selected, then no further 
processing is performed after receiving the RM or ASX fi le. 

Play Requested M edia for N seconds: You can specify how much of the streaming media fi le the virtual 
user should play, in  seconds, before moving on to the next request. A value of zero indicates that the ent ire 
media stream should be played. 

Note: While a virtual user is playing a media request it will not make any other requests in the transaction 
loop. This may be different than what the user performed when recording the transaction because a browser 
is capable of spawning the streaming media player as a separate executable which can execute at the same 
time that the user continues to make further web requests in the browser. 
 
 

 

CJK and Visual Navigator 

The Visual Navigator handles both nat ive and encoded Chinese, Japanese, and Korean (CJK) characters. 
(See CJK Support in  QALoad for more in formation about CJK support.) 

The fol lowing graphic shows how the Visual Navigator provides nat ive character support. Both Engl ish and 
Chinese characters are displayed in the Workbook Pane. 
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The same capture fi le, Shanghai.cap, is open in the graphic below. Here, the Visual Navigator displays the 
Chinese characters in  encoded format. 
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Primary Script  Elements 

Primary Elements of a Visual Navigator Script  

When you open a Visual Navigator script , you'l l  see standard elements of your script  l isted in  the left  pane. 
Each element can contain  a number of script  i tems, which in  turn have attributes that are editable in  some 
cases. This topic l ists the major elements of a script , and l inks to addit ional help topics describing each 
element 's associated script  i tems:  

The main elements of a Visual Navigator script  are: 

WWW Playback Options 

Variables  

Parameterizat ion Rules 

Datapool Fi les  

Common Http Headers  

Common Content Checks  

Transact ion Setup  

Transact ion Loop  

Transact ion Cleanup  

 

 

WWW Playback Opt ions 

This i tem contains sett ings related to playback such as proxy sett ings, t ime out value, number of 
concurrent connect ions, baud rate emulat ion, and fi l ters.  

Parsing 

Caching 

Traffic Fi l ters 

Connect ion Sett ings 

Content Type Handling 

Proxy 

General 

Siebel 

 

Variables 

These are local variables that have been created for th is script .  When you h ighl ight a variable in  the tree 
view, the fields display data related to the variable type you selected.  For in formation about 
parameterizat ion, see Parameterizat ion. 
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Parameterizat ion Rules Script  Items 

Lists Parameterizat ion Rules that you create when you define a variable to subst i tute for a value. Saving the 
variable as a rule enables you to reuse i t  for other instances of the variable. 

When you cl ick Param eteri zat ion  Rules in  the Visual Navigator tree-view, detai ls of the rules stored in  the 
Rule Library appears in  the right-hand pane.  

Note:  Properties for the rules are defined using the Rule Library Wizard or the Variable Replacement 
Wizard. 

Datapool Files 

The datapool fi les being cal led by the script . Each datapool l isted has a l ist  of variables under i t  
represent ing columns in the datapool fi le. Datapools can be Local (specific to a single Player) or Central  
(avai lable to al l  Players). 

Common Ht tp Headers 

Lists headers that were recorded from at least 50% of your requests. These headers wi l l  be sent out with 
every request that is made at playback unless they are overwrit ten by a header of the same name 
underneath an individual request act ion.  

You can insert  new header i tems from the tree-view by cl icking Visual  Navigator>Insert  Tree I tem >Ht tp 
Header. In  addit ion, you can modify the values in  the Http Header form in the right pane.  

Common Content  Checks 

Lists common content checks, which apply to al l  repl ies sent by the server. Content checks enable you to 
veri fy whether the correct  page was returned based on the existence or absence of a specific search string. 
You can also set content checks at the page level. Cl ick the Add New  Con ten t  Check  I tem  button in  the 
form-view to add new common content checks. 

Common content checks can include variables. Common content checks enable you to generate an error 
code on a set condit ion even i f no individual page-level content checks are enabled. The search string is 
compared to the raw HTML returned by the server, so you may need to include HTML tags in  your search 
to match the text that appears in  the browser. 

Transact ion Setup 

Lists any act ions that occurred before the main transact ion loop. Any i tems/act ions that occur under th is 
heading wil l  be executed after the Synchronize but before the BEGIN_TRANSACTION(); statement at 
playback. For example, you may have logged in to a part icular Web site and do not want to log in  and out 
with every transact ion at playback. You can move the Transact ion Setup i tem in the tree-view by 
h ighl ight ing it  and cl icking the Move UP/M ove DOWN buttons. The Transact ion Setup can contain cl ient 
cert i ficate tree i tems. 
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Client  Cert ificate Tree Item 

If the recorded transact ion contains a l ine with a ssl-clientcert command, then 
Visual Navigator wi l l  create a Cl ient Cert i ficate tree i tem and place i t  direct ly 
beneath the Transact ion Setup tree i tem. 

The Client Cert i ficate string can be modified or variabl ized in  the form-view. 

The Client Cert i ficate i tem can also be moved up and down the tree l ike other 
tree i tems, such as checkpoints. This al lows you to move i t  in to the Transact ion 
Loop area i f you wish to change the cert i ficate with each transact ion. 

A Client Cert i ficate i tem wil l  generate a script  l ine similar to the fol lowing: 

Set (EVERY_REQUEST, CERTIFICATE, “qaload_cl”); 
If the Requi res Passw ord check box is selected, the generated script  l ine is similar to the fol lowing: 

Set (EVERY_REQUEST, CERTIFICATE_PASSWORD, "~encr~250F7641455876"); 

Transact ion Loop 

Lists the requests in  your transact ion. Al l  i tems/act ions that occur under th is heading are placed between 
the BEGIN_TRANSACTION and END_TRANSACTION statements, causing them to be repeated for as many 
t imes as the Conductor tel ls them to be. The transact ion loop has a number of possible sub-elements, 
depending on the Web site you tested. For detai led descript ions of the elements that can be l isted in  a 
transact ion loop, see Looking at a transact ion loop. 

M ove UP/ M ove DOW N: Click the arrow to move the selected transact ion loop i tem in the tree-view up or 
down.  

The fol lowing i tems are automatical ly cleared at the end of a transact ion. When you move the transact ion 
loop, you can prevent memory leaks by select ing the i tems to clear at the end of the transact ion.  

Cook ies: Select th is checkbox to clear al l  cookies at the end of the transact ion . This checkbox outputs the 
appropriate statement for the Clear(ALL_COOKIES) statement in  the generated script . 

Cache: Select th is checkbox to clear the WWW cache at the end of the transact ion. This checkbox outputs 
the appropriate statement  for the Clear(CACHE) statement in  the generated script . 

Connect ions: Select th is checkbox to close any remain ing connect ions at the end of the transact ion. Th is 
checkbox outputs the appropriate statement for the Clear(CONNECTIONS) statement in  the generated 
script . 

Referring Page: Select th is checkbox to clear the HTML referring page at the end of the transact ion. Th is 
checkbox outputs the appropriate statement for the Clear(REFERER) statement  in  the generated script . 

Basic Authori zat ion : Select th is checkbox to clear the basic NTLM authorizat ion at the end of the 
transact ion. This checkbox outputs the appropriate statement for the Clear(BASIC_AUTH_FLAG) statement 
in  the generated script . 

Proxy Authori zat ion : Select th is checkbox to clear the proxy authorizat ion at the end of the transact ion. 
This checkbox outputs the appropriate statement for the Clear(PROXY_AUTH_FLAG) statement in  the 
generated script . 
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Transact ion Cleanup 

Lists act ions that occur after the script  has fin ished execut ing the appropriate number of t ransact ions. Any 
i tems that occur under th is heading are placed after the END_TRANSACTION statement. For example, you 
may want to log out of a part icular Web site after complet ing the appropriate number of t ransact ions.  

M ove UP/ M ove DOW N: Click the arrow to move the selected transact ion cleanup i tem in the tree-view up 
or down.  

The fol lowing i tems are automatical ly cleared at the end of a transact ion. When you move the transact ion 
cleanup i tem, you can prevent memory leaks by select ing the i tems to clear at the end of the transact ion .  

Cook ies: Select th is checkbox to clear al l  cookies at the end of the transact ion . This checkbox outputs the 
appropriate statement for the Clear(ALL_COOKIES) statement in  the generated script . 

Cache: Select th is checkbox to clear the WWW cache at the end of the transact ion. This checkbox outputs 
the appropriate statement  for the Clear(CACHE) statement in  the generated script . 

Connect ions: Select th is checkbox to close any remain ing connect ions at the end of the transact ion. Th is 
checkbox outputs the appropriate statement for the Clear(CONNECTIONS) statement in  the generated 
script . 

Referring Page: Select th is checkbox to clear the HTML referring page at the end of the transact ion. Th is 
checkbox outputs the appropriate statement for the Clear(REFERER) statement  in  the generated script . 

Basic Authori zat ion : Select th is checkbox to clear the basic NTLM authorizat ion at the end of the 
transact ion. This checkbox outputs the appropriate statement for the Clear(BASIC_AUTH_FLAG) statement 
in  the generated script . 

Proxy Authori zat ion : Select th is checkbox to clear the proxy authorizat ion at the end of the transact ion. 
This checkbox outputs the appropriate statement for the Clear(PROXY_AUTH_FLAG) statement in  the 
generated script . 

Transact ion Loop Items 

Transact ion Loop Items 

The fol lowing i tems can exist  under a Transact ion Loop i tem in the 
tree-view:  

  Synch 

   IP Spoof 

   Read Datapool 

   Checkpoint pair 

   Increment/Decrement/Reset Variable 

    Debug Print 

    Comment 

 

Synch 

Inserts a Synch  i tem immediately after the current ly selected HTML Page. A Synch  i tem represents a spot 
where al l  virtual users wi l l  pause during replay unt i l  al l  act ive virtual users have reached the same point . 
Once the virtual users are synchronized th is way, the Conductor wi l l  instruct them al l  to cont inue.  
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A Synch  i tem can be moved up or down the tree using Up/Dow n in the form-view.   

IP Spoof 

Inserts an IP Spoof  i tem immediately after the current ly selected HTML page. 

In order for IP Spoofing to work with Visual Navigator, i t  is necessary to create or insert  an exist ing local 
datapool fi le cal led IPSPOOF.dat in  the Visual Navigator tree-view. For more in formation about creat ing 
th is datapool fi le and insert ing i t , see Sett ing Up IP Spoofing.  

Read Datapool 

Opens the Datapool and Variables dialog box, al lowing you to choose which datapool to use, and then 
inserts a Read Datapool  i tem immediately after the current ly selected HTML Page. 

You can move th is i tem up or down the tree-view by cl icking Up/Dow n in the form-view. 

Checkpoint  Pair Script  Item 

Inserts a Begin  Checkpoi n t  i tem before the current ly selected HTML Page and an End Checkpoin t  after 
the current ly selected HTML Page. 

Checkpoints are used to measure durat ion t imes for certain act ions to be completed. You can move ei ther 
the Begin  or End checkpoint i tem to encompass several requests, i f necessary. To move either i tem, 
h ighl ight i t  and then cl ick M ove Up/M ove Dow n in the form-view. 

Print  Values (debugging) 

Inserts a Debug Prin t  i tem after the current ly selected HTML Page. This causes a string to be output to the 
Player window during playback. This can be useful for debugging a script  whi le you are trying to variabl ize 
i t  so that i t   replays correct ly with mult iple virtual users. 

Comment  

Inserts a Com m ent  i tem after the current ly selected HTML page. Type your comment in to the form-view 
(bottom pane). 
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HTML Pages 

HTML Page Form-view 

The form-view (bottom pane) for an 
HTML Page tree i tem contains the 
fol lowing in formation: 

Reply Status: The code designat ing 
the status of the reply. For most pages 
that were returned correct ly, th is wi l l  
be 200 OK. 

Requested URI: This read-only field 
l ists the URI which was requested that 
resulted in  th is page being displayed. 

Checkpoin t  Nam e: If the page has a t i t le, then i t  wi l l  be used as the checkpoint name. If not, the word 
Checkpoint wi l l  be used. To make sure al l  checkpoin t names are unique, a number may be appended to the 
end of the checkpoint name.  

M eta Ref resh  Requi red [  ] Seconds Before Redi rect ion : If the META Refresh opt ion was selected on the 
WWW Convert Options General dialog box, th is field displays the number of seconds that QALoad waits 
before i t  t reats a META refresh request as a normal request. This field only appears when refresh t imeouts 
are enabled. 

HTML Page Sub-items 

The fol lowing script  i tems can exist  under a Page (HTML) i tem in the Visual Navigator's tree-view. Each 
possible page sub-i tem is l isted below, along with descript ions for the fields that appear in  the form-view in 
the right pane when you select the i tem in the tree-view. 

In addit ion, a Page i tem can contain sub-i tems that you insert  manually after recording the transact ion.  

Content Check sub-i tem 

PageCheck sub-i tem 

Addit ionalSubRequests sub-i tem 

SubRequests sub-i tem 

Cookies Set by Server sub-i tem 

Sleep sub-i tem 

Fi l l  In  Form sub-i tem 

Act ion sub-i tems 
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Content Check Sub-item 

Inserts a Con ten t  Check  i tem for the current ly-selected HTML page. This veri fies that the correct page was 
returned based on the existence or absence of a part icular search string in  the server's reply for that page. 
Content checks can include variables. The search st ring is compared to the raw HTML returned by the 
server, so you may need to include HTML tags in  your search to match the text that appears in  the 
browser. 

The top pane displays the source for the HTML page. You can easi ly select text in  the top pane and add i t  
to the content check defin i t ion by cl icking the Copy f rom  Source button. 

PageCheck Sub-item 

Page Check enables you to veri fy that the t i t le of the page that was requested is correct. 

Addit ionalSubRequests Sub-item 

Some requests are contained in applets, Act iveX components, or other objects that are captured, but not 
played back by QALoad . These subrequests, which are not recognized as normal subrequests, are l isted in  
the Addi t i onalSubRequests tree i tem. 

Each addit ional subrequest i tem appears in  the script  as a pre-loaded subrequest just before the main 
act ion. As a result , the playback engine requests the main page, regular subrequests, and then the pre-
loaded subrequests. 

For example: 

//---------  REQUEST # 2  --------- 
// 
//  current page url is http://c96852d01/pda/ 
// 
// Pre-load the following image requests before the next request is made. 
// These requests seem to have been made by javascript or applets associated 
// with the next page but will not be made automatically by the replay engine, 
// hence they are here in the script. 
// 

Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/images/LeftBackgrnd.jpg"); 

Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/menuopen.gif"); 
Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/menuclose.gif"); 
Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/menuclose.gif"); 
Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/images/browsex.gif"); 

Click_On(IMAGE, 1, SRC_ATTRIBUTE, "http://c96852d01/pda/images/browse.gif"); 

SubRequests Sub-item 

Lists al l  subrequests (such as images) that the page performed in order to be ful ly rendered in the browser. 
Subrequests cannot be changed and are shown strict ly to provide detai led in formation about the requests 
that were made during the recording session. 
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Cookies Set  by Server Sub-item 

If the reply from the server for the requested page contains a Set-Cookie command, i t  is l isted here. This 
i tem cannot be modified, i t  is l isted for your in formation only.  

Sleep Sub-item 

Every page has a Sleep i tem immediately before i ts Act ion  i tem. The sleep value specifies how many 
seconds were spent viewing th is page (or fi l l ing out a form) before an act ion was taken (such as cl icking on 
a l ink or button). 

Fill In Form Sub-item 

If a requested page contains a Form (html element) that was fi l led in  by the user, then a Fi l l  In  Form  item 
and i ts associated elements wi l l  be created in  the tree-view. When th is tree i tem is selected, a bl inking 
frame wil l  appear around the form in the browser-view (top pane).  

Extract  St ring Sub-item  

Inserts an Extract String i tem when you need to extract in formation from the script  and store i t  in  a 
variable to use later in  the script .  

When an Extract String i tem is inserted in to the tree-view, the browser-view displays the HTML source for 
the page in which the i tem is inserted. The string to extract is recognized by the text preceding i t  and the 
text fol lowing i t . The test string in  between is extracted and saved into a local variable. You must specify 
the local variable that receives the extracted string at run t ime by cl icking on Select  Var. 

Frames 

When an HTML page that  is recorded contains frames, they are represented in the tree-view (left  pane) 
with a circle icon contain ing a capital F. A frame page is indented beneath the page that is i ts parent. If you 
cl ick on a frame icon in the tree-view, the corresponding frame is h ighl ighted in  the browser-view (top 
pane) with a bl inking frame around i t  for ident i ficat ion. 

Duplicated frameset pages 

Sometimes when a user cl icks on a l ink or takes some other act ion inside of a frame, the new page that was 
requested simply replaces the contents of one of the frames already shown in the browser. To indicate that 
the frameset page (the main page that holds the frames) has not changed, Visual Navigator renames i t  
Duplicated Frameset n. Where n is an ident i fying number for the frameset that is incremented as more 
frameset pages are dupl icated. 

Act ion Sub-Items 

Act ion Sub-items 

An Act ion i tem appears under each HTML Page except the last one in the script . This represents the act ion 
that the user took to get to the next page. Act ion i tems include: 
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!  NavigateTo – Visual Navigator could not determine how the user accessed the next page (they may 
have typed a URL direct ly in to the address bar, or a JavaScript may have caused the jump). 

Note: A NavigateTo item is the first element that appears under the Transaction Loop element. 
This is because when the browser is launched during recording, the user must specify a starting 
address (typically by typing it into the Address bar). 

!  Click On Link – The user cl icked on a text l ink 

!  Click On Image – The user cl icked on an image l ink 

!  Click On Button – The user cl icked on a Submit type button 

!  PostTo – Data was sent to the server with a POST command but a matching submit button was not 
found. This may have been caused by a JavaScript. 

Action i tems can contain various sub-elements. For detai ls, see Act ion i tem sub-elements. 

NavigateTo Sub-item 

Specifies a URI to be requested. If the Script  Development Workbench cannot determine how the next 
page was requested (typical ly due to a JavaScript making the request), then i t  wi l l  use a NavigateTo tree 
i tem instead of something more specific, such as a Cl i ck  On  Link . 

Click On Link Sub-item 

When the user cl icks on a text l ink or an image l ink, then a Cl ick On Link action i tem is inserted under 
that page. This is used to describe the act ion that was taken while on th is page that resulted in  the next 
page being requested. 

When a Click On Link tree-view i tem is selected, the text or image in the browser-view (top pane) is 
h ighl ighted by a bl inking frame to make i t  easier to locate. There are several types of Cl ick On Links: 

 Tex t  Links – One of the more common l inks in  web pages are Text based l inks. These usual ly 
appear as underl ined text.  

 Im age Links – An image can have a l ink, similar to text. 

 Cl ien t -Side Im age M ap – A Client-Side Image Map is an image on a page that  has mult iple 
l inks associated with i t . Each l ink is associated with a region, which can be any shape. When 
the user cl icks on the image, the browser determines which region was cl icked on and requests 
the page l inked to that region. 

 Server-Side Im age M ap – A Server-Side Image Map is an image on a page that has mult iple 
l inks associated with i t . Unl ike Cl ient-Side Image Maps, these l inks are stored on the server 
rather than the cl ient. When a user cl icks on the image, the browser sends the server the mouse 
coordinate relat ive to the top-left  corner of the image. The server then repl ies with the 
appropriate page. 

Click On Button sub-item 

Clicking on Subm i t  is usual ly associated with entering values in to a form (Fi l l  In  Form  item). When the 
Cl i ck  On  But ton  tree-view i tem is selected, the associated button in  the browser window (top pane) wi l l  be 
h ighl ighted with a bl inking frame, making i t  easier to locate. 
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PostTo sub-item 

If the recorded request was a POST request rather than a GET request and the Script Development 
Workbench could not find a matching Submit type button, then a PostTo tree act ion i tem wil l  be inserted 
under the page. This can sometimes happen i f the request is in i t iated by JavaScript. 

Act ion Item Sub-Items 

Act ion item sub-elements 

The fol lowing i tems can exist  under Act ion i tems in the tree-view:  

Http Headers sub-i tem 

Cookies sub-i tem 

CGI Parameters sub-i tem 

NTLM Authent icat ion sub-i tem 

Basic Authent icat ion sub-i tem 

  

Http Headers Sub-item 

If a header exists under an Act ion i tem, then i t  wi l l  be sent for that 
request only. If the header has the same name as one of the common 
headers, then i t  wi l l  override the common header for th is request 
only. It  is possible to insert  addit ional HTTP headers. 

 

Cookies sub-item 

When a Cookie i tem is a sub-element of an Act ion i tem, i t  contains a 
l ist  of cookie i tems that were sent in  the header of the request that 
the Act ion i tem made when recording. Cookies are added 
automatical ly by the browser based on the URI that is being 

requested. They are either set as a result  of the previous reply (the server returned a Set-Cookie command), 
or they are set by JavaScript contained in the previous reply. 

If the Cookie shown has a matching Set-Cookie i tem, then noth ing displays in  the script  since the cookie is 
created automatical ly during playback. If there is no matching Set-Cookie i tem, then a Set-Cookie type 
statement is generated in  the script . 

You can insert  addit ional cookies in to the Cookies sect ion of a page as another means of variabl izing the 
playback. How? 

CGI Parameters Sub-item 

Lists CGI parameters sent along with the request made by the Act ion i tem.  
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NTLM Authent icat ion Sub-item 

Sometimes the pages being requested require NTLM  Authent icat ion, that is, the user wi l l  be presented with 
a dialog box asking for a UserID, Password, and Domain. This in formation is recorded and l isted in  the 
tree-view under the Act ion i tem that requires i t .  

Forms 

Forms Sub-items 

Many pages that are used during a WWW load test ing session contain forms that a user must fi l l  out, and 
submit buttons that are cl icked. QALoad ident i fies forms and the elements with in them, as well  as 
determin ing which submit button was cl icked i f there is more than one. 

When a page contains a form that wi l l  be submitted, then a Fi l l  In  Form item is inserted in to that page’s 
l ist  of i tems in the tree-view (left  pane). When a Fi l l  In  Form item is selected in  the tree-view (left  pane), 
Visual Navigator h ighl ights the form with a bl inking frame in the browser-view (top pane).  

Underneath the Fi l l  In  Form item in the tree view are Form Element i tems, such as Edit  Boxes, Radio 
Buttons, and Check Boxes, represent ing elements that can appear in  forms on HTML pages. Fol lowing the 
Fi l l  In  Form item is either a Cl ick On Button i tem or a PostTo i tem.  

The fol lowing sub-i tems can appear under a Fi l l  In  Form item: 

Hidden sub-i tem 

Editbox sub-i tem 

Selectbox sub-i tem 

TextArea sub-i tem 

Checkbox sub-i tem 

Radio sub-i tem 

Hidden sub-item 

Forms can contain h idden fields that do not show up on the page. These 
fields are not visible to the end user in teract ing with the browser, but 
they may need to be variabl ized for a load test, for example a field that 
contains a session ID may need to be variabl ized.  

Form  View  Fields 

The form-view (bottom pane) for a Hidden Field element l ists the 
fol lowing in formation: 

Nam e: The name of the h idden field 
Value: The value of the h idden field. 
Al l ow  th i s h idden  f i eld to be variabl i zed: Select to variabl ize th is field. 
Cl ick the var... button to select a variable. 
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Editbox Sub-item 

One of the more common elements in  a form is an edit  box. When th is tree item is selected, QALoad wil l  
draw a bl inking frame around the appropriate edit  box in  the browser-view (top pane). The edit  box in  the 
browser-view wil l  show the value that was original ly typed in when the transact ion was recorded.  

Form View Fields 

The form-view (bottom pane) for an Edit  Box element l ists the fol lowing in formation: 

General  

Nam e: The name of the edit  box. 
Value: The value of the edit  box. Any changes made to th is field wi l l  be reflected in  the edit  box in  the 
browser window. 

M atch ing Param eter Rul es 

Rule: Lists the rules that have been created for th is variable type. These rules may or may not have been 
placed in the Rule Library. 

Appl ied to I tem : Indicates whether the rule is appl ied to th is variable. 

GoTo Rule: Goes to the individual rule under the Parameterizat ion Rules tree i tem. In the right-hand pane, 
in formation in  the M atch ing I tem  tab of the Rule Detai ls dialog box displays. 

Previous M atch : Goes to the next matching variable immediately preceding the current i tem in the script . 

Nex t  M atch : Goes to the next matching variable immediately fol lowing the current i tem in the script . 

Apply: Appl ies the rule h ighl ighted in  the l istbox to th is variable. Only one rule can be appl ied to an 
instance of a  variable. 

Undo Apply: Removes appl icat ion of the rule h ighl ighted in  the l istbox from th is variable. Other 
matching variables to which th is rule is appl ied are not affected. 

Selectbox Sub-item 

A select box is often cal led a drop down select ion box or l ist  box. The form-view wil l  appear sl ight ly 
different depending upon whether the Select Box is capable of support ing mult iple select ions or not. 

Form  View  Fields 

The form-view (bottom pane) for a Select Box element l ists the fol lowing in formation: 

Nam e: The name (in  the HTML) of the select box. 
I tem s f rom  the Select  Box : Lists the i tems present in  the Select Box in  the browser-view. An i tem has a 
checkbox next to i t  to indicate i f i t  has been selected. To change a select ion, select or clear the checkbox. 
Your choices wil l  be reflected in  the browser. If the Select Box only supports one select ion, then only the 
most recent select ion is selected. 
Variabl i zed Select ions: Edit  boxes that al low the use of variables (local or from a datapool) to specify what 
opt ions are chosen from the Select Box. For a mult iple select ion Select Box, i t  is possible to add up to six 
variables in  addit ion to any i tem chosen using the check boxes.  

For a single select ion Select Box, a single edit  box is provided to al low you to use a variable (local or from a 
datapool) to specify the opt ion you want chosen from the Select Box.  
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TextArea Sub-item 

A Text Area i tem is a multi-l ine text box. 

Form View Fields 

The form-view (bottom pane) for a TextArea element l ists the fol lowing in formation: 

General  

Nam e: The name of the Text Area field. 
Value: The value of the Text Area field. Any changes you enter in to th is edit  box are reflected in  the 
browser-view (top pane). To enter a l inefeed, press Ctrl+Enter. 

M atch ing Param eter Rul es 

Rule: Lists the rules that have been created for th is variable type. These rules may or may not have been 
placed in the Rule Library. 

Appl ied to I tem : Indicates whether the rule is appl ied to th is variable. 

GoTo Rule: Goes to the individual rule under the Parameterizat ion Rules tree i tem. In the right-hand pane, 
in formation in  the M atch ing I tem  tab of the Rule Detai ls dialog box displays. 

Previous M atch : Goes to the next matching variable immediately preceding the current i tem in the script . 

Nex t  M atch : Goes to the next matching variable immediately fol lowing the current i tem in the script . 

Apply: Appl ies the rule h ighl ighted in  the l istbox to th is variable. Only one rule can be appl ied to an 
instance of a  variable. 

Undo Apply: Removes appl icat ion of the rule h ighl ighted in  the l istbox from th is variable. Other 
matching variables to which th is rule is appl ied are not affected. 

Checkbox Sub-item 

The form-view (bottom pane) for a Checkbox element l ists the fol lowing in formation: 

Nam e: Name of the Checkbox. 
Value: Value of the Checkbox. 
State: Reflects whether the box is checked (selected) or not. If the State is 1 (checked), then the Name and 
Value are passed along in the request to the server. If the State is 0 (not checked) then the Name and Value 
are not passed along. You can change the value of the State by cl icking on the checkbox control in  the 
browser-view (top pane). 

Radio Sub-item 

Form View Fields 

The form-view (bottom pane) for a Radio Button element l ists the fol lowing in formation: 

General  

Group Nam e: The Group Name is shared by al l  radio buttons that belong to the same group. 
Value: The Value field is what different iates one radio button from another. The group name and value of 
the selected radio button wil l  be sent along with the request to the server. The Value of a radio button can 
be, and often is, di fferent than the text shown in the browser. 
use th i s val ue but ton : When you select a radio but ton in  the browser-view (top pane) i ts value wil l  display 
in  th is text box. Cl ick th is button to transfer th is value in to the above Value field. 

M atch ing Param eter Rul es 
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Rule: Lists the rules that have been created for th is variable type. These rules may or may not have been 
placed in the Rule Library. 

Appl ied to I tem : Indicates whether the rule is appl ied to th is variable. 

GoTo Rule: Goes to the individual rule under the Parameterizat ion Rules tree i tem. In the right-hand pane, 
in formation in  the M atch ing I tem  tab of the Rule Detai ls dialog box displays. 

Previous M atch : Goes to the next matching variable immediately preceding the current i tem in the script . 

Nex t  M atch : Goes to the next matching variable immediately fol lowing the current i tem in the script . 

Apply: Appl ies the rule h ighl ighted in  the l istbox to th is variable. Only one rule can be appl ied to an 
instance of a  variable. 

Undo Apply: Removes appl icat ion of the rule h ighl ighted in  the l istbox from th is variable. Other 
matching variables to which th is rule is appl ied are not affected. 

XML Requests 

XML Document-view 

When you cl ick on an XML Request i tem in the tree-view (left  pane) the right pane becomes a document-
view displaying a tree-view of detai ls about the XM L document requested or returned as the result  of an 
XML request. Each individual XML item appears as a node in the XML document tree. XML elements can 
have chi ld elements and these appear as chi ld nodes of the XML element. Attributes of an element appear 
as chi ld nodes of the element, with the attribute value appearing as a chi ld of the attribute name. 

What if no XML data is associated with a request? 

If there is no XML document associated with the XML request (for example, an HTTP GET) a message 
indicat ing that there is no XML to be displayed is shown in the XML document-view. 

How does the document-view relate to the form-view? 

Select ing an i tem in the XML document tree displays the form-view detai ls corresponding to that XML 
element type in the bottom pane. 

Fol lowing is an example of XML request data displayed in a port ion of the XML document-view: 

 

XML Form-view 

When an XML request is displayed in the document-view (top pane) — as a result  of an XML request i tem 
or XML reply chi ld i tem being selected in  the Visual Navigator tree-view — you can cl ick on i tems in the 
document-view to display in formation about each in the form-view (bottom pane). If no XML item is 
selected in  the document-view, the XML Page form-view displays instead. For XML items, the form view 
display opt ions depend on two th ings: 
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!  what type of XML item is selected in  the Visual Navigator tree-view (left  pane): an XML request or 
an XML reply 

!  what type of XML item is subsequently selected in  the XML document-view (top pane) 

When an XML item is selected in  the XML document-view, the value of that XML item is displayed in an 
edit  box in  the form-view. Some values — attribute values and text values — can be edited or variabl ized 
(that is, subst i tut ing one or more variables for the value in  an XML request or select ing the return value 
from an XML reply i tem to be received by a variable for later use in  the script). Text i tems, which are values 
between element tags, and attribute values represent volat i le i tems in an XML document structure, used for 
passing values to and from Web Services, for example. 

The fol lowing tables l ist  the possible act ions for XML items displayed in a form-view. Val id act ions are 
determined by the XML item type and whether the i tem is from an HTTP POST request or from an HTTP 
reply. 

In  the fol lowing tables: 

!  If an i tem is editable, the value in  the form-view can be changed and the new value is used during 
replay. 

!  If a value can be variablized, a variable can be subst i tuted for al l  or part  of the value. The variable's 
value is placed in the variable's locat ion at replay. An example is a value received from an i tem 
from a previous XML document reply. 

!  If a variable can receive a replay value, the return value for the i tem can be placed into a selected 
variable during replay. The variable can then be subst i tuted for an input value in  a later XML 
request . 

XM L Request  I tem s 

XM L Request  I tem  Edi table? Can  the Value 
be Variabl i zed? 

Declarat ion No No 

DTD (Document 
Type Defin i t ion) 

No No 

PI (Processing 
Instruct ion) 

No No 

Comment No No 

Element No No 

Attribute (Name) No No 

Attribute (Value) Yes Yes 

Text Yes Yes 

 
XM L Reply I tem s 

XM L Request  I tem  Can  Variable 
Receive Replay 

Value 

Declarat ion No 
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DTD (Document Type 
Defin i t ion) 

No 

PI (Processing 
Instruct ion) 

No 

Comment No 

Element No 

Attribute (Name) No 

Attribute (Value) Yes 

Text Yes 
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Par am et er i zat ion  in  t he Visual  Navig at or  

Parameterizat ion  
Parameterizat ion is the process of subst i tut ing certain values in  a script  with variables you define. 
Parameterizat ion is used in Visual Script ing for WWW scripts.  

When you modify QALoad scripts before replaying them, the modificat ions usual ly are repet i t ive and 
consistent. Parameterizat ion provides the means for replacing values with system-generated variables 
throughout your scripts. The values for variables are derived from a datapool, an extract string, or a 
calculated value.  

Methods for Parameterizing a Script  

Values in  a script  that you can parameterize are noted in  the form-view (bottom pane) with the var... 
button next to the field. This gives you access to the Datapool and Variables dialog box, where you can 
define values for variables.  

Certain values in  the script  support the Variable Replacement Wizard. The Variable Replacement Wizard 
simpli fies the process of parameterizat ion by taking you through the necessary steps for defin ing variables 
for the fields you want to replace. Fields for which the Variable Replacement Wizard is avai lable are shown 
in the form-view with Var Wiz... button next to the field. 

Saving Parameters as Rules 

You can create and maintain a table of the variables you define by storing them as rules in  the Rule 
Library. Once stored, the script   looks for these rules and replaces the value wi th the parameters you assign 
to that rule.  

Using Variables with Visual Navigator 

Overview of Variables 

When you record a transact ion, the result ing script  is a recording of the act ions of a single end-user. When 
you play back that script  mult iple t imes during a load test, you probably want i t  to emulate the act ions of 
multiple users making differing requests of your server instead of the single user that was recorded. One way 
to achieve that is to replace certain data with a variable that draws i ts value from a l ist  of values that you 
provide. Here are some examples of why and how you might use variables in  a script : 

!  If your original script  recorded a user logging on to a si te using an ID and password, you can 
replace the ID and password with variables in  the script . At test t ime, those variables draw their 
values from a datapool fi le of acceptable values, using a different set of values for each transact ion 
run. In  other words, that one script  could emulate a number of different users by ut i l izing a 
different user ID/password combinat ion for each transact ion. 

!  If your script  inserted new records in to a customer database, you might want the names to be 
unique each t ime the script  is run (each transact ion). You could create a datapool fi le of names, 
and then insert  a variable in to the script  where the name was typed. At test t ime, the variable 
inserts a different name from the datapool fi le with each transact ion. 

!  If an ID string is returned from the server and that ID is then used as part  of future requests to the 
server, and each virtual user may get back a differen t ID from the server, you can use a variable to 
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use a specific ID. You could extract an ID from the reply, place i t  in to a variable, and then use the 
value in  that variable in  place of the actual ID for future requests, ensuring you only use the ID you 
specify. 

There are a number of values in  your script  that can be replaced with variables. Those values are noted in  
the  form view (bottom pane) with var.... Values that use the Variable Replacement Wizard are shown in 
the form view with Var Wiz. Typical ly variables derive their values from a datapool an extracted string, or 
a calculated value. 

Naming Variables 

When you first  create a datapool fi le, the included variables are automatical ly assigned the default  names 
Var1, Var2, Var3, and so forth.  

QALoad al lows you to rename those variables with meaningful names that can even include spaces. This 
makes i t  much easier to work with datapools. For example, you could name a datapool variable something 
logical l ike City, rather than trying to remember that Var4 in  your datapool is the City variable. 

Renaming Variables 

You can quickly and easi ly rename local or datapool variables from the tree-view. Simply h ighl ight the 
variable under the Datapool Fi les or Variables tree-view i tem, and then change the variable name in the 
result ing form-view (bottom pane). 

You can also edit  from the Datapools and Variables dialog box. To access i t , right-cl ick anywhere in  the 
tree-view and then choose Datapools and Variables from the shortcut menu. Highl ight the variable to 
rename and cl ick Renam e.  

Datapools and Variables 

Datapools and variables can be added or modified by several methods. To simply create, delete, or modi fy 
datapool fi les and variables at any t ime while a script  is open in the editor, choose Visual  
Navigator>Datapools an d Variables from the menu to access the Datapools and Variables dialog box.  

Alternately, the same dialog box wil l  open automat ical ly whenever you are asked to choose a variable or 
datapool fi le whi le working with the script , al lowing you to create the variables you need on-the-fly.  

Data that can be variabl ized is denoted in the form-view (bottom pane) by the var... button. Cl icking 
the var... button wil l  open the Datapools and Variables dialog box. 

Types of Variables 

Types of Variables 

When values in  a script  are replaced with variables, the variables typical ly are derived from extract strings, 
datapools, or calculated variables. 

Ex t ract  St r i ngs 

Insert  an Extract String i tem when you need to extract in formation from a reply and store i t  in  a variable to 
use in  future requests or simply for logging the in formation. For example, i f a string is located inside a 
JavaScript or in  a h idden tag that is not visible in  the browser, and i t  m ight change each t ime th is page is 
requested, use an Extract String to extract the value. Extract strings search on the text preceding and the 
text fol lowing the string you want to extract.  

Datapools 
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Datapools draw values from a fi le of acceptable values and use a different set of values each t ime a 
parameter is replaced. You can select an exist ing datapool fi le or create a new datapool fi le to add to your 
script  from your datapool directory. Each datapool has a l ist  of variables under i t  represent ing columns in 
the datapool fi le. When you create a datapool, you specify the number of columns (variables) and rows 
(values) i t  contains.  

The datapool fi le you choose is added to your script  and is l isted under Datapool Fi les in  the Visual 
Navigator tree-view.  You can choose to add a central or local datapool to a script .  

Note: You can have only one central datapool file associated with a script, but can have any number of 
local datapool files.   

Central 

Central datapools are Conductor-based. They reside on the same workstat ion as the QALoad Conductor, 
and are avai lable to any Player system on the network that requests i t  from the Conductor. You can apply 
only one central datapool  fi le to a script . 

Local 

Local datapools are Player-based. They reside on a Player workstat ion, and are only avai lable to that Player. 
You can apply any number of local datapool fi les to a script . 

Calculated Variables 

Calculated variables are generated dynamical ly at runt ime and are based on a formula you define. For 
example, you might want  each virtual user to have a unique string, such as Smith1, Smith2, and so forth, 
or you may want to calculate a new value each t ime through the transact ion loop.  

Calculated variables are strings bui l t  from one or more elements. These can include datapools, local 
variables, and text, as well  as the fol lowing:  

Date and Time 

Insert  the date and t ime in the format you select. 

Random Alphanumeric 

Subst i tutes the value with random alphanumeric characters at runt ime. Specify the type and length of 
characters to use. You can select: let ters only, numbers only, or both let ters and numbers. 

The value can be a fixed length, where you specify the number of characters, or variable length, where you 
specify the min imum and maximum number of characters. 

Random Numeric 

Subst i tutes the value with a random number at runt ime. You specify the min imum value, maximum value, 
the number of decimal places, and the number of leading digits. Numbers generated with fewer leading 
digits are padded with zeros.  

Local Variable 

A variable with a stat ic value that you set when you create i t . 

Virtual User Number 

The number used to ident i fy the virtual users during a test. You can include a virtual user number (VU) in  
the calculat ion. VUs may be absolute (assigned by the Conductor) or relat ive (assigned by the Player at 
runt ime). 

Absolute 
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The absolute virtual user number is assigned by the Conductor based on the total number of virtual users 
on al l  Players. Each virtual user is assigned a number and no numbers are repeated. Insert  an absolute 
virtual user number when i t  is necessary to use a completely unique virtual user number in  place of a 
variable.  

Relat i ve 

The relat ive virtual user number is the number assigned to the virtual user by i ts Player. Because a test has 
mult iple Players and each Player assigns virtual user numbers from 0-n, a relat ive virtual user number is 
only unique on a single Player. 

Local  Variable 

A local variable is a stat ic value that you can subst i tute wherever variables can be used. You can quickly 
add local variables to your script  from the Visual Navigator tree-view. Insert  Increment Variable, 
Decrement Variable, and Reset Variable i tems into the tree-view to manipulate the value of any variables. 

About Extract Strings  

Insert  an Extract String i tem in your script  when you need to replace a system-generated value or reuse a 
system-created value later in  a script . You can extract in formation from a reply and store i t  in  a variable to 
use in  future requests. For example, i f a system-created order number is assigned during a transact ion that 
must be used again later in  the transact ion, you can use an Extract String to store the value and insert  i t  
in to the script  at  the appropriate point. 

When you select text to store in  an extract string, Visual Navigator uses 10 or more characters on either 
side of the extracted text to make the search string unique and find th is copy of the extracted text. You can 
increase or decrease the size of the strings.   

About Local Variables 

A local variable has a constant value that you assign  when you create the variable. It  can be subst i tuted 
wherever variables can be used. You can quickly add local variables to your script  by right-cl icking in  the 
Visual Navigator tree-view and select ing Datapools and Variables.  

Note: You can insert Increment Variable, Decrement Variable, and Reset Variable items into the tree-view to 
manipulate the value of any variables. 

Edit ing Variables 

Adding a Variable 

Add variables to the script  from the Visual Navigator tree-view. Types of variables are: 

!  Local variables 

!  Datapools 

!  Calculated variables 

!  Extract Strings 

Note: You can insert Increment  Variable, Decrement  Variable, and Reset  Variable items into the tree-
view to manipulate the value of any variables. 

 

 

 



QALoad 05.06 Using the Player, Script  Development Workbench, and Analyze 

186 

Using the Rule Library 

Overview of the Rule Library 

You can save variable replacements you define as rules. These are stored in  the Rule Library, where you can 
use them in future recordings and reduce repet i t ive parameterizat ion tasks.  

When subsequent captures are converted, the Visual  Navigator scans the Rule Library for matching 
parameters. For example, i f a rule parameterizes the value of a CGI Parameter named SessionID, the Visual 
Navigator scans through the Visual Tree for any CGI Parameters that match the descript ion defined in the 
rule. If a match is found, the rule is added to the Visual Tree, where you can apply i t  to the script . 

From the Rule Library, you can create rules, edit  rules, and view detai ls of individual rules and the folders 
in  which they are stored. 

Elements of the Rule Library Dialog Box 

Create or modify parameter rules from the Rule Library dialog box. The dialog box contains the fol lowing 
areas:  

!  Menus 

!  Tree view 

!  Detai ls 

Rule Library Menus 

M en u Com m and Descript i on  

Fi l e New  Rule - Opens the Rule Creat ion Wizard. Use the wizard to 
define a rule that you can use to parameterize future scripts. 

New  Folder - Creates a new folder in  the tree-view.  

Edi t  Use the Edit  menu to cut, copy, paste, delete, or rename rules. 

Rule Edi t  Rule - Opens the Rule Creat ion Wizard so you can edit  a 
rule you select in  the Rule Library. 

Help Displays QALoad help. 

Rule Library Tree-View 

The Rule Library tree-view displays a h ierarchical view of al l  rules and folders with in the Rule Library.  
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Rule Library Dialog Box Details  

The Detai ls area of the Rule Library dialog box displays in formation on the rules defined in the Rule 
Library. There are two levels of detai l : 

!  Folder - When you select a folder name in the Rule tree, the Detai l s area of the dialog box displays 
in formation for each rule in  the folder.  

!  Individual Rule - When you select a rule in  a folder in  the Rule tree, the Detai l s area of the dialog 
box displays in formation for the individual rule in  three tabs.  

Applying a Rule  

When you define values to replace variables in  a script , you can save them as rules and apply them to other 
scripts. 

To apply a rule f rom  t he Visual  Tree: 

1. In  the Visual Navigator vistree, cl ick the Param eter i zat ion  Rules script  i tem and select the rule to 
apply. A descript ion of the rule displays in  the form-view. 

2. Click the M atch ing I tem s tab. The propert ies that determine the matching i tems and each 
matching i tem found in the script  display. 
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3. Do one of the fol lowing: 

!  Click Apply Rule on the left-hand side of the dialog box to apply the rule to al l  the 
matching i tems. 

!  Select an i tem or i tems in the table and cl ick Apply to I tem  on the right-hand side of the 
dialog box . 

 Note: When a different rule has been applied to an individual item, a red exclamation mark (!) appears 
next to the item in the table. Only one rule can be applied at a time. Click Go to Item and review the 
information in the Matching Parameter Rules area of the form-view to view the rule applied to the item. 

To apply a rule f rom  t he f orm -view  f or  a var iable: 

1. In  the Visual Navigator vistree, select the variable to which you want to apply the rule. 

2. In  the M atch ing Param eter Rules area at the bottom of the form-view (right-hand pane), select 
the rule you want to apply. 

3. Click Apply. The rule is appl ied to the variable. 

Edit ing a Rule  

Follow these steps to edit  rules stored in  the Rule Library. 

To edi t  a rule: 

1. Select a rule in  the Rule Library visual t ree, and cl ick Rule>Edi t  Rule. The Rule Creat ion Wizard 
opens and displays the in formation on the rule you selected. 

2. Follow the procedure for creat ing a rule to make changes to the rule elements. 
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Sam p le Scr ip t s 

Overview — Sample Scripts 
This sect ion shows examples of how you can manipulate converted scripts to address specific si tuat ions or 
resolve certain problems. Samples include examples of variabl izat ion, changes to transact ion logic, and 
detai led descript ions of commonly used commands. Sample scripts are shown for these middlewares: 

Citrix 

Oracle Forms Server 

SAP 

Winsock 

WWW 

 

Cit rix Scripts 

Cit rix Script  Samples 

You can address specific si tuat ions or resolve certain  problems by modifying converted Citrix scripts.  

Tips: Uppercase characters are not captured when the CAPS Lock key is on. Manually modify the script to 
use uppercase characters or hold down the SHIFT key during recording. 
Similarly, the Windows Logo key is not supported. Do not use the Windows Logo key to start applications 
while recording a Citrix script. 

The scripts l isted below include a descript ion of the problem, the procedure for implementing the 
modificat ion, and samples of a modified script .  

Handl ing Citrix Server Farms 

Handling Dynamic Window Tit les 

Handling Intermit tent Windows 

Handling Unexpected Events 

Moving Citrix Connect and Disconnect Outside the Transact ion Loop 

Script ing Mouse Act ions 

Using the CtxWaitForScreenUpdate Command 

Flushing Past Events from the Internal Queue 

Handling Cit rix Server Farms 

Handling Citrix Server Farms 

Citrix servers can be grouped in farms. When load test ing, you may want to connect to a Citrix server farm 
rather than to a specific server. Load test ing requirements may include connect ing to a Citrix server farm, 
where the load balancing feature supports dynamic redirect ion to a given server at connect ion t ime. This 
load tests the server farm and Citrix load balancing rather than a single server, which can provide a more 
real ist ic load test.   
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To record a script  that connects to a farm, you must use an ICA fi le to connect. However, when a capture 
takes place, a specific server (in  the farm) must have a connect ion. Specify the correct ICA fi le to connect 
to the server farm as well  as a specific server with in that server farm.  

To veri fy that your script  is connect ing to a server farm and not a specific server, assign the server name to 
one blank space when val idat ing the script . In  order to record a script  that connects to a farm, you must 
use an ICA fi le specified in  the Citrix Record Options dialog. Since the ICA fi le should contain al l  the 
necessary connect ion in formation, the server field should be left  blank when recording.  

When converted, the CitrixServer variable has a blank space: 

. 

. 

. 

/* Declare Variables */ 
const char *CitrixServer   = " "; 
const char *CitrixUsername = "citrix"; 
const char *CitrixPassword = "~encr~657E06726F697206"; 
const char *CitrixDomain   = "qacitrix2"; 
const int CitrixOutputMode = OUTPUT_MODE_NORMAL; 

. 

. 

. 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("Orders.cpp"); 

CitrixInit(4); 

/* Citrix replay settings */ 

CtxSetConnectTimeout(90); 
CtxSetDisconnectTimeout(90); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetDomainLoginInfo(CitrixUsername, CitrixPassword, Citrix-Domain); 
CtxSetICAFile("PRD desktop.ica"); 
CtxSetEnableCounters(TRUE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 

SYNCHRONIZE(); 

 

The Citrix cl ient ignores th is value and uses the ICA fi le to dynamical ly retrieve the server name at 
playback t ime. 

Conclusion  

When you use these techniques to set up a Citrix server farm test script , you al low for dynamic server 
redirect ion at playback as part  of test ing a load balanced Citrix server farm.  

Handling Dynamic Window Tit les 

Example One 

Script  Sam ples: Exam ple One - Using a Subst r ing M atch  
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In  th is example, the M icrosoft  Word appl icat ion generates a dynamic t i t le. The dynamic name is a 
concatenat ion of the default  document that Word creates at appl icat ion startup with the name of the 
appl icat ion.  

Original Window Tit le (Record)  “ M icrosoft  Word”  

Actual Window Tit le (Val idat ion) “ document1 - M icrosoft  Word”  

Actual Window Tit le (Val idat ion) “ document 2 - M icrosoft  Word”  

The script  is altered to reflect the fact that the string “ M icrosoft  Word”  is always part  of the window t i t le. 
 The asterisk (*) wi ldcard is subst i tuted for the default  document name. 

“ Match Pattern”  from window 
t i t les 

 “ * - M icrosoft  Word”  

Example Two 

Script  Sam ples: Exam ple Tw o - Using a Wi ldcard M atch  

In th is example, the Sample Appl icat ion generates a dynamic t i t le. The dynamic name is the name of the 
appl icat ion fol lowed by the t ime the script  is created.  

Original Window Tit le (Record)  “ Sample Appl icat ion – 09:01:23 AM”  

Actual Window Tit le (Val idat ion) “ Sample Appl icat ion – 11:00:04 AM”  

Actual Window Tit le (Val idat ion) “ Sample Appl icat ion – 12:20:52 PM”  

The quest ion mark (?) wi ldcard is subst i tuted for a given t ime. 

“ Match Pattern”  from window 
t i t les 

“ Sample Appl icat ion – ??:??:?? ?M”  

Handling Intermit tent  Windows 

Modifying the Script for Intermittent Windows 

Windows that don't  appear when a script  is recorded can appear in termit tent ly during replay. One 
example commonly encountered with Citrix is the ICA Seamless Host Agent window.  If an unexpected 
window appears at val idat ion or playback, you must modify the script  to handle the window event.  

To simpli fy the script ing process, record a temporary session and convert  i t  to a script . This should be a 
session where the unexpected window appears so that the user must in teract, for example, with a mouse 
cl ick or keyboard entry, to dismiss the in termittent window. Note the locat ion in  the playback script  where 
the presence of the in termit tent window prevented the script  from cont inuing. This is where code is added 
to the script .   

Do the fol lowing i f a val idat ion or playback session indicates an unexpected window appeared that 
requires user in teract ion:   

!  Record a temporary script  where the unexpected window event appears.  

!  Convert the original session to a script . 

!  Modify the original script  with a sect ion of the temporary script . 
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To record a t em porary scr ip t : 

Simpli fy  the script ing effort  required by doing the fol lowing: 

1. Record a temporary session of the transact ion. This should include the appearance of the 
in termit tent window and the subsequent user in teract ion that dismisses the window.   

2. Add a comment when the window appears and before the window is dismissed. 

3. Give the successful record session a temporary name.   

4. Click Opt ions>Convert , and cl ick OK to convert  the session to a script . 

To m odi f y t he or ig inal  scr ip t : 

Extract a small  sect ion of the temporary script  code and insert  i t  in to the original script . 

1. Ident i fy the locat ion in  the original script  where the unexpected window appeared.  You can do 
th is by not ing the last window that was successful ly created before val idat ion fai lure.  

Tip: Note the location with a code-style comment. This is the location where you paste in code from the 
temporary script. 

2. Ident i fy the code in the temporary script  that creates the Citrix window object.  This code is in  the 
sect ion labeled /* Citrix Window Information Objects */  and can be ident i fied by the name 
parameter.   

3. Cut and paste th is l ine in to the corresponding sect ion in  the original script .   

4. Modify the l ine pasted in to the original script ,  giving the statement a unique Citrix window 
ident i fier.   

Note: This identifier, CWI_n, must be a unique value in the original script or the script will not compile.   

5. Find the l ine in  the temporary script  that deletes the Citrix window object. This code is after the 
END_TRANSACTION cal l .   

6. Copy th is l ine to the same locat ion in  the original script  and modify i t  with the unique Citrix 
window ident i fier from Step 4. 

7. Add a special version of the CtxSetWindowMatchTit le command in the original script  in  the 
locat ion where the original script  fai led because of the in termit tent window.   

This is where the window must be recognized and dismissed, i f i t  exists. The first  parameter is the 
Citrix window object ident i fier from Step 2. The second parameter is an asterisk enclosed in double 
quotes (“ *” ). This parameter ensures that commands l ike CtxClick work with any matched window, 
even i f the in termit tent window does not exist . 

9. Ident i fy the code that dismisses th is window in the temporary script  by scrol l ing to the comment 
you inserted during capture, and backtracking unt i l  you find the correct CtxWaitForWindowCreate 
statement. Usual ly th is code consists of either a set of CtxPoint and CtxClick or one or more 
keyboard entry cal ls after the window create event.    

Caut ion: Do not include the CtxWaitForWindowCreate statement. 

10. Copy the code from the temporary script  and paste i t  after the CtxSetWindowMatchTit le cal l  added 
in Step 5. Ensure that the Citrix window object parameter for these cal ls is the Citrix window 
object ident i fier from Step 2. 

Conclusion  

Fol lowing these techniques, you can modify a session to handle the appearance of in termit tent windows 
that require user act ion to dismiss. The sample scripts i l lustrate th is process. 

Sample original script  
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Sample temporary script  

Sample modified script   

Handling Unexpected Events 

Modifying the Script to Handle Unexpected Events 

Unexpected Citrix events that were not recorded in the original script  can occur during a playback session . 
These can include Intermit tent Windows or appl icat ion windows that may appear based on the user’s 
session state. For example, the calculator appl icat ion may already be present when the Citrix user logs on a 
session, or the user may need to invoke the appl icat ion.  

When there is the possibi l i ty of unexpected events occurring, you must modi fy the script  to respond to the 
changes and cont inue the load test. Use the CtxWindowEventExists funct ion to create a condit ional block 
of code that handles the unexpected dialogs.   

When you modify a script  to handle unexpected events, you must: 

!  Perform an in i t ial  val idat ion of the script . 

!  Record a temporary script  to capture the unexpected event. 

!  Modify the original script  to include and handle the unexpected event. 

!  Re-val idate the script . 

Note: You may need to configure the workbench and player for validation. 

To per f orm  an in i t ial  val idat ion: 

1. Click Session>Val idate to val idate the script . This is when an unexpected event can cause sporadic 
fai lure during val idat ion or playback.  

2. Ident i fy the sporadic event visual ly so that you can recognize i t  in  a later record session . 

To record a t em porary scr ip t : 

1. Click Opt ions>Record to record a second script  that recreates the unexpected event.  Successive 
sessions should be recorded unt i l  the unexpected event occurs.  

2. Insert  comments at two points:  

 Where the event is fi rst  recognized. 

 Where the event is acted on and the Citrix session state and any window states have 
returned to the state before the event occurred.  

Note: You may need to position the mouse over a window or control, such as a button, before inserting 
the second comment. (See Scripting Mouse Events.)  

3. Give th is capture a name to denote th is session’s temporary status. 

4. Click Opt ions>Convert , then cl ick OK to convert  the session to a script . 

To m odi f y t he or ig inal  scr ip t  w i t h code f rom  t he t em porary scr ipt : 

Fol low these steps to insert  script  code from the temporary script  that handles the unexpected event.  

1. Insert  a code comment in  the original script  where the unexpected event occurred. 
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2. Copy the code between the two comments in  the temporary script  and paste i t  in to the original 
script  at  the locat ion of the unexpected event you ident i fied.  

Note: Comments ensure that the pasted code is clearly marked in the script.   

3. Ident i fy any Citrix window objects that exist  in  API cal ls in  the pasted code snippet. For each 
object, do one of the fol lowing: 

 If the window object is whol ly contained, both created and destroyed, in  the pasted code 
snippet: 

a. Ident i fy the Citrix window creat ion and delet ion l ines of code in the temporary script .   

b. Copy these l ines to the original script . This is the creat ion l ine in  the /* Citrix Window 
Information Objects */  sect ion and the delet ion l ine after the END_TRANSACTION cal l .   

c. Give the Citrix window object variable a unique variable name.   

d. Change al l  variable references to the Citrix window in the pasted code snippet API cal ls to 
the new variable name. 

 If the window object referenced in a pasted API cal l  is an act ion on an exist ing window object 
in  the original script , modify al l  API cal ls in  the pasted cal ls to refer to the variable name of the 
Citrix window object in  the original script . 

4. Before the code snippet, add a condit ional check to see i f the unexpected window event has 
occurred. Use the CtxWindowEventExists API cal l  in  an If condit ional, where i f the result  is TRUE, 
a block of code is executed. Then add a BeginBlock on the next l ine. BeginBlock is logical ly 
ident ical to the C begin brace “ {“ . 

5. After the code snippet, add an EndBlock. EndBlock is logical ly ident ical to the C end brace “ }“ . 

Note: If there is code in the original script that should not be executed if the condition is TRUE, 
 put this code in an Else block within the BeginBlock and EndBlock calls. 

To re-val idat e t he scr ipt : 

1. Click Session>Com pi le to compile the script  after making script ing changes. 

2.  Cl ick Session>Val idate Script  to val idate the script .  Make sure that val idat ion succeeds when the 
unexpected event occurs and when the event does not occur. 

Conclusion  

Fol lowing these techniques, you can modify scripts to handle unexpected events that occur during 
playback.  Script ing around unexpected events al lows you to perform load test ing for complex user 
scenarios. The fol lowing sample scripts i l lustrate th is process: 

Sample original script  

Sample modified script   

Script ing Mouse Act ions 

Modifying the Script for Controlling Mouse Actions  

Changes to screen resolut ion or server sett ings can cause the appearance, size, and locat ion coordinates of 
a window to differ from the expected behavior in  the recorded script . By sett ing Display coordinate 
tool t i p on  r i gh t -cl i ck  opt ion  in  val idat ion  w indow  in the Convert  Opt ions dialog box, you can right-
cl ick the mouse at the desired locat ion to extract screen coordinate values that correspond to buttons and 
other controls in  real t ime during val idat ion .  

To modify a script  to retrieve coordinate values, you must: 
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!  Validate the sett ings. 

!  Modify the script . 

To val idat e t he set t ings: 

1. Click Opt ions>Convert , and cl ick the Ci t r i x  tab.  

2. Ensure that the Display coordinate tool t i p on  r i gh t -cl i ck  opt ion  in  val i dat ion  w indow  
checkbox is selected.  

3. Set Replay output  m ode to Normal. 

4. Click OK to convert  the script . 

  

During val idat ion, a right mouse-cl ick results in  a toolt ip display of the screen coordinate values. You can 
use these values in  a manually added CtxPoint cal l  to ensure that the mouse is moved to these coordinates 
before any subsequent mouse cl ick act ions. 

Tip: Make a note of these coordinate values, since this tooltip is not logged. 
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To m odi f y t he scr ipt : 

Once you determine the correct mouse coordinates from val idat ion, modify the script .  

1. Add or modify the CtxPoint command. 

2. Insert  the new values in to the script . 

Conclusion  

Fol lowing these techniques, you can retrieve screen coordinates at val idat ion and insert  them into a script . 
This corrects mouse behavior as a result  of changes to the server sett ings or the user session environment. 
The sample scripts, showing added CtxPoint and CtxMouseClick, and modified CtxPoint, i l lustrate these 
techniques. 

Sample: Script Snippet with Modified CtxPoint 

The fol lowing sample shows a script  extract with a modified CtxPoint command. Comments and added 
script  l ines are h ighl ighted in  bold. 

Sam ple Script  
…beginning of script… 

DO_MSLEEP(1844); 
// Window CWI_10 ("") destroyed 1113840796.133 
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DO_MSLEEP(1828); 

/// Modifying a CtxPoint is easy once you have the 
/// target coordinates and have identified the  
/// CtxClick statement that was failing. Just 
/// insert the X and Y coordinates as the parameters. 

CtxPoint(200, 200);  //1113840798.309 
 
DO_MSLEEP(344); 
CtxClick(CWI_5, 78, L_BUTTON, NONE); //1113840798.387 

…end of script… 

OFS Scripts 

Oracle Forms Server Script  Samples 

You can address specific si tuat ions or resolve certain  problems by modifying converted Oracle Forms Server 
(OFS) scripts. The samples shown here include a descript ion of the problem, the procedure for 
implementing the modificat ion, and samples of a modified script . Script  modificat ions are discussed for: 

Parameterizat ion of Login Credent ials 

Changing Accessibi l i ty Options in  Oracle EBS-12 

SAP Scripts 

SAP Script  Samples  

You can address specific si tuat ions or resolve certain  problems by modifying converted SAP scripts. The 
samples shown here include a descript ion of the problem, the procedure for implementing the 
modificat ion, and samples of a modified script . Script  modificat ions are discussed for: 

Checking and Handling SAPGuiCheckScreen Errors 

Checking the SAP Status Bar 

Extract ing a String from a SAP Control 

Extract ing a Unique String from a SAP Control 

Handling Mult iple SAP Logons in a Single Script  

Implementing Content Check of a SAP Control 

Required SAP Commands to Support Transact ion Restart  

Required SAP Script Commands 

Retrieving SAP Counter Data 
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Checking the SAP Status Bar 

Overview: Checking the Status Bar 

The SAP status bar displays error and status messages. When running an SAP script , you can check the 
status bar to determine whether the script  is execut ing properly.  

 

Conclusion  

Use the SAPGuiCheckStatusbar command to test for certain status responses in the SAP environment and 
take act ions based on messages returned from the SAP server. The sample script  i l lustrates th is procedure. 

See Also 

SAP Scripts Overview 

 

Sample Script: Checking the SAP Status Bar  

The SAPGuiCheckStatusbar command is used in the fol lowing script  example to test for certain status 
responses. The code added to check the status bar is shown in bold. 

Sam ple Script  
... 
SAPGuiPropIdStr("wnd[0]");//1109615021.466 
SAPGuiCmd1(GuiMainWindow,SendVKey,4); 
SAPGuiCheckScreen("PA40","SAPMP50A","Personnel Actions");  //1109615021.481 
 
DO_SLEEP(15); 
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SAPGuiPropIdStr("" 
   "wnd[1]/usr/tabsG_SELONETABSTRIP/tabpTAB001/ssubSUBSCR_PRESEL:SAPLSDH4:0220/sub:" 
"SAPLSDH4:0220/txtG_SELFLD_TAB-LOW[0,24]" ); //1109615036.231 
SAPGuiCmd1(GuiTextField,PutText,"pan"); 
SAPGuiCmd1(GuiTextField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[1]/tbar[0]/btn[0]");//1109615036.246 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("PA40","SAPLSDH4","Restrict Value Range"); //1109615036.246 
 
// Check to determine if the name we chose is found in db 
// If not stop the script should not continue 
BOOL bRetSts =  
SAPGuiCheckStatusbar("wnd[0]/sbar", "No values for this selection"); 
if (bRetSts) 
{ 
    RR__printf(" No such last name in Database"); 
    SAPGui_error_handler(s_info," End Now No such name in Database"); 
} 
... 

Extract ing a St ring from a SAP Control 

Overview: Extracting a String from a SAP Control 

When running an SAP script , you may want to get the control ’s text.  

For example, in  the fol lowing screen, after Chi ld1 Col. 2 is selected, the right table is fi l led in  with data by 
the SAP server. You can use the in formation as needed.  

 

Use the SAPGuiGetControlText command to extract  data from a SAP server returned control. The sample 
script  i l lustrates th is procedure. 

Sample: Extracting a String from a SAP Control 

The fol lowing sample script  shows the SAP commands required  to extract a data string from a returned 
control in  an SAP environment. You can use SAPGuiGetControlText to get the content of the Even t  nam e 
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textfield. Use convert  opt ion I nser t  SAP cont r ol  comment s:  al l  cont r ol s to output al l  controls as 
comment.  

Sam ple Script  
 

SAPGuiPropIdStr("wnd[0]/usr/cntlTREE_CONTAINER/shellcont/shell" 
        );//1152817068.134 

SAPGuiCmd2(GuiCtrlTree,SelectItem,"Child1","Column2"); 
SAPGuiCmd2(GuiCtrlTree,EnsureVisibleHorizontalItem,"Child1","Column2"); 
SAPGuiCmd2(GuiCtrlTree,PressButton,"Child1","Column2"); 
SAPGuiCheckScreen("DWDM","SAPCOLUMN_TREE_CONTROL_DEMO","SAP");//1152817068.321 
 

// *SAP* GuiMenubar   name="mbar"   Id="wnd[0]/mbar" 
// *SAP* GuiMenu   name="System"   Id="wnd[0]/mbar/menu[0]" 
// *SAP* GuiMenu   name="Create Session"   Id="wnd[0]/mbar/menu[0]/menu[0]" 
// *SAP* GuiMenu   name="End Session"   Id="wnd[0]/mbar/menu[0]/menu[1]" 
// *SAP* GuiMenu   name="User Profile"   Id="wnd[0]/mbar/menu[0]/menu[2]" 

                        ….. 
                      // *SAP* GuiLabel   name="%#AUTOTEXT004" 
  Id="wnd[0]/usr/lbl%#AUTOTEXT004" 

// *SAP* GuiTextField   name="G_EVENT"   Id="wnd[0]/usr/txtG_EVENT" 
// *SAP* GuiLabel   name="%#AUTOTEXT002"   Id="wnd[0]/usr/lbl%#AUTOTEXT002" 
// *SAP* GuiTextField   name="G_NODE_KEY"   Id="wnd[0]/usr/txtG_NODE_KEY" 
// *SAP* GuiLabel   name="%#AUTOTEXT005"   Id="wnd[0]/usr/lbl%#AUTOTEXT005" 

// *SAP* GuiTextField   name="G_ITEM_NAME"   Id="wnd[0]/usr/txtG_ITEM_NAME" 
// *SAP* GuiLabel   name="%#AUTOTEXT006"   Id="wnd[0]/usr/lbl%#AUTOTEXT006" 
// *SAP* GuiTextField   name="G_HEADER_NAME"   Id="wnd[0]/usr/txtG_HEADER_NAME" 
// *SAP* GuiStatusbar   name="sbar"   Id="wnd[0]/sbar" 
// *SAP* GuiStatusPane   name="pane[0]"   Id="wnd[0]/sbar/pane[0]" 
// *SAP* GuiStatusPane   name="pane[1]"   Id="wnd[0]/sbar/pane[1]" 
// *SAP* GuiStatusPane   name="pane[2]"   Id="wnd[0]/sbar/pane[2]" 
// *SAP* GuiStatusPane   name="pane[3]"   Id="wnd[0]/sbar/pane[3]" 
// *SAP* GuiStatusPane   name="pane[4]"   Id="wnd[0]/sbar/pane[4]" 
// *SAP* GuiStatusPane   name="pane[5]"   Id="wnd[0]/sbar/pane[5]" 

        // Check the event name 
char * strEvent = SAPGuiGetControlText("wnd[0]/usr/txtG_EVENT", "GuiTextField"); 
RR__printf(" The Event Name: %s", strEvent); 
free(strEvent); 

 

Required SAP Script  Commands 

Overview: Required SAP Script Commands 

Certain commands must be present in  an SAP script . These commands are created automatical ly during the 
conversion process. Most of the commands are before the BEGIN_TRANSACTION statement. Review th is 
sect ion i f you are having unexpected issues after script  edit ing. 

Note: If the SAP script supports transaction restarting, review Required Commands for Supporting 
Transaction Restart in SAP.   

Requi red Scri pt  Com m ands 

Required commands and associated code statements for the SAP script  are:    

SET_ABORT_FUNCTION(abort funct ion); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoIn it ial ize(0); 

i f( hr != ERROR_SUCCESS ) 

    RR__FailedMsg(s_info, "ERROR in it ial izing COM"); 
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SAPGuiSetCheckScreenWildcard(‘*’); 

SYNCHRONIZE(); 

Note: These functions are required, but additional SAP API script commands are also essential to run an 
SAP script. 

Conclusion  

When encountering unexpected compiler errors after script  edit ing, review the script  to ensure al l  required 
commands are present. This might reveal a problem created by the script  edits, especial ly when moving the 
transact ion loop. You must take care when doing extensive script  edit ing not to accidental ly remove 
cri t ical commands. Recording the transact ion again and doing a windiff comparison can also help when 
unexpected compiler errors occur. 

The sample script  shows the statements used in the script . 

Sample: SAP Script with Commands 

The fol lowing sample is a SAP Script with required commands. Required commands in the script  are 
h ighl ighted in  bold. 

Sam ple Script  

/* 
 *  capture.cpp 
 * 
 *  Script Converted on July 20, 2004 at 08:43:23 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 73 
 * 
 *  This script contains support for the following middlewares:  
 *      - SAP 
 */ 

/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Constants to Variables           : Yes 
 *  Remove Quotes                    : No 
 *  Tabs To Spaces                   : No 
 *  Auto Checkpoints                 : No 
 * SAP 
 *  Version                          : 6204.119.32 
 */ 

#define SCRIPT_VER 0x00000205UL 

#include <stdio.h> 
#include <windows.h> 
#include <atlbase.h> 
#include <objbase.h> 
#include "do_SAPCCOM.h" 
#include <atlwin.h> 
#include <atlcom.h> 
#include <atlhost.h> 
#include "cscript.h" 
#include "do_SapGui.h" 
#include "mwCommon.h" 

extern "C" { 
#include "smacro.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
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#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 

/// These script functions in bold must be present and  
/// before the SYNCHRONIZE command in every SAP script. 

ACTION(); 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 

    RR__FailedMsg(s_info,"SAP: ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 
 
SYNCHRONIZE(); 

BEGIN_TRANSDO_SetTransactionStart(); 

try{ 

SAPGuiConnect( s_info,"testsap620"); 

SAPGuiApplication(RegisterROT); 
 
SAPGuiVerCheckStr("6204.119.32");  
 
//Set SapApplication = CreateObject("Sapgui.ScriptingCtrl.1") 
//SapApplication.OpenConnection ("testsap620") 
//Set Session    = SapApplication.Children(0).Children(0) 
 
DO_SLEEP(18); 
 
SAPGuiPropIdStr("wnd[0]");//1057828784.513 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(16); 
 
SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME");//1057828800.786 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 
 
SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE");//1057828800.796 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~0000x_'9d"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[0]");//1057828800.836 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP");//1057828800.856 
 
DO_SLEEP(6); 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(3); 
 
SAPGuiPropIdStr("wnd[0]/tbar[0]/btn[15]");//1057828809.839 
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SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSMTR_NAVIGATION","SAP Easy 
Access");//1057828809.859 
 
DO_SLEEP(2); 
 
SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1");//1057828811.382 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off");//1057828811.402 
 
} // end try 

catch (_com_error e){ 
char buffer[1024]; 
sprintf(buffer,"SAP: EXCEPTION 0x%x  %s for VU(%i)\n",e.Error(), (char 
*)e.Description(), S_task_id); 
SAPGui_error_handler(s_info,buffer); 
} // end catch 

DO_SetTransactionCleanup(); 

SAPGuiApplication(RevokeROT); 
 
END_TRANSACTION(); 

REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 

Retrieving SAP Counter Data 

Modifying the Script to Retrieve SAP Counter Data 

SAP scripts can retrieve customer counter in formation for each virtual user. By insert ing code snippets that 
use the SAPGui script ing API in to the SAP script , you can obtain and save SAP server in formation.  

To m odi f y t he scr ipt  t o ret r ieve SAP count er  dat a: 

1. Declare and in i t ial ize the counter ident i ficat ion (ID) variables using the in t  data type. You should 
declare a variable for each counter value to be extracted. The DEFINE_COUNTER macro in i t ial izes the 
declared counter ident i fier variable and creates a holder for the value in  the t im ing fi le. 

2. Declare and in i t ial ize the variable to hold the actual  SAP counter value. You should  declare the 
variable using a datatype that can hold any expected value for the counter. Usual ly a long is 
appropriate.  

3. Retrieve the counter in formation from the SAP server using the SAPGuiSessionInfo command. The 
value is placed in the variable you created in  Step 2. The first  parameter is the SAP property object 
corresponding to the counter. The second parameter is the variable to hold the value.  

4. Save the counter value to the t im ing fi le. The COUNTER_VALUE macro command extracts the value 
from the server.  The value is extracted to the variable created in  Step 2. It  is stored in  the t im ing fi le 
using the associated ID created in  Step 1.  
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Conclusion  

Fol lowing these techniques, you can obtain customer counter in formation from the SAP server, save i t  to 
the virtual user’s t im ing fi le, and view i t  in  Analyze. The sample original script  and sample modified script  
i l lustrate th is modificat ion.  

Sample: Original SAP Script with Counters 

The fol lowing sample shows an original SAP script  extract with counters. Points of in terest in  the script  are 
h ighl ighted in  bold. 

Sam ple Script  

/* 
 *  counters.cpp 
 * 
 *  Script Converted on July 20, 2004 at 08:43:23 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 73 
 * 
 *  This script contains support for the following middlewares:  
 *      - SAP 
 */ 

/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Constants to Variables           : Yes 
 *  Remove Quotes                    : No 
 *  Tabs To Spaces                   : No 
 *  Auto Checkpoints                 : No 
 * SAP 
 *  Version                          : 6204.119.32 
 */ 

#define SCRIPT_VER 0x00000205UL 

#include <stdio.h> 
#include <windows.h> 
#include <atlbase.h> 
#include <objbase.h> 
#include "do_SAPCCOM.h" 
#include <atlwin.h> 
#include <atlcom.h> 
#include <atlhost.h> 
#include "cscript.h" 
#include "do_SapGui.h" 
#include "mwCommon.h" 

extern "C" { 
#include "smacro.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 

/// Declare the SAP custom counter variable IDs 
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/// Also declare any SAP counter value variables. 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("counters.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"SAP: ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 

/// Initialize the SAP custom counter variable IDs. 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 

try{ 

SAPGuiConnect( s_info,"testsap620"); 

SAPGuiApplication(RegisterROT); 
 
SAPGuiVerCheckStr("6204.119.32");  
 
//Set SapApplication = CreateObject("Sapgui.ScriptingCtrl.1") 
//SapApplication.OpenConnection ("testsap620") 
//Set Session    = SapApplication.Children(0).Children(0) 
 
DO_SLEEP(18); 
 
SAPGuiPropIdStr("wnd[0]");//1057828784.513 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(16); 
 
SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME");//1057828800.786 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 
 
SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE");//1057828800.796 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~0000x_'9d"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[0]");//1057828800.836 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP");//1057828800.856 
 
DO_SLEEP(6); 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(3); 
 
SAPGuiPropIdStr("wnd[0]/tbar[0]/btn[15]");//1057828809.839 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSMTR_NAVIGATION","SAP Easy 
Access");//1057828809.859 
 
DO_SLEEP(2); 
 
SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1");//1057828811.382 
SAPGuiCmd0(GuiButton,Press); 
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/// This is where we would like to retrieve the RoundTrips  
/// and Flushes counter.  Here the SAPGuiSessionInfo command  
/// will be inserted to retrieve these SAP counter values from the server. 

SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off");//1057828811.402 

/// Here is where the counter information will actually be  
/// written to the timing file.  
 

} // end try 

catch (_com_error e){ 
char buffer[1024]; 
sprintf(buffer,"SAP: EXCEPTION 0x%x  %s for VU(%i)\n",e.Error(), (char 
*)e.Description(), S_task_id); 
SAPGui_error_handler(s_info,buffer); 

} // end catch 

DO_SetTransactionCleanup(); 

SAPGuiApplication(RevokeROT); 
 
END_TRANSACTION(); 

REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 

Sample: Modified SAP Script with Custom Counters 

The fol lowing sample shows a modified SAP script  with SAP custom counters. Changes to Original script  
are h ighl ighted in  bold. 

Sam ple Script  

/* 
 *  counters.cpp 
 * 
 *  Script Converted on July 20, 2004 at 08:43:23 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 73 
 * 
 *  This script contains support for the following middlewares:  
 *      - SAP 
 */ 

/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Constants to Variables           : Yes 
 *  Remove Quotes                    : No 
 *  Tabs To Spaces                   : No 
 *  Auto Checkpoints                 : No 
 * SAP 
 *  Version                          : 6204.119.32 
 */ 

#define SCRIPT_VER 0x00000205UL 
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#include <stdio.h> 
#include <windows.h> 
#include <atlbase.h> 
#include <objbase.h> 
#include "do_SAPCCOM.h" 
#include <atlwin.h> 
#include <atlcom.h> 
#include <atlhost.h> 
#include "cscript.h" 
#include "do_SapGui.h" 
#include "mwCommon.h" 

extern "C" { 
#include "smacro.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 

/// Scripting: Step 1 

int id1, id2, id3, id4; 
long lRoundTrips,lFlushes; 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("counters.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"SAP: ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 

/// Scripting: Step 2 

// "Counter Group", "Counter Name", "Counter Units 
// (Optional)", Data Type, Counter Type. 

id1 = DEFINE_COUNTER("Cumulative Group", "Cumulative RoundTrips", 0, DATA_LONG, 
COUNTER_CUMULATIVE); 

id2 = DEFINE_COUNTER("Cumulative Group", "Cumulative Flushes", 0, DATA_LONG, 
COUNTER_CUMULATIVE); 

id3 = DEFINE_COUNTER("Instance Group", "Instance RoundTrips", 0, DATA_LONG, 
COUNTER_INSTANCE); 

id4 = DEFINE_COUNTER("Instance Group", "Instance Flushes", 0, DATA_LONG, 
COUNTER_INSTANCE); 

 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
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try{ 

SAPGuiConnect( s_info,"testsap620"); 

SAPGuiApplication(RegisterROT); 
 
SAPGuiVerCheckStr("6204.119.32");  
 
//Set SapApplication = CreateObject("Sapgui.ScriptingCtrl.1") 
//SapApplication.OpenConnection ("testsap620") 
//Set Session    = SapApplication.Children(0).Children(0) 
 
DO_SLEEP(18); 
 
SAPGuiPropIdStr("wnd[0]");//1057828784.513 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(16); 
 
SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME");//1057828800.786 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 
 
SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE");//1057828800.796 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~0000x_'9d"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[0]");//1057828800.836 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP");//1057828800.856 
 
DO_SLEEP(6); 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(3); 
 
SAPGuiPropIdStr("wnd[0]/tbar[0]/btn[15]");//1057828809.839 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSMTR_NAVIGATION","SAP Easy 
Access");//1057828809.859 
 
 
DO_SLEEP(2); 
 
SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1");//1057828811.382 
SAPGuiCmd0(GuiButton,Press); 

/// Scripting: Step 3 

SAPGuiSessionInfo(GetRoundTrips,lRoundTrips); 
SAPGuiSessionInfo(GetFlushes,lFlushes); 

SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off");//1057828811.402 
 
/// Scripting: Step 4 

COUNTER_VALUE( id1,lRoundTrips); 
COUNTER_VALUE( id2,lFlushes); 
COUNTER_VALUE( id3,lRoundTrips); 
COUNTER_VALUE( id4,lFlushes); 

} // end try 

catch (_com_error e){ 
char buffer[1024]; 
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sprintf(buffer,"SAP: EXCEPTION 0x%x  %s for VU(%i)\n",e.Error(), (char 
*)e.Description(), S_task_id); 
SAPGui_error_handler(s_info,buffer); 

} // end catch 

DO_SetTransactionCleanup(); 

SAPGuiApplication(RevokeROT); 
 
END_TRANSACTION(); 
REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 

Winsock Scripts 

Winsock Script  Samples  

You can address specific si tuat ions or resolve certain  problems by modifying converted Winsock scripts. 
These samples show a descript ion of the problem, the procedure for implementing the modificat ion, and 
samples of a modified script . Script  modificat ions are discussed for: 

Handling Winsock Connect ion Problems 

Accessing Local and Remote Network Addresses 

Using Central Datapools with in a Winsock Script 

Using Local Datapools with in a Winsock Script 

Accessing Server Replies with DO_WSK_Read 

Accessing Server Replies with DO_WSK_Recv 

Receiving Winsock UDP Data with DO_WSK_Recvfrom 

Sending Variable Data with DO_WSK_Send 

Sending Variable Data using DO_WSK_SendAll  

Sending Variable Data using DO_WSK_SendTo 

Sending Variable Data using DO_WSK_Write 

Accessing Server Replies Using Response() and ResponseLength() 

Parsing Server Replies Using ScanFloat and ScanInt 

Parsing Server Replies Using ScanSkip and ScanString 

Parsing Server Replies Using SkipExpr and ScanSkip 
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Accessing Local and Remote Network Addresses  

You can retrieve the IP address or port  to which a socket handle is connected, or retrieve the IP address and 
port  to which a socket handle is bound. The sample script  i l lustrates how to retrieve and store socket 
address and port  in format ion. The required code is shown in bold.  

Sample Script 
... 
/* Declare Variables */ 

//Belows are two socket structs that will store the address and port information. 
struct sockaddr_in RemoteAddr; 
struct sockaddr_in LocalAddr; 
… 
BEGIN_TRANSACTION(); 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_TCP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
/* Socket S2 was bound to address 0.0.0.0 on port 3320 (hibyte=12,lobyte=248) */   

//Called after the DO_WSK_Bind() to see which address the socket was bound to 
LocalAddr.sin_addr.s_addr = ntohl(GetLocalAddr(S1)); 

//Called after the DO_WSK_Bind() to see which port the socket was bound to 
LocalAddr.sin_port  = GetLocalPort(S1); 

DO_WSK_Connect(S1, "10.4.26.24", 80, AF_INET); 

//Called to retrieve the remote address that S1 is connected to. 
RemoteAddr.sin_addr.s_addr = ntohl(GetRemoteAddr(S1)); 

//Called to retrieve the remote port that S1 is connected to. 
RemoteAddr.sin_port = ntohs(GetRemotePort(S1)); 

//The function below will print the remote and local address and port information 
// to the playerbuffer. Within the RR__printf() the script is using the socket function 
// “inet_ntoa()” to convert the IP from an unsigned long to a string 
// format, “XXX.XXX.XXX.XXX”. 
RR__printf("Remote: address=%s port=%d",inet_ntoa(RemoteAddr.sin_addr), 
RemoteAddr.sin_port); 
RR__printf("Local: address=%s port=%d",inet_ntoa(LocalAddr.sin_addr), LocalAddr.sin_port); 

DO_WSK_Closesocket(S1); 

… 
Conclusion 

When th is code is executed, a message is prin ted to the playerbuffer, such as: 

VU  0 : Remote: address=10.4.26.24 port=80 

VU 0 : Local: address=10.15.16.26 port=1125 

Parsing Server Replies Using ScanFloat  and ScanInt   

Sometimes local appl icat ions must in terpret and act on numeric values sent from a remote appl icat ion. For 
example, remote appl icat ions may send a port  number to the local appl icat ion. The local appl icat ion parses 
the remote port  from the data i t  receives and attempts to connect to the remote machine on the new port .  

By using ScanInt(), you can parse the received buffer for numeric values, such as port  numbers, or use 
ScanFloat() to parse for larger numeric values. The sample script  i l lustrates how to use ScanFloat() and 
ScanInt(). The required code is shown in bold. 
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Sample Script 

... 

/* Declare Variables */ 

//The variable "port" was declared to store the port# that the remote 

// application sends. The variable "nID" is used to store the unique 

// ID that is sent by the remote application. 

unsigned short port; 

float nID; 

... 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_TCP); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 

DO_WSK_Connect(S1, "10.15.21.225", 33, AF_INET); 

 

/* 11 bytes: "port=\nA\0\0aB" */ 

 

//Since the end of the data that is being received is dynamic, the 

// script will use DO_WSK_Read() to receive the data instead 

// using the DO_WSK_Expect() that was converted into the script. 

//DO_WSK_Expect(“B”); 
DO_WSK_Read(S1,11); 

//Calling ScanSkip to move the pointer to the first byte of the port 

ScanSkip(5); 

 

//Calling ScanInt to copy the next two bytes into a variable that will 

// store the port from the remote application. 

ScanInt(MyByteOrder(),2,(char*)&port); 

 

//Calling ScanFloat to copy the next four bytes into a variable that will 

// store the unique ID from the remote application. 

ScanFloat(MyByteOrder(),4,(char*)&nID); 

//Printing the port number to the playerbuffer window, and converting  

// the value from network byte order to host byte order. 

RR__printf("port=%d",ntohs(port)); 

//Printing the unique ID that the remote application sent to the  

// playerbuffer. 

RR__printf("float=%f",nID); 

DO_WSK_Closesocket(S1); 

//Below is the original DO_WSK_Connect that was converted into the script 

//DO_WSK_Connect(S2,”10.15.21.225”, 2526, AF_INET); 
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//Uses the port that was returned above to reconnect to the remote application 

DO_WSK_Connect(S2, "10.15.21.225", ntohs(port), AF_INET); 

DO_WSK_Send(S2,"Hello World"); 

DO_WSK_Closesocket(S2); 

... 

Conclusion 

In th is example, the script  parses the port  number sent from the remote appl icat ion and uses th is to 
reconnect to the remote appl icat ion. The script  also uses ScanFloat() to parse a unique ID from the message 
sent by the remote appl icat ion. 

Parsing Server Replies Using ScanSkip and ScanString  

Data returned from the server may be too dynamic to base your parsing on actual characters. In  th is case, 
 you can base your search on character posit ions using ScanSkip() and ScanString().  

For example, you can save characters 20 through 25 that are returned from a server. The ScanSkip() skips 
the specified number of characters in  the in ternal buffer that stores the response received in the 
DO_WSK_Expect(). The ScanString() scans the number of characters you specify in to a character string 
from the current posit ion in  the buffer.  

In  th is sample,  the buffer returned from the server is xxx123456789yyy. You are retrieving the value 
between xxx and yyy. The required code is shown in bold. 

Sample Script 

... 

/* Declare Variables */ 

//Variable to store the string that we are searching for. 

char temp[15]; 

… 
BEGIN_TRANSACTION(); 

… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 

 

DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

 

DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

 

//Below is the actual data that was returned at capture time. 

/* 16 bytes: xxx0123456789yyy */ 

DO_WSK_Expect(S1, "yyy"); 

//making sure that all of the data within our variable has been initialized  

memset(temp,'\0',15); 

//skips 3 bytes within the buffer that was received. 
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ScanSkip(3);  

 

//copies the next 10 bytes of the buffer that was received into our temp variable 

ScanString(10,temp); 

//Displays the string that was found to the playerbuffer window. 

RR__printf("string=%s",temp); 

DO_WSK_Closesocket(S1); 

... 

Conclusion 

In th is example, the message “ string=0123456789”  is prin ted to the player buffer window. 

Receiving Winsock UDP Data with DO_WSK_Recvfrom  

When the appl icat ion you are capturing is using the UDP protocol, you can use the DO_WSK_Recvfrom() 
to receive data from the remote appl icat ion. The sample script  i l lustrates how to use the Do_Wsk_Recvfrom 
(). The required code is shown in bold. 

Sample Script 

... 

/* Declare Variables */ 

//The variable strBuf is used to formulate the dynamic data that is  

// sent in the DO_WSK_Sendto() below. 

char strBuf[256]; 

//RemoteAddr stores the remote applications address and port 

struct sockaddr_in RemoteAddr; 

//nBytes is used to stor the number of bytes that were received via DO_WSK_Recvfrom() 

int nBytes = 0; 

… 
BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_DGRAM, IPPROTO_UDP); 

 

DO_WSK_Bind(S1, "10.15.16.26", 333); 

 

//Receives data via the UDP protocol 

DO_WSK_Recvfrom(S1,strBuf,(struct sockaddr*) &RemoteAddr, 256, 0, &nBytes);  

 

//Prints to the player buffer the number of bytes that were received and 

// the remote address and port that sent them. 

RR__printf("Received %d bytes from %s:%d", 

nBytes, inet_ntoa(RemoteAddr.sin_addr),  

ntohs(RemoteAddr.sin_port)); 

… 
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DO_WSK_Closesocket(S1); 

Conclusion 

This example shows how to use DO_WSK_Recvfrom() to receive UDP protocol data. It  shows how to access 
the address and port  of the remote appl icat ion sending the data. 

Sending Variable Data with DO_WSK_Send  

Captured data may not be the data you want to use while running a test. For example, you might change 
the user name sent during capture t ime to a differen t value during replay. You can change the value in  the 
DO_WSK_Send() to make a stat ic value with in the funct ion. However, i f you want to subst i tute a different 
value each t ime, you can create a dynamic variable, such as a datapool value, to replace the user name.  

In  th is example, the script  includes a DO_WSK_Send() that sends “ name=Jim”  to the server as the user 
name. For test ing purposes, you want to change the name to include a variable that represents a different 
name, such as “ Mark” . The code required for th is is shown in bold. 

Sample Script 

…  

/* Declare Variables */ 

//Below are variables needed for the dynamic data. The size of these 

//variables will depend upon how big the buffer is that you are replacing 

char buffer[65]; 

char sendbuffer[65]; 

… 
BEGIN_TRANSACTION(); 

… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 

 

DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

 

DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

 

//Below is the original send based upon the capture file. 

// DO_WSK_Send(S1,"name=Jim"); 

//The script will now create a buffer that is different than what was captured, 

//and if we wanted the string “Mark” could also of been a datapool value. 
strcpy( buffer, "Mark"); 

sprintf( sendbuffer, "name=%s", buffer); 

//The script will now send the variable string that was created above 

DO_WSK_Send(S1, sendbuffer); 

/* 2 bytes: ok */ 

DO_WSK_Expect(S1,"ok"); 



Script Development Workbench 

215 

DO_WSK_Closesocket(S1); 

Conclusion 

In th is example, the user name sent to the server is changed from “ name=Jim”   to “ name=Mark”  by 
modifying the buffer before the DO_WSK_Send() and passing the new buffer as the second parameter of 
the DO_WSK_Send(). 

Sending Variable Data using DO_WSK_SendAll  

When only a port ion of a string that the script  is sending must be modified to make i t  dynamic, using the 
DO_WSK_SendAll() can be easier than modifying the DO_WSK_Send().  

The fol lowing example sends the username “ Bob”  and the password “ CPWR”  to the server to logon. Since 
only one instance of th is user can be logged on to the server, you must modify the script  to read different 
user names and passwords from a datapool before sending i t . In  the sample script  sn ippet, the required 
code is shown in bold. 

Sample Script 

... 

BEGIN_TRANSACTION(); 

//Reads in a datapool record to be used to make the username and password dynamic. 

GET_DATA(); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 

 

DO_WSK_Bind(S2, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Connect(S2, "10.0.6.32", 80, AF_INET); 

 

//In the string that was sent below "Bob" and "CPWR" both need to be modified 

// to allow for multiple users to execute this script. 

/* 20 bytes */ 

//DO_WSK_Send(S2, "^@user=Bob^@pwd=CPWR^@\377"); 

 

//Using DO_WSK_Sendall the message that is being sent can easily be modified, so 

// that the script can read in the username and password from a datapool file. 

DO_WSK_SendAll(S2,5, "^@user", VARDATA(1), "^@pwd=", VARDATA(2), "^@\377"); 

/* 15 bytes: SID=1234567890^@ */ 

DO_WSK_Expect(S2, "^@"); 

 

DO_WSK_Closesocket(S2); 

... 

Conclusion 

In the sample modified script , the user name and password are read in from a datapool fi le and the data is 
sent using the DO_WSK_SendAll(). 
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Sending Variable Winsock UDP Data 

Captured data may not be the data that you want to use while running a test. For example, you may want 
to subst i tute a user name sent during capture with a different value each t ime during replay. You can do 
th is using a dynamic variable, such as a datapool variable.  

Note: Changing the value located in the DO_WSK_Sendto() makes the value static within the function.  

In  th is sample, the code in bold below shows how change data values. 

Sample Script 

... 

/* Declare Variables */ 

//The variable strBuf is used to formulate the dynamic data that is  

// sent in the DO_WSK_Sendto() below. 

char strBuf[24]; 

…  
BEGIN_TRANSACTION(); 

//Reads in a row of data from a central datapool file, and this will be 

//used as part of the dynamic data that will be sent via the DO_WSK_Sendto() 

GET_DATA(); 

DO_WSK_Socket(S1, AF_INET, SOCK_DGRAM, IPPROTO_IP); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_BROADCAST, 1); 

 

DO_WSK_Bind(S1, "127.0.0.1", 5634); 

 

//Below is the original DO_WSK_Sendto() that was converted into the script 

//DO_WSK_Sendto(S1, "name=Brian", "10.25.26.24", 1234); 

//The example below reads a record in from a central datapool, and the value 

// is then sent as part of the DO_WSK_Sendto() buffer. 

memset(strBuf, 0, 24); 

sprintf(strBuf, "name=%s", VARDATA(1)); 

DO_WSK_Sendto(S1, strBuf, "10.25.26.24",  1234); 

… 
DO_WSK_Closesocket(S1); 

… 

Conclusion 

In th is example, the virtual user reads in  a row of data from a central datapool, which is used to create a 
dynamic message. This message is used in the DO_WSK_Sendto() to send i t  to the address “ 10.25.26.24” . 

Sending Variable Data using DO_WSK_Write  

You can use DO_WSK_Write() instead of DO_WSK_Send() when coding scripts by hand. DO_WSK_Write() 
does not expect strings that have certain control and nul l  characters encoded, as does DO_WSK_Send(). 
This al lows you to send data without using EscapeStr() to encode any possible control characters.  
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The sample script  i l lustrates how to use DO_WSK_Write(). The required code is shown in bold. 

Sample Script 

... 

/* Declare Variables */ 

//Variable that will be used to send data to the server via DO_WSK_Write() 

char temp[24]; 

... 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 

DO_WSK_Bind(S2, ANY_ADDR, ANY_PORT); 

DO_WSK_Connect(S2, "10.4.26.24", 60, AF_INET); 

 

//The original data that was sent was... "^@user=Bob^@pwd=CPWR^@", and the 

// ^@ are encoded null characters. The function below constructs the same 

// data that was sent without the data being encoded. 

memcpy(temp,"\0user=Bob\0pwd=CPWR\0", 19); 

/* 19 bytes */ 

//The DO_WSK_Send() below was converted to the script from the capture file. 

//DO_WSK_Send(S2, "^@user=Bob^@pwd=CPWR^@"); 

 

//Since the script is now using DO_WSK_Write() to send the data it does not 

//need to call EscapeStr() to encoded the NULL characters within the string 

//that is being sent. 

DO_WSK_Write(S2,temp, 19); 

/* 15 bytes: SID=1234567890^@ */ 

DO_WSK_Expect(S2, "^@"); 

DO_WSK_Closesocket(S2); 

... 

Conclusion 

In the sample script , the data was sent using the DO_WSK_Write() instead of the DO_WSK_Send(). This 
al lows you to send data without encoding i t .  

Using Central Datapools within a Winsock Script   

You can use dynamic data in  your script  by reading data from a datapool fi le. However, datapool fi les must 
be in  an ASCII string, and not al l  dynamic data are in  th is format. For example, when the string 
 “ \ 121\ 101\ 114\ 157\ 141\ 144”  appears in  a datapool fi le and is read in using a one of the datapool 
funct ions, you receive \ \ 121\ \ 101\ \ 114\ \ 157\ \ 141\ \ 144 as the output.  

You can ensure that the output string you receive is accurate by using the OctalToChar() to convert  any 
octal sequences into their binary representat ion. In  th is sample script , the string 
“ \ 121\ 101\ 114\ 157\ 141\ 144”  is read in from a central datapool fi le and converted to i ts binary 
representat ion. The required code is shown in bold. 
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Sample Script 

/* Declare Variables */ 

//Variable declared to store the central datapool record. 

char temp[40]; 

… 
BEGIN_TRANSACTION(); 

//Gets a row of data from the Conductor during the test. 

GET_DATA(); 

… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 

 

DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

//Read the first column from the central datapool row that was  

//returned when the GET_DATA() was called. 

strcpy(temp,VARDATA(1)); 

 

//used to convert octal strings to their binary format 

OctalToChar(temp);  

//The script is now setup to send the data that was read in from the 

//central datapool file instead of the hard coded values that were captured. 

DO_WSK_Send(S1,temp); 

//Below is the original send that was captured. 

//DO_WSK_Send(S1,”\121\101\122\165\156”); 
DO_WSK_Closesocket(S1);  

Conclusion 

In th is example, the DO_WSK_Send() sends the octal representat ion for the string “ QALoad” , 
 “ \ 121\ 101\ 114\ 157\ 141\ 144” , to the server.  

Using Local Datapools within a Winsock Script   

You can use dynamic data in  your script  by reading data from a datapool fi le. However, datapool fi les must 
be in  an ASCII string, and not al l  dynamic data are in  th is format. For example, when the string 
 “ \ 121\ 101\ 114\ 157\ 141\ 144”  appears in  a datapool fi le and is read in using a one of the datapool 
funct ions,  you receive \ \ 121\ \ 101\ \ 114\ \ 157\ \ 141\ \ 144 as the output.  

You can ensure that the output string you receive is accurate by using the OctalToChar() to convert  any 
octal sequences into their binary representat ion. In  th is sample script , the string 
“ \ 121\ 101\ 114\ 157\ 141\ 144”  is read in from a local datapool fi le and converted to i ts binary 
representat ion. The required code is shown in bold. 

Sample Script 

//This is used as an easy to remember descriptor for the datapool file. 
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#define DP1 1/* Identifier for a datapool file*/ 

/* Declare Variables */ 

//Variable declared to store the local datapool record. 

char temp[40]; 

… 
//Opens the datapool file 

OPEN_DATA_POOL("datapool.dat", DP1, TRUE) 

BEGIN_TRANSACTION(); 

//Reads a row of data in from the datapool file that was opened above 

READ_DATA_RECORD(DP1); 

… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 

 

DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

//Read the first column from the local datapool row that was  

//returned when the READ_DATA_RECORD () was called. 

strcpy(temp, GET_DATA_FIELD(DP1, 1)); 

 

//used to convert octal strings to their binary format 

OctalToChar(temp);  

//The script is now setup to send the data that was read in from the 

//local datapool file instead of the hard coded values that were captured. 

DO_WSK_Send(S1,temp); 

//Below is the original send that was captured. 

//DO_WSK_Send(S1,”\121\101\122\165\156”); 

DO_WSK_Closesocket(S1);  

Conclusion 

In th is example, the DO_WSK_Send() sends the octal representat ion for the string “ QALoad” , 
 “ “ \ 121\ 101\ 114\ 157\ 141\ 144” , to the server.  

Accessing Server Replies 

Accessing Server Replies Using Response and ResponseLength  

You can save the ent ire reply that a server returns using Response() and ResponseLength(). When you cal l  
Response() direct ly after the DO_WSK_Expect(), i t  returns a pointer to the data received by the 
DO_WSK_Expect(). To receive the length of the received reply, cal l  the ResponseLength(). This returns the 
number of characters received.  

The sample script  i l lustrates how to use these commands to save a server reply. In  th is sample, the code in 
bold shows how to use Response() and ResponseLength().  
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Sam ple Script  
/* Declare Variables */ 
//Below are variables needed for this example 
int x = 0; 
char *temp; 
… 
BEGIN_TRANSACTION(); 
… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 
 
//Below is the actual buffer that was returned at capture time. 
/* 21 bytes: You are now connected */ 
DO_WSK_Expect(S1, "d"); 

// used to store the data that was received by the DO_WSK_Expect 
temp = Response();  

//used to get the size of the response that was received so far. 
x = ResponseLength(); 

//The line below will print the length of the response  to the playerbuffer 
RR__printf(“The size of the received buffer was %d bytes ",x,); 

DO_WSK_Closesocket(S1); 

Conclusion  

In th is example, Response() and ResponseLength() are used to prin t  the message “ The size of the received 
buffer was 21 bytes”  to the player buffer window. 

Accessing Server Replies with DO_WSK_Read  

When data received is too dynamic and there is noth ing on which to base the unique string, you cannot 
use the DO_WSK_Expect() to access server repl ies. In  th is case, when the number of characters received is 
always the same, you can use DO_WSK_Read().  

In  the fol lowing example, the user sends a logon string to the server and the server sends back a unique 
key that is used for subsequent cal ls. Since the ending characters always change, DO_WSK_Read is cal led to 
receive a specified number of characters. You can parse th is data for any values you need. The required 
code is shown in bold. 

Sam ple Script  
... 
BEGIN_TRANSACTION(); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 
 
DO_WSK_Bind(S2, ANY_ADDR, ANY_PORT); 
 
DO_WSK_Connect(S2, "10.4.26.24", 80, AF_INET); 
 
/* 20 bytes */ 
DO_WSK_Send(S2, "^@user=Bob^@pwd=CPWR^@\377"); 
 
//The data that is being sent from the server is dynamic and the ending 
// character is never the same. Since this is the case using 
// DO_WSK_Expect() will not work, so the script will use DO_WSK_Read() 
// to receive the same number of bytes that were originally sent. 
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/* 14 bytes: SID=1234567890 */ 
//DO_WSK_Expect(S2, "^@"); 
 
//The script will now print the response that was received by 
// calling Response() to gain access to the received buffer. 

If ( DO_WSK_Read(S2,14) != -1) 
RR__printf("String = %s",Response()); 
... 

Conclusion  

Using DO_WSK_Read() instead of DO_WSK_Expect() al lows the virtual user to receive a specific number of 
bytes instead of a sequence of characters. 

Accessing Server Replies with DO_WSK_Recv  

When the data returned is too dynamic and the DO_WSK_Expect() fai ls, you can use DO_WSK_Recv() to 
store the reply returned from the server. This saves the response based on i ts size instead of on the unique 
character string used in the DO_WSK_Expect(). When you use DO_WSK_Recv(), you specify how much 
data you want to receive and where to store i t .  

The sample script  i l lustrates how to use DO_WSK_Recv  to store the reply from the server. The required 
code is shown in bold. 

Sam ple Script  

/* Declare Variables */ 
//Below are variables that were declared to use with DO_WSK_Recv, 
//and the size of temp will vary depending upon the buffers that your 
//application is returning. 
int size = 0; 
char temp[45]; 
… 
BEGIN_TRANSACTION(); 
… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 
 
//Below is the data that was received at capture time. 
/* 21 bytes: You are now connected */ 
 
//Initializing the temp variable 
memset(temp,'\0',45); 

//Instead of calling DO_WSK_Expect() to receive the data, the 
//script will now call DO_WSK_Recv(). This will allow the script to  
//receive a specified number of characters instead of looking at the data 
//to determine if the buffer has been received entirely or not. 

DO_WSK_Recv(S1,temp,45,0,&size); 

//Original function that was in the script 
//DO_WSK_Expect(S1, “d”); 
//Prints the size of the string that was received to the playerbuffer. 
RR__printf("Size of the received buffer was %d bytes", size); 

DO_WSK_Closesocket(S1); 
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Conclusion  

In th is example, the message “ Size of the received buffer was 21 bytes”  is prin ted to the player buffer 
window.  

Caut ion: When using this method instead of the DO_WSK_Expect(), verify that you receive the correct 
information before moving on to the next function in your script. 

WWW Scripts 

WWW Script  Samples  

You can address specific si tuat ions or resolve certain  problems by modifying converted WWW scripts. The 
samples shown here include a descript ion of the problem, the procedure for implementing the 
modificat ion, and samples of a modified script . Scripts modificat ions are discussed for: 

Extract ing a String from a WWW Response and Reusing i t  as a CGI Parameter 

Extract ing and Reusing Web Service XML Values 

Moving the Transact ion Loop 

Extract ing and Reusing Cookies 

Extract ing a String from a WWW Response for Val idat ion 

Forcing a Subrequest 

IP Spoofing with a Local Datapool 

Prevent ing Unwanted Subrequests 

Extract ing and Reusing Cookies 

Overview: Extracting and Reusing a Cookie 

In some load tests, you may need to extract a cookie and use i t  later in  the script .   

Script i ng 

To extract the cookie, use the DO_GetCookie(). Reuse the value with DO_SetValue. 

Conclusion  

The sample script  sn ippet i l lustrates extract ing and reusing a cookie. 

Sample: Extracting and Reusing a Cookie  

The fol lowing sample is a port ion of a script  that extracts and reuses a cookie. 

Sam ple Script  
char * userid;  
char * aspsessionid;  
...  
...  
BEGIN_TRANSACTION();  
...  
...  
/* Request: 1 */  
DO_Http ("GET http://company.com/ HTTP/1.0\r\n\r\n");  
/*  
 * Get a cookie named USER_ID  
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 */  
DO_GetCookie ( "USER_ID", 1, &userid );  
/*  
 * Get the second ASPSESSIONID cookie. ASPSESSIONID  
 * cookies always have extra characters on the end to make  
 * them unique.  
 *  
 * An example ASPSESSIONID: ASPSESSIONIDQQQGGQDO=EBOOONBBFH  
 * BBELAJIMEFAKAP  
 */  
DO_GetCookie ("ASPSESSIONID*", 2, &aspsessionid );  
DO_SetValue(“User”, userid) 
DO_Http("POST http://company.com/ HTTP/1.0\r\n\r\n” 
 “Content-Type: application/x-www-form-urlencoded\r\n" 
 "Content-Length: {*content-length}\r\n" 
        “{User}”);  

Forcing a Subrequest  

Overview: Forcing a Subrequest that is not Being Made Automatically 

Occasional ly, one of the necessary subrequests that is recorded is not requested automatical ly at playback 
t ime. This can be caused by complex javascript  code not execut ing correct ly, or by an Act iveX control that 
cannot be used at playback t ime. You can force th is subrequest by insert ing an 
ADDITIONAL_SUBREQUEST statement. 

Script i ng 

To request an addit ional subrequest, insert  a command l ike the one below before the act ion statement 
(Cl ick_On, Navigate_To, or Post_To).   

Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST, "http://xyz.com/onsale.aspx"); 

This adds the specified URL to the l ist  of subrequests automatical ly generated when the requested page is 
parsed. 

Conclusion  

Using these techniques, you can modify a script  to force a subrequest. The sample modified script  
i l lustrates forcing a subrequest. 

Sample: Modified Script for Forcing a Subrequest  

In  th is example, one of the pages has an Act iveX object associated with i t  that automatical ly generates a 
request for i tems that are on sale.  However, at  playback th is request is not made because Act iveX objects 
are not executed at playback t ime. To force th is subrequest, you can insert  an Addit ional Subrequest i tem 
just before the act ion statement. Relevant statements are shown in bold. 

Sam ple Script  
//---------  REQUEST # 5  (see action item on Page 4)  --------- 
// 
//  current page url is http://xyz.com/chairs.htm 
// 
Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST, "http://xyz.com/onsale.aspx"); 
Click_On(LINK, 1, DESCRIPTION, "Nuts and Bolts"); 
Verify(PAGE_TITLE, "Nuts and Bolts"); 
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IP Spoofing with a Local Datapool 

IP Spoofing with a Local Datapool 

Datapools can provide IP spoofing addresses to scripts on playback machines. By creat ing a special IP 
spoofing datapool for the part icular playback machine, you can spoof the correct addresses at runt ime.   

Note:  For the script to execute properly, the IP addresses in the local datapool must match the IP 
addresses bound to the network cards on the playback machine. 

Script i ng 

When you modify a Visual Script  to al low for IP spoofing for a local playback machine, you must: 

!  Create a datapool file with the IP addresses associated with the network cards on the playback machine. 

!  Insert the required scripting code for datapool access into the script. 

!  Retrieve and use the spoofed IP address. 

Visual  Navigator 

Visual Navigator provides GUI in terfaces in  the tree view for creat ing datapool fi les and using spoofed IP 
addresses. You can use the datapool variables as IP spoofing addresses in  the IP spoof in terface. 

Conclusion  

By fol lowing these script ing techniques, you can modify a Visual Script  to extract IP addresses from 
datapool fi les for use as  spoofed addresses. The modified script  sample i l lustrates the modificat ions 
required in  the script . 

Moving the Transact ion Loop Statements 

Moving the Transaction Loop Statements 

Load test ing a web site can require you to log on and log out when you want to perform mult iple 
transact ions during a single session. You can move the BEGIN_TRANSACTION statement and the 
END_TRANSACTION statement so that the virtual user does not log on and log out with every transact ion. 

To m odi f y t he C++ scr ip t : 

1. Move the BEGIN_TRANSACTION and RESTART_TRANSACTION_TOP statements so that they are 
just below any statements that log the user onto the system. 

2. Keep the RESTART_TRANSACTION_BOTTOM, Clear(...), and END_TRANSACTION statements 
together and move them so that they are immediately above the Logout requests. 

Tip: The Clear(...) statements give you the opt ion of retain ing or removing i tems at the end of each 
transact ion. The Clear statements are automatical ly included in the script  and remove al l  cookies, WWW 
cache, connect ions, referring page, basic authorizat ion, and proxy authorizat ion i tems. To retain any i tem 
at the end of the transact ion, you must comment out the related Clear(...) command. 

Visual  Navigator 

If you are using Visual Navigator, you can move the Transact ion Loop and Transact ion Cleanup statements 
in  the tree view rather than in the C++ script . You also can select the i tems to clear at the end of each 
transact ion in  the Visual Navigator form view. Items you can clear or retain are: cookies, WWW cache, 
connect ions, referring page, basic authorizat ion, and proxy authorizat ion. 

Note: By default, all objects are selected and cleared at the end of the transaction.  
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To m odi f y t he Visual  Navigat or  t r ee view : 

1. Select the Transact ion Loop i tem and cl ick the Move Down button in  the form view unt i l  i t  moves 
below the Logon pages.   

2. In  the Cleared i tems at end of t ransact ion sect ion of the form view, clear the checkbox next to each 
i tem you want retained at the end of the transact ion.  

3. Do the same for the End Transact ion by select ing the Transact ion Cleanup tree i tem and moving i t . 
  

4. In  the Cleared i tems area at end of t ransact ion sect ion of the form view, clear the checkbox next to 
each i tem you want retained at the end of the transact ion. Any pages after the Transact ion 
Cleanup, such as the Logout, take place after al l  t ransact ion in  the main loop have fin ished 
execut ing. 

Sam ple Script s 

The original script  sample and modified script  sample show a script  that logs in to a newsgroup forum, 
performs act ions, such as reading threads and replying to them, and then logs out. The scripts ident i fy the 
Logon and Logout requests and show the old and new locat ions of the transact ion statements. The original 
script  shows al l  objects selected in  Visual Navigator for clearing at the end of the transact ion. In  the 
modified script , the Cookies are unchecked in Visual Navigator and are not cleared at the end of the 
transact ion. 

Note: When you modify the C++ script, the Clear (ALL_COOKIES) statement is manually commented out 
 to retain cookies at the end of the transaction. 

Prevent ing Unwanted Subrequests 

Sample: Preventing Unwanted Subrequests 

The fol lowing sample uses a fi l ter string to prevent the unwanted subrequest. Points of in terest are 
h ighl ighted in  bold. 

Sam ple Script  
Set (EVERY_REQUEST, BLOCK_TRAFFIC_FROM, "AcmeAds"); 
SYNCHRONIZE(); 
 
BEGIN_TRANSACTION();  
RESTART_TRANSACTION_TOP(); // do not modify this statement 
 
//---------  REQUEST # 1  --------- 
// 
Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 1 - "); 
 
Navigate_To("http://www.mystore.com/"); 
Verify(PAGE_TITLE, "Jack’s Hardware Store"); 
etc.  
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Net Load  

Using NetLoad 
NetLoad is QALoad’s suite of load generat ion scripts that al lows you to simulate load condit ions on your 
network using any of the fol lowing protocols: 

!  FTP 

!  HTTP 

!  PING 

!  LDAP 

!  POP3 

!  SMTP 

!  TCP 

!  UDP 

!  MSExchange 

NetLoad includes QALoad-provided scripts, which you can access from the Conductor to run in  a test, for 
each protocol. You can customize the act ivi ty of the script  by creat ing reusable datapools in  the QALoad 
Script Development Workbench to use during test ing. When you run a test, each virtual user requests a 
single datapool record. Once al l  the records have been read, the datapool fi le is rewound and the process 
starts again. You can use QALoad’s components to run scripts and analyze the results as usual, or you can 
integrate your results with Compuware’s ServerVantage product. 

In  short , NetLoad al lows you to generate traffic on your network in  a control led manner and gather 
performance t im ings from the network. To faci l i tate test ing under TCP/IP and UDP, NetLoad provides you 
with a server module to simulate server act ivi ty — al lowing you to gather network t im ings without 
expending your actual server resources. 

Note: To use NetLoad for MSExchange to test on Outlook 2000, you must ensure that CDO support is 
installed on your workstation before you continue. For instructions, see Verifying CDO Support for 
MSExchange. 

For more in formation on the NetLoad Server modules, see NetLoad Server Modules for TCP/IP and UDP. 

 

NetLoad server modules for TCP/ IP and UDP 
If you are load test ing a network running TCP/IP or UDP, you should use the appropriate NetLoad Server 
module to simulate server responses during your load test. This al lows you to load your network and 
col lect t im ings without expending your own server’s resources. The NetLoad Server modules are only for 
use i f you’re test ing on TCP/IP or UDP. You do not need to instal l  the Server modules to test any other 
NetLoad-supported protocol.  

You can instal l  or copy the NetLoad Server modules to any Windows workstat ion on your network. After 
start ing the appropriate Server module, you supply the QALoad Script Development Workbench with the 
host name of the machine where the Server module is running and the port  number that you specified 
when you started the Server module. When you are ready to run a test, start  the Server module fi rst . During 
the test NetLoad communicates with the NetLoad Server module, effect ively loading the network. If 
NetLoad does not find the NetLoad Server module at the specified port—for instance i f you mistyped the 
port  number—the test fai ls (TCP) or fai ls to in i t iate (UDP).  
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Determining when to use the TCP server module 

If you are going to send TCP packets using NetLoad, you must have a QALoad TCP Server module running 
on each machine that you are sending packets to. Copy the TCP Server module fi le, Net loadTCPServer.exe, 
to each machine that wi l l  be receiving packets and double-cl ick on the fi le to start  the TCP Server module. 

Because the QALoad TCP Server module is a Windows-based program, you cannot use i t  to send NetLoad 
TCP packets to a UNIX machine.  

Determining when to use the UDP server module 

It  is not necessary to have a QALoad UDP Server module running at the dest inat ion machine for NetLoad 
to successful ly send packets to i t ; however, the Netload UDP Server can be useful to veri fy that the packets 
are being sent. To instal l  the UDP Server module on  a machine you are sending packets to, copy the 
program NetloadUDPServer.exe to that machine. Double-cl ick the fi le to start  the UDP Server module. 

Since i t  is not necessary to have the UDP Server module running, you can send NetLoad UDP packets to 
both UNIX and Windows workstat ions. 

Note: If you are testing UDP in “ broadcast”  mode, it is not necessary to use the NetLoad Server module. 

Installing the NetLoad Server module 
If you are load test ing a network running TCP/IP or UDP, the NetLoad Server module appropriate for your 
protocol must be running on a Windows workstat ion on your network before you start  the test. The Server 
modules are instal led automatical ly i f you chose the opt ion to instal l  them during setup. However, once 
the Server module is instal led on one workstat ion, you can instal l  i t  on another workstat ion by simply 
copying the program from one workstat ion to another. The NetLoad Server modules are instal led to the 
directory \Program Files\Compuware\QALoad\Middlewares\NetLoad\Server, and are named: 

!  NetLoadTCPServer.exe (for TCP/IP): If you are going to send TCP packets using NetLoad, you 
must have a TCP Server module running on each machine you are sending packets to. Because the 
TCP Server module is a Windows program, you cannot send NetLoad TCP packets to a UNIX 
machine. 

!  NetLoadUDPServer.exe (for UDP): It  is not necessary to have a UDP Server module running on the 
machines you are sending UDP packets to. However, the UDP Server is useful for veri fying that the 
packets are being sent. Since i t  is not necessary to have a UDP Server module instal led on the 
dest inat ion workstat ions, you can send NetLoad UDP packets to UNIX machines.  

 

Start ing the NetLoad Server Module 
You can configure and start  the NetLoad server module from the Start  menu.  

If you are load test ing a network running TCP/IP or UDP, the NetLoad Server module appropriate for your 
protocol should be running on a Windows workstat ion on your network before you start  the test. The 
Server modules are instal led with your QALoad product i f you chose to instal l  them during setup. If you are 
unsure i f you should be using a NetLoad Server module, see NetLoad server modules for TCP/IP and UDP. 

To st ar t  t he m odule: 

1. Point to Start>Program s>Com puw are> QALoad >NetLoad. Then cl ick on the appropriate Server 
module: TCP Server or UDP Server. 

2. When prompted, type the port  number of the host machine and cl ick OK. 
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3. On the QALoad NetLoad Server window, under the Opt ions menu, select one of the fol lowing: 

 Show  M essage Every Packet  — Displays a message, including byte size, after sending or 
receiving a packet. 

 Show  M essage Every 100 Packets — Displays a message every 100 packets l ist ing the total 
number of packets received.  

Start ing a NetLoad session 
You can start  a NetLoad session from the workbench with an exist ing datapool fi le or a new one. 

To st ar t  a session: 

1. From the QALoad Script Development Workbench, choose Session>NetLoad. 

2. Open an exist ing protocol datapool fi le or create a new one: 

 To create a new datapool f i le, choose Fi le>New . The New NetLoad Fi le dialog box opens. 

 To open an exist ing datapool fi le, choose Fi le>Open . The Open NetLoad Fi le dialog box opens. 

3. Select the protocol you wish to test on and cl ick OK. If you are opening an exist ing datapool fi le, 
navigate to the fi le and open i t . 

4. Enter or edit  the appropriate datapool in formation in  the Workbook  Pane. 

The QALoad Script Development Workbench al lows you to have mult iple fi les open at the same t ime. 
Datapool fi les are located in  the directory \Program 
Files\Compuware\QALoad\Middlewares\NetLoad\Scripts.  

Creat ing a NetLoad datapool 

To creat e a Net Load dat apool : 

1. From the QALoad Script Development Workbench, cl ick Session>NetLoad. 

2. Click Fi l e>New  to open the New NetLoad Fi le dialog box. 

3. Select the protocol for wh ich you wish to create a datapool fi le and cl ick OK. 

A grid opens in the Workbook Pane. Each row on the grid represents a single data record. The 
column headings indicate the appropriate field in formation to enter. Note that the actual fields in  
the grid vary by protocol. 

4. Enter the appropriate in formation for your datapool  fi le. 

Some fields on the grid contain pul l-down menus. To act ivate them, cl ick anywhere with in the field. 
Then make your select ion  from the menu that appears. 

5. When you are fin ished, select Fi l e>Save to name and save the datapool fi le. 

The datapool fi le is l isted in  the Workspace Pane Datapools tab. QALoad creates a script  with the same 
name and l ists i t  on the Scripts tab. Both fi les are saved to the \NetLoad\Scripts directory (for example, 
c:\Program Files\Compuware\QALoad\Middlewares\NetLoad\Scripts\datapool.dat).  

To ent er  dat apool  dat a: 

1. From the QALoad Script Development Workbench, choose Session>NetLoad. 
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2. Click Fi l e>New  to open the New  NetLoad Fi le dialog box. Select the protocol for which you wish 
to create a datapool fi le and cl ick OK. A grid similar to the one shown below appears in  the 
Workbook Pane. Each row on the grid represents a single data record. The column headings 
indicate the appropriate field in formation to enter. Note that the actual fields in  the grid vary by 
protocol . 
 

 

3. Enter the appropriate in formation for your datapool  fi le. Note that some fields on the grid contain 
pul l-down menus. To act ivate them, cl ick anywhere with in the field. Then make your select ion 
from the menu that appears. 

4. When you are fin ished, cl ick Fi l e>Save to name and save the datapool fi le. Note that your datapool 
fi le is l isted in  the Workspace Pane Datapools tab. QALoad creates a C++ script  by the same name 
and l ists i t  in  the Workspace Pane Scripts tab. Both fi les wi l l  be saved to your \NetLoad\Scripts 
directory (for example, c:\Program 
Files\Compuware\QALoad\Middlewares\NetLoad\Scripts\datapool.dat). 

3. (Optional) Write a descript ion of th is datapool fi le for later reference by select ing 
Opt ions>NetLoad. Once a descript ion has been entered for a datapool fi le, you can review or edit  
the descript ion any t ime the fi le is open by select ing Opt ions>NetLoad again . 

Edit ing a NetLoad datapool 
You can edit  the NetLoad datapool to make changes or addit ions to the fi le. 

To edi t  a dat apool : 

1. With the appropriate NetLoad protocol session open, open the datapool by choosing Fi l e>Open  
and navigat ing to i t , or select i t  from the Workspace tab Datapools tab. 

2. Make any changes or addi t ions to the fi le. 

3. To delete an ent ire record (a single row), cl ick i ts row number and select Grid>Delete Row (s). 

4. To insert  a new record (a single row) above an exist ing record, cl ick a row number and select 
Grid>In sert  Row . NetLoad inserts a blank row above the selected row. 

5. Save any changes to the fi le by select ing Fi l e>Save.  
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Adding or edit ing a NetLoad datapool descript ion 
You can add a meaningful descript ion, or edit  a previous one, for any NetLoad datapool. 

To edi t  a descr ipt ion: 

1. With a datapool fi le open, select Opt ions>NetLoad. 

2. Enter a descript ion for the current datapool fi le.  

Datapool fields 
The fol lowing protocol-specific fields are provided with in a datapool: 

MSExchange 

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Prof i l e Nam e: Type the name of your mail  profi le. For example, M icrosoft  Out look. 

Send To: Type the names of one or more mail  recipients, separated by commas (,) or semi-colons (;). 

Cc: Type the names of one or more mail  recipients, separated by commas (,) or semi-colons (;). 

Size of  Body: Select a fi le size from the drop-down l ist  for the body of the mai l  message. 

At tached f i l e si ze: Select a fi le size for the attachment fi le from the drop-down l ist . 

FTP 

Send/ Receive: Specifies whether the script  wi l l  be sending or receiving a fi le. 

ASCII / Binary: Describes whether the fi le contains ASCII or binary data. 

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host : The name of the host computer. 

User ID: A user ID for accessing the host computer. 

Passw ord: A password for accessing the host computer. 

Fi l e Size Opt ions: Describes whether the fi le being sent to the host is of fixed or random size. 

Fi l e Size (m in ): The min imum fi le size to send to the host or the size of the fixed fi le. 

Fi l e Size (m ax): The maximum fi le size to send to the host. 

Path : The path of the fi le to receive, or the dest inat ion of the fi le being sent. You must enter an absolute 
path. 

Fi l enam e: The name of the fi le to receive or of the fi le being sent. 

HTTP  

Connect ion : Describes whether the connect ion is regular (the connect ion is closed after the 
request/ response completes) or persistent (the connect ion remains open for subsequent requests). 

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

URL: The address of the page to receive. 

Proxy Server: The name of the proxy server (opt ional). Note that only proxy servers that do not require a 
user ID and password are supported. 
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PING  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host  Nam e: The name of the host computer. 

Pk t  Size (Fixed/ Random ): Describes i f the packet being sent to the host is of fixed or random size. 

Pk t  Size (m in ): The min imum packet size to send, or the size of the fixed packet to send. 

Pk t  Size (m ax): The maximum packet size to send. 

LDAP  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host  Nam e: The name of the host computer. 

Search  St r ing: The text string to search for. 

POP3  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

POP3 Server: The name of the POP3 server machine. 

User ID: A user ID for accessing the POP3 server. 

Passw ord: A password for accessing the POP3 server. 

Delete af ter read: Choose whether to delete the message after i t  has been read. 

Connect ion : Describes whether the connect ion is regular (the connect ion is closed after the 
request/ response completes) or persistent (the connect ion remains open for subsequent requests). 

SMTP  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

SM TP Server: The name of the SMTP server machine. 

From : Enter an email  address or name. 

Send To: Type the names of one or more mail  recipients, separated by commas (,) or semi-colons (;). 

Cc: Type the names of one or more mail  recipients, separated by commas (,) or semi-colons (;). 

Size of  Body: Select a fi le size from the drop-down l ist  for the body of the mai l  message. 

Fi l e Path : Select a fi le from the drop-down l ist  to use as the body of the mail  message. This field displays 
fi les in  the local directory only i f you selected Browse in the Size of Body field. 

At tached f i l e si ze: Select a fi le size for the attachment fi le from the drop-down l ist . 

At tached f i l e path : Select a fi le from the drop-down l ist  to use as an attachment. This field displays fi les in  
the local directory only i f you selected Browse in the Attached Fi le Size field. 

Connect ion : Describes whether the connect ion is regular (the connect ion is closed after the 
request/ response completes) or persistent (the connect ion remains open for subsequent requests). 

TCP  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host  Nam e: The name of the host computer. 

Port : The port  number of the host computer. 

Pk t  Size (Fixed/ Random ): Describes i f the packet being sent to the host is of fixed or random size. 

Pk t  Size (m in ): The min imum packet size to send, or the size of the fixed packet to send. 



QALoad 05.06 Using the Player, Script  Development Workbench, and Analyze 

232 

Pkt  Size (m ax): The maximum packet size to send. 

UDP  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host  Nam e: Type the name of the host computer that is to receive the packet. 

Port : The port  number of the host computer. 

Pk t  Size (Fixed/ Random ): Describes i f the packet being sent to the host is of fixed or random size. 

Pk t  Size (m in ): The min imum packet size to send, or the size of the fixed packet to send. 

Pk t  Size (m ax): The maximum packet size to send. 

Verifying CDO Support  for MSExchange 
Before you can successful ly test with NetLoad for M SExchange using Outlook 2000, you must ensure that 
Col laborat ion Data Objects (CDO) support is instal led. 

To ver i f y CDO suppor t : 

1. From the Windows task bar, cl ick Start>Set t i ngs>Con t rol  Panel . 

2. Double-cl ick the Add/ Rem ove Program s icon. 

3. From the l ist  on the Instal l / Un instal l  tab, select M icrosoft  Office 2000 or M icrosoft  Out look 2000. 

4. Click the Add/ Rem ove button. 

5. Click Add or Rem ove Features. 

6. Click the plus sign (+) next to M icrosoft  Out look for Windows. 

7. Select Col laborat ion  Data Objects, and then cl ick Run  f rom  M y Com puter . 
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UNIX 

Transfer Scripts to a UNIX Player 
Normally, the appropriate script  is automatically uploaded from the QALoad Conductor to the Players and 
compiled at runt ime. However, i f i t  is ever necessary to manually transfer a script , use the procedure that 
fol lows. 

Note: The machine where the QALoad Script Development Workbench is installed must have Winsock-
based TCP/IP to transfer a script to the UNIX machine where you wish to run it. 

To t ransf er  a scr ip t : 

The fol lowing procedure describes how to transfer a script  fi le from the Windows workstat ion where the 
QALoad Script Development Workbench resides to the system running the QALoad Player. 

1. Access the Script Development Workbench. 

2. From the Session  menu, choose the middleware session you want to start . 

3. In  the Workspace Pane, cl ick the Scripts tab. 

4. On the Scripts tab, select the script  you want to transfer. 

5. From the Tools menu, choose FTP to open the FTP Transfer dialog box. Note that the fi le name 
you selected to transfer appears in  the Fi l e to Transfer field. 

6. Enter the Host  Nam e, User Nam e, Passw ord, and Dest inat ion  Di rectory. 

7. Click Transfer to send the fi le to the system where your QALoad Player is instal led. 

8. If you want to save the in formation you have entered for subsequent transfers, cl ick Save Set t i ngs. 

9. Click Close/ Abort  to exit  the FTP Transfer dialog box .  

 



QALoad 05.06 Using the Player, Script  Development Workbench, and Analyze 

234 

Test ing  w i t h  QARun  

Creat ing a QARun script  
To create a QARun script , insert  any number of QARun transact ions (QARun scripts) in to a QALoad 
template script  accessible from the QALoad Script Development Workbench. The template script  is a 
simple QALoad script  that can be compiled and run; however, i t  contains no funct ional i ty unt i l  you insert  
the QARun transact ions appropriate for your test ing needs. QALoad provides two methods for insert ing 
QARun transact ions: automated and manual. 

Using the automated method, you enter in formation in  the QALoad Script Development Workbench about 
the QARun transact ions to use and then let  QALoad generate the test script  using the in formation you 
provided. This method is fast and efficient when you know exact ly which QARun scripts to use and where 
they are located. 

The manual method al lows you to open a copy of the QALoad template script  and insert  t ransact ions and 
commands manually. You may want to use th is method i f you suspect you may need to edit  your script  
whi le you're creat ing i t . 

Automat ically creat ing a QARun script  

To aut om at ical ly creat e a QARun scr ipt : 

1. From the QALoad Script Development Workbench, cl ick Session>QARun  to start  a QARun 
script ing session. 

2. Click Session>Generate Script . The Create New QARun Execut ion Script dialog box opens. 

3. In  the Login  St r ing field, select or type a val id username and password to access your instal lat ion 
of QARun. 

4. In  the Envi ronm en t  field, select the appropriate QARun environment. 

5. In  the QARun  Script  field, enter the name of the QARun transact ion to insert , or select i t  from the 
l ist , which contains a record of the last five QARun script  names you entered.  
 
Although you can enter a script  name from any database, when the test is actual ly running and 
QALoad invokes QARun, QARun attempts to retrieve that script  from its default  database. 
Therefore, in  the QARun program instal led on the Player, you should designate a default  database 
that contains the script(s) you want to run. 

6. Select the Autom at i cal l y Include Checkpoin t  check box i f you want QALoad to automatical ly 
insert  a checkpoint in to the script  after th is QARun transact ion. 

7. In  the QALoad Script  Nam e field, enter a name for th is QALoad script . To write over an exist ing 
script , cl ick the Brow se button to the right of th is field and select a script  from the l ist  of avai lable 
scripts. 

8. To add addit ional QARun transact ions to th is script , cl ick Add Script  and repeat Steps 3–6 for each 
addit ional t ransact ion. 

9. When you are fin ished, cl ick Create Script . The QALoad script  is saved in the directory \Program 
Files\Compuware\QALoad\Middlewares\QARun\Scripts, and the script  opens in the script  editor. 

10. To compile the script  for test ing, cl ick Session>Com pi le.  
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Manually creat ing a QARun script  
You can manually insert  QARun commands or scripts in to a QALoad script  to compile. 

To m anual ly creat e a scr ipt : 

1. From the QALoad Script Development Workbench, select Session>QARun  to start  a QARun 
script ing session. 

2. Select Session>New  Tem plate to create a new script  from the QALoad template script . 

3. In  the Choose Script Name dialog box, enter a name for the new QALoad script  in  the Script  Nam e 
field and cl ick OK. The script  is saved in the directory \Program 
Files\Compuware\QALoad\Middlewares\QARun\Scripts, and the script  opens in the script  editor. 

4. Edit  the script  as necessary: 

!  You can manually enter any transact ions or script ing commands direct ly in  the script . 

!  You can insert  a QARun transact ion by posit ion ing the cursor on the appropriate l ine and 
select ing Session>In sert>Transact ion . On the Insert  a QARun  Transact ion  dialog box that 
opens: 

"  In  Login  St r ing, select or type a val id user name and password to access your instal lat ion of 
QARun. 

"  In  Envi ronm en t , select the appropriate QARun environment. 

"  In  QARun  Script  Nam e, enter the name of the QARun transact ion to insert , or select i t  
from the l ist , which contains a record of the last five QARun script  names you entered. Note 
that you can enter a script  name from any database; however, when the test is actual ly 
running and QALoad invokes QARun, QARun wil l  at tempt to retrieve that script  from its 
default  database. Therefore, in  the QARun program instal led on the Player, you should 
designate a default  database that contains the script (s) you want to run. 

!  When you are fin ished, cl ick Insert  to insert  the script  you just created in to the QALoad script . 

5. When you are fin ished, save any changes. 

6. To compile the script  for test ing, select Session>Com pi le.  

 



QALoad 05.06 Using the Player, Script  Development Workbench, and Analyze 

236 

Pack ag ing  Scr ip t s f or  Cl i en t Van t age 

Overview - Packaging Scripts for ClientVantage 
ClientVantage users must veri fy that versions of scripts and Player software located on each agent mach ine 
are compatible. When dispari t ies exist , for example, when product ion systems are upgraded, the test scripts 
used to monitor the end-user experience also must be updated.  

QALoad's Package Script funct ion enables you to select a QALoad script , veri fy that i t  is up-to-date, and 
then package i t  in  a zip fi le that you can transfer to Player machines in  any locat ion. The Package Script  
ut i l i ty automatical ly determines and includes al l  associated fi les, such as datapools and binary fi les, that 
are required to run the script . The zip fi le contains the script , i ts auxi l iary fi les, and a manifest fi le that l ists 
the packaged fi les and the middleware the script  uses.  

Note: You must compile scripts before placing them in the zip file. 

How to Package a Script   
Use th is procedure to select a QALoad script  and package i t  and al l  i ts associated fi les in to a zip fi le that you 
can transfer to a Player machine for use by ClientVantage. 

To select  a scr ip t : 

1. Open a session in  the Script Development Workbench. 

2. Select a script  in  the Workspace pane and cl ick Fi l e>Package Scri pt . The Package Scripts dialog box 
appears with the script  you selected displayed in the Script  Fi l e field. 

Note: You can open the Package Scripts dialog box before choosing a script, then click Browse to open 
the Select Script File to Package dialog box and select the script.  

To package t he scr ip t : 

1. In  the Package Scripts dialog box, cl ick Package. The Select Package Directory and Name dialog box 
appears. 

2. Click the down arrow in the Save in  field to select the directory where you want to save the zip 
fi le. The default  directory provided is Program Files\Compuware\QALoad. 

3. In  the Fi l e nam e field, type a name for the zip fi le. The default  name provided is the name of the 
script . 

4. Click Save. The zip fi le is created and saved in the directory you selected. The Package Scripts 
dialog box displays. 

Note: You can only package compiled scripts. If you try to use the Package Scripts utility on an uncompiled 
script, an error message appears. You must exit the Package Scripts dialog box, compile the script, and start 
the script packaging process again.  

5. Select another script  to package, or cl ick Close. 

To unpackage t he scr ip t : 

To unpackage the script , access the Vantage Console in  Cl ientVantage where you can publ ish the script . 
For more in formation on how to use the Vantage Console, refer to the onl ine help in  Cl ientVantage. 
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Tr oub leshoot ing  

ODBC Memory Error Crash 
Whenever a user-started capture is in i t iated, QALoad appears to begin capturing, but as soon as the 
program to capture against i t  is started, a memory except ion is encountered. 

The fol lowing error is not encountered immediately. It  may not occur unt i l  you attempt to cl ick on 
something or perform some sort  of act ivi ty on your machine.  

Application popup: explorer.exe - Application Error : The instruction at 
"0x1001ee30" referenced memory at "0x1001ee30". The memory could not be 
"written". 

To f ix  t he ODBC m em ory er ror  crash: 

If you are running Windows XP Pro SP2, perform the fol lowing steps: 

1. Right-cl ick on M y Com puter and select Propert i es. The System Propert ies dialog box appears. (If 
your My Computer is not avai lable, access Con t rol  Panel>System .) 

2. Select the Advanced tab, then cl ick Set t i ngs in  the Performance group box .  

 

3. On the Performance Options dialog box, select the Data Execut ion  Preven t ion  tab. Make sure that 
Turn  on  DEP for al l  program s…”  is selected. 
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4. Click Add, then navigate to select the fol lowing appl icat ions:   

a. <systemroot>\explorer.exe  

b. <systemroot>\system32\rundll32.exe  

5. Click OK for any warnings that appear. 

6. Click OK on the Performance Options dialog box to save your changes and close the dialog box . 

The Default  Session Prompt  Did Not  Open? 
If the Default  Session Prompt fai ls to open when you start  a middleware session, then default  session 
checking was previously disabled. Do the fol lowing to enable default  session checking: 

1. From the Opt ions menu, choose Workbench . The Configure QALoad Script Development 
Workbench dialog box opens. 

2. On the Workben ch  Con f igurat ion  tab, select the Enable defaul t  Session  ch eck ing check box . 

The next t ime you open a QALoad Script Development Workbench middleware session, you are prompted 
to make i t  your default  session.  
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Winsock Running Out  of Socket  Resources 
You may encounter a problem running out of socket resources on NT or Solaris when there are large 
numbers of short-l ived connect ions. 

When TCP/IP connect ions are shutdown, they go in to a TIME_WAIT state wait ing for the specified in terval 
to expire. While in  that state the connect ion is looking for any stray packets that may have been sent to 
th is connect ion and remain unacknowledged. 

If th is process was skipped, i t  would be possible for a new connect ion to be opened using the same address 
and port  as the previous connect ion and to incorrect ly receive data that was intended for the previous 
connect ion. When QALoad is generat ing many short-l ived connect ions, during a Winsock or WWW load 
test, the default  sett ing for the t imed wait  delay may be so h igh that the driver machine wil l  run out of 
socket resources as al l  closed sockets wait  in  the TIME_WAIT state. 

To change the sett ing for the t imed wait  delay: 

Windows NT 

Set the registry key: 

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\tcpip\ 
Parameters\TcpTimedWaitDelay 

to a lower value. It  can be set to anyth ing between 30 and 300. Compuware suggests using the lowest 
possible value (30). 

Solaris 2.6 

Using "ndd" set the "tcp_close_wait_interval" to 30 seconds: 

ndd -get /dev/tcp tcp_close_wait_interval 

ndd -set /dev/tcp tcp_close_wait_interval 30000 

Solaris 2.7 

Use "ndd" as shown previously for Solaris 2.6, but subst i tute the "tcp_t ime_wait_interval"  

Cit rix 

Performance issues with SAP or Cit rix scripts 

If you experience performance issues with SAP or Citrix scripts, increase your system paging fi le size to a 
fixed size of at least four t imes the amount of RAM on the machine. 

Recording Cit rix Scripts for Rest ricted Desktops  

When recording a Citrix script  on a restricted desktop, you must take extra steps to ensure proper playback. 
Dynamic windows may be created and destroyed with no user in teract ion at both logon and logoff. To 
prevent unexpected results during playback, do not cl ick on any of these dynamic windows. For example, 
the script  might attempt to cl ick on a destroyed window or a window that has not been created yet. The 
appearance of dynamic windows often depends on the speed of the server or the load on the farm during 
playback. 
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Desktop Screen Resolut ion When Recording Cit rix Scripts 

To ensure that the ent ire Citrix in terface is visible during recording, set the Resolut ion field in  the Citrix 
recording opt ions to a lower value than that of the desktop. Also, the screen resolut ion must be the same 
as the screen resolut ion specified in  the Citrix ICA fi le. 

Wait  Points in Cit rix Scripts 

When mouse move consol idat ion is enabled via the Combine Mouse Input opt ion on the Convert  Opt ions 
dialog box, not al l  events that were captured appear during replay. As a result , the placement of wait  points 
for window moves and window resizing is importan t. When a window is moved on the desktop, a window 
move event is created for each mouse move. However, during replay of a consol idated script , only one 
mouse move is made (to the final dest inat ion), and subsequently only one window move event occurs. 
Because of th is consol idat ion of consecut ive mouse and window moves, the CtxWaitForWindowMove 
command in your script  should target the final window move in the series. This issue also appl ies to the 
CtxWaitForWindowResize command and the resizing of windows on the desktop. 

If a window's t i t le changes while the window is being created (such as a browser window's t i t le bar 
changing once the default  Web page begins to load), the CtxWaitForWindowCreate command may t ime 
out. If th is occurs, remove the wait  point or insert  a CtxWaitForScreenUpdate command to preserve the 
wait  in  the script . 

SAP 

Performance issues with SAP or Cit rix scripts 

If you experience performance issues with SAP or Citrix scripts, increase your system paging fi le size to a 
fixed size of at least four t imes the amount of RAM on the machine. 

SAP Script  Validat ion Fails 

If your SAP script  fai ls during val idat ion i t  perform any of the fol lowing procedures to resolve the problem.  

Disable Autom at i c Proxy Con f igurat ion  in  In ternet  Explorer 

To d isable aut om at ic p roxy conf igurat ion: 

You may need to disable automatic proxy configurat ion in  Internet Explorer. 

1. In  Internet Explorer, cl ick Tools>In ternet  Opt ions. 

2. On the Connect ions tab, cl ick LAN Set t i ngs. 

3. Ensure that the Use autom at i c con f igurat ion  scri pt  check box is cleared. 

Increase the Scri pt  Execut ion  Tim eout  Value 

To increase t he t im eout  value: 

If disabl ing the automatic proxy configurat ion does not solve the problem, consider increasing the script  
execut ion t imeout value to 100 seconds or to the length of the capture fi le (in  seconds), whichever is 
greater. 
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1. With an SAP session open in the Script Development Workbench, cl ick Opt ions>Workbench . 

2. On the Script  Val idat ion  tab, type the new value in  the Wai t  up to field. 

3. Click OK. 

Do Not  M in im ize the SAP Window  

To m axim ize t he SAP w indow : 

During val idat ion of SAP scripts, do not min imize the SAP window. If the window is min imized, the 
val idat ion may fai l . This problem does not occur i f you do the fol lowing: 

1. In  Conductor, select the Script  Assignm en t  tab. 

2. In  the Type column, cl ick  [...] to browse. 

3. Select the Hide Graph ical  User In terface for SAP Users opt ion . 

 

 

Compiler Errors with SAP Scripts 

If you receive a type mismatch error when compil ing an SAP script , you must remove the quotat ion marks 
around the last parameter of the affected command. For example: 

error C2664: '<FuncName>' : cannot convert parameter n from 'char [n]' to 'long' 

This compiler error, which can occur in  commands that manipulate column widths, indicates a data type 
error and can be corrected by removing the quotat ion marks around the last parameter.  

The fol lowing example shows the l ines in  a script  that could cause an error, and the corrected version of 
the same l ines: 

Script  that  produces the error: 
   SAPGuiPropIdStr("wnd[0]/shellcont[1]/shell"); 
   SAPGuiCmd2(GuiCtrlTree, SetColumnWidth, "REPNAME", "218"); 

Corrected scri pt : 
   SAPGuiPropIdStr("wnd[0]/shellcont[1]/shell"); 
   SAPGuiCmd2(GuiCtrlTree, SetColumnWidth, "REPNAME", 218); 
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Analyze 
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Over view  of  QALoad  Analyze 
QALoad Analyze is the QALoad component used to create summary stat ist ics and graphs from t im ing data 
col lected during a load test. Set cri teria for col lect ing and displaying test data in  QALoad Analyze before or 
after opening a test ’s t im ing fi le (.t im). For example, alter output opt ions, t ime ranges, and graphics display 
opt ions.  

QALoad Analyze stores the state of a t im ing fi le when i t  is closed so that next t ime you open i t , you see the 
same reports and graphs that were present last t ime you viewed i t .  You also have the abi l i ty to easi ly create 
templates, which enable you to specify the reports and graphs that are automatical ly generated for any 
new t im ing fi le you open. 

In addit ion, QALoad Analyze generates a working folder where al l  fi les and reports related to the t im ing fi le 
are stored. QALoad Analyze provides seven pre-defined reports as well  as the abi l i ty to create custom 
reports using XML fi le (.xml), XSL translat ion fi le (.xsl), and HTM fi le (.h tm) formats. View these reports in  
QALoad Analyze or in  a Web browser.      

QALoad Analyze displays a t im ing fi le tab in  the Workspace, each tab contain ing groups. Use QALoad 
Analyze’s in teract ive view to sort  test data, produce detai led checkpoint data, produce a variety of graphs 
and reports (with drag and drop funct ional i ty), export  data to different formats, and email  test results and 
pre-defined reports. 
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Accessing  Analyze 
The fol lowing procedures describe how to start  QALoad Analyze. 

To access Analyze f rom  t he QALoad Conduct or : 

1. In  the QALoad Conductor, cl ick Tools>Opt ions. The Options dialog box appears. 

2. Click the General  tab. In  the General Options area, select the Launch  An alyze Af ter Test  check 
box . 

At the end of each test run, QALoad Conductor automatical ly launches QALoad Analyze and opens the 
most recent t im ing fi le. If you did not select the Launch Analyze After Test check box before the test, 
fol low the steps below.  

1. Click Tools>Analyze. 

2. In  QALoad Analyze, cl ick Fi l e>Open . The Open Timing Fi le dialog box appears. Select a t im ing fi le 
to work with by double-cl icking the fi le name in the l ist  of avai lable t im ing fi les. 

To access Analyze f rom  t he W indow s St ar t  m enu: 

Cl ick Start>Program  Fi les>Com puw are> QALoad >Analyze. 
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Under st and ing  Dur at ion s 
When you begin to analyze your test results, i t  is important to understand how durat ions are calculated by 
QALoad.  

Transact ion Durat ion 
Transact ion durat ion is the t ime that the script  being tested takes to complete a transact ion, from the 
BEGIN_TRANSACTION command to the END_TRANSACTION command. 

Three factors comprise transact ion durat ion: 

!  The script  processing t ime including, but not l im ited to, added script  logic, QALoad processing of 
server repl ies, and other QALoad processing. 

!  Sleep t ime. 

!  The response t ime of the appl icat ion under test including, but not l im ited to, the appl icat ion 
server, database access, and network. 

Checkpoint  Durat ion 
Checkpoint durat ion is the amount of t ime between begin and end checkpoint statements. The fol lowing 
factors comprise checkpoint durat ion and apply to both automatic checkpoints and user-defined 
checkpoints. 

If you select the Conductor's Enable t im ing of  autom at i c m iddlew are checkpoin ts opt ion or use the 
BeginCheckpoint and EndCheckpoint funct ions in  the script , the fol lowing factors comprise checkpoint 
durat ion: 

!  The response t ime of the appl icat ion under test, including, but not l im ited to, the appl icat ion 
server, database access, and network. 

!  Sleep t ime, i f the Conductor's Incl ude sleep t im es w hen  calculat ing checkpoin t  t im ings opt ion 
is selected. 

!  QALoad processing t ime is not included with in these checkpoints in  order to provide a more 
accurate value of server, database, and network response t imes. 

Checkpoint durat ions do not always sum to the same value as the transact ion durat ion. For more 
in formation, see Comparing checkpoint durat ions to transact ion durat ion. 
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QALoad  Analyze M enus and  Toolbar  But t ons 
Click a menu or toolbar name in the fol lowing l ist  for a descript ion.  

Fi le 

Edit  

View 

Template 

Tools 

Window 

Help 

Analyze Toolbar buttons 

Graph Toolbar buttons  
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Accessing  Test  Dat a 

Using Timing Files 
When you run a test using a part icular session ID fi le (set up in  the Conductor), each Player compiles a 
local t im ing fi le comprised of a series of t im ing records for each checkpoint of each script  run on that 
Player. Each t im ing record in  the fi le consists of a response t ime/elapsed t ime pair of values specifying the 
amount of t ime i t  took a certain checkpoint to fin ish (response t ime) at a specific t ime in the test (elapsed 
t ime). 

At the end of a test, Player t im ing fi les are sent to the Conductor and are merged into a single t im ing fi le, 
cal led the Primary t im ing fi le, for analysis. If you set  up in tegrat ion with Compuware's ServerVantage 
product, the Conductor col lects t im ing data from the ServerVantage central console and merges that data 
in to the t im ing fi le as well . 

Primary t im ing fi les are saved in the \Program Files\Compuware\QALoad\TimingFiles directory, and 
are name <sessionID>_date_time.tim. 

The Primary t im ing fi le created by the Conductor after a test run contains al l  of the t im ing records of al l  
Players in  that test run. Use QALoad Analyze to view, sort , graph, and create reports using the test data in  
the t im ing fi le. 

Hint : In the event that something goes wrong on the network and a Player timing file is not passed to the 
Conductor, it is still possible to analyze results from a Player timing file. Player timing files are saved in the 
\Program Files\Compuware\QALoad\TimingFiles directory and are named 
tim_yyyymmdd_hhmmss_xxx.ptf, where yyyymmdd_hhmmss is the date/ time the test was started, and 
xxx is the Player number. 

Accessing Test  Data 
When you open a t im ing fi le, QALoad ’s Analyze program summarizes the checkpoints recorded in the fi le 
during the load test and presents the data in  a report  format cal led the Summary report .  

You can access QALoad Analyze and open a t im ing fi le contain ing test results from each of the QALoad 
components. 

To access Analyze f rom  t he QALoad Conduct or : 

1. In  the QALoad Conductor, cl ick Tools>Opt ions. The Options dialog box appears. 

2. Click the General  tab. In  the General Options area, select the Launch  An alyze Af ter Test  check 
box . 

At the end of each test run, QALoad Conductor automatical ly launches QALoad Analyze and opens the 
most recent t im ing fi le. If you did not select the Launch Analyze After Test check box before the test: 

1. Click Tools>Analyze. 

2. In  QALoad Analyze, cl ick Fi l e>Open . The Open Timing Fi le dialog box appears. Select a t im ing fi le 
to work with by double-cl icking the fi le name in the l ist  of avai lable t im ing fi les. 

To access a previously-creat ed t im ing f i le in  Analyze f rom  t he W indow s St ar t  m enu: 

1. Click Start>Program  Fi les>Com puw are> QALoad >Analyze. 
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2. Click Fi l e>Open . The Open Timing Fi le dialog box appears. Select a t im ing fi le to work with by 
double-cl icking the fi le name in the l ist  of avai lable t im ing fi les. 

3. Select the template to use for viewing the t im ing fi le. 

To access a previously creat ed t im ing f i le f rom  t he QALoad Scr ip t  Developm ent  W orkbench: 

1. In  the QALoad Script Development Workbench, cl ick Tools>Analyze. 

2. In  QALoad Analyze, cl ick Fi l e>Open . The Open Timing Fi le dialog box appears. Select a t im ing fi le 
to work with by double-cl icking the fi le name in the l ist  of avai lable t im ing fi les. 

3. Select the template to use for viewing the t im ing fi le. 

Accessing Test  Data via Groups 
The QALoad Analyze Workspace displays t im ing fi le data in  groups. Each group displays different aspects 
of the data from a t im ing fi le. The data displayed and the groups avai lable may vary, depending on the 
type of data col lected during the load test. 

Cl ick a group name below to view the type of data displayed in each group. 

Reports Top Processes 

Checkpoints RIP Fi les 

Counters Appl icat ionVantage 

Server Monitoring Expert  User 

Player Performance Counters  
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Using Templates 

Using Timing File Templates  

Timing fi le templates enable you to save current views of an open t im ing fi le. Al l  open views, such as 
reports, graphs, and thresholds are stored in  the template. When you reopen a t im ing fi le or open a new 
t im ing fi le and apply a template, i t  appears with the set of views defined for the template.  

Every t ime you close a t im ing fi le in  Analyze, a Last Viewed State template for the t im ing fi le is created. 
This fi le stores the reports and graphs that are open, their posit ions and sizes, and any thresholds you 
defined. You can use an opt ion s in  the Open  menu or in  the Tools>Opt ions menu to choose to reopen a 
t im ing fi le in  the same state i ts last viewed state.   

Use the Tem plate menu to: 

!  Save the current views of a t im ing fi le to create a template. 

!  Select an exist ing template and apply i t  to the open t im ing fi le. 

!  Remove the template from the current t im ing fi le or from disk. 

!  Create system-wide thresholds for counters and checkpoints. 

You can apply a template to any t im ing fi le you open. If any part  of the template cannot be appl ied to the 
t im ing fi le, for example, i f the template references a script  that doesn't  exist  in  the current fi le, a dialog box 
displays with the name of the report  or graph that doesn't  apply. The default  name for the template is the 
SessionID port ion of the f i le name of the open t im ing fi le.  

Note: Only one t im ing fi le is saved to a template. If more than one t im ing fi le is open, the opt ion to 
define a template is disabled. 

Creat ing a New Template 

Create a template to save the views of an open t im ing fi le. This saves reports and graphs that are open, as 
well  any thresholds that have been defined. When you open other t im ing fi les using the template, the fi les 
display in  the views saved to the template.  

To creat e a new  t em plat e: 

1. Click Tem plate>Save curren t  view s. The Speci fy Tem plate to Save curren t  view s and 
th resholds dialog box appears. 

Note: This menu option is available only if a single timing file is open. 

2. Select a folder in  the Save in  field. By default , al l  templates are stored in  the Tem plates folder. The 
default  template name is the Session ID port ion of the t im ing fi le name.  

3. Do one of the fol lowing: 

 Click Create to accept the Session ID as the template name. When you use th is name 
for the template, al l  future t im ing fi les created by th is Conductor session automatical ly 
open with the views speci fied in  the template. 

 Type a name for the new template in  the Fi l e nam e field, and cl ick Create.  

Note: You can choose template options that globally set how timing files open using the options 
in the Analyze Options dialog box . 



QALoad 05.06 Using the Player, Script  Development Workbench, and Analyze 

252 

Opening a Timing File in a Template 

When you open a t im ing fi le, you can select how it  displays by opening i t  in  a template. Specifying a 
template opens the reports, graphs, and thresholds defined in the template. 

To open a t im ing f i le in  a t em plat e: 

1. Click Fi l e>Open . The Open  Tim ing Fi l e dialog box displays. 

2. In  the Fi l e nam e field, select the t im ing fi le to open. 

3. Select one of the fol lowing: 

!  Open  last  view ed state i f  avai lable - (Default) Opens the t im ing fi le in  the same views that 
were displayed when you last closed i t .  This restores al l  reports and graphs that were open, 
their posit ions and sizes, as well  as any defined thresholds for graphs. If there is no last viewed 
state or i f you do not select th is opt ion, the fi le opens using the opt ion you select in  the 
Tem plate area below. 

!  In  the Tem plate area, cl ick one of the fol lowing opt ions: 

"  Do NOT use a tem plate w hen  open ing t im ing f i le - No template is appl ied and only the 
Summary report  for the t im ing fi le displays. 

"  Use tem plate associated w i th  Session  ID f i l e nam e - (Default) Appl ies the template with 
the same Session ID name as the t im ing fi le. Use th is opt ion to open al l  future t im ing fi les 
created by th is Conductor session with the views specified in  the template. If no match is 
found, only the Summary report  displays. 

"  Use th i s tem plate for open ing the t im ing f i l e - Enables the Brow se (...) button. Select a 
saved template to apply to al l  t im ing fi les when they are opened.  

Note: By default, both the Open in last  viewed state if available and Use template associated with the 
Session ID file name are selected. This way if there is no last viewed state, the template associated with the 
Session ID file name is applied to the timing file. 

4. Click Open . The t im ing fi le you selected appears in  the views defined for the selected template. 

Applying a Template to an Open Timing File 

You can select an exist ing template and apply i t  to al l  open t im ing fi les. This closes al l  reports and graphs 
that are open and displays the t im ing fi le in  the views defined in the template.  

To apply a t em plat e t o an open t im ing f i le: 

1. Click Tem plate>Use ex ist i ng. The Select Template to Use for Open Timing Fi les dialog box 
appears. 

2. Select a template and cl ick Apply.  

Al l  open reports and graphs are closed and those specified in  the template are opened.  

Note: If any part of the template cannot be applied to the timing file, for example, if the template 
references a script that does not exist in the current file, a dialog box appears with the name of the report or 
graph that cannot be displayed. 
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Applying Templates Globally with the Opt ions Dialog Box 

Use the Analyze Options dialog box to select template opt ions that global ly set how t im ing fi les open. 
Using a template saves the reports, graphs, and thresholds defined in the template.  

Note: Use Template>Use Exist ing to apply a template to an individual open timing file.   

To speci f y a t em plat e: 

1. Click Tools>Opt ions.   

2. Click the Tem plates tab and select one of the fol lowing: 

 Open  last  view ed state i f  avai lable - (Default) Opens the t im ing fi le in  the same views 
that were displayed when you last closed i t . This restores al l  reports and graphs that 
were open, their posit ions and sizes, as well  as any defined thresholds for graphs. If 
there is no last viewed state or i f you do not select th is opt ion, the fi le opens using the 
opt ion selected in  the Tem plate area below.  

 In  the Tem plate area, select one of the fol lowing: 

o Do NOT use a tem plate w hen  open ing t im ing f i les - No template is appl ied. The 
Summary report  for the t im ing fi le displays.  

o Use tem plate associated w i th  the Session  ID f i l e nam e - (Default) Appl ies the template 
with the same Session ID name as the t im ing fi le. Use th is opt ion to open al l  future t im ing 
fi les created by th is Conductor session with the views specified in  the template. If no match 
is found, only the Summary report  displays.  

o Use th i s tem plate for open ing t im ing f i l es - Enables the Browse (...) button. Select a saved 
template to apply to al l  t im ing fi les when they are opened.  

Note: By default, both Open in last  viewed state if available and Use template associated with the 
Session ID file name are selected. This way if there is no last viewed state, the template associated with the 
Session ID file name is applied to the timing file. 
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Disp laying  Det ai l  Dat a 

Displaying Detail Data 
Display detai led stat ist ics from a t im ing fi le such as checkpoints, counters, in  the QALoad Analyze Data 
window. View stat ist ics for not only the act ive t im ing fi le, but also for other t im ing fi les and drag and drop 
onto the act ive t im ing fi le detai l  view. 

To d isplay det ai led st at ist ics: 

1. In  the workspace, with the appropriate Timing Fi le tab selected, cl ick the group for which you want 
to view stat ist ics.  

2. Select the appropriate checkpoints or counters (depending on which group you choose).  

3. From the Analyze toolbar, cl ick the Detai l  button or right-cl ick on a selected checkpoint or counter 
and choose Detai l .  

Detai l  in formation is presented in the Data window in both a summary and data table. The information  
displayed varies based on the group selected.  

Note: If the test aborts, complete data for all the checkpoints and counters may not display. 

The fol lowing detai l  views are avai lable: 

Checkpoints Detai l  Data 

Counters Detai l  Data 

Server Monitoring Detai l  Data 

Player Performance Counters Detai l  Data 

Top Processes Detai l  Data 

Expert  User Detai l  Data 

Detail Views 
You can view detai l  data by right-cl icking a script  or group and select ing Detai l . The detai l  view displays 
data from a t im ing fi le. The data displayed and the groups avai lable may vary, depending on the type of 
data that was col lected during the load test. Detai l  data is displayed in two panes: a summary table and a 
data table.  

You can view detai ls for the fol lowing groups: 

Checkpoints 

Counters 

Server Monitoring 

Player Performance Counters 

Top Processes 

Expert Users 
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Sort ing Test  Data 
A Detai l  view potent ial ly contains a large number of checkpoints, counters, and so forth, especial ly i f a 
load test had many virtual users. To make information manageable, specify up to three levels of cri teria to 
sort  by, in  ascending or descending order. 

For example, i f a test ran using five scripts on 100 virtual users, sort  the data by script  name. Suppose each 
virtual user ran more than one transact ion using a part icular script , then sort  by both script  name and by 
virtual user. Or, to quickly locate any t im ing bott lenecks, sort  by response t ime. 

Use the Sort  Detai ls dialog box to sort  a detai l  view. To access th is dialog box, select Tools>Sort  from the 
Analyze menu or cl ick Sort  on the Analyze toolbar. 

Graphing QALoad Timing Data 
A t im ing fi le can potent ial ly contain enough data that graphing al l  of i t  at  one t ime results in  an 
unreadable graph. Before beginning, consider th inning the amount of data to be shown on a single graph. 
Detai ls 

Select  t he group t o graph: 

In the Workspace, with the appropriate Timing Fi le tab selected, cl ick the group for which to create a 
graph.  

Note: If the test aborts, complete data may not be available for all checkpoints and counters. 

The fol lowing groups are avai lable, depending on the t im ing fi le: 

Checkpoints 

Counters 

Server Monitoring 

Player Performance Counters 

Top Processes 

Expert User 
Note: For each Group except Checkpoints and Expert User, the graph type is a line graph. For graphing 

multiple checkpoints or expert users, the graph type is either a line or bar graph. For graphing a single 
checkpoint only, in addition to line and bar graphs, you can also create Response Time Distribution and 
Cumulative Response Time Distribution graphs. 

Thresholds 

Using Thresholds 

Thresholds are user-defined values that show the expected warning and cri t ical l im its for a counter or 
checkpoint. Thresholds help ident i fy problem areas in  the test, such as checkpoints or counters that go 
above or below a specified number. They act ively monitor response t imes by indicat ing whether data 
records are surpassing user-defined expected warning and cri t ical levels.  

Thresholds are saved in the Template fi le. The information displays in  graphs and detai l  reports in  the 
detai l  data view.  
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Graphs 

The selected data is displayed in a l ine graph format in  the Data window. Graphs show thresholds as 
horizontal l ines with the number of fai led points.  

 

Detail Reports 

Detai l  reports display thresholds in  a Summary table and a Data table. The Summary table is a summary of 
raw data col lected from a load test. The defined threshold l im its, the percentage of fai lures for the 
threshold, and the total violat ions are displayed. In the Data table, the fai led points are shown in red. 
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Creat ing Thresholds 

Define thresholds to show the expected warning and cri t ical l im its for a counter or checkpoint. 

To creat e Thresholds: 

1. Select Tem plate>Th resholds. The Th resholds dialog box appears. 

2. Click the appropriate group in the Workspace. Data with in each group is l isted in  a tree-view. 

3. Highl ight a counter or checkpoint and drag i t  to the Th reshold dialog box.  

Note: You can drag entire groups or individual items to the Threshold dialog box.  

4. Click Edit  to name the threshold and set the threshold l im its and condit ions. 

5. Do one of the fol lowing: 

!  Click the check box in  the Act i ve column for the thresholds you want to use, then cl ick Apply.  

!  Click Act i vate Al l  to use al l  of the thresholds, then cl ick Apply. 

Edit ing Thresholds 

Once you create the threshold, set the threshold propert ies using the Edi t  funct ion. 

To edi t  Thresholds: 

1. In  the Th resholds dialog box, do one of the fol lowing: 

 Double-cl ick the threshold you want to edit .  

 Highl ight the appropriate threshold and cl ick Edi t . 

The Th reshold Propert i es dialog box appears. 

2. In  the Th reshold Label  field, type a name for the threshold. This is opt ional. 

3. In  the Lim i t  field, type the number for the threshold. This is used with the Condi t i on  you select to 
calculate violat ions. 
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4. In  the Lim i t  Condi t ion  sect ion, choose how the threshold violat ions are calculated. You can select : 

!  Greater than the threshold l im it  you defined (>) 

!  Equal to the threshold l im it  you defined (=) 

!  Less than the threshold l im it  you defined (<) 

5. Click OK. The Th reshold dialog box appears showing the l im it and condit ion you specified. 

Viewing Thresholds 

Threshold in formation displays in  graphs and detai l  reports in  the detai l  data view .  

Note: The data displayed and the groups available may vary, depending on the type of data that is 
collected during the load test. 

To view  t h resholds in  g raphs: 

1. In  the Workspace, cl ick the appropriate Timing Fi le tab. Data is l isted in  a tree-view. 

2. Click the group to view, and select the appropriate checkpoints or counters to display in  the graph. 
  

Note: You can select an entire group or individual data files. 

3. Click View > Graph  or right-cl ick and choose Graph  from the context menu.  

The selected data displays in  a l ine graph format in  the Data window.  Graphs show thresholds as 
horizontal l ines with the number of fai led points.  

To view  t h resholds in  det ai l  repor t s: 

1. In  the Workspace, cl ick the appropriate Timing Fi le tab. Data is l isted in  a tree-view. 

2. Click the group to view, and select the appropriate checkpoints or counters to display in  the detai l  
report .  

Note: You can select an entire group or individual data files. 

3. Click View > Detai l  or right-cl ick and choose Detai l  from the context menu.  

The detai l  report  for the selected data displays. Detai l  reports display thresholds in  a Summary table and a 
Data table. The Summary table is a summary of raw data col lected from a load test. In  the Data table, the 
fai led points are shown in red. 
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Cr eat ing  a Char t  or  Gr ap h  

Analyze Graph Types 
The fol lowing basic graph types are avai lable in  QALoad Analyze.   

Line Graph 

A l ine graph plots response t imes versus elapsed t imes for the selected checkpoints. It  provides a good 
representat ion of how much fluctuat ion there is in  response t imes over the course of a test. 

Bar Graph 

A bar graph shows the median, mean, or percent i le response t imes for the selected checkpoints. 

Transaction Throughput Graph 

This type of graph shows the cumulat ive number of t ransact ions that occurred with in the user-specified 
t ime range over the durat ion of the test. 

Response Time Distribution Graph 

This type of graph shows the percentage of checkpoint t im ings that fal l  with in a part icular response t ime 
range. A response t ime distribut ion graph shows i f response t imes tend to fal l  with in the range or are 
widely dispersed. A response t ime distribut ion graph only shows results for a single checkpoint, al though i t  
can compare results from mult iple t im ing fi les. 

Cumulative Response Time Distribution Graph 

This type of graph shows the percentage of t ransact ions for a single checkpoint that have a response t ime 
equal to or less than a specified value. 

Graphing QALoad Timing Data 
A t im ing fi le can potent ial ly contain enough data that graphing al l  of i t  at  one t ime results in  an 
unreadable graph. Before beginning, consider th inning the amount of data to be shown on a single graph. 
Detai ls 

Select  t he group t o graph: 

In the Workspace, with the appropriate Timing Fi le tab selected, cl ick the group for which to create a 
graph.  

Note: If the test aborts, complete data may not be available for all checkpoints and counters. 

The fol lowing groups are avai lable, depending on the t im ing fi le: 

Checkpoints 

Counters 

Server Monitoring 

Player Performance Counters 

Top Processes 

Expert User 
Note: For each Group except Checkpoints and Expert User, the graph type is a line graph. For graphing 

multiple checkpoints or expert users, the graph type is either a line or bar graph. For graphing a single 
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checkpoint only, in addition to line and bar graphs, you can also create Response Time Distribution and 
Cumulative Response Time Distribution graphs. 

Thinning Data Before Graphing 
Test results may contain more data than can reasonably be graphed. Thinning data before graphing 
provides a clearer and more manageable graph. 

To t h in t im ing dat a in  Conduct or : 

1. With your test session ID fi le open, cl ick the Scri pt  Assignm en t  tab. 

2. For each script  for which you would l ike to th in your test data, cl ick the button in  the Tim ing 
Opt ions column. 

3. On the Timing Options dialog box, cl ick the Enable Tim ing Data Th inn ing check box. 

4. In  the Th in  Every... field, type the number of t ransact ions to average. The average is sent to the 
Conductor for inclusion in  the t im ing fi le, rather than every value. 

5. Click OK. 

6. Save your changes to your test session ID fi le by choosing Fi l e>Save from the Conductor menu. 

For more detai ls about the Timing Options dialog box, see Timing Options. 

To set  up dat a t h inning  in  Analyze: 

1. With a t im ing fi le open, cl ick Tools>Opt ions. 

2. Click the Data Th inn ing tab. 

3. Type the number of data points to plot on each graph and select the method by which to graph the 
data points. 

4. Click OK. 

For a descript ion of the opt ions on th is dialog box, see Options Dialog Box - Data Thinning Tab.  

Graphing Checkpoints 
Note: A timing file can potentially contain enough data that graphing all of it at one time results in an 

unreadable graph. Before beginning, consider thinning the amount of data to be shown on a single graph. 
Details 

To graph checkpoin t s: 

1. Open the appropriate .t im  fi le in  QALoad Analyze. In  the Workspace, cl ick the Checkpoin ts group. 
Checkpoint data is l isted in  a tree-view. 

2. Select the checkpoints to graph. 

3. From the View  menu, choose Graph . The Select Graph dialog box appears.  

4. In  the Graph Type drop-down l ist , select from the fol lowing: 

 Line (response t imes versus elapsed t imes for the selected data.) 

 Bar (median, mean, or a percent i le response t ime of the selected checkpoints.) 
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Note: The BAR graph displays only one data point for each selected counter. The data point represents 
the mean, median, or percentile response time. When you select a LINE graph after a BAR graph through the 
BAR graph’s context menu, the LINE graph displays the data of the BAR graph, not the data from the tree 
control on the left pane. Since there is only one data point per selected counter, the line graph does not 
display a line. This display is different from the LINE graph that you request from the tree control, which 
displays all the data points for each selected counter. 

The following graph types are only available when graphing a single checkpoint: 

 Response Time Distribut ion (how the response t imes of a single checkpoint are distributed.) 

 Cumulat ive Response Time Distribut ion (the percentage of checkpoint t im ings that were equal 
to or less than a specified value.) 

Data for the selected checkpoint(s) is graphed in the Data window in the format selected in  step 4. 

Graphing Counters 
Note: A timing file can potentially contain enough data that graphing all of it at one time results in an 

unreadable graph. Before beginning, consider thinning the amount of data to be shown on a single graph. 
Details 

To graph count er s: 

1. Open the appropriate .t im  fi le in  QALoad Analyze. In  the Workspace, cl ick the Coun ters group. 
Counter data is l isted in  a tree-view. 

2. Select the counter(s) to graph. 

3. From the View  menu, choose Graph . Data for the selected counter(s) is graphed in a l ine graph 
format in  the Data window. 

Graphing Player Performance Counters 
Note: A timing file can potentially contain enough data that graphing all of it at one time results in an 

unreadable graph. Before beginning, consider thinning the amount of data to be shown on a single graph. 
Details 

To graph Player  per f orm ance count er s: 

1. Open the appropriate .t im  fi le in  QALoad Analyze. Select the Player Perform ance Coun ters group. 

2. In  the Workspace, select the performance counter(s) to graph. 

3. Click the View  Graph  but ton or right-cl ick and choose Graph  from the context menu. Data for the 
selected Agent(s) is graphed in a l ine graph format in  the Data window. 

Graphing Server Monitoring Data 
Monitoring servers is a method of load test ing. QALoad provides performance counter data through three 
server monitoring methods: 

!  Remote M onitoring - Performs the monitoring of performance counters from a machine under test 
without the use of agent software on the machine. 

!  Server Analysis - Performs the monitoring of performance counters from a machine under test 
using the ServerVantage agent software instal led on  the machine. 
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!  ServerVantage - An Avai labi l i ty Management appl icat ion complementary to QALoad for service 
level monitoring of performance counters for appl icat ions, servers, and databases during 
product ion. ServerVantage also provides not i ficat ion, event management, and report ing features. 

Graphing Top Processes 
Note: A timing file can potentially contain enough data that graphing all of it at one time results in an 

unreadable graph. Before beginning, consider thinning the amount of data to be shown on a single graph. 
Details 

To graph t op  processes: 

1. Open the appropriate .t im  fi le in  QALoad Analyze. Select the Top Processes group.  

Note: The Top Processes group is available only if you enable the option in the QALoad Conductor Server 
Analysis Agent configuration screen before running a test. 

2. In  the Workspace, select the data point(s) to graph. 

3. Click the View  Graph  but ton or right-cl ick and choose Graph  from the context menu. Data for the 
selected Agent(s) is graphed in a l ine graph format in  the Data window. 

Graphing Expert  User Data 
Note: A timing file can potentially contain enough data that graphing all of it at one time results in an 

unreadable graph. Before beginning, consider thinning the amount of data to be shown on a single graph. 
Details 

To graph exper t  user  dat a: 

1. Open the appropriate .t im  fi le in  QALoad Analyze.  

2. Select the Expert  User group in the Workspace tree-view. 

3. In  the Workspace, select the data point(s) to graph. 

4. Click the View  Graph  but ton or right-cl ick and choose Graph  from the context menu. Data for the 
selected Agent(s) is graphed in a l ine graph format in  the Data window. 

Creat ing a Scat ter Chart  

To creat e a scat t er  char t : 

1. Click the View  Graph  but ton or choose Graph  from the View  menu. The Select Graph dialog box 
appears. 

2. Select the Line graph type.  

3. Click OK. Data for the selected checkpoints is presented in a l ine graph format in  QALoad Analyze’s 
data window. 

4. Right-cl ick anywhere in  the graph, and select Gal lery from the menu. The gal lery of graph types 
displays. 

5. Click the Scatter  type graph.  

6. Right-cl ick anywhere in  the graph.  
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7. Select Propert i es from the menu. The Chart FX Propert ies dialog box displays. 

8. Click the Series tab. 

9. In  the Show  every: field, cl ick the up or down arrow to increase or decrease the number of data 
points displayed, for example, show every 5th point. 

10. In  the Size: field, cl ick the up or down arrow to increase or decrease the size of the scatter points.   

11. Click Apply. 

12. In  the Shape: field, cl ick the arrow and select the shape for the scatter points. 

13. Click Apply, then cl ick OK. 

See Customizing a graph for more in formation about customizing a graph.  

Creat ing Financial Charts 
There are three financial charts in  QALoad Analyze: Candlest ick, High-low-close, and Open-high-low-close. 
Use th is procedure to display these charts in  the graph Gallery, and then create graphs of these types. 

To access t he f inancial  char t s: 

1. Go to the QALoad root directory. The default  is c:\Program Files\Compuware\QALoad. 

2. In  a text editor, open the graphprops.xm l  fi le. 

3. In  the l ine <FinancialCharts value="false/">, replace the value by h ighl ight ing the word false 
and typing true. 

4. Click Fi l e>Save, then cl ick Fi l e>Ex i t . 

To use t he f inancial  char t s: 

In  QALoad Analyze, do the fol lowing: 

1. Click the View  Graph  but ton or choose Graph  from the View  menu. The Select Graph dialog box 
appears. 

2. Click the down arrow select the Line graph type.  

3. Click OK. Data for the selected checkpoints is presented in a l ine graph format in  QALoad Analyze’s 
data window. 

4. Right-cl ick anywhere in  the graph. 

5. Select Gal lery from the menu. The gal lery of graph types displays. 

6. Click the graph you want to use.  
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Cust om izing  a Char t  or  Gr aph  

Customizing a Graph 
Change the style and appearance of a graph using opt ions avai lable from either of the Graph toolbars. The 
Graph toolbars contain buttons for standard Windows operat ions as well  as for customizing a graph's 
appearance. Display the Graph toolbars by right-cl icking in  an open area of a graph and choosing 
Toolbars>Toolbar or An notate Toolbar from the shortcut menu. 

The fol lowing features can be customized from the Graph toolbar. Cl ick on any feature in  the fol lowing 
l ists for addit ional in formation or instruct ions: 

Graph Type 

Color 

Grid Orientat ion (horizontal and vert ical) 

Legend Box 

Dimension (3D or 2D) 

Rotat ion 

Z-Cluster 

Font  

Text/Object 

Adding Text  or an Object  to a Graph 
To create explanatory text  or an object on a graph, use any of the text or object buttons on the Graph 
Annotate toolbar.   

To add a not e or  object  t o a graph t em plat e: 

1. Display the Annotate toolbar. 

2. Add text and/or an object  to the graph .  

Storing a Note or Object  in a Template 

You can add explanatory text or objects to a graph to be ut i l ized as part  of a template when the template is 

appl ied to future t im ing fi les. For text, use the Tex t  Box  or the Bal loon  w i th  Tex t  button . To 

create an object, use the Rectangle or Ci rcle button .  

Note: These are the only objects that can be stored in a template.  

To save t he in f orm at ion  in  a t em plat e: 

1. Complete the steps above for adding a note or object. 

2. Follow the instruct ions for Creat ing a New Template. The saved note or object is avai lable when 
the template is appl ied to future t im ing fi les.  
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View ing  Repor t s 

Pre-Defined Reports 
QALoad Analyze provides pre-defined reports for viewing load test results without t ime-consuming data 
manipulat ion. 

In  the Workspace, select the Reports group and cl ick the appropriate report . The reports are in  HTML 
generated by XSL fi les. View them in QALoad Analyze, or direct ly in  a Web browser.  

Note: Compuware provides each of the available pre-defined reports as convenience to view the results of 
a load test without any data manipulation. In addition, create customized versions of these reports by 
selecting the appropriate group and creating detail reports and graphs. 

The fol lowing reports are avai lable. Cl ick a report  name for detai ls. 

Summary 

Session 

Concurrent Users 

Response Time Analysis 

Output 

Cl ient Throughput 

Server Monitoring 

Transact ion Throughput 

Top Ten Longest Checkpoint Durat ions 

Worst Performing Checkpoints and Counters 

Player Performance  

Expert  User 

Appl icat ion Vantage 
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Summary report  
The Summary report  is the primary output from each test run, one of the pre-defined reports QALoad 
Analyze makes avai lable. When you open a t im ing fi le, QALoad Analyze automatical ly displays the Load 
Test Summary in  the Data window. It  presents t im ing in formation for each transact ion in  the t im ing fi le 
and the min imum, maximum, and median response t imes for each checkpoint.  

The output is divided into two sect ions. The first  sect ion presents the Summary Test In formation, Test 
Time information, and Data Thinning and Time Range information. The second sect ion presents the Script 
In formation for each script . It  shows t im ing Summaries and Checkpoint in formation for each script . 

With the Summary Report open in Analyze, cl ick a heading in  the Test In formation area to display detai led 
in formation on scripts, errors, and messages. When you enable data th inning, the number of errors and 
messages is th inned, accordingly. 

Note: There is a limit of 3000 errors processed for each script and 3000 messages processed for each 
group within a script. When you click # Errors or #Messages for detailed information, any script or group 
within the script that exceeds the limit does not display. A script or group can fall within the limit when data is 
thinned but exceed the limit when data is not thinned. This means that more scripts may appear in the Error 
section and more groups may appear within scripts in the Script Message section when data is thinned. 

Sample Summary Report  

For a brief descript ion of each report  sect ion, scrol l  down and cl ick a sect ion heading in  the fol lowing 
sample.  
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Session report  
Provides summary in formation about the test session. The information in  th is report  was obtained from 
the Conductor’s configurat ion sett ings when the load test was started. To view a summary of test sett ings 
that includes changes made while the test was running, see the Summary report .  
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For descript ions of the in formation provided in each sect ion, cl ick the sect ions in  the fol lowing image.  

 

 

Concurrent  Users report  
Displays the total number of virtual users for the test, concurrent users vs. elapsed t ime, as well  as graphs 
for individual scripts that were part  of the test.  

Note: A totals graph will not display if the test contains only one script. 
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Response Time Analysis report  
Provides an indicator of how well  a script  ran. The report  displays a graph of each script 's transact ion 
durat ion (response t ime vs. elapsed t ime) as well  as the fol lowing checkpoint summary data: 

#Tran s: Number of data points used to calculate the stat ist ics. 
#Recs: Number of data records. This value, i f di fferent from the value of #Trans, reflects the number of 
checkpoint records that are used for analysis after data th inning has been appl ied. 
M in : M in imum recorded response t ime. 
M ax : Maximum recorded response t ime. 
Std. Dev: Standard deviat ion of al l  response t imes. A large standard deviat ion indicates a wide variance in 
response t imes. 
M edian : Median response t ime, in  seconds. 
nth%: n percent of the responses have a value less than the value shown.  

 

 

Output  report  
Provides a cumulat ive l ist  of al l  errors, sorted by script  and occurrence in t ime, that occurred during the 
course of a load test.  

Note: Failed messages are included in the errors count that appears in the Test Information section of the 
report, but are detailed in the Script Messages section. 
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Client  Throughput  report  
Provides a graph of HTTP Reply analysis for key HTTP counters, HTTP counter vs. elapsed t ime. 

 

Server Monitoring report  
Server monitoring is a component of load test ing. QALoad provides performance counter data through 
three server monitoring methods: Remote M onitoring, ServerVantage, and Server Analysis Agent 
monitoring. 
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Transact ion Throughput  report  
Provides the cumulat ive number of t ransact ions over elapsed t ime for each script  and for the total test.  
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Top Ten Longest  Checkpoint  Durat ions Report  
Provides graphs and l ists detai ls about checkpoints that had the longest checkpoint durat ion during the 
test. Checkpoints with longest durat ions are those that consumed the most amount of t ime during the test. 
This report  contains the fol lowing sect ions: 

!  A summary sect ion with overview information about the test.  

!  A bar graph of the ten longest checkpoint durat ions in  the test, fol lowed by detai ls for each 
checkpoint in  the graph. These checkpoints can originate in  any script  that was included in the 
test. 
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!  Bar graphs for each script  that show up to the ten longest checkpoint durat ions, fol lowed by detai ls 
for each checkpoint in  the script . 

The report  is generated by Analyze only i f each script  has at least one checkpoint other than the durat ion 
checkpoint. The data provided in the report  can be used as a start ing point to ident i fy performance 
problems. 

Note: Transaction duration checkpoints are not included in the report. 
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Player Performance report  
Displays transact ion durat ions in  a graph format by player machine. This report  helps ident i fy individual 
player machines that have poor test results. In  addi t ion to the bar graph that plots the average transact ion 
durat ion for each player machine, the report  also includes summary data for the overal l  test, and detai ls for 
each player machine. This report  is generated by Analyze only i f two or more player machines were used in 
the test.  

 

Worst  Performing Checkpoints and Counters Report  
This report  provides graphs and l ists detai ls about checkpoints and counters that had the worst 
performance during the test. Performance is based on the thresholds you define.  

Checkpoints with the worst performance are calculated using the average response t ime for each 
checkpoint. Counters with the worst performance are those that consume the most amount of t ime during 
the test. Checkpoints with the most errors and counters with the h ighest fai lure rates are l isted first . The 
data provided is a start ing point for ident i fying performance problems. 

Note: The report is generated by Analyze only if a threshold is defined and if the threshold is violated by 
the data. Thresholds that are not violated do not appear in the report. 

The bar graphs for each script  show up to ten of the longest checkpoint durat ions and are fol lowed by 
detai ls for each checkpoin t in  the graph. The checkpoints can originate in  any script  that was included in 
the test. The report  contains the fol lowing sect ions: 

!  A summary sect ion with overview information about the test.  

!  Bar graphs for checkpoints and bar graphs for counters showing the fol lowing:  

 Sum m ary by percen tage of  violat i ons - Shows the number of points that exceeded the 
threshold divided by the total number of data points. For example, in  the report  for counters 
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below, the total fai lure of 8 divided by the total records of 60, yields a fai lure rate of 13.3 
percent. 

 Sum m ary by severi ty - Shows the percent of t ime during the test that the data is in  violat ion 
of the threshold. This calculat ion uses a weighted average to determine the percentage. For 
example, in  the report  for counters below, when the weighted average is used to calculate the 
severi ty, the fai lure rate is 7.6 percent and 6.5 percent.  

Since the first  method measures the fai lure rate by percentage of violat ions, and the second method 
measures fai lures by the amount of t ime the data is in  violat ion, the numbers can differ great ly between 
the two methods. It  is possible for a data set to have a 5 percent fai lure rate when calculated by percentage 
of fai lures, and an 80 percent fai lure rate when calculated by severi ty. This can indicate that an error 
deviat ing significant ly from the norm may be a more notable fai lure than a greater number of fai lures. 

In  the example below, the counter summary by percent of violat ions for Server Analysis shows a total of 8 
fai lures out of 60 records, for a fai lure rate of 13.3 percent. The percentage of violat ions for Remote 
Monitoring has a total of 3 fai lures in  41 records, for a fai lure rate of 4.2 percent.  

When measured by severi ty, however, the fai lure rate for Remote Monitoring is more serious than for 
Server Analysis. Here, the fai lure rate for Remote M onitoring is 7.6 percent compared to the rate 6.5 
percent for Server Analysis.  

Note: Transaction duration checkpoints are not included in the report. 
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Expert  User Report   
Displays in formation on the scripts that ran on each player machine with the Expert  User opt ion enabled. 
It  provides a t im ing breakdown of the individual components, such as HTML, images, and objects, of the 
web pages that were requested during a test. The Expert User report  shows how much t ime i t  took to 
download a part icular component of a web page from the server. It  also shows the percentage of network 
and server t ime for the request. 

The Expert User report  contains a summary sect ion and a detai l  sect ion. The Summary sect ion at the top of 
the report  displays overview information about the test for each QALoad Player instance.  

The detai l  sect ion displays the main requests and each subrequest made when the script  executes. Main 
requests are made when Navigate_to(), Cl ick_On(), Post_to(), DO_http(), or DO_https() are executed in a 
WWW script. The subrequests, or Web components, that make up the main page can include html, css, js 
pages, and so forth. 

The percentage of server and network t ime displays in  the Average Server and Average Network fields, with 
a graphic representat ion in  the Server/Network field. This in formation can help you determine whether 
web pages with a h igh response t ime are having server- or network-related performance problems. If an  
except ional amount of t ime is being spent on the server, you can monitor the server that is under test 
using a server monitoring tool such as ServerVantage or QALoad's Remote M onitoring opt ions. If too much 
t ime is being spent on the network, you can monitor the network under test using a tool such as 
Appl icat ionVantage. 
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Applicat ionVantage Report  
Displays in formation on the scripts that ran on each player machine. It  contains a summary sect ion with 
overview information about the test, and a graph of the transact ion response t ime of the script  in  seconds. 

Note: If Expert User data was collected (WWW only), the Network and Server percentage data also is 
included.  

A detai l  sect ion displays the beginning and ending t ime for the trace fi les produced by the scripts running 
on the Appl icat ionVantage player machines. A separate sect ion appears for each Applicat ionVantage Player 
machine that ran during the test period, . 
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Pub l i sh ing  or  Shar ing  Test  Resu l t s 

Export ing Test  Data 
Convert test data in to three convenient formats for viewing or export ing: 

HTM L — Export data in  a detai l  view or graph to HTML fi les for convenient viewing in  a default  Web 
browser or for sending as attachments in  an email  message. See Export ing Data to HTML for instruct ions. 

RIP — Any t ime a user fai ls during load test ing, QALoad Analyze generates a RIP fi le contain ing user errors. 
If a t im ing fi le has RIP fi le data, you can export  the RIP fi le to the working folder and view i t  in  QALoad 
Analyze or the QALoad Script Development Workbench. See Export ing RIP Fi le Data for instruct ions.  

Appl i cat ionVan tage (AV) t race f i l es - When a t im ing fi le has Appl icat ionVantage data, you can export  
the Appl icat ionVantage trace fi les to a working directory and view them with in Appl icat ionVantage. See 
Export ing Appl icat ionVantage Trace Fi les for instruct ions. 

Export ing data to HTML 

To expor t  dat a f rom  a det ai l  view  t o HTM L: 

1. Open a t im ing fi le. 

2. Generate a detai l  view or graph. 

3. Click anywhere in  the detai l  view or graph, making i t  act ive. 

4. From the Fi l e menu, choose Export>Data. The Save As dialog box appears. 

5. Navigate to the appropriate locat ion for saving the HTML fi le and name the fi le. 

6. Select Web Page (*.h tm ;*.h tm l ) as the fi le type and cl ick Save. 

Export ing RIP file data 
Note: If a timing file does not contain any RIP data, then a RIP Files group will not exist in the Workspace. 

To expor t  t he RIP f i le dat a t o t he w ork ing f older : 

1. Open a t im ing fi le. 

2. In  the Workspace, cl ick the RIP Fi les group. 

3. In  the tree view, select the appropriate RIP fi les check box. 

4. Right-cl ick on the selected fi les and choose Export . The Browse For Folder dialog box appears. 

5. Select the folder you wish to export  the RIP fi le data to. The default  is the working folder. 

6. Click OK. Analyze exports the RIP fi le to the working folder. 

Export ing Applicat ionVantage Trace Files 
You can export  Appl icat ionVantage trace fi les to a working folder or to Appl icat ionVantage. 

Note: If a timing file does not contain any ApplicationVantage data, then the ApplicationVantage group 
does not exist in the Workspace. 
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To expor t  t he Appl icat ionVant age dat a t o a w ork ing  f older : 

1. Open a t im ing fi le. 

2. In  the Workspace, cl ick the Appl icat ionVantage group. 

3. In  the tree view, select the appropriate Appl icat ionVantage fi les check box. 

4. Right-cl ick on the selected fi les and choose Export  to Fi l e. The Browse For Folder dialog box 
appears. 

5. Select the folder you wish to export  the Appl icat ionVantage fi le data to. The default  is the working 
folder. 

6. Click OK. Analyze exports the Appl icat ionVantage fi le to the working folder. 

To expor t  t he Appl icat ionVant age dat a t o App l icat ionVant age: 

1. Open a t im ing fi le. 

2. In  the Workspace, cl ick the Appl icat ionVantage group. 

3. In  the tree view, select the appropriate Appl icat ionVantage fi les check boxes. 

4. Do one of the fol lowing: 

 Right-cl ick on the selected fi les and choose Export  to Appl i cat ionVan tage.  

 Double-cl ick the fi le to export . 

The trace fi les are loaded into the Appl icat ionVantage database and then opened in 
Appl icat ionVantage.  

Sending email messages with test  data 
If you are using a M icrosoft  mail  program, QALoad Analyze can send an emai l  message with a t im ing fi le or 
pre-defined report  at tached. The recipient(s) of the message wil l  be able to open the fi les in  a Web browser. 

To em ai l  p re-def ined repor t s: 

1. Choose Fi le>Send. 

2. In  the Send dialog box, select reports, views, and t im ing fi les from their respect ive tabs and cl ick 
Add to add them to the l ist  of i tems you want to send.  

3. In  the Send To field, choose Em ai l  Recipien t .  

4. (opt ional) Cl ick the Zip to f i l e check box to send the fi les in  the compressed .zip format. Type a 
name for the .zip fi le in  the adjacent field. 

5. Click OK. Analyze creates a new Outlook email  message that contains al l  of the pre-defined reports, 
.xml, .xsl, and fi les associated with the t im ing fi le as attachments, or a single .zip fi le that contains 
those fi les as an attachment. Address the email , add message text, and send the message. 

Creat ing a .zip f ile of test  results 
You can create a .zip fi le to convenient ly package al l  test data in to one fi le for sending to others or storing 
local ly. Analyze creates a f i le in  .zip format, which you can either save to a locat ion on your computer or 
send as an attachment to an email . 
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To creat e a .zip f i le: 

1. Choose Fi le>Send. 

2. In  the Send dialog box, select reports, views, and t im ing fi les from their respect ive tabs and cl ick 
Add to add them to the l ist  of i tems you want to include in the .zip fi le.  

3. In  the Send To field, choose Em ai l  Recipien t  to email  the zip fi le or choose Fi le to save the fi le on 
your computer.  

4. Click the Zip to f i l e check box to send the fi les in  the compressed .zip format. Type a name for the 
.zip fi le in  the adjacent field. 

5. If you chose Fi le in  step 3, type the path of the locat ion for the .zip fi le or cl ick the browse button 
[...] to select a locat ion. 

6. Click OK. Depending on which opt ion you chose in step 3, Analyze performs one of the fol lowing 
act ions: 

 If you chose Em ai l  Recipi en t , Analyze creates a new Outlook email  message that 
contains al l  of the pre-defined reports, .xml, .xsl, and fi les associated with the t im ing 
fi le as a single, compressed .zip fi le attachment. Address the email , add message text, 
and send the message. 

 If you chose Fi le, Analyze creates a single, compressed .zip fi le in  the locat ion you 
specified in  step 5 that contains al l  of the pre-defined reports, .xml, .xsl, and fi les 
associated with the t im ing fi le. 

Viewing Reports 
View reports generated by QALoad Analyze on a machine with QALoad instal led or on any machine with a 
Web browser. In  order to save the contents of a t im ing fi le's working folder when viewing reports, clear the 
Rem ove XM L Work ing Folder opt ion on the  Workspace tab of the Options dialog box. For more 
in formation, see Options Dialog Box - Workspace Tab.  

Viewing reports on a machine with QALoad Analyze 

To view reports in  QALoad Analyze, cl ick the Summary report  button or any of the pre-defined report  
buttons in  the QALoad Analyze Workspace. See Load Test Summary for a quick in troduct ion to viewing 
reports. 

Viewing reports on a machine without  QALoad Analyze 

To view reports in  a Web browser, copy the ent ire working folder for the t im ing fi le onto the machine. The 
fol lowing fi les are required (where <Summary> represents the name of the report): 

!  <Summary>.htm 

!  <Summary>.xml 

!  <Summary>.xsl 

In  addit ion, the M icrosoft  XML version 4.0 parser (provided with QALoad ) is required to view QALoad 
reports. View any of the pre-defined reports by cl icking the <Summary>.htm fi le to launch a report  with the 
assistance of the associated XML and XSL support fi les. 
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Other ways to view test  data 

View not only pre-defined reports, but also t im ing fi le detai l  views and graphs by export ing or sending 
email  messages with test data to another machine. Cl ick the fol lowing l inks for more in formation:  

!  Export ing Test Data 

!  Sending Email  Messages with Test Data 

Viewing test  results in a Web browser 
An important part  of the load test ing process is viewing and studying the results of a test. You can view the 
results of a load test not only on a machine where QALoad is instal led, but also on any machine with a 
Web browser. QALoad Analyze provides pre-defined reports as well  as .xml and .xsl fi les that can be 
customized to meet desired specificat ions. 

When you open a t im ing fi le, QALoad Analyze generates a working folder contain ing al l  support ing fi les, 
reports, and images generated from that t im ing fi le. This folder is located in  the directory \Program 
Files\Compuware\QALoad\TimingFiles\xxx.xml.source where <xxx> is the name of the t im ing fi le. 

The fol lowing fi les are found in the working folder: 

Fi l e Nam e Descript i on  

<timingfile>.xml.source Working folder generated in  the Reports folder when opening a 
t im ing fi le. The working folder name is always the <name of the 
t im ing fi le> with a .xml.source extension. 

<timingfile>.xml Original t im ing fi le with just enough information to create the 
QALoad Analyze pre-defined reports. It  is a representat ion of the 
t im ing fi le, <t im ingfi le>.t im. 

<timingfile>.complete.xml Original t im ing fi le contain ing al l  data col lected during a load 
test. It  can be an extremely large fi le. Use th is fi le i f creat ing a 
report  using XSL that requires th is data. 

summary.htm Use th is HTM fi le to view the Summary report  (or any other 
avai lable pre-defined report) in  any Web browser. 

summary.xml Generated XML fi le for the Summary report  (or any other 
avai lable pre-defined report .) 

summary.xsl Generated XSL fi le for the Summary report  or any other 
avai lable pre-defined report . Translates the .xml fi le specifying 
HTML as i ts output and generates the HTML report . Use th is fi le 
to customize the reports by writ ing in  .xsl. 

default.htm Report that provides a main screen to  launch any other pre-
defined reports. Uses nav.htm for the navigat ion frame. 

When closing a t im ing fi le, ei ther keep al l  of the reports generated from the t im ing fi le in  the working 
folder, or delete them. To set th is opt ion, see the Workspace tab on the Options dialog box. 

To view load test results in  a Web browser, cl ick: How to View Reports. 
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